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Introduction

Overview

This manual describes how to configure and monitor the SMxTBTxSA via the web via its RJ-45 serial
interface and Ethernet ports.

The SM8TBT2SA delivers 8 (10M/100M/1G) RJ45 with 4 PoE+ (PoE output max. 30W per port) and 4
PoE++ (PoE output max. 90W per port) and 2 Combo GbE RJ45/SFP ports.

The SM24TBT4SA delivers 24 (10M/100M/1G) RJ45 with 16 PoE+ (PoE output max. 30W per port) and 8
PoE++ (PoE output max. 90W per port) and 4 Combo GbE RJ45/SFP ports.

The embedded Device Managed System (DMS) features provides users with the benefits of easy-to-
use/configure/install/troubleshoot in the video surveillance, wireless access, and other SMBs and
Enterprises applications. The SMxTBTxSA is ideal to deliver management simplicity, better user
experience, and lowest total cost of ownership.

Features
e |Pv4/IPv6 dual stack management e DHCP Relay (Option 82)
e SSH/SSL secured management e DHCP Snooping
e SNMP vi/v2c e 802.1d (STP), 802.1w (RSTP) and 802.1s
e RMON groups 1,2,3,9 (MSTP)
e [IGMP v1/v2 Snooping e LACP and static link aggregation
e MLD v1/v2 Snooping e Q-in-Q double tag VLAN
e RADIUS and TACACS+ authentication e Extend PoE Mode to 250 m at 10 Mbps
e |P Source Guard e Percepxion ready/enabled & LPM support

About This Manual

This manual gives specific information on how to operate and use the SMxTBTxSA management
functions with an HTTP/HTTPs web browser. This manual is intended for use by network administrators
who are responsible for operating and maintaining network equipment; it assumes a strong knowledge
of switch functions, the Internet Protocol (IP), and Hypertext Transfer Protocol (HTTP).

Related Manuals
Related manuals include:
e SMxTBTxSA Quick Start Guide, 33871
o SMxTBTxSA Install Guide, 33872
e SMxTBTxSA CLI Reference, 33874
o Release Notes (version specific)

For Lantronix Drivers, Firmware, Manuals, Product Notifications, Warranty Policy & Procedures, etc. go to
the Lantronix Technical Resource Center.

For Lantronix Documentation, Firmware, App Notes, etc. go to https://www.lantronix.com/technical-
support/. Visit the Lantronix Web site at www.lantronix.com/support/documentation for the latest
documentation. Note that this manual provides links to third party websites for which Lantronix is not
responsible.

Cautions and Warnings: See the Install Guide for important Cautions and Warnings.
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Chapter 1 Web-based Management

Initial Configuration

This chapter describes how to configure and manage the SMxTBTxSA via the web user interface. With
this facility, you can easily access and monitor through any one port of the switch all the status of the
switch, including each port activity, Spanning tree status, port aggregation status, multicast traffic, VLAN
and priority status, even illegal access. SMxTBTxSA default values are:

IP Address 192.168.1.77
Subnet Mask 255.255.255.0
Default Gateway 192.168.1.254
Username admin
Password admin

After the SMxTBTxXSA interface has been configured, you can browse it. For instance, type 192.168.1.77
in the address row in a browser; it will show the Login screen and ask you for a username and password
in order to login and access authentication.

The default Username is admin and default Password is admin. For first time use, enter the default
username and password, and then click the Login button. The login process now is complete. In the login
menu, you must enter the complete username and password respectively. The SMxTBTxSA allows two or
more users using administrator’s identity to manage this switch; the administrator to do the last setting will
be the configuration to affect the system.

@ Note: When you login to the switch Web page to manage, type the Username admin and press the
<tab> key. Then type the Password admin and press Enter. When you login to the switch Web Ul, you
can use IPv4 or IPv6 login to manage.

To optimize the display effect, we recommend Microsoft IE 6.0 above, Netscape V7.1 above or Firefox
V1.00 above with 1024x768 resolution. See the SMxTBTxSA Install Guide for Web browser support.

@ Note: The SMxTBTxSA has the DHCP function disabled by default, so if you do not have a DHCP
server to provide an IP addresses to the switch, enter the default IP address (192.168.1.77).

LANTRONIX"  LANTRONIX'

admin
S Il
Figure 1: The Login page

o
— : Show password text as it is typed.

4

: Hide password text as it is typed.
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Chapter 2 First Time Wizard

The first time you use this device you must configure some basic settings such as password, IP address,
date and time, and system information. Use the following procedure:

Step 1: Change default password

Enter a new password and then enter it again. The Password must contain at least 8 characters, at least
1 upper case letter, 1 lower case letter and one numeric character. The new password cannot be blank or
the default value. Click the Next button.

LANTRONIX
——a
LANTRONIX'
Set IP address
n Interface VLAN ID
Obtain IP address via DHCP
Change default password ® set IP agdress manually
IP address
New password
27
Subnet mask
Repeat new password
assasszse0
Default router
Password must contain: 192165.1.254
1. Minimum of 8 characters
2 At least 1 upper case, 1 lower case and 1 numeric DNS
New password should not be blank or default value.

Figure 2-1: Change default password
Step 2: Set IP address

Select “Obtain IP address via DHCP” or “Set IP address manually” to set the IP address.

00 If setting manually, enter IP address, Subnet mask, and Default router.
[0  If obtaining via DNS, enter a DNS server IP address. See “Messages” below.
[  If obtaining via DHCP, enter a DHCP server IP address.

Click the Next button.

Set IP address

Set IP address

Figure 2-2a: Set IP address
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Set IP address

Figure 2-2b: Set IP address

The value of 'DNS' must be a valid IP address in dotted decimal notation ('x.y.z.w'). The following
restrictions apply: 1) x, y, z, and w must be decimal numbers between 0 and 255, 2) x must not be 0
unless also y, z, and w are 0, 3) x must not be 127, and 4) x must not be greater than 223.

Step 3: Set date and time

Enable “Automatic data and time” or select “Manually” to set or select the desired date and time.
If you enable “Automatic data and time” then you must enter a “Server Address” and select a “Time

zone”. Click the Next button when done.
LANTRONIX

12 8

EazEWORD IF ADCREzE CATE & TIME

NEORMATION

Set date and time

Automatic date and time

Manually

2022-02-03 14:23:6

Figure 2-3: Set date and time
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Step 4: Set system information

You can set some system information to this device, such as “System contact”, “System name”, and
“System location”. Click the Apply button when done.

LANTRONIX™

12 8 a

FAESWORD F ADCRESS CATE & TIME NFORMATION

Set system information

System contact

System name

SMIBTATZSA

System location

[l ]

Figure 2-4: Set system information

Message: Password format error.

Message: The value of ' DNS' must be a valid IP address in dotted decimal notation ('x.y.z.w').
The following restrictions apply: 1) x, y, z, and w must be decimal numbers between 0 and 255, 2) x must
not be 0 unless also y, z, and w are 0, 3) x must not be 127, and 4) x must not be greater than 223.
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Webpage Controls

Webpage controls and icons are shown and described below.

LANTRONIX' =| = -

2 I

SM16TAT2SA System Information @Home -~ System - System Information

Click the Lantronix logo to return to the Switch > System > System Information page from any page.

Click the === icon to alternately display / hide the left hand menu bar.

‘ ‘ F s
Hover the cursor over any port to see its current status: or Port$: doun
Click on any port to display its current Detailed Port Statistics page.

Auto-logout | 10 min ¥ H 9 c*

Top right corner icons:

- [
H Save Configuration: Click to save parameter changes to the running-config file. Click OK
when the message “Please confirm to save current running-config file as startup-config file?” displays.

Do not reset or power off the switch until the save completes.
9 Help: Displays the Help page for the current webpage.

C* Logout: Logs you out and displays the Login prompt.

. [ A .
e Home System S L L : Displays the current webpage path.

e gl 10 min ¥ : Auto-logout dropdown lets you set the amount of time after

a successful login before an automatic log out occurs. The selections are OFF, 1, 2, 3, 4,
5, 10, 20, 30, 40, and 60 minutes. The default is 10 minutes. When set to OFF, no Auto-
logout occurs.

After you change the Auto-Logout timeout and then log out and log back in, the
Auto-Logout timeout setting will be the setting saved to the start-up config file.

When the Auto-Logout timeout setting is changed, it directly writes to running-config.

To save the timeout change to start-up config, you must execute a save to startup-config.

To examine the running-config, you can run the CLI command “showing running-config” or
in the Web Ul just log out and log back in again.

Auto-logout

[oFF

1 min
2 min
3 min
4 min
5 min
20 min
30 min
40 min
50 min
|60 min

To save the timeout change into startup-config, you must do a save to startup-config and then reboot the

switch.
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Auto-logout summary:

o When you power on the switch, it will get the settings from startup-config.
¢ When you logout and login (without switch reboot), the switch will get the timeout settings from

startup-config.

e When you reload defaults, the switch will get the timeout settings default-config.

For the “Save to start-up config” behavior, if you don’t save the config, when you change the timeout
setting but logout, at the next login the timeout setting remains unchanged as the setting in start-up

config.

If you save timeout setting to start-up config:

If you don’t save timeout setting to start-up
config:

When you change the timeout setting and save
to startup-config (click the disc icon), the
changed timeout setting will be applied to
running-config and start-up config immediately.

When you change the timeout setting (without save
to startup-config), the timeout change will be applied
to running-config immediately.

After Logout and login, the timeout setting will be
the setting saved in start-up config.

After Logout and login, the timeout setting will be the
setting saved in start-up configure.

After a switch reboot, the timeout setting will be
the setting saved in start-up config.

After you reboot the switch, the timeout setting will be
the setting saved in start-up config.

Webpage Messages

Message: Wrong username or password!

Recovery: Re-try the login with the correct username and password credentials.

Message: There are too many users in the system.
Recovery: Try to log in later.
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Chapter 3 System

This chapter describes the basic configuration tasks including System Information and certain System
parameters (e.g., IP Address, System Time, LLDP, UPnP).

3-1 System Information

You can enter a system name, location, and contact here. Additional switch-related information is also
provided here (e.g., Model Name, HW version, FW version, Serial Number, etc.). To view and set System
Information in the web Ul:

1. Click System and System Information.

2. View the read-only parameters.

3. Enter System Name, Location, and Contact information (optional).
4. Click the Apply button.

' L/\NT?ONIX = Tw -"""-:: nuologoue [oFF_ v @ G |

SM8TBT2SA
Switch DMS

@Home - Systern - System Information

System Information

System Description 4 ports 10M/100M/1G PoE+ RJ45 + 4 ports 10M/100M/1G PoE++ RJ45 +
¥ System 2 ports 1G RJ45/SFP (PoE 240W)
> System Information

Rty Model Name SMETBT2SA
ress <
> System Time Hardware Version v1.01
= [P Mechanical Version v1.01
> UPnP
Firmware Version v1.04.0124
» Port Management <
PoE Firmware
» PoE Management < Version RNU-1002
» <
VLAN Management MAC Address 00-40-C7-1D-53-29
» Quality of Service <
Serial Number A229123AR3500002
» Spanning Tree <
System Name SMBTBT2SA
» MAC Address Table <
» Multicast < Location
- i <
» Percepxion Contact
» DHCP <
| System Date 2024-01-02 11:05:26 +0000
» Security <
b Access Control < System Uptime 0 days, 0:23:31
» SNMP < ( ( 1

| Apply || Reset ‘

Figure 3-1: System Information
Parameter descriptions:

System Description: e.g., 4 ports 10M/100M/1G PoE+ RJ45 + 4 ports 10M/100M/1G PoE++ RJ45 + 2
ports 1G RJ45/SFP (PoE 240W).

Model Name: the specific switch model number (SM8TBT2SA or SM24TBT4SA).
Hardware Version: the current version of hardware (e.g., v1.07).

Mechanical Version: the current mechanical version (e.g., v1.07).
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Firmware Version: the current running version of switch firmware (e.g., v1.04.0124).
PoE Firmware Version: the current PoE MCU FW version (e.g., RNU-1002).

MAC Address: the switch MAC Address in the format 11-22-33-44-55-66.

Serial Number: the switch S/N (e.g., A012417AR3100001).

System Name: An administratively assigned name for this managed node. By convention, this is the
node's fully-qualified domain name. A domain name is a text string drawn from the alphabet (A-Z, a-z),
digits (0-9), minus sign (-). No space characters are permitted as part of a name. The first or last
character must not be a minus sign. The allowed string length is 0-128 characters (e.g., SM8TBT2SA).

Location: The physical location of this node (e.g., telephone closet, 3rd floor). The allowed string length
is 0 - 128 character, and the allowed content is an ASCII character 32-126.

Contact: The textual identification of the contact person for this managed node, with information on how
to contact this person. The allowed string length is 0-128 characters, and the allowed content is ASCII
characters 32-126.

System Date: the current date and time (e.g., 2023-09-25 13:26:58 +0000).
System Uptime: the time the switch has been running since the last power cycle (e.g., 6 days, 23:28:42).

Buttons
Apply: Click to save changes.
Reset: Click to undo any changes made locally and revert to previously saved values.
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3-2 IP Address
3-2.1 IP Settings

At System > IP Address > IP Settings you can configure the IPv4 address and related parameters.

The IPv4 address for the switch could be obtained via DHCP Server for VLAN 1. To manually configure
an address, you need to change the switch's default settings to values that are compatible with your
network. You may also need to establish a default gateway between the switch and management stations
that exist on another network segment.

To configure IP settings in the web Ul:

1. Click System, IP Address, IP Settings.

2. Check the “IPv4 DHCP Client Enable” box.

3. Enter the IPv4 Address, Subnet Mask, Gateway, and DNS Server parameters.
4. Click Apply.

A
S LATRONIX Auto-logout |OFF v up
LANTRONIX" =| s wewwwe w1 H O C
SM8TBT2SA IP Settings g&Home - System - IPAddress - IP Settings
Switch DMS
IPv4 DHCP Client Enable [v]
b System v B
> System Information IPv4 Address 172.27.198.150
» IP Address v
Subnet Mask 255.255.255.0
> |P Settings
> Advanced IP Settings Gateway 172.27.198.1
> Status
~ . DNS Server Mo DMS server ~
> System Time
» LLDP < —
- | Apply |

Figure 3-2.1: IP Settings page
Parameter descriptions:

IPv4 DHCP Client Enable: Check the box to enable DHCP Client support globally. Enable the DHCP
client by checking this box. If this option is enabled, the system will configure the IPv4 address and mask
of the interface using the DHCP protocol. The DHCP client will announce the configured System Name as
hostname to provide DNS lookup.

IPv4 Address: The IPv4 address of the interface in dotted decimal notation (e.g., 192.168.1.77). If DHCP
is enabled, this field is not used. The field may also be left blank if IPv4 operation on the interface is not
desired.

Subnet Mask: The sub-net mask of the IP interface. Valid format is dotted decimal notation or a valid
IPv6 notation. Gateway and Network must be of the same type. User IP subnet mask of the entry (e.g.,
255.255.255.0).

Gateway: The IP address of the IP gateway. Valid format is dotted decimal notation or a valid IPv6
notation. The Gateway and Network must be of the same type.
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DNS Server: Select either No DNS server, Configured, From this DHCP interface,
or From any DHCP interfaces. If you select “Configured”, enter an IP address.
If you select “From this DHCP interface”, enter a DNS Server number (configured in

No DNS server r

: f « . » Configured
the following section “Advanced IP Settings”. o this DHCP interface

This setting controls the DNS name resolution done by the switch. The following |_From any DHCP interfaces

modes are supported:
No DNS server. No DNS server will be used.
Configured: Explicitly provide the IP address of the DNS Server in dotted decimal notation.

From this DHCP interface: Specify from which DHCP-enabled interface a provided DNS server
should be preferred.

From any DHCP interfaces: The first DNS server offered from a DHCP lease to a DHCP-enabled
interface will be used.

Buttons
Apply: Click to save changes.
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3-2.1 Advanced IP Settings

The IPv4 address for the switch can be obtained via DHCP Server for VLAN 1. To manually configure an
address, you must change the switch's default settings to values that are compatible with your network.
You may also need to establish a default gateway between the switch and management stations that
exist on another network segment.

Configure switch-managed IP information on this page, including DNS server settings, IP interfaces, Link
Local Address binding interface, and IP routes. You can configure up to 8 interfaces and 8 routes.
To configure advanced IP settings in the web UI:

1. Click System, IP Address, Advanced IP Settings.

2. Click Add Interface and configure the new Interface for the switch.

3. Click Add Route and configure the new route for the switch.

4. Click Apply.
LANTRONIX' =| 7% swwees oven [ M @ G
SMETBT2SA Advanced IP Settings @Home - System - IPAddress - Advanced IF Settings
Switch DMS
DNS Server No DNS server v
P System

> System Information

» IP Addres IP Interfaces
Aadress

7 P DHCP Per Port
d IP Settings
Mod. icable
> Status ode Disabled
> System Time VLAN VAN
%» LLDP <
> UPnP P
» Port Management <
» PoE Management < DHCPv4 IPv4 IPv6
» VLAN Management < Mask Mask
Delete VLAN  Enable Fallback Current Lease Address Length Address Length
» Quality of Service
» Spanning Tree <l [[@ 1 v 30 172.27.198.150/24 | 192.168.1.1 24
» MAC Address Table N
Add Interface
» Multicast —
> Consoleflow Link-Local Address binding interface
» DHCP <
» Security < IP Routes
» Access Control Delete Network Mask Length Gateway Next Hop VLAN
» SNMP <
» Event Notification < ‘ Add Route
» Diagnostics < ‘ Apply H Reset‘
» Maintenanre <

Figure 3-2.1: Advanced IP Settings
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Parameter descriptions:
Advanced IP Settings

DNS Server: Controls the DNS name resolution done by the switch. These modes are supported:
No DNS server. No DNS server will be used.

Configured: Explicitly provide the IP address of the DNS Server o
in dotted decimal notation. No DNS server M
From this DHCP interface: Specify from which DHCP-enabled
interface a provided DNS server should be preferred. Configured
From any DHCP interfaces: The first DNS server offered from a From this DHCP interface
DHCP lease to a DHCP-enabled interface will be used. From amy DHCP interfaces
IP_Interfaces !..le
Delete: Select this option to delete an existing IP interface. Mode R

P

DHCP Per Port Mode: At the dropdown select Enable or Disable
DHCP per Port operation. The default is Disabled. DHep per port

DHCP Per Port VLAN: The VLAN associated with the IP interface. Only ...
ports in this VLAN will be able to access the IP interface. This field is

only available for input when creating a new interface. This ‘DHCP IP VLAN v v

per Port’ function lets you assign a static IP address from a DHCP pool e

to a switch port such that it will always be assigned that specific IP

address. The IP address is configured in the Interface Config settings. Note that this is binding an IP
address to an interface, not to a MAC address, which is the typical binding method used on this and most
other switches.

DHCP Per Port IP: Define the IP range for DHCP Per Port. The range must be equal to the number of
switch RJ45/TP ports (e.g., 24 for the SM24TBT4SA).

DHCPv4 Enabled: Enable the IPv4 DHCP client by checking this box. If this option is enabled, the
system will configure the IPv4 address and mask of the interface using the DHCP protocol. The DHCP
client will announce the configured System Name as hostname to provide DNS lookup.

DHCPv4 Fallback: The number of seconds for trying to obtain a DHCP lease. After this Timeout period
expires, a configured IPv4 address will be used as IPv4 interface address. A value of zero disables the
fallback mechanism, such that DHCP will keep retrying until a valid lease is obtained. Valid values are 0
to 4294967295 seconds.

DHCPv4 Current Lease: For IPv4 DHCP interfaces with an active lease, this column shows the current
interface address, as provided by the DHCP server.

IPv4 Address: The |IPv4 address of the interface in dotted decimal notation.
If DHCP is enabled, this field is not used. The field may also be left blank if IPv4 operation on the
interface is not desired.

IPv4 Mask: The IPv4 network mask, in number of bits (prefix length). Valid values are 0 - 30 bits for an
IPv4 address. If DHCP is enabled, this field is not used. The field may also be left blank if IPv4 operation
on the interface is not desired.

IPv6 Address: The IPv6 address of the interface. An IPv6 address is in 128-bit records represented as
eight fields of up to four hexadecimal digits with a colon separating each field (:). For example,
fe80::215:c5ff:fe03:4dc7. The symbol :: is a special syntax that can be used as a shorthand way of
representing multiple 16-bit groups of contiguous zeros; but it can appear only once. It can also represent
a valid IPv4 address. For example, ::192.1.2.34. The field may be left blank if IPv6 operation on the
interface is not desired.
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IPv6 Mask: The IPv6 network mask, in number of bits (prefix length). Valid values are 1 - 128 bits for an
IPv6 address. The field may be left blank if IPv6 operation on the interface is not desired.

Link-Local Address binding interface: Configure Link-Local IP address to a different VLAN interface.
The first IP interface entry is for the default value. A link-local address is a network address that is valid
only for communication within the network segment or the broadcast domain that the host is connected
to. Link-local addresses are not guaranteed to be unique beyond their network segment. IPv4 link-local
addresses are assigned from address block 169.254.0.0/16 (169.254.0.0 - 169.254.255.255). In IPv6,
they are assigned from the block fe80::/10.

IP_ Routes
Delete: Select this option to delete an existing IP route.

Network: The destination IP network or host address of this route. Valid format is dotted decimal notation
or a valid IPv6 notation. A default route can use the value 0.0.0.0or IPv6 :: notation.

Mask Length: The destination IP network or host mask, in number of bits (prefix length). It defines how
much of a network address that must match, in order to qualify for this route. Valid values are 0 - 32 bits
for IPv4 routes and128 bits for IPv6 routes. Only a default route will have a mask length of 0 (as it will
match anything).

Gateway: The IP address of the IP gateway. Valid format is dotted decimal notation or a valid IPv6
notation. Gateway and Network must be of the same type.

Next Hop VLAN (Only for IPv6): The VLAN ID (VID) of the specific IPv6 interface associated with the
gateway. The valid VID range is 1 - 4094 and will be effective only when the corresponding IPv6 interface
is valid.

If the IPv6 gateway address is link-local, it must specify the next hop VLAN for the gateway.

If the IPv6 gateway address is not link-local, system ignores the next hop VLAN for the gateway.

Buttons

Add Interface: Click to add a new IP interface. A maximum of 8 interfaces is supported.
Add Route: Click to add a new IP route. A maximum of 8 routes is supported.

Apply: Click to save changes.

Reset: Click to undo any changes made locally and revert to previously saved values.

Messages:

Message: ERROR: DHCP Per Port IP range (192.168.1.1 - 192.168.1.10) is not equal to switch RJ45/TP
port number (16)

Message: Subnet overlaps with VLAN 1

Message: VLAN 1 used for more than one interface

Message: This field is required.

Message: Subnet of VLAN 2 overlaps VLAN 1

Message: ‘Address mask length’ must be an integer value between 1 and 30.
Message: /P address must not be a broadcast address

Message: ipv4 — 1.2.3.4 — Address confilict
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Message: The value of ‘Interface IP address’ must be a valid IP address in dotted decimal notation
(z.y.zw).

The following restrictions apply:

1) z, y, z, and w must be decimal numbers between 0 and 255,

2) x must not be 0,

3) x must not be 127, and

4) x must not be greater than 223.

Message: A static address is only used if the fall-back timeout is non-zero.
Message: /nvalid route - address bits outside mask: 0.0.1.77

Message: Default route mask length must be zero.

Message: ERROR: Already exists

Message: IP address will be modify in management interface, and then use the new IP address to
reconnect.
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3-2.2 IP Status

This page displays the status of the IP protocol layer. The status is defined by the IP interfaces, the IP
routes and the neighbor cache (ARP cache) status.

To display IP status in the web Ul:

1. Click System, IP Address, Status.
2. View the IP status information.

Y
o | emoe - Auto-dogout -
LANTRONIX" =| s sewswwes = = o ec
SMETBT25A IP Status @Home - System - IPAddress - Stetus
Switch DMS
Auto-refresh
b System -
» System Information IP Interfaces
# |P Address -
» IP Settings Interface * Type Address Status
» Advanced IP Settings ) .
05:lo Link 00-00-00-00-00-00 UP LOOPEACK RUNMNING MTU:16436 Metric:1
» Status
3 System Time 05:lo Pvd 127.0.0.1/8
» LLDP € 05:lo Pve =if128
> UPRP . .
VLANL Link 00-40-C7-1D-53-25 UP BROADCAST RUNNING MULTICAST MTU:1500 Metric:1
*» Port Managemant < i
VLANL Pvd 17227.158.150/24 DHCP
* PoE Management <
VLAN1 PvE fe@0::240:c T -feld:5329/64 Link Local Address

» VLAN Management <
» Quality of Service < L. ________________________________________________________________________________________________________JJ

¥ Spanning Tree

IP Routes
» MAC Address Table <
» Multi v
viess Metwaork * Gateway Status Interface
> Conzoleflow
0.0.0.0/0 172.27.198.1 UP GATEWAY VLAN1
» DHCP v
- < 0.0.0.0/0 0.0.0.0 ur VLANL
* Security
» Accesz Control < 127.0.0.0/24 0.0.0.0 ur 05l
» SHME ¢ 169.254.0.0/16 0.0.0.0 UF VLAN1
¥ Event Notification E 172.27.192.0/24 0.0.0.0 uF VLAN1
. . y
» Disgnostics =1/128 = ur 05:lo
* Maintenance . §
fei0z /64 = upr VLAN1
fed0:240:c7Hfe1d:5329/128 o up a5l
ffoo=fe o up WLAN1
ff02:1:-ffe6:dfe1/128 ff02::1:fa6:dfs1 UP CACHE VLANL
floz:2/128 ffo2::2 UP CACHE VLAN1

4 S >
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Meighbour Cache

IP Addres= * Link Address
165.254.113 166 VLAMNL:00-c0-f2-52-24-3b
165.254.134 161 VLAMNL:00-c0-f2-20-01-22
165.254 187 186 VLAML:00-40-cT-1d-52-24
165.254.154.113 VLANL:00-c0-f2-52-5¢-01
165.254.201 218 WVLAMNL:00-c0-f2-28-05-56
165.254.216.65 VLAML:00-c0-f2-26-df-31
169.254.225.16 VLANL:00-c0-f2-59-12-d2
165254240 24 VLAMNL:00-c0-f2-32-18-Eb
169.254.252 118 VLAMN1:00-c0-f2-3a-b5-be
165.254.35.145 VLANL:00-c0-f2-28-72-24
165.254.6.35 VLANL:00-c0-f2-58-ce-b1
165.254.659.176 VLANL:00-c0-f2-21-0d-Th
165.254.83.65 VLANL:00-c0-f2-2b-55-53
172.27.15%8.1 VLAML1E-Ta-3b-38-Be-2a
172.27.158.2 VLAML:00-c0-f2-a1-18-32
172.27.1%8.7 VLAML:00-c0-f2-21-0d-Th

's____________________________________________________________________________________NJ

DM3 Server
Type IF Address Interface
None 0.0.0.0

Figure 3-2.2: IP Status page
Parameter descriptions:
IP Interfaces
Interface: Shows the name of the interface (e.g., OS:lo or VLAN1).
Type: Shows the address type of the entry. This may be LINK or IPv4 or IPv6.

Address: Shows the current address of the interface (of the given type; e.g., 192.168.1.77/24 or ::1/128
or 00-40-C7-1C-CB-6E).

Status: Shows the status flags of the interface (and/or address). For example: UP LOOPBACK
RUNNING MTU:16436 Metric:1 or UP BROADCAST RUNNING MULTICAST MTU:1500 Metric:1, or
Manual, or Link Local Address, or DHCP Fallback.

IP_ Routes

Network: Shows the destination IP network or host address of this route (e.g., 192.168.1.0/24).
Gateway: Shows the gateway address of this route (e.g., 192.168.1.254 or ::).

Status: Shows the status flags of the route (e.g., UP or UP GATEWAY).

Interface: Shows the name of the interface (e.g., OS:lo or VLAN1).

Neighbor Cache
IP Address: Show the IP address of the entry (e.g., 192.168.1.99).

Link Address: Show the Link (MAC) address for which a binding to the given IP address exists (e.g.,
VLAN1:00-1b-11-b2-6d-4b).
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DNS Server

Type: Show the address type of the entry. This may be LINK or IPv4 or DHCP any.
IP Address: Show the current address of the interface (of the given type).
Interface: Show the name of the interface.

Buttons Auto-refresh ‘ Refresh J
Auto-refresh: Check to refresh the page automatically every 3
seconds.

Refresh: Click to manually refresh the page immediately.
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3-3 System Time

The switch provides manual and automatic ways to set the system time via NTP. To manually set system

time, enter the “Year”, “Month”, “Day”, “Hour” and “Minute” within the valid range indicated for each item.
To configure Time in the web Ul:

1. Click System and System Time.

2. Specify the Time parameters.

3. Click Apply.
o | e -
LANTRONIX" =| “s sewwwens % =
SMETBT2SA Time Configuration
Switch DMS
Time Configuration
b System .
» System Information Clock Source Local Settings W
% |P Address "
» Systam Time System Date 204701022 05:18:59 fyyyy-mm-dd hh:mm:ss)
> UPnP Time Zone Configuration
* Port Management s -
Time Zone Hone o
* PoE Management i
< Acronym [0~ 16 characters)

¥ WVLAM Management

¥ Quality of Service
Daylight Saving Time Configuration

-

Spanning Tree

-

MAC Addrezs Table Daylight Saving Time

-

Multicast
Start Time settings
Consoleflow

w

b DHCP ¢ Maonth lan W
F Security < Week 1 W
¥ Accezs Control s
Day fon W
P SHNMP E
» Ewvent Notification s Hours 1w
. = £ . .
¥ Disgnostics End Time settings
b Maintenance s
Maonth Jan W
Week 1w
Day Mon W
Hours 0 W
Offset settings
Offset &0 {1-T720) Minutes
| Apply | Rezet |

Figure 3-3: Time Configuration page
Time Configuration

Clock Source: There are two modes for configuring how the Clock Source from. Select "Local Settings" :
Clock Source from Local Time or select "NTP Server" : Clock Source from NTP Server.

System Date: Show the current time of the system. The year of system date must be 2000 - 2037.
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Time Zone Configuration

Time Zone: Lists various Time Zones worldwide. Select appropriate Time Zone from the drop down and
click Apply to set.

Acronym: You can set the acronym of the time zone. This is a user configurable acronym to identify the
time zone (range: up to 16 characters).

Daylight Saving Time Configuration

Daylight Saving Time: This is used to set the clock forward or backward according to the configurations
set below for a defined Daylight Saving Time duration. Select 'Disable’ to disable the Daylight Saving
Time configuration. Select 'Recurring' and configure the Daylight Saving Time duration to repeat the
configuration every year. Select 'Non-Recurring' and configure the Daylight Saving Time duration for
single time configuration. (Default: Disabled).

Recurring Configuration

Start time settings:
Month - Select the starting month (Jan — Dec).
Week - Select the starting week number (1-5).
Day - Select the starting day (Mon — Sun).
Hours - Select the starting hour (0-23).

End time settings:
Month - Select the starting month (Jan — Dec).
Week - Select the starting week number (1-5).
Day - Select the starting day (Mon — Sun).
Hours - Select the starting hour (0-23).

Offset settings: Offset - Enter the number of minutes to add during Daylight Saving Time. The valid
range is 1 to 1440 minutes. The default is 60 minutes.

@ Note: The information under “Start Time Settings” and “End Time Settings” displays what you set
on the “Start Time Settings” and “End Time Settings” field information.

Buttons

Configure NTP Server: Click to configure an NTP server when at Clock Source ‘NTP Server’ is selected.
Apply: Click to save changes.

Reset: Click to undo any changes made locally and revert to previously saved values.
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Configure NTP Server
At “Clock Source” select NTP Server. This enables the Configure NTP Server button.

Click the Configure NTP Server button to configure NTP server.

A
L LAQTRONIX Auto-logout [OFF
LANTRONIX" = wevwwe br -1 B @ &
SM8TBT2SA NTP Configuration @Heme - Systam o System Time

Switch DMS

Server 1
P System e
> System Information Server 2
» IP Address <

Server 3
> Systemn Time
» LLDP < Server 4

> UPnP
Server 5

-

Port Management
» PoE Management < Server 6

» VLAN Management
Interval g0min

-

Quality of Service

-

Spanning Tree € ‘ Apply ‘

Reset ‘

Figure 3-3: NTP Configuration page

NTP (Network Time Protocol) is used to sync the network time based Greenwich Mean Time (GMT). If
use the NTP mode and select a built-in NTP time server or manually specify a user-defined NTP server
as well as Time Zone, the switch will sync the time in a short after pressing Apply button. Though it
synchronizes the time automatically, NTP does not update the time periodically without user’s processing.

Time Zone is an offset time off GMT. You must select the time zone first and then perform time sync via
NTP because the switch will combine this time zone offset and updated NTP time to come out the local
time, otherwise, you will not be able to get the correct time. The switch supports configurable time zone
from —12 to +13 in 1 hour steps. The default Time zone is +8 Hrs.

Parameter descriptions:

Server 1 to 6: Provide the NTP IPv4 or IPv6 address of this switch. IPv6 address is in 128-bit records
represented as eight fields of up to four hexadecimal digits with a colon separating each field (:).

For example, 'fe80::215:c5ff:fe03:4dc7'. The symbol "::' can be used as a shorthand way of representing
multiple 16-bit groups of contiguous zeros; but it can only appear once. It can also represent a valid IPv4
address. For example, '::192.1.2.34".

Interval: You can specify the time interval in seconds after which a time check and, Interval \:l
in case of deviation, a resynchronization of the internal device clock against the

5 min

specified timeserver via Network Time Protocol (NTP) should be performed. 10 min
The selections are 5 min, 10 min, 15 min, 30 min, 60 min, and 120 min. lm::
60 min

120 min

Buttons: These buttons are displayed on the NTP page:
Apply: Click to save changes.

Reset: Click to undo any changes made locally and revert to previously saved values.
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Messages

Message:

The input value ‘Server 2 Address’ (::)

is not a valid IPv6 address.

The Unspecified Address must never be assigned to any node.

Message:

The value of ‘Server 2 Address’ (:: ::)
must be a valid IPv6 address.

The symbol ::’ can appear once.

Message:

The value of ‘Server 2 Address’ (::)

must be a valid IPv6 address in 128-bit record represented as

eight fields of up to four hexadecimal digits with a colon (:) separating
each field.

Message:
The format of ‘Server 3 Address’ is invalid.

It must either be a valid IP address in dofted decimal notation

(x.y.z.w’) or a valid hostname.

A valid hostname is a string drawn from the alphabet (A-Za-z), digits

(0-9), dot (.), hyphen (-).

Spaces are not allowed, the first character must be an alphanumeric character,
and the first and last characters must not be a dot or hyphen.
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3-4 LLDP oo

> LLDP Configuration

The switch supports the Link Layer Discovery Protocol (LLDP) which provides a
standards-based method to enable switches to advertise themselves to adjacent
devices and to learn about adjacent LLDP devices.

> LLDP-MED Configuration
» LLDP Neighbor

5 IEEA

LLDP is a vendor-neutral Link Layer protocol in the Internet Protocol Suite used by
network devices for advertising their identity, capabilities, and neighbors on a IEEE
802 local area network, principally wired Ethernet. The protocol is formally referred
to by the IEEE as Station and Media Access Control Connectivity Discovery specified in standards
document IEEE 802.1AB.

LLDP can be used as a component in network management and network monitoring applications.
LLDP is also used to advertise power over Ethernet capabilities and requirements and negotiate power
delivery.

> LLDP-MED Neighbor

LLDF Statistics

LLDP-MED provides extended and automated power management of Power over Ethernet (PoE) end
points. Media Endpoint Discovery is an enhancement of LLDP, known as LLDP-MED.

3-5.1 LLDP Configuration

This page lets you view and set LLDP detail parameters on a per-port basis; the settings take effect
immediately.

LLDP uses System Capability Codes: B = Bridge (Switch), C = DOCSIS Cable Device, O = Other,
P = Repeater, R = Router, S = Station, T = Telephone, and W = WLAN Access Point.

LLDP information is sent by devices from each of their interfaces at a fixed interval, in the form of an
Ethernet frame. Each frame contains one LLDP Data Unit (LLDPDU). Each LLDPDU is a sequence of
type-length-value (TLV) structures.

The Ethernet frame used in LLDP typically has its destination MAC address set to a special multicast
address that 802.1D-compliant bridges do not forward. Other multicast and unicast destination addresses
are permitted. The EtherType field is set to 0x88cc.

Each LLDP frame starts with the mandatory TLVs Chassis ID, Port ID, and Time-to-Live.

Web Interface

To configure LLDP:

1.  Click System, LLDP, and LLDP Configuration.

2 Modify LLDP Parameters and LLDP Port Parameters.

3.  Specify the information to include in the TLV field of advertised messages.
4 Click Apply.
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LANTRONIX E’ o buto-logout [OFF ] oo
SM8TBT2SA LLDP Configuration @Homs - System - LLDP - LLDP Configuration
Switch DMS

LLDP Parameters

Tx Interval 30 seconds
Tx Hold 4 times

Tx Delay 2 seconds
Tx Reinit 2 seconds

LLDP Port Configuration

Optional TLVs

> UPnP Port Mode CDP Aware  Port Description  System Name  System Description ~ System Capabilities =~ Management Address
+ Port Management & 1 Disabled O
+ PoE Management &
2 Disabled D
© VLAN Management S
+ Quality of Service < 3 Dissbled O
* Spanning Tree & 4 Disabled ~| [
+ MAC Address Table S
5 Disabled D
+ Multicast S
+ Consoleflow 8 Disabled v ]
- DHCP <5 bled
7 Disabled |:|
* Security s
8 Disabled |:|
+ Access Control S
+ SNMP < q Disabled D
e St <
Event Notification 10 Dissbled v [
+ Diagnostics &
+ Maintenance 3 ‘ Apply || E-:-s=_1|

Figure 3-5.1: LLDP Configuration page
LLDP Parameters:

Tx Interval: The switch periodically transmits LLDP frames to its neighbors for having the network
discovery information up-to-date. The interval between each LLDP frame is determined by the Tx Interval
value. Valid values are 5 - 32768 seconds. The default is 30 seconds.

Tx Hold: Each LLDP frame contains information about how long the information in the LLDP frame will be
considered valid. The LLDP information valid period is set to Tx Hold multiplied by Tx Interval seconds.
Valid values are 2 - 10 times. The default is 4 times.

Tx Delay: If some configuration is changed (e.g., the IP address) a new LLDP frame is transmitted, but
the time between the LLDP frames will always be at least the value of Tx Delay seconds. Tx Delay cannot
be larger than 1/4 of the Tx Interval value. Valid values are 1 - 8192 seconds. The default is 2 seconds.

Tx Reinit: When a port is disabled, LLDP is disabled or the switch is rebooted, an LLDP shutdown frame
is transmitted to the neighboring units, signaling that the LLDP information isn't valid anymore. Tx Reinit

controls the number of seconds between the shutdown frame and a new LLDP initialization. Valid values
are 1 - 10 seconds. The default is 2 seconds.

LLDP Port Configuration: The LLDP port settings relate to the currently selected, as reflected by the
page header.

Port: The switch port number of the logical LLDP port.
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Mode: Select LLDP mode:
Rx only The switch will not send out LLDP information, but LLDP information from neighbor units is
analyzed.

Tx only The switch will drop LLDP information received from neighbors but will send out LLDP
information.

Disabled The switch will not send out LLDP information and will drop LLDP information received
from neighbors.

Enabled the switch will send out LLDP information and will analyze LLDP information received from
neighbors.
CDP Aware: Select CDP awareness.

The CDP operation is restricted to decoding incoming CDP frames (the switch doesn't transmit CDP
frames). CDP frames are only decoded if LLDP on the port is enabled.

Only CDP TLVs that can be mapped to a corresponding field in the LLDP neighbors’ table are decoded.
All other TLVs are discarded (Unrecognized CDP TLVs and discarded CDP frames are not shown in the
LLDP statistics.). CDP TLVs are mapped onto LLDP neighbors’ table as shown below.

CDP TLV "Device ID" is mapped to the LLDP "Chassis ID" field.

CDP TLV "Address" is mapped to the LLDP "Management Address" field. The CDP address TLV can
contain multiple addresses, but only the first address is shown in the LLDP neighbors’ table.

CDP TLV "Port ID" is mapped to the LLDP "Port ID" field.
CDP TLV "Version and Platform" is mapped to the LLDP "System Description" field.

Both the CDP and LLDP support "system capabilities", but the CDP capabilities cover capabilities that are
not part of the LLDP. These capabilities are shown as "others" in the LLDP neighbors’ table.

If all ports have CDP awareness disabled, the switch forwards CDP frames received from neighbor
devices. If at least one port has CDP awareness enabled all CDP frames are terminated by the switch.

@ Note: When CDP awareness on a port is disabled, the CDP information isn't removed immediately
but gets disabled when the hold time is exceeded.

Port Descr: Optional TLV: When checked the "port description" is included in LLDP information transmitted.
Sys Name: Optional TLV: When checked the "system name" is included in LLDP information transmitted.

Sys Descr: Optional TLV: When checked the "system description” is included in LLDP information
transmitted.

Sys Capa: Optional TLV: When checked the "system capability” is included in LLDP information transmitted.
Mgmt Addr: Optional TLV: When checked the "management address" is included in LLDP information
transmitted.

Buttons

Apply: Click to save changes.

Reset: Click to undo any changes made locally and revert to previously saved values.

Messages:
Tx Delay must not be larger than 1/4 of the Tx Interval value (IEEE 802.1AB-clause 10.5.4.2)
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3-4.2 LLDP-MED Configuration

This page lets you configure LLDP-MED. This function applies to devices which support LLDP-MED.
Media Endpoint Discovery is an LLDP enhancement, called LLDP-MED, that provides these facilities:

e Auto-discovery of LAN policies (such as VLAN, Layer 2 Priority and Differentiated services
(Diffserv) settings) enabling plug and play networking.

¢ Device location discovery allows creation of location databases and, in the case of Voice over
Internet Protocol (VolP), Enhanced 911 services.

e Extended and automated power management of Power over Ethernet (PoE) end points is
provided.

¢ Inventory management, allowing network administrators to track their network devices, and
determine their characteristics (manufacturer, software and hardware versions, and serial or asset
number).

To configure LLDP-MED in the web Ul:

Click System, LLDP, and LLDP-MED Configuration.

Modify Fast Start Repeat Count parameter; the default is 4.
Modify Coordinates Location parameters.

Enter Civic Address Location parameters.

Enter Emergency Call Service parameter.

Click the Add New Policy button and configure a new policy.
Select a Policy ID for each port.

Click Apply.

N RAWN=

LANTRONIX' =[ 7% wewewewe 25 w1 M@ G

SMETBT2SA

LLDP-MED Configuration dincme - s Low

LLDF-MED Confguration

0

DMS

Fast Start Repeat Count

Fast start repeat count 4 zeconds

Coordinates Location

D Er < City City District Block (Heighborhood)
* PoE Management * Street Leading Street Direction Trailing Street Suffix
» VLAN Management <
Street Suffix House No. House No. Suffix
* Quality of Service <
b ErTiramE: ¢ Landmark Additional Location Info Mame
sddress Teble < . .
b MAC Address Table Zip Code Building Apartment
* Multicast *
Floor Room No. Place Type
> Conzoleflow
¥ DHCP Postal Community Name P.0.Box Additional Code
»
» Control Emergency Call Service

¥ SNMP

* Event Notification
* Diagnostics

¥ Maintenance

Latitude 0 : North W Longitude o P East W
Altitude 0 leters W Map Datum WGSBS e

Civic Address Location

Country Code State/Province County

Emergzncy Call Service

Policies

Delete Policy ID

Application Type

Tag

Table is Empty

VLAN ID

L2 Priority

Figure 3-5.2: LLDP-MED Configuration page

Parameter descriptions:

Dscp
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Fast start repeat count

Rapid startup and Emergency Call Service Location Identification Discovery of endpoints is a critically
important aspect of VolP systems in general. In addition, it is best to advertise only those pieces of
information which are specifically relevant to particular endpoint types (for example only advertise the
voice network policy to permitted voice-capable devices), both in order to conserve the limited LLDPU
space and to reduce security and system integrity issues that can come with inappropriate knowledge of
the network policy.

With this in mind LLDP-MED defines an LLDP-MED Fast Start interaction between the protocol and the
application layers on top of the protocol, in order to achieve these related properties. Initially, a Network
Connectivity Device will only transmit LLDP TLVs in an LLDPDU. Only after an LLDP-MED Endpoint
Device is detected, will an LLDP-MED capable Network Connectivity Device start to advertise LLDP-MED
TLVs in outgoing LLDPDUs on the associated port. The LLDP-MED application will temporarily speed up
the transmission of the LLDPDU to start within a second, when a new LLDP-MED neighbor has been
detected in order share LLDP-MED information as fast as possible to new neighbors.

Because there is a risk of an LLDP frame being lost during transmission between neighbors, it is
recommended to repeat the fast start transmission multiple times to increase the possibility of the
neighbors receiving the LLDP frame. With Fast start repeat count it is possible to specify the number of
times the fast start transmission would be repeated. The recommended value is 4 times, given that 4
LLDP frames with a 1 second interval will be transmitted, when an LLDP frame with new information is
received.

It should be noted that LLDP-MED and the LLDP-MED Fast Start mechanism is only intended to run on
links between LLDP-MED Network Connectivity Devices and Endpoint Devices, and as such does not
apply to links between LAN infrastructure elements, including Network Connectivity Devices, or other
types of links.

Coordinates Location

Latitude: Latitude normalized to within 0-90 degrees with a maximum of 4 digits. It is possible to specify
the direction to either North of the equator or South of the equator.

Longitude: Longitude normalized to within 0-180 degrees with a maximum of 4 digits. It is possible to
specify the direction to either East of the prime meridian or West of the prime meridian.

Altitude: Altitude normalized to within -32767 to 32767 with a maximum of 4 digits.
It is possible to select between two altitude types (floors or meters).
Meters: Representing meters of Altitude defined by the vertical datum specified.

Floors: Representing altitude in a form more relevant in buildings which have different floor-to-floor
dimensions. An altitude = 0.0 is meaningful even outside a building and represents ground level at the
given latitude and longitude. Inside a building, 0.0 represents the floor level associated with ground level
at the main entrance.

Map Datum: The Map Datum is used for the coordinates given in these options:

WGS84: (Geographical 3D) - World Geodesic System 1984, CRS Code 4327, and Prime Meridian
Name: Greenwich.

NADB83/NAVD88: North American Datum 1983, CRS Code 4269, Prime Meridian Name: Greenwich;
the associated vertical datum is the North American Vertical Datum of 1988 (NAVD88). This datum
pair is to be used when referencing locations on land, not near tidal water (which would use Datum
= NAD83/MLLW).

NADS83/MLLW: North American Datum 1983, CRS Code 4269, Prime Meridian Name: Greenwich;
the associated vertical datum is Mean Lower Low Water (MLLW). This datum pair is to be used when
referencing locations on water/sea/ocean.

Civic Address Location: IETF Geopriv Civic Address based Location Configuration Information (Civic
Address LCI).

Country code: The two-letter ISO 3166 country code in capital ASCII letters - Example: DK, DE or US.
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State: National subdivisions (state, canton, region, province, prefecture).
County: County, parish, gun (Japan), district.

City: City, township, shi (Japan) - Example: Copenhagen.

City district: City division, borough, city district, ward, chou (Japan).
Block (Neighborhood): Neighborhood, block.

Street: Street - Example: Poppelve;.

Leading street direction: Leading street direction - Example: N.
Trailing street suffix: Trailing street suffix - Example: SW.

Street suffix: Street suffix - Example: Ave, Platz.

House no.: House number - Example: 21.

House no. suffix: House number suffix - Example: A, 1/2.

Landmark: Landmark or vanity address - Example: Columbia University.
Additional location info: Additional location info - Example: South Wing.
Name: Name (residence and office occupant) - Example: Flemming Jahn.
Zip code: Postal/zip code - Example: 2791.

Building: Building (structure) - Example: Low Library.

Apartment: Unit (Apartment, suite) - Example: Apt 42.

Floor: Floor - Example: 4.

Room no. : Room number - Example: 450F.

Place type: Place type - Example: Office.

Postal community name: Postal community name - Example: Leonia.
P.O. Box: Post office box (P.O. BOX) - Example: 12345.

Additional code: Additional code - Example: 1320300003.

Emergency Call Service: Emergency Call Service (e.g., E911 and others), such as defined by TIA or
NENA.

Emergency Call Service: Emergency Call Service ELIN identifier data format is defined to carry the
ELIN identifier as used during emergency call setup to a traditional CAMA or ISDN trunk-based PSAP.
This format consists of a numerical digit string, corresponding to the ELIN to be used for emergency
calling.

Policies: Network Policy Discovery enables the efficient discovery and diagnosis of mismatch issues with
the VLAN configuration, along with the associated Layer 2 and Layer 3 attributes, which apply for a set of
specific protocol applications on that port. Improper network policy configurations are a very significant
issue in VolP environments that frequently result in voice quality degradation or loss of service.

Policies are only intended for use with applications that have specific 'real-time' network policy
requirements, such as interactive voice and/or video services.

The network policy attributes advertised are:

1. Layer 2 VLAN ID (IEEE 802.1Q-2003)
2. Layer 2 priority value (IEEE 802.1D-2004)
3. Layer 3 Diffserv code point (DSCP) value (IETF RFC 2474)
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This network policy is potentially advertised and associated with multiple sets of application types
supported on a given port. The application types specifically addressed are:

1. Voice

2. Guest Voice

3. Softphone Voice

4. Video Conferencing

5. Streaming Video

6. Control / Signaling (conditionally support a separate network policy for the media types above)

A large network may support multiple VolP policies across the entire organization, and different policies
per application type. LLDP-MED allows multiple policies to be advertised per port, each corresponding to
a different application type. Different ports on the same Network Connectivity Device may advertise
different sets of policies, based on the authenticated user identity or port configuration.

It should be noted that LLDP-MED is not intended to run on links other than between Network
Connectivity Devices and Endpoints, and therefore does not need to advertise the multitude of network
policies that frequently run on an aggregated link interior to the LAN.

Delete: Check to delete the policy. It will be deleted during the next save.

Policy ID: ID for the policy. This is auto generated and is used when selecting the polices that will be
mapped to the specific ports.

Application Type: Intended use of the application; types include:

Voice - for use by dedicated IP Telephony handsets and other similar appliances supporting interactive
voice services. These devices are typically deployed on a separate VLAN for ease of deployment and
enhanced security by isolation from data applications.

Voice Signaling (conditional) - for use in network topologies that require a different policy for the
voice signaling than for the voice media. This application type should not be advertised if all the same
network policies apply as those advertised in the Voice application policy.

Guest Voice - support a separate 'limited feature-set' voice service for guest users and visitors with
their own IP Telephony handsets and other similar appliances supporting interactive voice services.

Guest Voice Signaling (conditional) - for use in network topologies that require a different policy for
the guest voice signaling than for the guest voice media. This application type should not be advertised
if all the same network policies apply as those advertised in the Guest Voice application policy.

Softphone Voice - for use by softphone applications on typical data centric devices, such as PCs or
laptops. This class of endpoints frequently does not support multiple VLANS, if at all, and are typically
configured to use an 'untagged' VLAN or a single 'tagged' data specific VLAN. When a network policy is
defined for use with an 'untagged' VLAN (see Tagged flag below), then the L2 priority field is ignored
and only the DSCP value has relevance.

Video Conferencing - for use by dedicated Video Conferencing equipment and other similar
appliances supporting real-time interactive video/audio services.

Streaming Video - for use by broadcast or multicast based video content distribution and other similar
applications supporting streaming video services that require specific network policy treatment. Video
applications relying on TCP with buffering would not be an intended use of this application type.

Video Signaling (conditional) - for use in network topologies that require a separate policy for the
video signaling than for the video media. This application type should not be advertised if all the same
network policies apply as those advertised in the Video Conferencing application policy.

Tag : Tag indicating whether the specified application type is using a 'tagged' or an 'untagged' VLAN.

Untagged indicates that the device is using an untagged frame format and as such does not include a
tag header as defined by IEEE 802.1Q-2003. In this case, both the VLAN ID and the Layer 2 priority fields
are ignored and only the DSCP value has relevance.
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Tagged indicates that the device is using the IEEE 802.1Q tagged frame format, and that both the VLAN
ID and the Layer 2 priority values are being used, as well as the DSCP value. The tagged format includes
an additional field, known as the tag header. The tagged frame format also includes priority tagged frames
as defined by IEEE 802.1Q-2003.

VLAN ID : VLAN identifier (VID) for the port as defined in IEEE 802.1Q-2003.

L2 Priority: L2 Priority is the Layer 2 priority to be used for the specified application type. L2 Priority may
specify one of eight priority levels (0 through 7), as defined by IEEE 802.1D-2004. A value of O represents
use of the default priority as defined in IEEE 802.1D-2004.

DSCP: DSCP value to be used to provide Diffserv node behavior for the specified application type as
defined in IETF RFC 2474. DSCP may contain one of 64 code point values (0 through 63). A value of 0
represents use of the default DSCP value as defined in RFC 2475.

Port Policies Configuration: Every port may advertise a unique set of network policies or different
attributes for the same network policies, based on the authenticated user identity or port configuration.

Port: The port number to which the configuration applies.

Policy Id: The set of policies that will apply to a given port. The set of policies is selected by check
marking the checkboxes that corresponds to the policies.

Buttons

Add New Policy: Click to add a new policy. Specify the Application type, Tag, VLAN ID, L2 Priority and
DSCP for the new policy. Click "Apply".

Apply: Click to save changes.

Reset: Click to undo any changes made locally and revert to previously saved values.

33873 Rev. A https://www.lantronix.com/ Page 30 of 273



https://www.lantronix.com/

Lantronix SMXTBTxSA Web User Guide

3-4.3 LLDP Neighbor

This page provides a status overview for all LLDP neighbors. The displayed table contains a row for each
port on which an LLDP neighbor is detected. If your network device doesn’t support LLDP or if LLDP is
not enabled, the table displays “No LLDP neighbor information found’.
To show LLDP neighbors:

1. Click System, LLDP, and LLDP Neighbor.

2. Click Refresh to manually update the web page.

3. Click Auto-refresh to automatically update web page every 3 seconds.

i Y
LANTRONIX™ =/ T s @Y M @ G
SM8TBT2SA LLDP Neighbor Information @Home - System - LLDP - LLDP Neighbor
Switch DMS —
Auto-refresh | Refresh |
» System >
> System Information Local System Management
- Port  ChassisiD  PortID  Port Description System Name Capabilities  System Description Address
Addres: <
> System Time Port1 00-CO-F2- 2 GigabitEthernet SQABTB2 Core Bridge(+) Managed PoE+ Switch, 24-port 10/100/1000Base-  172.27.198.30
- EE 87-24-5C 1/8 SW for Smart0S s T PoE Plus + (4) 1G/10G SFP+slots (IPv4)
> LLDP Configuration A0-36- Linux th2-pcl-smartos 6.1.0-1027-oem #27-
- AD-36-9F- Interface 14 as th2-pcl- 172.27.198.101
DMER i et Port5 SF-80- Router(+) Ubuntu SMP PREEMPT_DYNAMIC Mon Nov 20 ) .
» LLDP-MED Configuration 80-B7-9F enp4s0f3 smartos (IPvd4)
B7-9F 15:08:14 UTC 2023 x86_64
> LLDP Neighbor

Figure 3-5.3: LLDP Neighbor Information

Parameter descriptions:

Local Port: The port on which the LLDP frame was received.

Chassis ID: The Chassis ID is the identification of the neighbor's LLDP frames.

Port ID: The Remote Port ID is the identification of the neighbor port.

Port Description: Port Description is the port description advertised by the neighbor unit.
System Name: System Name is the name advertised by the neighbor unit.

System Capabilities: System Capabilities describes the neighbor unit's capabilities. The possible system
capabilities are: 1. Other, 2. Repeater, 3. Bridge, 4. WLAN Access Point, 5. Router, 6. Telephone, 7.
DOCSIS cable device, 8. Station only, 9. Reserved.

When a capability is enabled, the capability is followed by (+). If the capability is disabled, the capability is
followed by a (-).

System Description: Displays the system description.

Management Address: The neighbor unit's IP address that is used for higher layer entities to assist
discovery by the network management. This could for instance hold the neighbor’s IP address. You can
click the linked text to display the device webpage. See the example below.

Buttons
Auto-refresh: Check to refresh the page automatically every 3 seconds.

Refresh: Click to manually refresh the page immediately.
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3-4.4 LLDP PoE

This page provides a status overview for all LLDP PoE neighbors. The displayed table contains a row for
each port on which an LLDP PoE neighbor is detected.

To show LLDP neighbors’ PoE information:

1. Click System, LLDP, and LLDP PoE.

2. Observe the parameters displayed.

3. Click Refresh to manually update the web page immediately.

4. Click Auto-refresh to automatically update web page every 3 seconds.

A

& LATRONIX Auto-logout [OFF v
LANTRONIX' =| 7% wwwwwe @c
SMEBTBT2SA LLDP Neighbor Power Over Ethernet Information SHome - System - LLOP - LLDPPoE
Switch DMS e
Auto-refresh | Refresh

P System -

> System Information Local Port Power Type Power Source Power Priority Maximum Power

2 IPAsETEs < Port1 PSE Device Primary Power Supply Low 0.0 [W]

Figure 3-4.3: LLDP Neighbor Power Over Ethernet Information
Parameter descriptions:
Local Port: The port for this switch on which the LLDP frame was received.

Power Type: The Power Type represents whether the device is a Power Sourcing Entity (PSE) or Power
Device (PD). If the Power Type is unknown it is represented as "Reserved".

Power Source: Represents the power source being utilized by a PSE or PD device.

If the device is a PSE device it can either run on its Primary Power Supply or its Backup Power
Supply.

If it is unknown whether the PSE device is using its Primary Power Source or its Backup Power Source it
is indicated as "Unknown".

If the device is a PD, it can either run on its local power supply or it can use the PSE as power source.

It can also use both its local power supply and the PSE.

If it is unknown what power supply the PD device is using it is indicated as "Unknown".

Power Priority: Represents the priority of the PD device, or the power priority associated with the PSE
type device's port that is sourcing the power. The three levels of power priority are Critical, High and
Low. If the power priority is unknown it is indicated as "Unknown".

Maximum Power: The Maximum Power Value contains a numerical value that indicates the maximum
power in watts required by a PD device from a PSE device, or the minimum power a PSE device is
capable of sourcing over a maximum length cable based on its current configuration. The maximum
allowed value is 102.3 W. If the device value is higher than 102.3 W, it is represented as "reserved".

Buttons
Auto-refresh: Check this box to refresh the page automatically every 3 seconds.
Refresh: Click to manually refresh the page immediately.
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3-4.4 LLDP-MED Neighbor

This page provides a status overview of all LLDP-MED neighbors. The displayed table contains a row for
each port on which an LLDP neighbor is detected. This function applies to VolP devices which support
LLDP-MED. If your network has no devices that support LLDP-MED then the table will show “No LLDP-
MED neighbor information found’.

To show LLDP-MED neighbor:
1. Click System, LLDP, and LLDP-MED Neighbor.
2. Click Refresh to manually update web page.

3. Click Auto-refresh for auto-update web page.

LLD P'M ED Neighbor |nf0rmat|0n @ Home - System LLDP L1 DP-MED Meighbor

Auto-refresh Refresh

Port5
Device Capabilities
Type
Endpoint e : :
Ehissit LLDP-MED Capabilities, Network Policy, Extended Power via MDI - PD, Inventory
ass
Application Policy Tag VLANID  Priority DSCP
Type
Voice
2 ‘ Unknown Untagged
Signaling
Auto- Auto- Auto-negotiation Capabilities MAU Type

negotiation negotiation
status

1000BASE-T half duplex mode, 1000BASE-X, -LX, -SX, -CX full duplex mode , 100BaseTXFD - 2 pair
Supported Enabled Asymmetric and Symmetric PAUSE for full-duplex inks, Symmetric PAUSE for full- category 5 UTP, full duplex
duplex links mode

Figure 3-4.4: LLDP-MED Neighbor Iformation page
Parameter descriptions:
Port: The port on which the LLDP frame was received.

Device Type: LLDP-MED Devices are comprised of two primary Device Types: Network Connectivity
Devices and Endpoint Devices.

LLDP-MED Network Connectivity Device Definition: LLDP-MED Network Connectivity Devices, as
defined in TIA-1057, provide access to the IEEE 802 based LAN infrastructure for LLDP-MED Endpoint
Devices. An LLDP-MED Network Connectivity Device is a LAN access device based on any of these
technologies:

1. LAN Switch/Router

2. IEEE 802.1 Bridge

3. IEEE 802.3 Repeater (included for historical reasons)

4. |IEEE 802.11 Wireless Access Point

5. Any device that supports the IEEE 802.1AB and MED extensions defined by TIA-1057 and can relay
IEEE 802 frames via any method.
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LLDP-MED Endpoint Device Definition: LLDP-MED Endpoint Devices, as defined in TIA-1057, are
located at the IEEE 802 LAN network edge, and participate in IP communication service using the LLDP-
MED framework.

Within the LLDP-MED Endpoint Device category, the LLDP-MED scheme is broken into further Endpoint
Device Classes, as defined in the following.

Each LLDP-MED Endpoint Device Class is defined to build on the capabilities defined for the previous
Endpoint Device Class. For-example will any LLDP-MED Endpoint Device claiming compliance as a
Media Endpoint (Class Il) also support all aspects of TIA-1057 applicable to Generic Endpoints (Class 1),
and any LLDP-MED Endpoint Device claiming compliance as a Communication Device (Class Ill) will also
support all aspects of TIA-1057 applicable to both Media Endpoints (Class Il) and Generic Endpoints
(Class I).

LLDP-MED Generic Endpoint (Class I): The LLDP-MED Generic Endpoint (Class I) definition is
applicable to all endpoint products that require the base LLDP discovery services defined in TIA-1057,
however do not support IP media or act as an end-user communication appliance. Such devices may
include (but are not limited to) IP Communication Controllers, other communication related servers, or any
device requiring basic services as defined in TIA-1057.

Discovery services defined in this class include LAN configuration, device location, network policy, power
management, and inventory management.

LLDP-MED Media Endpoint (Class Il): The LLDP-MED Media Endpoint (Class Il) definition is applicable
to all endpoint products that have IP media capabilities however may or may not be associated with a
particular end user. Capabilities include all of the capabilities defined for the previous Generic Endpoint
Class (Class I) and are extended to include aspects related to media streaming. Example product
categories expected to adhere to this class include (but are not limited to) Voice / Media Gateways,
Conference Bridges, Media Servers, and similar.

Discovery services defined in this class include media-type-specific network layer policy discovery.

LLDP-MED Communication Endpoint (Class lll): The LLDP-MED Communication Endpoint (Class Ill)
definition is applicable to all endpoint products that act as end user communication appliances supporting
IP media. Capabilities include all of the capabilities defined for the previous Generic Endpoint (Class I)
and Media Endpoint (Class Il) classes and are extended to include aspects related to end user devices.
Example product categories expected to adhere to this class include (but are not limited to) end user
communication appliances, such as IP Phones, PC-based softphones, or other communication
appliances that directly support the end user.

Discovery services defined in this class include provision of location identifier (including ECS / E911
information), embedded L2 switch support, inventory management.

LLDP-MED Capabilities: LLDP-MED Capabilities describes the neighborhood unit's LLDP-MED
capabilities. The possible capabilities are:
1. LLDP-MED capabilities
. Network Policy
. Location Identification
. Extended Power via MDI - PSE
. Extended Power via MDI - PD
. Inventory
. Reserved

N O ok ODN
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Application Type: Indicates the primary function of the application(s) defined for this network policy,
advertised by an Endpoint or Network Connectivity Device. The possible application types are:

1. Voice - for use by dedicated IP Telephony handsets and other similar appliances supporting
interactive voice services. These devices are typically deployed on a separate VLAN for ease of
deployment and enhanced security by isolation from data applications.

2. Voice Signalling - for use in network topologies that require a different policy for the voice
signalling than for the voice media.

3. Guest Voice - to support a separate limited feature-set voice service for guest users and visitors
with their own IP Telephony handsets and other similar appliances supporting interactive voice
services.

4. Guest Voice Signalling - for use in network topologies that require a different policy for the guest
voice signalling than for the guest voice media.

5. Softphone Voice - for use by softphone applications on typical data centric devices, such as PCs
or laptops.

6. Video Conferencing - for use by dedicated Video Conferencing equipment and other similar
appliances supporting real-time interactive video/audio services.

7. Streaming Video - for use by broadcast or multicast based video content distribution and other
similar applications supporting streaming video services that require specific network policy
treatment. Video applications relying on TCP with buffering would not be an intended use of this
application type.

8. Video Signalling - for use in network topologies that require a separate policy for the video
signalling than for the video media.

Policy: Indicates that an Endpoint Device wants to explicitly advertise that the policy is required by the
device. Can be either Defined or Unknown

Unknown: The network policy for the specified application type is currently unknown.

Defined: The network policy is defined.

TAG: Indicates whether the specified application type is using a tagged or an untagged VLAN. Can be
Tagged or Untagged.

Untagged: The device is using an untagged frame format and as such does not include a tag
header as defined by IEEE 802.1Q-2003.

Tagged: The device is using the IEEE 802.1Q tagged frame format.
VLAN ID: The VLAN identifier (VID) for the port as defined in IEEE 802.1Q-2003. A value of 1 through 4094
is used to define a valid VLAN ID. A value of 0 (Priority Tagged) is used if the device is using priority tagged

frames as defined by IEEE 802.1Q-2003, meaning that only the IEEE 802.1D priority level is significant and
the default PVID of the ingress port is used instead.

Priority: The Layer 2 priority to be used for the specified application type. One of the eight priority levels (0
through 7).

DSCP: The DSCP value to be used to provide Diffserv node behavior for the specified application type as
defined in IETF RFC 2474. Contain one of 64 code point values (0 through 63).

Auto-negotiation: Identifies if MAC/PHY auto-negotiation is supported by the link partner.

Auto-negotiation status: identifies if auto-negotiation is currently enabled at the link partner.
If Auto-negotiation is supported and Auto-negotiation status is disabled, the 802.3 PMD operating mode
will be determined the operational MAU type field value rather than by auto-negotiation.

Auto-negotiation Capabilities: shows the link partners MAC/PHY capabilities.
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Lantronix
Buttons
g\euctgr;gesf.resh: Check to refresh the page automatically every 3 Auto-refrash Refresh

Refresh: Click to manually refresh the page immediately.
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3-4.5 LLDP Statistics

Two types of counters are shown. Global counters are counters that refer to the whole switch, while Local
counters refer to per-port counters for the switch.

To show LLDP Statistics:

1. Click System, LLDP, and LLDP Statistics.

2. Click Refresh to manually update the web screen.
3. Click Auto-refresh to auto-update the web screen.
4

Click Clear to clear all counters.

ry

LANTRONIX® =| *=* sss — T
= .
SM24TBT4SA LLDP Statistics @Home -~ System - LLDP - LLDP Statistics
Switch DMS ——
Auto-refresh ‘ Refresh || Clear ‘
» System i ) “ :
> System Information LLDP Global Counters
» |P Address <
Neighbor entries were last changed 1 days, 7:06:02 (111962 sec. ago)
> System Time
» LLDP » Total Neighbors Entries Added 0
> LLDP Configuration Total Neighbors Entries Deleted 0
> LLDP-MED Configuration
Total Neighbors Entries Dropped 0
> LLDP Neighbor
Total Neighbors Entries Aged Out 0

v

LLDP PoE

v

LLDP-MED Neighbor

s LLDP Statistics LLDP Statistics Local Counters

> W Local Port TxFrames RxFrames RxErrors FramesDiscarded TLVsDiscarded TLVsUnrecognized Org.Discarded Age-Outs

> 1 <
Port Management 1 0 0 0 0 0 0 0 0

» PoE Management <
2 0 0 0 0 0 0 0 0

» VLAN Management <
3 0 0 0 0 0 0 0 0

» Quality of Service <
. 4 0 0 0 0 0 0 0 0

» Spanning Tree <
b MACAddress Table ¢ 0 g g g 0 g g L
» Multicast < 6 0 0 0 0 0 0 0 0

Figure 3-4.5: LLDP Statistics information

Global Counters

Neighbor entries were last changed: Shows the time when the last entry was last deleted or added. It
also shows the time elapsed since the last change was detected.

Total Neighbors Entries Added: Shows the number of new entries added since switch reboot.
Total Neighbors Entries Deleted: Shows the number of new entries deleted since switch reboot.

Total Neighbors Entries Dropped: Shows the number of LLDP frames dropped due to the entry table
being full.

Total Neighbors Entries Aged Out: Shows the number of entries deleted due to Time-To-Live expiring. ]

Local Counters: The displayed table contains a row for each port. The columns display the following
information:

Local Port: The port on which LLDP frames are received or transmitted.

Tx Frames: The number of LLDP frames transmitted on the port.
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Rx Frames: The number of LLDP frames received on the port.
Rx Errors: The number of received LLDP frames containing some kind of error.

Frames Discarded: If an LLDP frame is received on a port, and the switch's internal table is full, the
LLDP frame is counted and discarded. This situation is known as "Too Many Neighbors" in the LLDP
standard. LLDP frames require a new entry in the table when the Chassis ID or Remote Port ID is not
already contained within the table. Entries are removed from the table when a given port's link is down, an
LLDP shutdown frame is received, or when the entry ages out.

TLVs Discarded: Each LLDP frame can contain multiple pieces of information, known as TLVs (TLV is
short for "Type Length Value"). If a TLV is malformed, it is counted and discarded.

TLVs Unrecognized: The number of well-formed TLVs, but with an unknown type value.
Org. Discarded: The number of organizationally received TLVs.

Age-Outs: Each LLDP frame contains information about how long time the LLDP information is valid
(age-out time). If no new LLDP frame is received within the age out time, the LLDP information is
removed, and the Age-Out counter is incremented.

Buttons Auto-refresh l Refresh || Clear |

Auto-refresh: Check to refresh the page automatically every 3
seconds.

Refresh: Click to manually refresh the page immediately.

Clear: Clears the counters for the selected port.
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3-5 UPnP

The Universal Plug and Play Forum was formed to standardize discovery and control of networked
devices. See the Open Connectivity Foundation webpage.

To configure UPnP in the web Ul:
1. Click System and UPnP.

2. Scroll to select the mode to enable or disable.

3. Specify the parameters in each field.

4. Click the Apply button to save the settings.

5. To cancel the setting click the Reset button to revert to previously saved values.

LANTRONIX® =| *™ )

SM24TBT4SA UPnP Configuration Auto-logout [OFF v |yor il oo M) uerlw
Switch DMS
» System e )
> System Information Interface VLAN .
» IP Address <
> System Time TTL 4
» LLDP < . .
Advertising Duration 100
> UPnP
» Port Management < Apply

Reset

fom s . v

Figure 3-5: UPnP Configuration page
Mode: Indicates the UPnP operation mode. Possible modes are:

Enabled: Enable UPnP mode operation.
Disabled: Disable UPnP mode operation.

When Mode is enabled, two ACEs are added automatically to trap UPNP related packets to the CPU. The
ACEs are automatically removed when the mode is disabled.

Interface VLAN: The Interface VLAN value is used by UPnP to send SSDP advertisement messages for
the Interface VLAN. Valid values are VIDs 1 - 4095.

TTL: The Time To Live (TTL) value is used by UPnP to send SSDP advertisement messages. Valid
values are 1 - 255 seconds.

Advertising Duration: The duration, carried in SSDP packets, is used to inform a control point or control
points how often it or they should receive an SSDP advertisement message from this switch. If a control
point does not receive any message within the duration, it will think that the switch no longer exists. Due
to the unreliable nature of UDP, in the standard it is recommended that such refreshing of advertisements
to be done at less than one-half of the advertising duration. In the implementation, the switch sends
SSDP messages periodically at the interval one-half of the advertising duration minus 30 seconds. Valid
values are 100 - 86400 seconds.

Buttons
Apply: Click to save changes.

Reset: Click to undo any changes made locally and revert to previously saved values.
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Chapter4 Port Management > Port Management

> Port Configuration

This section lets you view and configure switch Port functions. > Port Statistics
» SFP Port Information
4' 1 POI‘t Configuration > Energy Efficient Ethernet
. . . Link Aggregation
This page lets you view and configure current port parameters. T ‘
» Loop Protection <

To set Port Configuration parameters in the web Ul:

1. Click Port Management and Port Configuration.

2. Specify the Maximum Frame Size, Speed Mode, Flow Control, and Description parameters.
3. Click the Apply button.

| all
® o || pOnx i = Auto-logout . »

| LANTRONIX" = e swesssws = Y M@ e

|
SM8TBT2SA Port Configuration @ome - Forthznszement - Port Configuration
Switch DMS
Refresh ‘
| » System <
» Port Management v Maximum Frame Size 10000

> Port Configuration

> Port Statistics

Speed Flow Control
| > SFP Port Information

Port Link Status Mode Rx Status Tx Status Mode Description
> Energy Efficient Ethernet
» Link Aggregation < |1 o 10Mfdx Auto ~| off off O
» Loop Protection <
» PoE Management < 2 . down futo v|| off off B
» VLAN Management <

3 @ down Auto v Off Off 0
» Quality of Service <
¥ Spanning Tree < 4 . down Auto v Off off O
» MAC Address Table <
» Multicast < 5 [ ] 1oMfdx Auto v On on O
» Percepxion <

6 @) 10Mfdx Auto ~| On On [l
» DHCP 5
¥ Security ¢ 7 . down Auto v Off Off O
¥ Access Control <
» SNMP < 8 . down Auto v Off Off O
» Event Notification <

9 [ ] down Auto v| off off 0
» Diagnostics <
» Maintenance $ 10 o down Auto «| off off O

‘ Apply H Reset ‘

Figure 4-1: Port Configuration page
Parameter descriptions:

Maximum Frame Size : Maximum packet length filtering is examined on both receiving and transmitting
ports. Enter the maximum frame size allowed for the switch port, including FCS. The valid range is 1518-
10000 bytes. The default value is 10,000 bytes.

Port: This is the logical port number for this row.
Link: The current link state is displayed graphically. Green means the link is up and red means it is down.

Status: Provides the current link speed of the port if the port is up, otherwise displays ‘down’.
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Mode: (Configured Link Speed) Select any available link speed for the given switch port. Only speeds
supported by the specific port are shown. Possible speeds are:

Disabled - Disables the switch port operation.

Auto - Port auto negotiating speed with the link partner and selects the highest Mode
speed that is compatible with the link partner.
10Mbps HDX - Forces the cu port in 10Mbps half-duplex mode.
10Mbps FDX - Forces the cu port in 10Mbps full duplex mode. Disabled
100Mbps HDX - Forces the cu port in 100Mbps half-duplex mode. 10Mbps HDX
100Mbps FDX - Forces the cu port in 100Mbps full duplex mode. iEDﬁE;Fﬂ’;X
1Gbps FDX - Forces the port in 1Gbps full duplex mode. 100Mbps FDX

1Gbps FDX

Note: to power cycle an individual switch port, change the Configured Link Speed to
Disabled in the drop down menu of the option highlighted below. The port LED will then go out on that
port. Changing the Configured Link Speed to Auto or to the required speed will re enable the port.

Flow Control: When Auto Speed is selected on a port, this section indicates the flow control capability
that is advertised to the link partner. When a fixed-speed setting is selected, that is what is used.

The Rx Status column indicates whether pause frames on the port are obeyed, and the Tx Status column
indicates whether pause frames on the port are transmitted. The Rx and Tx Status settings are
determined by the result of the last Auto-Negotiation.

Check the Flow Control Mode checkbox to use flow control. This setting is related to the setting for
Configured Link Speed.

Description: Enter up to 63 characters to be descriptive name for identifies this port. Specify the detail
Port alias or description; an alphanumeric string describing the full name and version identification for the
system’s hardware type, software version, and networking application.

Buttons

Refresh: Click to refresh the Port link Status manually.

Apply: Click to save changes.

Reset: Click to undo any changes made locally and revert to previously saved values.
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4-2 Port Statistics

This page displays Port statistics information and provides an overview of general traffic statistics for all
switch ports. To display the Port Statistics Overview in the web Ul:

1. Click Port Management and Port Statistics.

2. To automatically refresh the page select “Auto-refresh”.

3. Click “ Refresh” to refresh the port statistics or clear all information when you click “Clear”.
4

To view detailed port statistics, click that port.

LANTRONIX™ =] *™ L ssssssassssssinz| v T H O O

SM24TBT4SA Port Statistics Overview gbHome - Port Management - Port Statistics
Switch DMS ]
Auto-refresh | Refresh ” Clear |
b System < ) = :
5 Er ETEsEET — Packets Bytes Errors Drops
> Port Configuration Port Received Transmitted Received Transmitted Received Transmitted Received Transmitted
> Port Statistics
1 4852144 954398 507964896 212024069 0 0 250016 0
> SFP Port Information
> Energy Efficient Ethernet - 0 0 0 0 0 0 0 0
#» Link Aggregation < 3 0 o 0 0 0 0 0 0
» Loop Protection <
4 0 1] 0 0 0 0 4] 0
» PoE Management <
5 242357 4091621 115040103 400209116 0 0 2606 0
» VLAN Management <
6 82546 3938637 5503179 384728434 0 0 1808 0
» Quality of Service <
. T 0 ] 0 0 4] 0 0 0
» Spanning Tree <
» MAC Address Table < & 0 0 0 0 0 0 0 0
» Multicast < 9 0 0 0 0 0 0 0 0
> Consoleflow 10 0 1] 0 0 4] 0 0 0
<
» DHCP 10 0 0 0 0 0 0 0
» i+ €
SRy 12 0 0 n n 0 0 0 n

Figure 4-2: Port Statistics Overview page

Parameter descriptions:

Port: The logical port for the settings contained in the same row.

Packets: The number of received and transmitted packets per port.

Bytes: The number of received and transmitted bytes per port.

Errors: The number of frames received in error and the number of incomplete transmissions per port.

Drops: The number of frames discarded due to ingress or egress congestion.

Auto-refresh Refresh | Clear 7
Buttons

Auto-refresh: Click to refresh the page automatically every 3 seconds.
Refresh: Click to manually refresh the page immediately.

Clear: Clears the counters for all ports.
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Detailed Port Statistics: Click a linked port to see its Detailed Port Statistics. The displayed counters are
the totals for receive and transmit, the size counters for receive and transmit, and the error counters for
receive and transmit.

A
LANT@NIX* | LANIRONIX & : Auto-logout H e c.
SM24TBT45A Detailed Port 1 Statistics @iHome - Fort Management - Port Statistics
Switch DMS —
Auto-refresh ‘ Refresh H Clear | Port1
» System <
. " Receive Total Transmit Total
» Port Management
> Port Configuration Rx Packets 4860521 Tx Packets 955873
> Port Statistics
Rx Octets 508857718 Tx Octets 212412550
> SFP Port Information
ficient Ethernet Rx Unicast 1432232 Tx Unicast 792072
< Rx Multicast 299700 Tx Multicast 2208
‘ Rx Broadcast 3128589 Tx Broadcast 161593
» M o <
e E T Rx Pause 0 Tx Pause 0
» VLAN Management <
» Quality of Service ¢ Receive Size Counters Transmit Size Counters
A <
» Spanning Tree Rx 64 Bytes 3255547 Tx 64 Bytes 618018
» MAC Address Tabl: <
ress lable Rx 65-127 Bytes 1170428 Tx 65-127 Bytes 79709
» Multicast <
Rx 128-255 Bytes 177289 Tx 128-255 Bytes 116781
> Consoleflow
Rx 256-511 Bytes 39873 Tx 256-511 Bytes 26837
» DHCP ¢
b Seeify < Rx 512-1023 Bytes 195363 Tx 512-1023 Bytes 36562
» Access Control ¢ Rx1024-1518 Bytes 21921 Tx 1024-1518 Bytes 77966
» SNMP < Rx 1519-max Bytes 0 Tx 1519-max Bytes 0
» Event Notification <
q c ¢ Receive Error Counters Transmit Error Counters
» Diagnostics
» Maintenance < Rx Drops 251872 Tx Drops 0
Rx CRC/Alignment 0 Tx Late Collision 0
Rx Undersize 0 Tx Excessive Collision 0 ]

Figure 4-2: Detailed Port Statistics page
Parameter descriptions:

Receive Total and Transmit Total

Rx and Tx Packets: The number of received and transmitted (good and bad) packets.

Rx and Tx Octets: The number of received and transmitted (good and bad) bytes. Includes FCS but
excludes framing bits.

Rx and Tx Unicast: The number of received and transmitted (good and bad) unicast packets.
Rx and Tx Multicast: The number of received and transmitted (good and bad) multicast packets.
Rx and Tx Broadcast: The number of received and transmitted (good and bad) broadcast packets.

Rx and Tx Pause: A count of the MAC Control frames received or transmitted on this port that have an
opcode indicating a PAUSE operation.

Receive and Transmit Size Counters: The number of received and transmitted (good and bad) packets
split into categories based on their respective frame sizes.

Receive Error Counters

Rx Drops: The number of frames dropped due to lack of receive buffers or egress congestion.
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Rx CRC/Alignment: The number of frames received with CRC or alignment errors.
Rx Undersize: The number of short 1 frames received with valid CRC.

Rx Oversize: The number of long 2 frames received with valid CRC.

Rx Fragments: The number of short 1 frames received with invalid CRC.

Rx Jabber: The number of long 2 frames received with invalid CRC.

Rx Filtered: The number of received frames filtered by the forwarding process.
Short frames are frames that are smaller than 64 bytes.
Long frames are frames that are longer than the configured maximum frame length for this port.

Transmit Error Counters

Tx Drops: The number of frames dropped due to output buffer congestion.

Tx Late/Exc. Coll.: The number of frames dropped due to excessive or late collisions.

Auto-refresh

Buttons
Auto-refresh: Click to refresh the page automatically every 3 seconds.
Refresh: Click to manually refresh the page immediately.

Clear: Clears the counters for the selected port.
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4-3 SFP Port Info
This page displays detailed SFP module information when an SFP is connected to the switch.
The information includes Connector type, Fiber type, wavelength, bit rate, Vendor OUI, etc.
To display the SFP information in the web Ul:

1. Click Port Management and SFP Port Info.

2. Use the port select dropdown to select the desired port.

3. View the displayed SFP Information.

a
LANT?ON'X — | Lwmonx - Auto-logout H @ &
- L
SM24TBT2SA SFP Port Information @Home  Port Managzement - SFP Port Information
Switch DMS —
Auto-refresh ‘ Refresh |
b System <
» Port Management v Port 2
> Port Configuration Connector Type SFP or SFP Plus - LC
> Port Statistics . .
Fiber Type Multi-mode (MM)

> SFP Port Information

> Energy Efficient Ethernet Tx Central Wavelength 850
ergy t Et t
» Link Aggregation < Bit Rate 1000 Mbps
» L Protecti
PRI ¢ Vendor OUI 00-c0-f2
» PoE Management <
- Vendor Name LANTRONIX
» VLAN Management g
Vendor P/N TN-GLC-SX-MM-RGD
» Quality of Service <
i Vendor Revision V2.0
» Spanning Tree <
b MAC Address Table ¢ Vendor Serial Number AL22030001168
» Multicast < Date Code 220224
» Percepxion < Temperature 22.23C
» DHCP ¢ wee 340V
i <
> SREny Mon1 (Bias) 3 mA
» Access Control <
Mon2 (TX PWR) -6.54 dBm
» SNMP <
Mon3 (RX PWR) none
» FEvent Notification <

Figure 4-3: SFP Port Information page

Port select: Use the dropdown to select the port to display its Port statistics (e.g., Port 0).

Connector Type: Display the connector type (e.g., SFP, SFP Plus, Reserved - LC, SC, ST, LC, etc.).

Fiber Type: Display the fiber mode, for instance, Multi-mode (MM) or Single-mode (SM).

Tx Central Wavelength: Display the fiber optical transmitting central wavelength, for instance, 850nm,

1310nm, 1550nm, etc.

Bit Rate: Displays the nominal bit rate of the transceiver (e.g., 1000 Mbps).

Vendor OUI: Displays the Manufacturer's OUI (Organizationally Unique Identifier) code which is assigned

by IEEE.

Vendor Name: Displays the company name of the module manufacturer.

Vendor P/N: Displays the product name of the naming by module manufacturer.

Vendor Revision: Displays the module revision.

33873 Rev. A

https://www.lantronix.com/

Page 46 of 273


https://www.lantronix.com/

Lantronix SMXTBTxSA Web User Guide

Vendor Serial Number: Shows the serial number assigned by the manufacturer.
Date Code: Shows the date this SFP module was made.

Temperature: Shows the current temperature of SFP module.

Vcce: Shows the working DC voltage of SFP module.

Mon1 (Bias) mA: Shows the Bias current of SFP module in milliamps.

Mon2 (TX PWR): Shows the transmit power of SFP module in dBm.

Mon3 (RX PWR): Shows the receiver power of SFP module in dBm.

Auto-refresh

Buttons
Auto-refresh: Check to refresh the page automatically every 3 seconds.

Refresh: Click to manually refresh the page immediately.
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4-4 Energy Efficient Ethernet

This page lets you view and configure the current EEE port settings. EEE (Energy Efficient Ethernet) is
defined in IEEE 802.3az as a power saving option that reduces the power usage when there is very low
traffic utilization (or no traffic).

EEE works by powering down circuits when there is no traffic. When a port gets data to be transmitted all
circuits are powered up. The time it takes to power up the circuits is named wakeup time. The default
wakeup time is 17 us for 1Gbit links and 30 us for other link speeds. EEE devices must agree upon the
value of the wakeup time in order to make sure that both the receiving and transmitting device has all
circuits powered up when traffic is transmitted. The devices can exchange information about the devices
wakeup time using the LLDP protocol.
To configure Energy Efficient Ethernet in the web Ul:

1. Click Port Management and Energy Efficient Ethernet.

2. For each port select enable or disable Energy Efficient Ethernet.
3. Click the Apply button to save the settings.
4

To cancel the setting click the Reset button to revert to previously saved values.

A
LANT?ONIXJ = | LANTRONIX ol il il Auto-logout H 9 C¢
= v
SM24TBT45A Energy Efficient Ethernet Configuration @ttoms - PortVansgemant - Snargy Eficient Etharnat
Switch DMS
Port Energy Efficient Ethernet Configuration
» System <
» Port Management v Port Configure
> Port Configuration
1 Diszbled v
> Port Statistics
» SFP Port Infermation 2 Disabled v
gy Efficient Ethernet
3 Disabled w
¢
» Loop Protection < 4 Disabled w
<
» PoE Management 5 Disabled
» VLAN Management <
. . 6 Disabled w
» Quality of Service <
» Spanning Tree < 7 Disabled
» MAC Address Table < )
8 Disabled +
» Multicast «
9 Disabled ~
> Consoleflow
» DHCP <10 Disabled

S P <

Figure 4-4: Port Energy Efficient Ethernet Configuration
Parameter descriptions:
Port: The switch port number of the logical EEE port.

Configure: Controls whether EEE is Enabled or Disabled for each switch port.

Buttons
Apply: Click to save changes.

Reset: Click to undo any changes made locally and revert to previously saved values.
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4-5 Link Aggregation » Link Aggregation
4-5.1 Port > Configuration

This section describes the Port setting/status used to configure the trunk
properties of each port. To configure the trunk property of each port via the web:

> Aggregator View
regation Hash Mode

> LACP System Priority

1. Click Port Management > Link Aggregation > Port Configuration.

2. Specify the Method, Group, LACP Role and LACP Timeout.

3. Click the Apply button to save the settings.

4. To cancel the setting click the Reset button to revert to previously saved values.

A
LANT@NIX = wwmonx ol il Auto-logout H @ ¢
= L ]
SM24TBT4SA Trunk Port Configuration/Status @Home - PartMnagement - UnkAggresstion  Cenfisuration
Switch DMS
Trunk Port Configuration/Status
b System <
b Errt N ErmTETE v Trunk Port Configuration Trunk Port Status
¥ Fei e Port Method Group LACP Role LACP Timeout Aggr Status
> Port Statistics
Mone ) Active Fasi ;
> SFP Port Information 1 ? v S c v = 1 Ready
> Energy Efficient Ethernet 2 None 0w Active v Fast 2
3 MNone ™ 0 v Active ™ Fast 3
4 None v Y Active  w Fast w 4
5 None 0 Active W Fast 5 Ready
ystem Priority
6 None v 0 v Active v Fast 6 Ready
» Loop Protection <
» PoEManagement < T Mone 0 W Active - Fast W 7
» VLAN Management < 2! None 0 v Active W Fast 8
» Quality of Service <
9 MNone ~ 0 v Active W Fast 9
» Spanning Tree <

MaA~ A aa oL ¢ 10 None v 0 v Active W Fast 10

Figure 4-5.1: Trunk Port Configuration/Status page

Port Trunk Configuration:

Port: The logical port number for the settings contained in the row.

Method: This determines the method a port uses to aggregate with other ports.
None: A port does not want to aggregate with any other port should choose this default setting.
LACP: A port uses LACP as its trunk method to get aggregated with other ports also using LACP.
Static: A port uses Static Trunk as its trunk method to get aggregated with other ports also using
Static Trunk.

Group: Ports choosing the same trunking method other than “None” must be assigned a unique Group
number (i.e., Group ID; valid value is 1 - 8) in order to declare that they wish to aggregate with each other.

LACP Role: This field is only referenced when a port’s trunking method is LACP.

Active: An Active LACP port begins to send LACPDU to its link partner right after the LACP protocol
entity started to take control of this port.

Passive: A Passive LACP port will not actively send LACPDU out before it receives an LACPDU
from its link partner.

LACP Timeout: The Timeout controls the period between BPDU transmissions.
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Fast: It will transmit LACP packets each second,
Slow: It will wait for 30 seconds before sending a LACP packet.

Trunk Port Status:

Aggr: Abbreviation of “aggregator”. Every port is also an aggregator, and its own aggregator ID is the
same as its own Port number. We can regard an aggregator as a representative of a trunking group.

Ports with the same Group ID and using same trunking method will have the opportunity to aggregate to a
particular aggregator port. This aggregator port is usually the port with the smallest Port No. within the
trunking Group.

Status: This field represents the trunking status of a port which uses a trunking method other than
“None”. It also represents the management link status of a port which uses the “None” trunking method. “-
--“ means “not ready”

Buttons
Apply: Click to save changes.
Reset: Click to undo any changes made locally and revert to previously saved values.
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4-5.2 Aggregation Status
This page displays the current port trunking information from the aggregator point of status. To view LACP
aggregation status in the web Ul:

1. Click Port Management, Link Aggregation, and Aggregation Status.

2. View the displayed status.

3. Click the Auto-refresh and Refresh buttons as needed.

A
LANTQONIX‘ = | uemoux L] : Aute-logout H o c’
SM24TBT4SA Aggregation Status g Home - PaortMansgement Link Aggregstion - Agsregation Status
Switch DMS —
Auto-refresh Refresh

» System <

Aggregation Status
» Port Management e gEres
> Port Configuration

Aggr 1D Name Type Speed Configured Ports Aggregated Ports Aggregated Bandwidth

> Port Statistics

. . . No a regation groups.
> SFP Port Information EETeE group

Figure 4-5.2: Port Management > Link Aggregation > Aggregation Status

Parameter descriptions:

Aggr ID: Shows the aggregator ID of aggregator ports.

Name: Show the aggregator Name of aggregator ports.

Type: Show the type a port uses to aggregate with other ports.

Speed: Show the port link speed of aggregator ports.

Configured Ports: Show all config ports of aggregator ports.

Aggregated Ports: Show all aggregated ports of aggregator ports.

Aggregated Bandwidth: Show the ports aggregated link speed bandwidth of aggregator ports.

Buttons
Auto-refresh: Check this box to refresh the page automatically every 3 seconds.

Refresh: Click to manually refresh the page immediately.
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4-5.3 Aggregator View
This page displays the current port trunking information from the aggregator point of view.
To see the LACP detail in the web Ul:

1. Click Port Management, Link Aggregation, and Aggregator View.
2. Click the LACP Detail radio button as required.
3. Click the LACP Detail button.

a
D e || LANTRONIX - ol ol o | (ol R ) R Auto-logout : »
LANTRONIX™ = L TETETE PETTYE S ¥ - M ec
SM24TBT45A Aggregator View @ Home - Port Management - Link Aggregation - AggregatorView
Switch DMS
Aggregator View
» System <
D EemEREEE T v Aggregator Method Member Ports Ready Ports LACP Detail
> Port Configuration 1 None 1 1 e
> Port Statistics
2 None 2 O
> SFP Port Information ~
> Energy Efficient Ethernet 3 None 3 \i)
% Link Aggregati v -
» Link Aggregation 4 None 4 o
> Configuration
> Aggregation Status 5 None 5 s W
> Aggregator View 6 None 6 6 O
> Aggregation Hash Mode ~
7 None 7 O
> LACP System Priority -
» Loop Protection < g None 8 O
» PoE Management < 9 None 9 @)
» VLAN Management « 10 None 10 s

» Quality of Service
Figure 4-5.3: Aggregator View page
Parameter descriptions:

Aggregator: Shows the aggregator ID of every port. Every port is also an aggregator, and its own
aggregator ID is the same as its own Port number.

Method: Show the method a port uses to aggregate with other ports.
Member Ports: Show all member ports of an aggregator (port).

Ready Ports: Show only the ready member ports within an aggregator (port).
LACP Detail: Lets you select the port that you want to see the LACP Detail.
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Buttons

LACP Detail: Click this radio button to display the Aggregator Information for the selected Aggregator as
described below.

Aggregator 2 Information

Aggregator Information

Actor Partner

System Priority Mac Address System Priority Mac Address

32768 00-E0-4C-00-00-00 32768 00-00-00-00-00-00
Actor Port Actor Key Trunk Status Partner Port Partner Key

2 257 2 0

Figure 4-5.4: LACP Detail page
Actor
System Priority: Show the System Priority part of the aggregation Actor. (1-65535).
Mac Address: The system ID of the aggregation Actor.
Actor Port: The actor's port number connected to this port.

Actor Key: The Key that the actor has assigned to this aggregation ID.

Partner

System Priority: Show the System Priority part of the aggregation partner (1-65535).
Mac Address: The system ID of the aggregation partner.

Partner Port: The partner's port number connected to this port.

Partner Key: The Key that the partner has assigned to this aggregation ID.

Trunk Status: This field represents the trunking status of a port which uses a trunking method other than
“None”. It also represents the management link status of a port which uses the “None” trunking method.
“---“ means “not ready”.

Button
Back: Click to undo any changes made locally and return to the Aggregator View page.

Messages: Method must be LACP and Member Ports must have a port at least.
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4-5.4 Aggregation Hash Mode

Aggregation Mode lets you select one of several Hash code contributors to calculate the destination port

for the frame.

To configure the Aggregation hash mode in the web Ul:
1. Click Port Management, Link Aggregation, and Aggregation Hash Mode.
2. Click Hash Code Contributors to select the mode.
3. Click the Apply button to save the settings.
4. To cancel the setting, click the Reset button to revert to previously saved values.

LANTRONIX™ =| "™ vew

SM24TBT4SA Aggregation Mode Configuration @riome - port 02k OFF_ ] pBion @ od
Switch DMS
Aggregation Mode Configuration
» System <
» Port Management v Hash Code Contributors

> Port Configuration
src-dst-mac

> Port Statistics

> SFP Port Information

| Apply || Reset |

> Energy Efficient Ethernet
» link Aooraoatinn

Figure 4-5.5: Aggregation Hash Mode
Hash Code Contributors

src-mac: The Source MAC address can be used to calculate the destination port for
the frame. Check to enable the use of the Source MAC address or uncheck to
disable. By default, Source MAC Address is enabled.

dst-mac: The Destination MAC Address can be used to calculate the destination port
for the frame. Check to enable the use of the Destination MAC Address or uncheck to
disable. By default, Destination MAC Address is disabled.

src-dst-mac: Use Source MAC Address + Destination MAC Address.

src-ip: Use Source MAC Address + IP Address.

dst-ip: Use Destination MAC Address + IP Address.

src-dst-ip: Use Source MAC Address + Destination MAC Address + IP Address.

Buttons
Apply : Click to save changes.

Reset : Click to undo any changes made locally and revert to previously saved values.

Hash Code Contributors

src-dst-mac

Src-mac

(1 dst-mac

| EETr——
src-ip

dst-ip
src-dst-ip
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4-5.5 LACP System Priority

This page lets you set the priority part of the LACP system ID. Link Aggregation Control Protocol (LACP)
will only aggregate together the ports whose peer link partners are all on a single system. Each system
that supports LACP will be assigned a globally unique System Identifier for this purpose. A system ID is a
64-bit field comprising a 48-bit MAC Address and 16-bit priority value. The System Priority is configurable;
its range is 1 - 65535. The default is 32768.

To configure the LACP System Priority in the web Ul:
1. Click Port Management, Link Aggregation, and LACP System Priority.
Specify the LACP System Priority.

2.
3. Click the Apply button to save the settings.
4. To cancel the setting click the Reset button to revert to previously saved values.

r
LANT?ON | X — LANTRONIX ol il ol Auto-logout H 0 C»
- L
SM24TBT4SA LACP System Priority @tome - FortManagement  Link Aggregation - LACP System Priority
Switch DMS
LACP System Priority
» System
» Port Management v System Priority 32768

> Port Configuration

> Port Statistics | Apply || Reset |

Figure 4-5.6: LACP System Priority page

Parameter descriptions:
System Priority: Show the System Priority part of a system ID (1-65535).

Buttons
Apply: Click to save changes.
Reset: Click to undo any changes made locally and revert to previously saved values.
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4-6 Loop Protection
4-6.1 Configuration

Loop Protection is used to detect the presence of traffic. When the switch receives packet’s (looping
detection frame) MAC address the same as oneself from port, Loop Protection is shown. The port will be
locked when it receives the looping Protection frames. To resume the locked port, find and remove the
looping path, then select the locked port and click on “Resume” to turn on the locked ports.

To configure Loop Protection parameters in the web Ul:

1. Click Port Management, Loop Protection, and Configuration.

2. Select “on” to enable port Loop Protection globally.

3. Click the Apply button to save the settings.

4. To cancel the setting, click the Reset button to revert to previously saved values

Y
e —| wwmox : rrrrr T rrrr T N O muto-logout [0FF  v| >
LANTQON'X - ‘o PYVYYYY YOYYwYw W W - H 9 C
SM24TBT4SA Loop Protection Configuration @Home - Port Mansgement - Loop Protection - Canfiguration
Switch DMS
Global Configuration

b System <
» Port Management v Enable Loop Protection

> Port Configuration

> Port Statistics Transmission Time 5 seconds

> SFP Port Information Shutdown Time 120 seconds

> Energy Efficient Ethernet

» Link Aggregation < . A
Port Configuration
» Loop Protection v
> Configuration Port Enable Action Tx Mode
> Status
= |_‘ < v - v
» PoE Management <
» VLAN Management < 1 |E\ Shutdown Port ~ Enable w
» Quality of Service < 2 [ Shutdown Fort v Enable w
» Spanning Tree < o
3 [w] Shutdown Port - Enable
» MAC Address Table e
» Multicast < 4 |2\ Shutdown Port ~ Enable w
> Consoleflow 5 [w] Shutdown Port v Enable
» DHCP § -
6 [w) Shutdown Port ~ Enable
» Security e
» Access Control < 7 [+ Shutdown Port v Enable
A < —
> SNMP 8 [w) Shutdown Port v Enable
» Fvent Notification <
a [ Shutdown Port M Fnabla  w

Figure 4-6.1: Loop Protection Configuration page

Global Confiquration

Enable Loop Protection: Controls whether loop protections is enabled (as a whole).

Transmission Time: The interval between each loop protection PDU sent on each port. Valid values are 1
to 10 seconds.
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Shutdown Time: The period (in seconds) for which a port will be kept disabled in the event of a loop is
detected (and the port action shuts down the port). Valid values are 0 - 604800 seconds (7 days).
A value of zero will keep a port disabled (until next device restart).

Port Configuration

Port: The switch port number of the port. Action
Enable: Controls whether loop protection is enabled on this switch port. = v‘
Action: Configures the action performed when a loop is detected on a port.
Valid values are Shutdown Port, Shutdown Port and Log, or Log Only. Shutdown Port and Log

Log Only

Tx Mode: Controls whether the port is actively generating loop protection PDUs, or m——
whether it is just passively looking for looped PDUs.

Buttons
Apply: Click to save changes.
Reset: Click to undo any changes made locally and revert to previously saved values.
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4-6.2 Status
This section displays the loop protection port status.
To display Loop Protection status in the web Ul:
1. Click Port Management, Loop Protection, and Status.
2. To automatically refresh the information, select “Auto refresh”.

3. Click “Refresh” to refresh the Loop Protection Status.

Loop Protection Status

Auto-refresh Refresh ‘
Port Action Transmit Loops Status Loop
1 Shutdown Enabled 0 Down
2 Shutdown Enabled 0 Down
3 Shutdown Enabled 0 Down
N-2 Shutdown Enabled 1] Down
N-1 Shutdown Enabled 0 Up
N Shutdown Enabled 0 Down

Figure 4-6.2: Loop Protection Status

Parameter descriptions:
Port: The switch port number of the logical port.

@Home - Port Management - Loop Protection - Status

Time of Last Loop

Action: The currently configured port action (Shutdown Port, Shutdown Port and Log, or Log Only).

Transmit: The currently configured port transmit mode.
Loops: The number of loops detected on this port.
Status: The current loop protection status of the port.
Loop: Whether a loop is currently detected on the port.

Time of Last Loop: The time of the last loop event detected.

Buttons
Auto-refresh: Check to refresh the page automatically every 3 seconds.

Refresh: Click to manually refresh the page immediately.
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Chapter 5 POE Management » PoE Management

> PoE Configuration
PoE (Power over Ethernet) is used to transmit electrical power to remote devices over > PoE Status
standard Ethernet cable. PoE can be used for powering IP cameras, wireless LAN X
access points and other equipment where it would be difficult or expensive to connect
equipment to the main power supply.

'oE Power Delay

> PoE Auto Power Reset

9

PoE Scheduling Profile
5-1 PoE Configuration

This page lets you view and configure current PoE port settings and show PoE Supply power.

To configure Power over Ethernet in the web Ul:

1. Click PoE Management and PoE Configuration.

2. Specify Reserved Power, Capacitor Detection, POE Mode, Extend PoE Mode, PoE Schedule,
Priority, and Maximum Power.

3. Click Apply to save the configuration.

B e || LgRorax i . Aute-logout : »
LANTRONIX" =| s wessswws = = M O C
SM8TBT2SA Power Over Ethernet Configuration @Home - PoE Manssamant - FoE Configuration
Switch DMS
Primary Power Supply [W] 240
» System <
Reserved Power determined by = @) class () Allocation () LLDP-Med
» Port Management < = - -
» PoE Management . Capacitor Detection O
> PoE Configuration
» PoF Status PoE Port Configuration
> PoE Power Delay
Port PoE Mode Extend PoE PoE Schedule Priority Maximum
> PoE Auto Power Reset Mode Power [W]
> PoE Scheduling Profile
1 Enabled Dissbled Disabled v Low ~ 30
» VLAN Management <
» QualityofSElvice < 2 Disabled ~ Disabled + Disabled v Low hd 30
i <
» Spanning Tree 3 Enabled Disabled Disabled v low  w 30
» MAC Address Table <
4 Disabled Disabled Disabled - low v 30
b Multicast <
» Percepxion < 5 Enabled v Disabled Disabled v low  w 0
» <
LR 6 Disabled Disabled Disabled hd Low hd a0
» Security <
7 Disabled Disabled Disabled - low  ~ 20
» Access Control <
b SNMP < 8 Disabled v Disabled v Disabled v low v 30

Event Notification <

-

Apply H Reset |

-

Diagnostics

Figure 5-1: PoE Configuration
Parameter descriptions:

Primary Power Supply [W]: Displays the primary power supply power in watts (e.g., 130 Watts).
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Reserved Power determined by: Radio button to select one of two modes for configuring how the
ports/PDs may reserve power:

Class: The PD will negotiate PD class then feed power if the PD request power complies with the
standard. If Maximum Power at the port is configured different then factory default value 30W, the
PD connects the port again; the PD cannot draw more power than the new configured Maximum
Power for the port. Class mode is the factory default mode. Note: When the Maximum Power per
port value is changed, it will change the mode to Allocation mode. When Class mode is set, PoE
allocated value will display after POE negotiation.

Allocation: The switch will only examine power in the Maximum Power field. So once the switch
receives PD request power, the switch will check Maximum Power configuration, and if the
configured value is smaller than PD request power, the switch will not feed power.

LLDP-Med: This mode is similar to the Class mode except that each port determines the amount
power it reserves by exchanging PoE information using the LLDP protocol and reserves power
accordingly. If no LLDP information is available for a port, the port will reserve power using the Class
mode. In Class mode the Maximum Power fields have no effect for all modes: If a port uses more
power than the reserved power for the port, the port is shut down.

Capacitor Detection: Check to enable or uncheck to disable the capacitor configuration. The default is
disabled. Check to enable legacy IP phones support.

PoE Port Confiquration

Port: This is the logical port number for this row.

PoE Mode: The PoE operating mode for the port (Enabled, Disabled, or Force), where:
Disabled: PoE disabled for the port (default). PoE Mode
Enabled: Enables PoE IEEE 802.3at (Class 4 PDs limited to 30W) (default).

Enabled
Force: The switch port powers up the linked PD without any detect/negotiate —

mechanism (PD limited to 30W). Note: Only connect PDs which support a power Disabled
input of 48~56V to prevent damage to PDs. When the port changes to Force mode,
the port’s PoE LED will light immediately. Select Force mode for devices that do not roree

do PoE negotiation (e.g., for a PoE DSRC RSU). Caution: Forcing the switch to send POE to non-
POE devices can physically damage those devices.

Extend PoE Mode: When enabled, the port will transfer data at a rate up to 10 Mbps in full duplex mode
and extend the PoE range up to 250 meters. If a PD is connected to the port, the switch follows the IEEE
802.3at PoE+ standard to supply power to the connected PD during power up. Note: With this feature
enabled on a port after the connected PD starts up completely, you must disable PoE and enable it again
or disconnect and reconnect the cable to the port for POE Extended Mode to take effect. The default is
Disabled.

PoE Schedule: Disable PoE Scheduling or select a PoE Schedule profile for each port.
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Priority: The Priority represents the ports priority. The three levels of power priority are Low, High and
Critical. The priority is used in the case where the remote devices require more power than the

power supply can deliver. In this case the port with the lowest priority will be turned off first Priority
starting from the port with the highest port number. If both power supplies are in use and are

required to provide enough power for the PoE connections that are in use, if one of the power

supplies fails and there is not enough power to support all of the PoE ports that are in use, then Low v

PoE power will be fed to PoE ports with higher priority. If the ports have the same priority, the oo

lower port number will be fed PoE power. High
Critical

Maximum Power [W]: Indicates the maximum power in watts that can be delivered to a remote
device. The valid range is 1-30 Watts. The default is 30 Watts.

Buttons

Apply: Click to save changes.
Reset: Click to undo any changes made locally and revert to previously saved values.

Messages

Message: PoE Mode(Force): The switch port will power up the linked PD without any detect/negotiate
mechanism(PD limited to 30W). Do you want to change this setting?

Meaning: Confirmation message ensuring that you want to make this config change.

Action: Click the OK button only if you are sure you want to change this setting. See the “PoE Mode”
parameter description above. If you are not sure you want to change this setting, click the Cancel button.
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5-2 PoE Status
This page displays the current status of all local ports. To display PoE Status in the web Ul:

1. Click PoE Management and PoE Status.
2. Set Auto-refresh to on or off.
3. Click the Refresh button to refresh the page.

A
LANT?ON | X ? = LANTRONIX ol il Auto-logout H e C’ |
—_— L ]
SM24TBT4SA Power Over Ethernet Status @Home - PoE Management - PoE Status
Switch DMS —
Auto-refresh ‘ Refresh |
b System < i
D Rerit [EEamt ¢ Local Port PDClass PowerAllocated PowerOverride PowerUsed CurrentUsed Priority Port Status
g
» PoE Management V 1 - 0[w] 0 0 [W] 0 [mA] Low No PD detected
PRI TEE 2 - 0[w] 0 0 [w] 0 [mA] Low No PD detected I
> PoE Status
N 3 - 0[w] 0 0 [W] 0 [mA] Low No PD detected
> PoE Power Delay
> PoE Auto Power Reset 4 - o[w] 0 0 [w] 0 [mA] Low No PD detected |
e B e |
» (el Sl e 5 5 0[w] 0 0 [W] 0 [mA] Low No PD detected |
1
\ < {
D LA M ErmgemmEt 6 - o[w] 0 0 [w] 0 [mA] Low Mo PD detected
» Quality of Service <
7 - 0[wW] 0 0 [W] 0 [mA] Low No PD detected
b Spanning Tree <

o A Nan n A nan ATl [ Kln DM Ardrnatard

Figure 5-2: Power Over Ethernet Status
Parameter descriptions:

Local Port: The logical port number for this row.

PD Class: Each PD is classified according to a class that defines the maximum power the PD will use.
PD Class will show by learning from the link partner no matter which “Reserved Power determined by”
mode is set. If Maximum Power at the port is configured different than the factory default value of 30W,
PD class still stays at the previous learned Class.
The PD Class field shows the PDs classes 0-4 where:

Class 0: Max. power 15.4 W

Class 1: Max. power 4.0 W

Class 2: Max. power 7.0 W

Class 3: Max. power 15.4 W

Class 4: Max. power 30.0 W

Power Allocated: Shows the amount of power the switch has allocated for the PD. Power gets updated
to power negotiation by Class, the value assigned and displayed is forced. When Power override =1, the
value is the same as the value of “Maximum Power (W)”. The Switch provides power to the PD if the
power required by the PD is less than this value.

Power Override: Displays 0 (override disabled) or 1 (override the default power requirement specified by
the IEEE classification). The difference between the power requirement mandated by the IEEE
classification and what is actually needed by the PD is returned into the global power budget for use by
additional PDs. This lets you extend the switch power budget and use it more effectively. So, if you have
devices that use less power than the default that will be assigned based on class, by overriding a lower
value you avoid maxing out the calculated total allocation for the switch. When "Power Allocated"
configuration value is different from the default value, displays 1. Otherwise displays 0.

Power Override Indicates whether the maximum power at the port has ever changed. If Maximum Power
at the port is configured different than the factory default value of 30W, it displays “1”.

Power Used: The Power Used shows how much power the PD currently is using.
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Current Used: The Current Used shows how much current the PD currently is using.
Priority: The Priority shows the port's priority currently configured (e.g., Critical, High, or Low).

Port Status: The Port Status shows the port's status. The status can be one of the following values:

Voltage injection: current was returned; that would affect one device at an adjacent port and
cannot completely power on.

PoE turned ON : PoE power is turned on and available.
PoE not available - No PoE chip found: PoE not supported for the port.
PoE turned OFF - PoE disabled: PoE is disabled by user.

PoE turned OFF - Power budget exceeded: The total requested or used power by the PDs
exceeds the maximum power the Power Supply can deliver, and port(s) with the lowest priority
is/are powered down. A port's PoE can be revoked for one of two reasons: 1) Port power budget
exceeded, or 2) Total power budget exceeded.

No PD detected: No Powered Device detected for the port.

PoE turned OFF - PD overload: The PD has requested or used more power than the port can
deliver and is powered down.

PoE turned OFF: PD is off.

Invalid PD: PD detected but is not working correctly.

PD overloaded: The PD consumed more power than the maximum limit configured for the port,

based on the default, user, or CDP configuration.
Total: A combined total is displayed for each column.
Balance PoE Power Available: Displays the remaining power that can be used (Total power of switch) —
(Sum of power allocated of all ports) in Watts.

14 o [\w] i o 0 [maA] Lo diatachad

Mo PL
detected

Mo PD

detecteo]

Tatal o0 Wy 0w
¢ | — |

C Balance PoE Power Availabls 160 W 3

(-]
=

Buttons
Auto-refresh: Check to refresh the page automatically every 3 seconds.

Refresh: Click to manually refresh the page immediately.
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PD Classes
Five PD Classes are defined by the_IEEE standards:
Class Usage Classification Power Range Class
g Current [mA] [W] Description
0 Default 0-4 0.44-12.94 Classification
unimplemented
Optional 9-12 0.44-3.84 Very Low power
Optional 17-20 3.84-6.49 Low power
3 Optional 26-30 6.49-12.95 Mid power
Valid for 802.3at (Type 2)
4 devices, not allowed for 802.3af 3644 12.95-25.50 High power
devices
33873 Rev. A
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5-3 PoE Power Delay
This page lets you specify the delay time before power is provided to a port after device rebooted.

To configure Power over Ethernet Power Delay in the web interface:
1. Click PoE Management and PoE Power Delay.
2. Enable or Disable Delay Mode.
3.  Specify the Delay Time.
4 Click Apply to apply the change.

Y
LANT?ON | X —— LANTRONIX ol il ol Auto-logout H 9 c»
- w
SM24TBT4SA POE Power Delay @Home - PoE Management - PoE Power Delay
Switch DMS
Port PokE Power Delay
» System <
» Port Management < Port Delay Mode Delay Time(0~300 sec)
» PoE Management - 1 Disabled 0
> PoE Configuration
> PoE Status 2 Disabled 0
> PoE Power Delay
3 Disabled ]
> PoE Auto Power Reset
> PoE Scheduling Profile 4 Disabled v 0
» VLAN Management < g Disabled o
» Quality of Service <
6 Disabled ]
» Spanning Tree <
» MAC Address Table < 7 Disabled  ~ 0
1 <
» Multicast g Disabled R

Figure 5-3: PoE Power Delay
Parameter descriptions:
Port: The port being configured; each port instance is represented by a line in the table.
Delay Mode: At the dropdown, select Enabled. The default is Disabled.

Delay Time(0~300 sec): Enter the amount of delay time (0~300 seconds). The default is 0 seconds.

If Port 1 PoE Power Delay time setting is 30 seconds, it means the switch will wait 30 seconds to provide
power to port 1 after the switch reboots.

Buttons
Apply : Click to save changes.

Reset : Click to undo any changes made locally and revert to previously saved values.
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5-4 PoE Auto Power Reset

This page lets you specify the auto detection parameters to check the link status between PoE ports and
PDs. When the switch detects a failed connection, it can reboot the remote PD automatically and log the
failure action.

To configure Power over Ethernet Auto Power Reset in the web interface:

1. Click PoE Management and PoE Auto Power Reset.

2. Enable the Ping Check function.

4. Specify the PD’s IP address, startup time, interval time, retry time, failure action, reboot time, and
max reboot times.

5. Click Apply to apply the change.

A~ T

LANTQON'X = [ wwmonx il il il Aute-logout H 9 C.p

-
SM24TBT4SA PoE Auto Power Reset Configuration @Home  Fof Mansgement - POE Auto ower Reset
Switch DMS
Ping Check
» System < |
» Port Management <

- PoE Port Configuration
» PoE Management

AR i=tatin Port PinglP Startup Interval Retry Time Failure Failure  Reboot Max.
> PoE Status Address Time Time(sec) Log Action Time(sec) Reboot
> PoE Power Delay Times
> PoE Auto Power Reset error:0,
1 0.0.0.0 60 30 3 ’ Notl w 15 0
> PoE Scheduling Profile total:0 |
» VLAN Management < ) error:0, 7
2 0.0.0.0 60 30 3 Notl w 15 0
. . total:0
» Quality of Service e
’ error:0,
» Spanning Tree < N 0.0.0.0 0 30 3 Notl v~ | 15 0
total:0
» MAC Address Table <
error:0,
» Multicast < 4 0.0.0.0 60 30 3 Motl  w 15 0
total:0

> Consoleflow
error:0,

5 0.0.0.0 0 30 3 notl v || 15 0
» DHCP < total:0
» i <
S error:0,
6 0.0.0.0 0 30 3 ’ notl v || 15 0
» Access Control < total:0
> SNMP < error:0,
7 0.0.0.0 0 30 3 rotal0. Notl v~ || 15 0
. otal:
» Event Notification <
i i ¢ error:0,
» Diagnostics 2 0.0.0.0 50 30 3 ’ Notl ~ || 15 0

Figure 5-4: PoE Auto Power Reset Configuration
Parameter descriptions:

Ping Check: Turn the Ping Check function on to detect the connection between PoE port and powered
devices (PDs). The default is off (Ping Check disabled).

Port: The logical port number for this row.
Ping IP Address: The PD's IP Address the system should ping.
Startup Time: After startup time, device will enable auto checking. Default: 30; range: 30-60 seconds.

Interval Time(sec): Device will send checking message to PD each interval time. The default is 30
seconds; the valid range is 10-120 seconds.

Retry Time: When PoE port can't ping the PD, it will try to send detection again. When ping fails the third
time, it will trigger the configured Failure Action. The default is 3 reties; the valid range is 1-5 retries.

Failure Log: Failure loggings counter.
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Failure Action: The action when the third fail detection.

Nothing: Keep Pinging the remote PD but do nothing further.
Reboot: Cut off the power of the PoE port, make PD reboot.

Reboot time(sec): When PD has been rebooted, the PoE port restores power after the specified time.
The default is 15 seconds, the valid range is 3-120 seconds.

Max. Reboot Times: When the number of reboots exceeds this setting, auto checking will stop on this
port until you change PoE mode without disabling in PoE configuration. The switch will issue an SNMP
Trap and Log to notify this remote PD no response. If Max Reboot Times is 0, auto checking will not stop.
The default is 0 reboots; the valid range is 0-10 reboots.

Buttons
Apply : Click to save changes.
Reset : Click to undo any changes made locally and revert to previously saved values.

PoE Auto Checking “AutoFill” Feature

When you enable Auto Power Reset (PoE Auto Checking) in DMS) the IP addresses of the connected
devices are automatically filled in the Auto Power Reset configuration page.

1. Configure the “PoE Auto Checking” parameter at Switch > POE Management > PoE Auto Power Reset.
The default value of the “Failure Action” parameter is “Nothing”.

2. Configure PoE parameters at DMS > Graphical Monitoring > Topology View. Left click on the switch icon

#

to display its device configuration popup. Click the PoE Config (7°E 272 ) jcon to display the PoE Auto
Checking pane.
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5-5 PoE Scheduling Profile

This page lets you define profiles for PoE scheduling.

LANTRONIX' =[*= i, sssssssssssasgzz] »i= 9 M @ &

I -
SM24TBT4SA PoE Scheduling Profile @Home - Pof Management - PoF Scheduling Profile
Switch DMS |
Profile 1 o |
» System < :
» Port Management E Name profile1 |

» PoE Management

> PoF Configuration Start Time End Time
> PoE Status |
Week Day HH MM HH MM |
> PoE Power Delay
*
> PoE Auto Power Reset = h - s - v - v
> PoE Scheduling Profile Monday 0 . o . 0 . R -
» VLAN Management E
Tuesday 0 - 0 - 0 - 0 -
» Quality of Service «
» Spanning Tree < Wednesday 0 v 0 v 0 v 0 v
<
» MAC Address Table Thursday 0 o o v 0 v 0 v
» Multicast E
Friday 0 v 0 v 0 v 0 v
> Consoleflow |
|
» DHCP < Saturday 0 v 0 v 0 ~ 0 ~
5 4
» Security Sunday o - 0 ~ 0 v 0 he
» Access Control <
< A
» SNMP A—-‘pply
N .

Figure 5-5: PoE Scheduling Profile page
Parameters:
Profile: The index of profile. You can configure up to 16 profiles.

Name: The name of profile. The default name is "profile 1". You can define the name for identifying the
profile.

Week Day: The day to schedule PoE.

Start Time: The hour (HH) and minute (MM) to start PoE. The time 00:00 means the first second of this
day.

End Time: The hour (HH) and minute (MM) to stop PoE. The time 00:00 means the last second of this
day.

Buttons

Apply: Click to save changes.

Messages: End time should not be earlier than start time
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Chapter 6 VLAN Management

6-1 VLAN Configuration

This page lets you assign a specific VLAN for management purpose. The management
VLAN is used to establish an IP connection to the switch from a workstation connected to a
port in the VLAN. This connection supports a VMS, SNMP, and Telnet session. By default,
the active management VLAN is VLAN 1, but you can designate any VLAN as the
management VLAN using the Management VLAN window. Only one management VLAN can
be active at a time.

When you specify a new management VLAN, your HTTP connection to the old management
VLAN is lost. For this reason, you should have a connection between your management
station and a port in the new management VLAN or connect to the new management VLAN
through a multi-VLAN route.

To configure VLAN membership in the web Ul:

1. Click VLAN Management and VLAN Configuration.

2. Configure for existing VLANSs, Ethertype, port types, ingress/egress, and allowed VLANSs.
3. Click the Apply button.

» VLAN Management
> VLAN Configuration
> VLAN Membership
> VLAN Port Status
> VLAN Selective QinQ
» MAC-based VLAN
* Protocol-based VLAN
» |P Subnet-based VLAN
> Private VLAN
» Port |solation

* \oice VLAN

a
LANT?ON'X ® — | Lavroni T T 7 Auto-logout H @ &)
- w
SM24TBT4SA VLAN Configuration @etome - VLAN Management  VLAN Configuration
Switch DMS
Global VLAN Configuration
» System <
» Port Management < Allowed Access VLANs 1
Y <
» PoE Management Ethertype for Custom S-ports a3a8
» VLAN Management e
> VLAN Configuration ) .
Port VLAN Configuration
> VLAN Membership
> VLAN Port Status Ingress Ingress Egress
> VLAN Selective QinQ Port Mode Port VLAN Port Type Filtering Acceptance Tagging Allowed VLANs
» MAC-based VLAN <
1 Acc v 1 C-Port 22 od Taggedand Unt + Untag Port  » 1
» Protocol-based VLAN <
> IP Subnet-based VLAN
2 Acc v 1 C-Port v | Taggedand Unt  + Untag Port + 1
> Private VLAN
> Port Isolation 3 Ac v 1 CPort v TaggedandUnt v Untag Port 1
» Voice VLAN ¢
» Quath of Service < 4 Acc v 1 C-Port ~ | Tagged and Unt  ~ Untag Port 1
» Spanning Tree <
5 Acc v 1 C-Port v | Tagged and Unt v Untag Port » 1
» MAC Address Table <
» i <
Multicast 6 Acc v 1 C-Port 22 o Taggedand Unt + Untag Port  » 1

> Consoleflow

[ BV < 7 Bre 1 ~Dart - - Tammad and lint lintam Dark  w 1

Figure 6-1: VLAN Configuration page
Global VLAN Configuration

Allowed Access VLANSs: This field shows the VLANSs that are created on the switch. By default, only
VLAN 1 exists. More VLANs may be created by using a list syntax where the individual elements are
separated by commas. Ranges are specified with a dash separating the lower and upper bound. The
following example will create VLANs 1, 10, 11, 12, 13, 200, and 300: 1,70-13,200,300. Spaces are

allowed between delimiters.

Ethertype for Custom S-ports: This field specifies the Ethertype/TPID (specified in hexadecimal) used for
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Custom S-ports. The setting is in force for all ports whose Port Type is set to S-Custom-Port.

Port VLAN Configuration

Port: This is the logical port number of this row.

Mode: The port mode (default is Access) determines the fundamental behavior of the port in question.
A port can be in one of three modes as described below. Whenever a particular mode is selected, the
remaining fields in that row will be either grayed out or made changeable depending on the mode in
question. Grayed out fields show the value that the port will get when the mode is applied.

Access: Access ports are normally used to connect to end stations. Dynamic features like Voice VLAN
may add the port to more VLANs behind the scenes. Access ports have these characteristics:

* Member of exactly one VLAN, the Port VLAN (a.k.a. Access VLAN), which by default is 1,

* accepts untagged frames and C-tagged frames,

« discards all frames that are not classified to the Access VLAN,

« on egress all frames are transmitted untagged.

Trunk: Trunk ports can carry traffic on multiple VLANs simultaneously and are normally used to
connect to other switches. Trunk ports have these characteristics:

* By default, a trunk port is member of all existing VLANs. This may be limited by the use of Allowed
VLANS,

« unless VLAN Trunking is enabled on the port, frames classified to a VLAN that the portis not a
member of will be discarded,

* by default, all frames but frames classified to the Port VLAN (a.k.a. Native VLAN) get tagged on
egress. Frames classified to the Port VLAN do not get C-tagged on egress,

* egress tagging can be changed to tag all frames, in which case only tagged frames are accepted on
ingress,

* VLAN trunking may be enabled.
Hybrid: Hybrid ports resemble trunk ports in many ways but adds additional port configuration features.
In addition to the characteristics described for trunk ports, hybrid ports have these abilities:

» Can be configured to be VLAN tag unaware, C-tag aware, S-tag aware, or S-custom-tag aware,

« ingress filtering can be controlled,

* ingress acceptance of frames and configuration of egress tagging can be configured independently.

Port VLAN: Determines the port's VLAN ID (a.k.a. PVID). Allowed VLANSs are in the range 1 through
4095; the default is 1.

On ingress, frames get classified to the Port VLAN if the port is configured as VLAN unaware, the frame is
untagged, or VLAN awareness is enabled on the port, but the frame is priority tagged (VLAN ID = 0).

On egress, frames classified to the Port VLAN do not get tagged if Egress Tagging configuration is set to
untag Port VLAN.

The Port VLAN is called an "Access VLAN" for ports in Access mode and “Native VLAN” for ports in Trunk
or Hybrid mode.

Port Type : Ports in hybrid mode allow for changing the port type, that is, whether a frame's VLAN tag is
used to classify the frame on ingress to a particular VLAN, and if so, which TPID it reacts on. Likewise, on
egress, the Port Type determines the TPID of the tag, if a tag is required.

Unaware: On ingress, all frames, whether carrying a VLAN tag or not, get classified to the Port VLAN,
and possible tags are not removed on egress.

C-Port: On ingress, frames with a VLAN tag with TPID = 0x8100 get classified to the VLAN ID
embedded in the tag. If a frame is untagged or priority tagged, the frame gets classified to the Port
VLAN. If frames must be tagged on egress, they will be tagged with a C-tag.

S-Port: On ingress, frames with a VLAN tag with TPID = 0x8100 or 0x88A8 get classified to the VLAN
ID embedded in the tag. If a frame is untagged or priority tagged, the frame gets classified to the Port
VLAN. If frames must be tagged on egress, they will be tagged with an S-tag.

S-Custom-Port: On ingress, frames with a VLAN tag with a TPID = 0x8100 or equal to the Ethertype
configured for Custom-S ports get classified to the VLAN ID embedded in the tag. If a frame is
untagged or priority tagged, the frame gets classified to the Port VLAN. If frames must be tagged on
egress, they will be tagged with the custom S-tag.
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Ingress Filtering: Hybrid ports allow for changing ingress filtering. Access and Trunk ports always have
ingress filtering enabled.
If ingress filtering is enabled (checkbox is checked), frames classified to a VLAN that the port is not a
member of get discarded.
If ingress filtering is disabled, frames classified to a VLAN that the port is not a member of are
accepted and forwarded to the switch engine. However, the port will never transmit frames classified to
VLANS that it is not a member of.

VLAN Trunking: Trunk and Hybrid ports allow for enabling VLAN trunking. When VLAN trunking is
enabled, frames classified to unknown VLANs are accepted on the port whether ingress filtering is
enabled. This is useful in scenarios where a cloud of intermediary switches must bridge VLANSs that
haven't been created. By configuring the ports that connect the cloud of switches as trunking ports, they
can seamlessly carry those VLANs from one end to the other.

Ingress Acceptance: Hybrid ports allow for changing the type of frames that are accepted on ingress.
Tagged and untagged: both tagged and untagged frames are accepted.
Tagged Only: Only tagged frames are accepted on ingress. Untagged frames are discarded.
Untagged Only: Only untagged frames are accepted on ingress. Tagged frames are discarded.

Egress Tagging: Ports in Trunk and Hybrid mode may control the tagging of frames on egress.

Untag Port VLAN: Frames classified to the Port VLAN are transmitted untagged. Other frames are
transmitted with the relevant tag.

Tag All: All frames, whether classified to the Port VLAN or not, are transmitted with a tag.

Untag All: All frames, whether classified to the Port VLAN or not, are transmitted without a tag. This
option is only available for ports in Hybrid mode.

Allowed VLANSs: Ports in Trunk and Hybrid mode may control which VLANSs they are allowed to become
members of. Access ports can only be member of one VLAN, the Access VLAN. The field's syntax is
identical to the syntax used in the Existing VLANS field. By default, a port may become member of all
possible VLANSs, and is therefore set to 1-4095. The field may be left empty, which means that the port
will not be member of any of the existing VLANS, but if it is configured for VLAN Trunking it will still be
able to carry all unknown VLANSs.

Buttons
Apply: Click to save changes.
Reset: Click to undo any changes made locally and revert to previously saved values.
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6-2 VLAN Membership

This page provides an overview of membership status of VLAN users.

Various internal software modules may use VLAN services to configure VLAN memberships on the fly.
The drop-down list on the right allows for selecting between showing VLAN memberships as configured
by an administrator (Admin) or as configured by one of these internal software modules.

The "Combined" entry will show a combination of the administrator and internal software modules
configuration, and basically reflects what is actually configured in hardware.

The VLAN User module uses the services of the VLAN management function to configure VLAN
memberships and VLAN port configurations such as PVID and UVID.

Web Interface
To configure VLAN membership in the web Ul:
1. Click VLAN Management and VLAN Membership.

2. At the dropdown select which VLANSs to be displayed.
3. Click Refresh to update the state.

LANT?ONIX E e L J L L, Auto-logout o C’

-

SM8TBT2SA VLAN Membership Status @Home - VLAN Management - VLAN Membership
Switch DMS ( )
Auto-refresh Refresh ‘
» System < ) ’
» Port Management < Show 10 «~ Admin v Search:
entries
» PoE Management <
» VLAN Management v Port Members
- VLAN ID
> VLAN Configuration 1 2 3 a 5 6 7 8 9 10
> VLAN Membership
1 u U U ] V) U u v u U

> VLAN Port Status

> VLAN Selective QinQ Previous n Next

» MAC-based VLAN <
4

>

Figure 6-2: VLAN Membership Status
Show entries: At the dropdown you can choose how many items you want to display (10, 25, 60, or All).

VLAN USER: The VLAN User module uses the services of the VLAN management function to configure
VLAN memberships and VLAN port configurations such as PVID and UVID. These VLAN user types are
currently supported: Combined, Admin, 802.1x, MVR, Voice VLAN, MSTP and DMS.

The VLAN Membership Status Page shows the current VLAN port members for all VLANs configured by
a selected VLAN User by using the combo box. When ALL VLAN Users are selected, it shows this
information for all the VLAN Users, and this is by default. VLAN membership allows the frames classified
to the VLAN ID to be forwarded on the respective VLAN member ports.

Combined: A combination of all VLAN User types.
Admin: Shows VLAN memberships configured by an administrator.

802.1x: Provides port-based authentication, which involves communications between a Supplicant,
Authenticator, and an Authentication Server.

MVR: Multicast VLAN Registration (MVR) is used to eliminate the need to duplicate multicast traffic for
subscribers in each VLAN. Multicast traffic for all channels is sent only on a single (multicast) VLAN.
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Voice VLAN: Voice VLAN is a VLAN configured specially for voice traffic typically :

originating from IP phones. Admin M

MSTP: The 802.1s Multiple Spanning Tree protocol (MSTP) uses VLANS to create Combined

multiple spanning trees in a network, which significantly improves network resource

utilization while maintaining a loop-free environment. 202.1x

DMS: Shows Device Management System VLAN membership status. | MVR

Voice VLAN

VLAN ID: VLAN ID for which the Port members are displayed. MSTP

Port Members: A row of icons for each port is displayed for each VLAN ID. If a portis ' DOMS_

included in a VLAN, an image indicating tagged (T) or untagged (U ) will display. Shows egress filtering
frame status whether tagged or untagged. Frames classified to the Port VLAN are transmitted tagged or
untagged.

Show entries: At the dropdown choose how many items you want to view per page (10, 25, 60, or ALL).
Search: Enter text to search for the information that you want to view.

Buttons

Auto-refresh: Check to refresh the page automatically every 3 seconds.
Refresh: Click to manually refresh the page immediately.

Next: Updates the system log entries, turn to the next page.

Previous: Updates the system log entries, turn to the previous page.

Messages:
ERROR: Invalid allowed VLAN list (1.30)
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6-3 VLAN Port Status

The Port Status function gathers the information of all VLAN status and reports it by the order of
Combined, Admin, NAS, GVRP, MVR, Voice VLAN, MSTP, DMS, and VCL.

To display VLAN Port Status in the web Ul:
1. Click VLAN Management and VLAN Port Status.
2. At the dropdown, specify the user type.

3. Click Refresh to display the current Port Status information.

a

LANTQONIX =| o= . - Autologout [OFF_ ~] o e

SM8TBT25A VLAN Port Status #eHome - VLAN Management - VLAN Port Status
Switch DMS —
Auto-refresh ‘ Refresh H Clear | Combined
» System < ) ” )
b Port Management < Port Port Type Ingress Filter Frame Type Port VLAN ID Tx Tag
» PoE Management < 1 C-Port true All 1 None
» VLAN Management h 2 C-Port true All 1 None
> VLAN Configuration
3 C-Port true All 1 None
> VLAN Membership
> VLAN Port Status 4 C-Port true All 1 None
> VLAN Selective QinQ 5 C-Port true All 1 None
MAC-based VLAN
7 MALDas " ¢ 6 C-Port true All 1 None
» Protocol-based VLAN <
7 C-Port true All 1 None

> IP Subnet-based VLAN

___ a PR Ty . anl 1 Mmoo~

Figure 6-3: VLAN Port Status page

VLAN USER: Various internal software modules may use VLAN services to configure ]

VLAN memberships on the fly. The drop-down list on the right allows for selecting Combined v

between showing VLAN memberships as configured by an administrator (Admin) or as

configured by one of these internal software modules. These VLAN User types are . Admin i

currently supported: 1 s021x
Combined: A combination of the administrator and internal software modules MVR
configuration, and basically reflects what is actually configured in hardware. Voice VLAN
Admin: VLAN memberships as configured by an administrator. EETSP

NAS: NAS provides port-based authentication, which involves communications
between a Supplicant, Authenticator, and an Authentication Server.

GVRP: GVRP (GARP VLAN Registration Protocol or Generic VLAN Registration Protocol) facilitates
control of VLANSs within a larger network. GVRP conforms to the IEEE 802.1Q specification, which
defines a method of tagging frames with VLAN configuration data.

MVR: Multicast VLAN Registration (MVR) is used to eliminate the need to duplicate multicast traffic for
subscribers in each VLAN. Multicast traffic for all channels is sent only on a single (multicast) VLAN.
Voice VLAN: Voice VLAN is a VLAN configured specially for voice traffic typically originating from IP
phones.

MSTP: The 802.1s Multiple Spanning Tree protocol (MSTP) uses VLANSs to create multiple spanning
trees in a network, which significantly improves network resource utilization while maintaining a loop-
free environment.

DMS: Lantronix’ DMS (Device Management System) is an intelligent management tool embedded in
the switch to intuitively help reduce support time, cost, and effort.

Port: The logical port for the settings contained in the same row.
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Port Type: Shows the Port Type, which can be Unaware, C-port, S-port, or Custom S-port. If Port Type is
Unaware, all frames are classified to the Port VLAN ID and tags are not removed. C-port is Customer
Port. S-port is Service port. Custom S-port is S-port with Custom TPID.

Ingress Filter: Shows the ingress filtering on a port. This parameter affects VLAN ingress processing.
If ingress filtering is true (enabled) and the ingress port is not a member of the classified VLAN, then the
frame is discarded.

Frame Type: Shows whether the port accepts all frames or only tagged frames or all. This parameter
affects VLAN ingress processing. If the port only accepts tagged frames, then untagged frames received
on that port are discarded.

Port VLAN ID: Shows the Port VLAN ID (PVID) that a given user wants the port to have. The field is
empty if not overridden by the selected user.

Tx Tag: Shows egress filtering frame status whether None, All, or All except-native.

Buttons Auto-refresh { Refresh H Clear ‘

Auto-refresh: Check to refresh the page automatically every 3
seconds.

Refresh: Click to manually refresh the page immediately.

Clear: Click to clear the page.
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6-4 VLAN Selective QinQ

A Q-in-Q VLAN tunnel enables a service provider to segregate the traffic of different customers in their
infrastructure, while still giving the customer a full range of VLANSs for their internal use by adding a
second 802.1Q tag to an already tagged frame.

Navigate to Switch > VLAN Management > VLAN Selective QinQ to create new and edit existing entries.

Y
& LANTRONIX' Auto-l t [OFF ~ .
LANTRONIX" =| 7% wwwwes oS MO G
SM8TBT2SA VLAN Selective QinQ Configuration @Home - VLAN Managzment - VLAN Selective QInQ
Switch DMS
Port Members

» System <

Delete CVID SPID 1 2 3 4 5 6 7 8 9 10
» Port Management <
» PoE Management < ‘ Delete ] [l O ] OJ [l O O O O

» VLAN Management e

Add New Entry |

> VLAN Configuration

> VLAN Membership

Apply || Reset
> VLAN Port Status —

> VLAN Selective QinQ

Parameter descriptions:

Delete: To delete a private VLAN entry, check this box. The entry will be deleted during the next apply.
CVID: 1-4095; the Customer VLAN ID List to which the tagged packets will be added.

SPID: 1-4095; this configures the VLAN to join the Service Provider’s VLAN as a tagged member.

Port Members: Checkmarks indicate which ports are members of the entry. Check or uncheck as needed
to modify the entry.

Buttons
Delete: To delete a QinQ configuration entry, check this box. The entry will be deleted during the next Save.

Add New Entry: Click the button to add a new instance. An empty row is added to the table, and the new
member can be configured as needed. Initially displays “Table is Empty”.

Apply: Click to save changes.

Reset: Click to undo any changes made locally and revert to previously saved values.
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6-5 MAC-based VLAN

This page lets you view and configure MAC-based VLAN Memberships. Navigate to Switch > VLAN
Management > MAC-based VLAN > Configuration to configure new entries and view the status of existing
entries.

MAC address-based VLAN decides the VLAN for forwarding an untagged frame based on the source
MAC address of the frame. A most common way of grouping VLAN members is by port, hence the name
port-based VLAN. Typically, the device adds the same VLAN tag to untagged packets that are received
through the same port. Later, these packets can be forwarded in the same VLAN. Port-based VLAN is
easy to configure and applies to networks where the locations of terminal devices are relatively fixed. As
mobile office and wireless network access gain more popularity, the ports that terminal devices use to
access the networks are very often non-fixed. A device may access a network through Port A this time,
but through Port B the next time. If Port A and Port B belong to different VLANSs, the device will be
assigned to a different VLAN the next time it accesses the network. As a result, it will not be able to use
the resources in the old VLAN. On the other hand, if Port A and Port B belong to the same VLAN, after
terminal devices access the network through Port B, they will have access to the same resources as
those accessing the network through Port A do, which brings security issues. To provide user access and
ensure data security in the meantime, the MAC-based VLAN technology is developed. MAC-based
VLANSs group VLAN members by MAC address. With MAC-based VLAN configured, the device adds a
VLAN tag to an untagged frame according to its source MAC address. MAC-based VLANs are mostly
used in conjunction with security technologies such as 802.1X to provide secure, flexible network access
for terminal devices.

6-5.1 Configuration

a

LANTRONIX' =| ™% wwwwwe °c
SM8TBT2SA MAC-based VLAN Membership COnﬂgUratiOn @Home - VLAN Management - MAC-based VLAN - Configuration
Switch DMS
Delete MAC Address VLAN ID
P System

1

~

‘i Delete

» Port Management

» PoE Management <

‘: Apply || Reset Add New Entry

» VLAN Management v

Parameter descriptions:

Delete: To delete a private VLAN entry, check this box. The entry will be deleted during the next apply.
MAC Address: Enter the MAC address for the entry. Must be a valid unicast MAC address.

VLAN ID: Enter the VLAN ID (VID) for the entry (1-4095).

Buttons
Apply: Click to save changes.
Reset: Click to undo any changes made locally and revert to previously saved values.

Add New Entry: Click the button to add a new MAC-based VLAN member. An empty row is added to the
table, and the new member can be configured as needed. Any unicast MAC address can be configured for
the MAC-based VLAN entry. No broadcast or multicast MAC addresses are allowed. Valid VLAN ID values
are 1-4095.
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6-5.2 Status

Navigate to Switch > VLAN Management > MAC-based VLAN > Status to view existing members’ status.

MAC-based VLAN Membership Status @Home - VLAN Management ~ MAC-based VLAN - Status
Auto-refresh ‘ Refresh |

MAC Address VLAN ID User

00-0A-02-0B-03-0C 1 Static

Parameter descriptions:
MAC Address: Displays the MAC address for the entry.
VLAN ID: Displays the VLAN ID (VID) for the entry.

User: Displays User Type for the entry (Combined, Admin, NAS, GVRP, MVR, Voice, VLAN, MSTP, DMS,
or VCL).

Buttons
Auto-refresh: Check to refresh the page automatically every 3 seconds.

Refresh: Click to manually refresh the page immediately.
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6-6 Protocol-based VLAN

6-6.1 Protocol to Group Mapping Table

This page lets you add new protocols to Group Name (unique for each Group) mapping entries as well as
allow you to see and delete already mapped entries for the switch.

Navigate to Switch > VLAN Management > Protocol-based VLAN > Protocol to Group to display the
Protocol to Group Mapping Table. Here you can add new entries and view or edit existing table entries.

L/\NT?ONIX = T8 - Auto-logout [OFF ] 0 &

SM8TBT2SA Protocol to Group Mapplng Table @Home - VLAN Management - Protocol-based VLAN - Protocol to Group
Switch DMS
Delete Frame Type Value Group Name
» System
» Port Management < ‘ [?:u:—letel Ethernet v Etype: 0x oso0
» PoE Management S v - .
Apply | Reset || Add New Entry |

» VLAN Management ot B -

Parameter descriptions:
Delete: To delete an entry, check this box. The entry will be deleted during the next apply.
Frame Type: At the dropdown, select the Ethernet frame type (Ethernet, SNAP, or LLC).

Value: Displays a value for the frame type. Valid value that can be entered in this text field depends on
the option selected from the preceding Frame Type selection menu. Below are the criteria for the three
different Frame Types:
Ethernet. Values in the text field when Ethernet is selected as a Frame Type is called etype.
Valid etype values are 0x0600-0xffff

SNAP: Valid value in this case also is comprised of two different sub-values.

a. OUI: OUI (Organizationally Unique Identifier) is value in format of xx-xx-xx Frame Type

where each pair (xx) in string is a hexadecimal value 0x00-0xff.

b. PID: If the OUI is hexadecimal 000000, the protocol ID is the Ethernet type Ethernet
(EtherType) field value for the protocol running on top of SNAP; if the OUl is an

OUI for a particular organization, the protocol ID is a value assigned by that
organization to the protocol running on top of SNAP. |'_ Efg\‘p |

LLC: Valid value in this case is comprised of two different sub-values.

a. DSAP: 1-byte long string (0x00-0xff)
b. SSAP: 1-byte long string (0x00-0xff)

Group Name: Displays the assigned group name for each entry.

Buttons
Apply: Click to save changes.
Reset: Click to undo any changes made locally and revert to previously saved values.

Add New Entry: Click the button to add a new entry. An empty row is added to the table, and the new
member can be configured as needed.
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6-6.2 Group Name to VLAN mapping Table
This page lets you map an already configured Group Name to a VLAN for the switch.

Navigate to Switch > VLAN Management > Protocol-based VLAN > Group to VLAN to display the Group
Name to VLAN mapping Table. Here you can add new entries and view or edit existing table entries.

a
LANTRONIX' =| % o
= L L L J
SM8TBT2SA GI’OUp Name to VLAN mapping Table gHome - VLAN Management - Protocol-based VLAN - Group to VLAN
Switch DMS
Port Members
» System <
Group VLAN
» Port Management
Delete Name ID 1 2 3 4 5 6 7 8 9 10
» PoE Management < ) i
» VLAN Management v ‘ el | D D D D D D D D D D
> VLAN Configuration
> VLAN Membership ‘ Apply || Reset || Add New Entry |

Parameter descriptions:

Delete: To delete a private VLAN entry, check this box. The entry will be deleted during the next apply.
Group Name: A valid Group Name is a string of a maximum of 16 characters.

VLAN ID: Indicates the ID to which Group Name will be mapped. A valid VLAN ID can be 1-4095.

Port Members: A row of check boxes for each port is displayed for each Group Name to VLAN ID
mapping. To include a port in a mapping, check the box. To remove or exclude the port from the mapping,
make sure the box is unchecked. By default, no ports are members, and all boxes are unchecked.

Buttons
Apply: Click to save changes.
Reset: Click to undo any changes made locally and revert to previously saved values.

Add New Entry: Click to add a new entry in the mapping table. An empty row is added to the table; the
Group Name, VLAN ID and port members can be configured as needed. Valid values for a VLAN ID are
1-4095. The Reset button can be used to undo the addition of a new entry.
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6-7 IP Subnet-based VLAN

Navigate to Switch > VLAN Management > Protocol-based VLAN > |IP Subnet-based VLAN to display the
IP Subnet-based VLAN Membership Configuration table. Here you can add new entries and view or edit
existing table entries.

® e [ ARONK Auto-logout |OFF  ~ »
LANTRONIX = vevvee o~ M @ G
SM8TBT2SA IP Subnet-based VLAN Membership Configuration @Home - VLAN Management - IP Subnet-based VLAN
Switch DMS
Delete IP Address Mask Length VLAN ID
» System ; ‘
» Port Management < | DS ‘ “ !

» PoE Management

‘ Apply || Reset || Add New Entry

» VLAN Management

Parameter descriptions:

Delete: To delete an entry, check this box. The entry will be deleted during the next apply.
IP Address: Enter an IP address for each entry.

Mask Length: Enter the mask length for each entry.

VLAN ID: Enter the VID for this new entry (1-4095).

Buttons
Apply: Click to save changes.
Reset: Click to undo any changes made locally and revert to previously saved values.

Add New Entry: Click the button to add a new entry. An empty row is added to the table, and the new
member can be configured as needed.
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6-8 Private VLAN

Private VLAN membership configurations for the switch can be monitored and modified here.
Private VLANs can be added or deleted here, and Port members of each Private VLAN can be added or
removed here.

Private VLANSs are based on the source port mask, and there are no connections to VLANs. This means
that VLAN IDs and Private VLAN IDs can be identical. A port must be a member of both a VLAN and a
Private VLAN to be able to forward packets. By default, all ports are VLAN unaware and members of
VLAN 1 and Private VLAN 1. A VLAN unaware port can only be a member of one VLAN, but it can be a
member of multiple Private VLANSs.

To configure Private VLAN membership via the web Ul:

1. Click VLAN Management and Private VLAN.

2. Configure the Private VLAN port members for the switch.
3. Click the Apply button.

a

LANT?ONIX = T = L L) Auto-logout o C‘

SM8TBT2SA Private VLAN Membership Configuration bHome - VLAN Management - Private VLAN
Switch DMS
Port Members
» System <
Delete PVLAN ID 1 2 3 4 5 6 7 8 9 10
» Port Management <
» PoE Management < J 1 O O OJ O O O
» VLAN Management e [
T Delete o o o o o o o o o o
> VLAN Configuration E—
> VLAN Membership ——————)
| Add New Entry |
> VLAN Port Status —_—
> VLAN Selective QinQ | Apply || Reset

» MAC based VLAN ”
Figure 6-4: Private VLAN Membership Configuration

Parameter descriptions:

Delete: To delete a private VLAN entry, check this box. The entry will be deleted during the next apply.

PVLAN ID: Indicates the ID of this particular private VLAN.

Port Members: A row of check boxes for each port is displayed for each private VLAN ID. To include a
port in a Private VLAN, check the box. To remove or exclude the port from the Private VLAN, make sure
the box is unchecked. By default, no ports are members, and all boxes are unchecked.

Adding New Private VLAN: Click the Add New Entry button to add a new private VLAN ID. An empty
row is added to the table, and the private VLAN can be configured as needed.

The Private VLAN is enabled when you click "Apply". The Reset button can be used to undo the addition
of new Private VLANS.

Buttons

Apply: Click to save changes.

Reset: Click to undo any changes made locally and revert to previously saved values.
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6-9 Port Isolation

Port Isolation provides for an apparatus and method to isolate ports on layer 2 switches on the same
VLAN to restrict traffic flow. The apparatus comprises a switch having said plurality of ports, each port
configured as a protected port or a non-protected port. An address table memory stores an address table
having a destination address / port number pair.

A forwarding map generator generates a forwarding map which is responsive to a destination address of
a data packet. The method for isolating ports on a layer 2 switch comprises configuring each of the ports
on the layer 2 switch as a protected port or a non-protected port. A destination address on a data packet
is matched with a physical address on said layer 2 switch and a forwarding map is generated for the data
packet based upon the destination address on the data packet. The data packet is then sent to the
plurality of ports pursuant to the forwarding map generated based on whether the ingress port was
configured as a protected or non-protected port.

This page is used for enabling or disabling port isolation on ports in a Private VLAN. A port member of a
VLAN can be isolated to other isolated ports on the same VLAN and Private VLAN.

To configure Port Isolation configuration in the web UI:

1.  Click VLAN Management and Port Isolation.
2. Select which port(s) on which you want to enable Port Isolation.
3.  Click the Apply button.

- 5 Y
LANTRONIX™ =| *s M 0 G|
— v L L
SM8TBT2SA Port Isolation Configuration @Home - VLAN Management - PortIsclation
Switch DMS
Port Number
» System <
1 2 3 4 5 6 7 8 9 10
» Port Management <
» PoE Management < O O O O O O O O OJ O
» VLAN Management R Y S —
e . |i'«p|3'l_\.-" Reset
> VLAN Configuration L )\

Figure 6-5: Port Isolation Configuration page

Parameter descriptions:

Port Number: A check box is provided for each port of a private VLAN. When checked, port isolation is
enabled on that port. When unchecked, port isolation is disabled on that port. By default, port isolation is
disabled (unchecked) on all ports.

Buttons
Apply: Click to save changes.

Reset: Click to undo any changes made locally and revert to previously saved values.
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6-10 Voice VLAN

The Voice VLAN feature enables voice traffic forwarding on the Voice VLAN; the switch can then classify
and schedule network traffic. It is recommended that there be two VLANs on a port - one for voice and
one for data. Before connecting the IP device to the switch, the IP phone should configure the voice
VLAN ID correctly. It should be configured through its own GUI.

6-10.1 Voice VLAN Configuration Table

To configure Voice VLAN feature parameters in the web Ul:

1. Click VLAN Management, Voice VLAN, and Configuration.
2. Click the Add New Entry button.
3. Select which port(s) on which you want to configure Voice VLAN.
4. Enter VLAN ID and Aging Time and select Traffic.
5.  For each Port select Mode, Security, and Discovery Protocol.
6.  Click the Apply button.
LANTRONIX® =| "% wwwews o c|
SME8TBT2SA Voice VLAN Configuration @Home - VLAN Management - VoiceVLAN - Configuration
Switch DMS
» Syeten P Port Members
> Refi G < Delete VLAN ID Aging Time Traffic 1 2 3 4 5 6 7 8 9 10
» PoE Management < ‘E 1000 25400 oow) v 0 O O O O O O O O O

» VLAN Management v

Add New Entry ‘

> VLAN Configuration

> VLAN Membership ) )
Port Configuration
> VLAN Port Status

> VLAN Selective QinQ Port Mode Security Discovery Protocol
» MAC-based VLAN <
1 Forced « Disabled ~ our v
» Protocol-based VLAN <
> IP Subnet-based VLAN 2 Forced v Disabled Ul v
> Private VLAN
. 3 Forced v Disabled + oul v
> Portsolation
2 VgL voo4 Forced v Disabled oul o~
> Configuration
s OUl 5 Forced ~ Disabled ~ oul o~
» Quality of Service < 6 Forced v Disabled v oul v
» Spanning Tree <
7 Forced + Disabled v our v

Figure 6-5: Voice VLAN Configuration page
Parameter descriptions:
Voice VLAN Configuration

VLAN ID: Indicates the Voice VLAN ID. It should be a unique VLAN ID in the system and cannot equal
each port PVID. It is a conflict in configuration if the value equals management VID, MVR VID, PVID etc.
The allowed range is 1-4095.

Aging Time: Indicates the Voice VLAN secure learning aging time. The allowed range is 10 to 10000000
seconds. It is used when security mode or auto detect mode is enabled. In other cases, it will be based
on hardware aging time. The actual aging time will be situated between the [age time; 2 * age_time]
interval.

Traffic: Indicates the Voice VLAN traffic class. All traffic on the Voice VLAN will apply this class. The
range is O (Low priority) to 7 (High priority). The default is O(Low) priority.

Port Members: Indicates the Voice VLAN port mode operation. You must disable the MSTP feature
before you enable Voice VLAN. It can avoid the conflict of ingress filtering. Select which port that you
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want to enable the Voice VLAN mode operation.

Port Configuration
Port: The switch port number of the Voice VLAN port.

Mode: Indicates the Voice VLAN port mode. When the port mode isn't equal disabled, we must disable
MSTP feature before we enable Voice VLAN. It can avoid the conflict of ingress filtering. Possible port
modes are:
Auto: Enable auto detect mode. It detects whether there is VoIP phone attached to the specific port
and configures the Voice VLAN members automatically.

Forced: Force join to Voice VLAN.

Security: Indicates the Voice VLAN port security mode. When the function is enabled, all non-telephonic
MAC addresses in the Voice VLAN will be blocked for 10 seconds. Possible security modes are:

Enabled: Enable Voice VLAN security mode operation.
Disabled: Disable Voice VLAN security mode operation.

Discovery Protocol: Indicates the Voice VLAN port discovery protocol. It will only work when auto detect
mode is enabled. We should enable LLDP feature before configuring discovery protocol to "LLDP" or
"Both". Changing the discovery protocol to "OUI" or "LLDP" will restart the auto detect process. Possible
discovery protocols are:

OUI: Detect telephony device by OUI address.
LLDP: Detect telephony device by LLDP.
Both: Both OUI and LLDP.

Buttons

Save: Click to save changes.

Reset: Click to undo any changes made locally and revert to previously saved values.
Delete: Click to do delete an existing Voice VLAN entry.

Add New Entry: Click to add a new entry in Voice VLAN configuration table.

Apply: Click to save changes.

Messages: The VLAN ID conflict with PVID
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6-6.1 Voice VLAN OUI Configuration Table

This page lets you configure the Voice VLAN OUI table. The maximum entry number is 16. Modifying the
OUI table will restart auto detection of the OUI process. An Organizationally Unique Identifier (OUI) is a
24-bit number that uniquely identifies a vendor, manufacturer, or other organization. The IEEE Public OUI
list is at http://standards-oui.ieee.org/oui/oui.txt.

To configure Voice VLAN OUI in the web Ul:

1. Click VLAN Management, Voice VLAN, and OUI.

2. Click the Add New Entry button.

4. Enter a Telephony OUI and Description for each instance.
5. Click the Apply button.

LANTRONIX™ =| s swwwwe oot 0F ] M @ G

SMSTBT2SA VOiCe VLAN OUl Table @@Home - VLAN Management - Voice VLAN ~ OUI

Switch DMS
Delete Telephony OUI Description
» System <

‘ Delete

» Port Management <

» PoE Management <

Add New Entry ‘

<

» VLAN Management

> VLAN Configuration

Reset

Apply

T2 P PR

Figure 6-6: Voice VLAN OUI Table

Parameter descriptions:

Telephony OUI: A telephony OUI address is a globally unique identifier assigned to a vendor by IEEE.
The OUI format is 'xx-xx-xx' (X is a hexadecimal digit). OUI examples include: 00-01-E3 (Siemens AG
phones), 00-03-6B (Cisco phones), 00-0F-E2 (H3C phones), 00-60-B9 (Philips and NEC AG phones), 00-
DO-1E (Pingtel phones), 00-E0-75 (Polycom phones), and 00-E0-BB (3Com phones).

Description: The description of OUI address. Normally, it describes which vendor telephony device it
belongs to. The allowed string length is 0 to 32 characters.

Delete: Click to delete an existing Voice VLAN OUI entry.

Add New Entry: Click to add a new entry in Voice VLAN OUI table. An empty row is added to the table to
configure the Telephony OUI and Description.

Buttons
Save: Click to save changes.

Reset: Click to undo any changes made locally and revert to previously saved values.
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» Quality of Service

> Global Settings

Chapter 7 Quality of Service

> Port Settings

7-1 Global Settings

Use the QoS Global Settings page to set the trust behavior for QoS basic mode.
This configuration is active when the switch is in QoS basic mode. Packets entering
a QoS domain are classified at the edge of the QoS domain.

> Port Policing
> Port Shaper
> Storm Control
> Port Scheduler
To configure QoS Global Settings in the web Ul: DT

» CoS5/802.1p Remarking

1. Click Quality of Service and Global Settings.

2. Select the trust mode when the switch is in QoS basic mode. If a packet CoS
level and DSCP tag are mapped to separate queues, the trust mode determines
the queue to which the packet is assigned.

3. Click Apply to save the configuration.
4. To cancel the setting, click the Reset button to revert to previously saved values.

> |P Precedence Mapping
> |P Precedence Remarking
> DSCP Mapping

> DSCP Remarking

LARNTRONES

LANTRONIX" = oo 0T M @ O

SM8TBT2SA QOS Global Settings @bHome - Quality of Service - Global Settings
Switch DMS
Trust Mode (@) Cos/302.1p
» System () pscp
» Port Management < (O 1P precedence
() CoS/302.1p-DSCP
» PoE Management <
» VLAN Management ' Apply 1l Reset |

» Quality of Service e
> Global Settings

Figure 7-1: QoS Global Settings page
Trust Mode:

Co0S/802.1p: Traffic is mapped to queues based on the VPT field in the VLAN tag or based on the per-
port default CoS/802.1p value (if there is no VLAN tag on the incoming packet), the actual mapping of the
VPT to queue can be configured on the CoS/802.1p to Queue page. This is the default setting.

DSCP: All IP traffic is mapped to queues based on the DSCP field in the IP header. The actual mapping
of the DSCP to queue can be configured on the DSCP to Queue page. If traffic is not IP traffic, it is
mapped to the best effort queue.

IP Precedence: Traffic is mapped to queues based on the IP precedence. The actual mapping of the IP
precedence to queue can be configured on the IP Precedence to Queue page.

Co0S/802.1p-DSCP: Uses the trust CoS mode for non-IP traffic and trust DSCP mode for IP traffic.

Buttons
Apply: Click to save changes.

Reset: Click to undo any changes made locally and revert to previously saved values.

W
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7-2 Port Settings
This page lets you set QoS port parameters. To configure QoS Port Settings in the web UI:

1. Click Quality of Service and Port Settings.
2. Select Mode, Default CoS, and Source CoS, for each port.

3. Check which port(s) on which you want to enable the Remark Cos, Remark DSCP, and Remark IP
Precedence.

4. Click Apply to save the configuration.
5. To cancel the settings, click the Reset button to revert to previously saved values.

LANT?ONIX = LANTRONES - - Auto-logout o G

SM8TBT2SA QOS Port Settir‘lgs gHome -~ Quality of Service -~ Port Settings
Switch DMS
Default Source Remark Remark Remark IP
b System ¢ Port Mode CoS CoS CoS DSCP Precedence
» Port Management <
1 Untrust 0 v cTAe v [ [l H
» PoE Management <
» VLAN Management < 2 Untrust v e v [ 0 0
» Quality of Service h 3 Untrust  w 0 v cme ~ [ (] 0
> Global Settings
> Port Settings - Untrust v 0o v ctac v [ ] ]
> Port Polici
SIS 5 Untrust v 0 v cte v (] ] ]
> Port Shaper
> Storm Control 6 Untrust v U cTas v [ O] OJ
> Port Scheduler
7 Untrust ~ 0 v C-TAG ~ D [:] D
> CoS/802.1p Mapping
> CoS/802.1p Remarking 8 Untrust v 0~ cac v [ ] ]

Figure 7-2: QoS Port Settings page
Parameter descriptions:
Port: The logical port for the settings contained in the same row.

Mode: Select Trust or Untrust, where:

Untrust: All ingress traffic on the port is mapped to the best effort queue and no
classification/prioritization takes place (default).

Trust: Port prioritize ingress traffic is based on the system wide configured trusted mode, which is
either CoS/802.1p trusted mode, IP Precedence trusted mode, or DSCP trusted mode.

Default CoS: Select the default CoS value to be assigned to incoming untagged packets (0 - 7).
Source CoS: The CoS value is determined based on C-Tag or S-Tag for incoming tagged packets
Remark CoS: Click the checkbox to remark the CoS/802.1p priority for egress traffic on this port.
Remark DSCP: Click the checkbox to remark the DSCP value for egress traffic on this port.

Remark IP Precedence: Click the checkbox to remark the IP precedence for egress traffic on this port.

Note: The CoS/802.1p priority and IP Precedence, or the CoS/802.1p priority and DSCP value can be
remarked simultaneously for egress traffic on a port, but the DSCP value and IP Precedence cannot be
remarked simultaneously.
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Buttons
Apply : Click to save changes.
Reset : Click to undo any changes made locally and revert to previously saved values.

33873 Rev. A https://www.lantronix.com/ Page 89 of 273



https://www.lantronix.com/

Lantronix SMXTBTxSA Web User Guide

7-3 Port Policing

This page provides an overview of QoS Ingress Port Policers for all switch ports. Port Policing is useful in
constraining traffic flows and marking frames above specific rates. Policing is primarily useful for data
flows and voice or video flows because voice and video usually maintain a steady rate of traffic.

To configure QoS Port Policers in the web UI:

1. Click Quality of Service and Port Policing.

2. Click which port need to enable the QoS Ingress Port Policers, and configure the Rate limit condition.
3. Click Apply to save the configuration.

4. To cancel the setting, click the Reset button to revert to previously saved values.

LANT?ONIX = LANTRONBC Auto-logout H o C’

w , L
SM8TBT2SA QoS Ingress Port Policers @eHome - Quality of Service - Port Policing
Switch DMS
Port Enable Rate (kbps)
» System <
» Port Management < 1 d 1000000
» PoE Management < 2 O 1000000
» VLAN Management <
3 O 1000000
» Quality of Service e
> Global Settings 4 (] 1000000
> Port Settings
5 1000000
> Port Policing .
> Port Shaper 6 O 1000000
> Storm Control
1000000
> Port Scheduler T D
> CoS/802.1p Mapping o e T B PV

Figure 7-3: QoS Ingress Port Policers page
Parameter descriptions:

Port: The logical port for the settings contained in the same row. Click on the port number to configure its
schedulers.

Enable: Check to enable for each Port you on which you want to enable the QoS Ingress Port Policers
function.

Rate (kbps): Set the Rate limit value for this port. Enter a value of 16-1000000; the default is 1000000
kbps.

Buttons

Apply : Click to save changes.

Reset : Click to undo any changes made locally and revert to previously saved values.
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7-4 Port Shaper

This page provides an overview of QoS Egress Port Shapers for all switch ports. To configure QoS Port
Shapers in the web Ul:

1. Click Quality of Service and Port Shaper.

2. Select the port to configure QoS Egress Port Shaper.
3. Click the port to enable, and configure the Rate limit condition.
4. Click Apply to save the configuration.
5. To cancel the setting, click the Reset button to revert to previously saved values.
'y
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> Storm Control 3 O 1000000
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> C0S/802.1p Mapping _
> C0S/802.1p Remarking 5 O 1000000
> IP Precedence Mapping
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> IP Precedence Remarking _
> DSCP Mapping 7 \:\ 1000000
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» MAC Add Tabl <
’ aaress fable Enable Rate (kbps)
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> Consoleflow —
» DHCP NS e Ee—
| Apply || Reset |
Lo —_— v

Figure 7-4: QoS Egress Port Shaper page
Parameter descriptions:

Port : The logical port for the settings contained in the same row. Click on the port number to configure
the shapers.

Queue Shaper
Queue : The queue number of the queue shaper on this switch port.
Enable : Controls whether the queue shaper is enabled for this queue on this switch port.

Rate(kbps) : Controls the rate for the queue shaper. The default value is 1000000.
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Port Shaper
Enable : Controls whether the port shaper is enabled for this switch port.

Rate (kbps) : Controls the rate for the port shaper. Valid values are 0 — 1000000 Kbps. The default value
is 1000000 Kbps.

Buttons
Apply : Click to save changes.
Reset : Click to undo any changes made locally and revert to previously saved values.
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7-5 Storm Control

This page lets you configure Storm control for the switch. There is a destination lookup failure (DLF)
storm rate control, multicast storm rate control, and a broadcast storm rate control. These only affect
flooded frames, i.e. frames with a (VLAN ID / DMAC) pair not present on the MAC Address table. You can
set the permitted packet rate for Broadcast, Unknown Multicast, and Unknown Unicast traffic across the
switch for each port. To configure Storm Control parameters in the web Ul:

1. Click Quality of Service and Storm Control.

2. Click the port(s) to be enabled, and configure the Rate limit condition.

4. Click the Apply button to save the settings.

5. To cancel the settings, click the Reset button to revert to previously saved values.
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> DSCP Mapping
. ] 500 ] 500 ] 500
> DSCP Remarking 10 U L] 3 [}
» Spanning Tree < -
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Figure 7-5: Storm Configuration page
Parameter descriptions:

Port : The logical port for the settings contained in the same row. Click on the port number to configure
storm control.

Frame Type : The settings in a particular row apply to the frame type listed here: Broadcast, Unknown
Multicast or Unknown Unicast.

Enable : Enable or disable the storm control status for the given frame type.
Rate : The rate unit in packets per second (pps). Valid values are 0 — 262143 pps. The 1 kpps is actually
1002.1 pps.

Buttons
Apply: Click to save changes.
Reset: Click to undo any changes made locally and revert to previously saved values.

Message: Please enter a value between 0 and 262143.
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7-6 Port Scheduler

This page lets you set QoS Egress Port Scheduler for all switch ports. To configure QoS Port Schedulers
in the web UlI:

1. Click Quality of Service > Port Scheduler.

2. Select a Scheduler Mode for each port.
3. If you select WRR (Weighted Round Robin) or WFQ (Weighted Fair Queueing), configure Weight.
4. Click the Apply button to save the settings.
5. To cancel the setting, click the Reset button to revert to previously saved values.

LANTRONIX® =| s vovsweer » = hufign oc
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Figure 7-6: QoS Egress Port Scheduler
Port: The logical port for the settings contained in the same row.
Scheduler Mode: Controls whether the scheduler mode is "Strict Priority", "WRR" or "WFQ" on this port.
WFQ allows specifying, for each flow, what fraction of the capacity will be given.
WRR serves a number of packets for each nonempty queue.

In a Strict Priority queue, an element with high priority is served before an element
with low priority. If two elements have the same priority, they are served according to
their order in the queue. This is the default setting.

Scheduler Mode

Strict Priority

Weight: Controls the weight for this queue. The default value is "0". This value is restricted WFQ
to 0-127. This parameter only displays if "Scheduler Mode" is set to "Weighted" (WRR or WFQ).

Buttons
Apply : Click to save changes.
Reset : Click to undo any changes made locally and revert to previously saved values.
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7-7 CoS/802.1p Mapping

Use the CoS/802.1p to Queue page to map 802.1p priorities to egress queues. The CoS/802.1p to
Queue table determines the egress queues of the incoming packets based on the 802.1p priority in their
VLAN tags. For incoming untagged packets, the 802.1p priority will be the default CoS/802.1p priority
assigned to the ingress ports.

To configure Cos/802.1p Mapping in the web Ul:

1. Click Quality of Service > Cos/802.1p Mapping.

2. Select a Queue ID.

3. Click the Apply button to save the settings.
4. To cancel the setting, click the Reset button to revert to previously saved values.
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> Port Scheduler

> CoS/802.1p Mapping

> CoS/802.1p Remarking

> P Precedence Mapping
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QoS Ingress CoS/802.1p to Queue Mapping
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Queue ID
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Auto-logout 9 c*

@Home - Quality of Service - Co5/802.1p Mapping

Figure 7-7: QoS Ingress CoS/802.1p to Queue Mapping

Parameter descriptions:

Co0S/802.1p: Displays the 802.1p priority tag values to be assigned to an egress queue, where 0 is the

lowest and 7 is the highest priority.

Queue ID: Select the egress queue to which the 802.1p priority is mapped. Eight egress queues are
supported, where Queue 8 is the highest priority egress queue and Queue 1 is the lowest priority egress

queue.

Buttons

Apply : Click to save changes.

Reset : Click to undo any changes made locally and revert to previously saved values.
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7-8 CoS/802.1p Remarking

Use the Queues to CoS/802.1p page to remark the CoS/802.1p priority for egress traffic from each
queue.

To configure Cos/802.1p Remarking in the web Ul:

1. Click Quality of Service > Cos/802.1p Remarking.

2. Select CoS/802.1p.

3. Click the Apply button to save the settings.

4. To cancel the setting, click the Reset button to revert to previously saved values.
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Figure 7-8: QoS Egress Queue to CoS/802.1p Remarking
Parameter descriptions:

Queue ID: Displays the Queue ID, where Queue 8 is the highest priority egress queue and Queue 1 is
the lowest priority egress queue.

Co0S/802.1p: For each output queue, select the CoS/802.1p priority to which egress traffic from the queue
is remarked.

Buttons

Apply: Click to save changes.

Reset: Click to undo any changes made locally and revert to previously saved values.
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7-9 IP Precedence Mapping

This page lets you map an IP precedence to an egress queue. To configure IP Precedence Mapping in
the web UlI:

1. Click Quality of Service > IP Precedence Mapping.
2. Select Queue ID.

3. Click the Apply button to save the settings.

4

To cancel the setting, click the Reset button to revert to previously saved values.
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Figure 7-9: QoS Ingress IP Precedence to Queue Mapping

Parameter descriptions:

IP Precedence: Displays the IP Precedence priority tag values to be assigned to an egress queue, where
0 is the lowest priority and 7 is the highest priority.

Queue ID: Select the egress queue to which the IP precedence priority is mapped. Eight egress queues
are supported, where Queue 8 is the highest priority egress queue and Queue 1 is the lowest priority
egress queue.

Buttons
Apply: Click to save changes.

Reset: Click to undo any changes made locally and revert to previously saved values.

33873 Rev. A https://www.lantronix.com/ Page 97 of 273



https://www.lantronix.com/

Lantronix SMXTBTxSA Web User Guide

7-10 IP Precedence Remarking

This page lets you map egress queue to IP precedence. To configure IP Precedence Remarking in the
web Ul:

1. Click Quality of Service and IP Precedence Remarking.
2. Select IP Precedence.

3. Click the Apply button to save the settings.

4

To cancel the setting, click the Reset button to revert to previously saved values.
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IP Precedence Remarking
Figure 7-10: QoS Egress Queue to IP Precedence Remarking
Parameter descriptions:

Queue ID: Displays the Queue ID, where Queue 8 is the highest priority egress queue and Queue 1 is
the lowest priority egress queue.

IP Precedence: For each output queue, select the IP Precedence priority to which egress traffic from the
queue is remarked.

Buttons
Apply: Click to save changes.

Reset: Click to undo any changes made locally and revert to previously saved values.
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7-11 DSCP Mapping

Use the DSCP to Queue page to map IP DSCP to egress queues. The DSCP to Queue table determines
the egress queues of the incoming IP packets based on their DSCP values. The original VLAN Priority
Tag (VPT) of the packet is unchanged. It is possible to achieve the desired QoS in a network by simply
changing the DSCP to Queue mapping, the queue schedule method, and bandwidth allocation.

To configure DSCP Mapping in the web Ul:

1. Click Quality of Service and DSCP Mapping.

2. Select Queue ID.

3. Click the Apply button to save the settings.

4. To cancel the setting, click the Reset button to revert to previously saved values.
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Figure 7-11: QoS Ingress DSCP to Queue Mapping
Parameter descriptions:
DSCP: Displays the DSCP value in the incoming packet and its associated class.

Queue ID: Select the traffic forwarding queue from the Output Queue drop-down menu to which the
DSCP value is mapped.

Buttons

Apply: Click to save changes.

Reset: Click to undo any changes made locally and revert to previously saved values.

33873 Rev. A https://www.lantronix.com/ Page 99 of 273



https://www.lantronix.com/

Lantronix SMXTBTxSA Web User Guide

7-12 DSCP Remarking

Use the Queues to DSCP page to remark DSCP value for egress traffic from each queue. To configure
DSCP Remarking in the web Ul:

1. Click Quality of Service and DSCP Remarking.

2. Select DSCP.

3. Click the Apply button to save the settings.

4. To cancel the setting, click the Reset button to revert to previously saved values.

ry
T o || RO | = Auto-logout |OFF :
LANTRONIX" E| Ve sewewwwe » = e~ M Q@ &
SM8TBT2SA QoS Egress Queue to DSCP Remarking @ome - Quelity of service - OSCP Remarking
Switch DMS
Queue ID DSCP
» System <
(BE) ~
» Port Management < 0 ¢
» PoE Management ¢ 1 2(Cs1) ~
» VLAN Management <
2 6(CS2) w
» Quality of Service e
> Global Settings 3 24(C33) w

v

Port Settings

4 32(C54)  w
> Port Policing
> Port Shaper 5 40(C85) v
> Storm Control

42 (CS6)
> Port Scheduler 8 : -
> Co5/802.1p Mapping 7 56 (CST v
> CoS/802.1p Remarking
> |P Precedence Mapping | Apply || Reset ‘

Figure 7-12: QoS Egress Queue to DSCP Remarking
Parameter descriptions:

Queue ID: Displays the Queue ID, where Queue 8 is the highest priority egress queue and Queue 1 is
the lowest priority egress queue.

DSCP: For each output queue, select the DSCP priority to which egress traffic from the queue is
remarked. For example, Expedited Forwarding (EF) for low-loss, low-latency traffic or Assured Forwarding
(AF) which assures delivery under prescribed conditions.

Buttons
Apply: Click to save changes.

Reset: Click to undo any changes made locally and revert to previously saved values.
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Chapter 8 Spanning Tree

The Spanning Tree Protocol (STP) can be used to detect and disable network loops, and to provide
backup links between switches, bridges or routers. This allows the switch to interact with other bridging
devices (that is, an STP-compliant switch, bridge or router) in your network to ensure that only one route
exists between any two stations on the network and provide backup links which automatically take over
when a primary link goes down.

STP uses a distributed algorithm to select a bridging device (STP- compliant switch, bridge or router) that
serves as the root of the spanning tree network. It selects a root port on each bridging device (except for
the root device) which incurs the lowest path cost when forwarding a packet from that device to the root
device. Then it selects a designated bridging device from each LAN which incurs the lowest path cost
when forwarding a packet from that LAN to the root device. All ports connected to designated bridging
devices are assigned as designated ports. After determining the lowest cost spanning tree, it enables all
root ports and designated ports, and disables all other ports. Network packets are therefore only
forwarded between root ports and designated ports, eliminating any possible network loops.

Designated . O
Roat. I

Designated Root .

5 , P, x \ i %\P I# greiz;gg?ted_. FOrt, Pnrt..

Figure 8: Spanning Tree Protocol

Once a stable network topology has been established, all bridges listen for Hello BPDUs (Bridge Protocol
Data Units) transmitted from the Root Bridge. If a bridge does not get a Hello BPDU after a predefined
interval (Maximum Age), the bridge assumes that the link to the Root Bridge is down. This bridge will then
initiate negotiations with other bridges to reconfigure the network to reestablish a valid network topology.

STP network protocol builds a loop-free logical topology for Ethernet networks. The basic function of STP
is to prevent bridge loops and the broadcast radiation that results from them. Spanning tree also allows a
network design to include backup links providing fault tolerance if an active link fails.

STP was originally standardized as IEEE 802.1D but the functionality of spanning tree (802.1D), Rapid
Spanning tree (802.1w), and Multiple Spanning tree (802.1s) has since been incorporated into IEEE
802.1Q-2014.

RSTP (Rapid Spanning Tree Protocol) was introduced as 802.1w in 2001 by the IEEE. RSTP provides
significantly faster recovery in response to network changes or failures, introducing new convergence
behaviors and bridge port roles to do this. RSTP was designed to be backwards-compatible with standard
STP.

MSTP (Multiple Spanning Tree Protocol) was originally defined in IEEE 802.1s-2002 and later merged
into IEEE 802.1Q-2005. MSTP defines an extension to RSTP to further develop the usefulness of virtual
LANs (VLANSs). In the standard a spanning tree that maps one or more VLANS is called “multiple
spanning tree” (MST). If MSTP is implemented a spanning tree can be defined for individual VLANSs or for
groups of VLANs. The administrator can also define alternate paths within a spanning tree. VLANs must
be assigned to a so-called multiple spanning tree instance (MSTI). Switches are first assigned to an MST
region, then VLANs are mapped against or assigned to this MST. A Common Spanning Tree (CST) is an
MST to which several VLANs are mapped; this group of VLANSs is called MST Instance (MSTI).
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8-1 State

This page lets you enable or disable MSTP; you can also select what protocol version you want.
The default is Spanning Tree enabled.

To enable and configure Spanning Tree Protocol version in the web Ul:

1. Click Spanning Tree and state.

Select “on” to enable Spanning Tree Protocol.

Select the Spanning Tree Protocol version.

Click the Apply button to save the settings.

To cancel the setting, click the Reset button to revert to previously saved values.

o rowDd

>

LANT?ONIX’ = LrgiTzonN - vw Aute-logout o c’

SM8TBT2SA MSTP State @Home - SpanningTree - State
Switch DMS
Multiple Spanning Tree Protocol ﬁ:ﬁl
» System
» Port Management < Force Version MSTP
» PoE Management <

» VLAN Management < | Apply || Reset |

» Quality of Service

» Spanning Tree

» State

Figure 8-1: MSTP State page

Parameter descriptions:
Multiple Spanning Tree Protocol: You can select on to enable MSTP or off to disable MSTP.

Force Version: The STP protocol version setting. Valid values are STP, RSTP and MSTP (see previous
page for descriptions). The default is MSTP.

Buttons
Apply: Click to save changes.

Reset: Click to undo any changes made locally and revert to previously saved values.
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8-2 Region Config

This page lets you configure the basic identification of a MSTP bridge. Bridges participating in a common
MST region must have the same Region Name and Revision Level.

To configure MSTP Region Config in the web Ul:

1. Click Spanning Tree and Region Config.

2. Specify the Region Name and Revision Level.

3. Click the Apply button to save the settings.

4. To cancel the setting, click the Reset button to revert to previously saved values.

LANT@NIXJ = LANTRONIX - - Auto-logout H o c’
SM&TBT2SA MSTP Region Config Brone ooeres st
Switch DMS
Region Name (0~32 characters) 00-40-CT-10-55-29
P System

N EGTENenaeement < Revision Level (0-65535) 0

» PoE Management e

» VLAN Management < |ﬂ”E|

Figure 8-2: MSTP Region Config
Parameter descriptions:

Region Name (0~32 characters): The name identifying the VLAN to MSTI mapping. Bridges must share
the name and revision (see below), as well as the VLAN-to-MSTI mapping configuration in order to share
spanning trees for MSTI's (Intra-region). Enter up to 32 characters.

Revision Level (0-65535): The revision of the MSTI configuration named above. This must be an integer
between 0 and 65535.

Buttons
Apply: Click to save changes.

Reset: Click to undo any changes made locally and revert to previously saved values.
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8-3 Instance View

This page provides an MST instance table which includes information (VLAN membership of a MSTI ) of
all spanning tree instances provisioned in the particular MST region which the bridge belongs to. Through
this table, additional MSTP configuration data can be applied and MSTP status can be retrieved.

To configure MSTP Instance in the web Ul:

1. Click Spanning Tree and Instance View.

Click the Add VLAN button.

Specify the Instance and Port.

Click Instance Status and Port Status to see the detail.
To cancel the settings click the Delete button.

o ks 0N

F Y

LANT?ONIX = v . - Auto-logout [OFF _ ~| 9 c’

SM8TBT2SA MSTP Instance Config @ tome - Spanning Tree - Instancs View
Switch DMS
Instance Corresponding Vlans
» System < D
» Port Management < 0 0 14004
» PoE Management &
» VLAN Management < | Add VLAN || D:‘Iet&|

-

Quality of Service | nstance Config || Port Config || nstance Status || Port Status ‘

-

Spanning Tree

Figure 8-3a: MSTP Instance Config

Parameter descriptions:

Instance ID: Every spanning tree instance must have a unique instance ID within 0~4095. Instance 0
(CIST) always exists and cannot be deleted. Additional spanning instances (MSTIs) can be added or
deleted. At least one VLAN must be provisioned for an MSTI to declare the need for the MSTI to exist.

Corresponding Vlans: 1-4095. Multiple VLANs can belong to an MSTI. All VLANs that are not
provisioned through this will be automatically assigned to Instance 0 (CIST).
Buttons

Add Vlan: Click to add an MSTI and provide its VLAN members or modify VLAN members for a specific
MSTI; you can add up to 63 for a total of 64.

Delete: Click to delete a selected MSTI.

Instance Config: Click to provision spanning tree performance parameters per instance.
Port Config: Click to provision spanning tree performance parameters per instance per port.
Instance Status: Click to show the status report of a particular spanning tree instance.

Port Status: Click to show the status report of all ports regarding a specific spanning tree instance.
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MSTP Create MSTI/Add Vlan Mapping:

MSTP Instance Config @aHome -~ SpanningTree - Instance View

Instance Corresponding Vlans
1D
-4

0 1 -19,41-4094

-r_lJ
[}

5

1 2,5,20-4

L=

Parameter descriptions:
Instance ID: The valid range is 1-4094.

Vlan Mapping: The list of VLANs mapped to the MSTI. The VLANs can be given as a single (xx, xx being
between 1 and 4094) VLAN, or a range (xx-yy), each of which must be separated with comma and/or
space. A VLAN can only be mapped to one MSTI. An unused MSTI should just be left empty (i.e., not
have any VLANs mapped to it). For example: 2,5,20-40.

Buttons
Apply: Click to save changes.
Reset: Click to undo any changes made locally and revert to previously saved values.

Cancel: Click to undo any changes made locally and return to the Users.

Instance Confiq of Instance 1 :

Instance Configuration (1D=1) @iome - SpanningTree - Instance View

Priority 19768 W

Figure 8-3b: Instance Config of Instance 1
Parameter descriptions:

Priority: The priority parameter used in the CIST (Common and Internal Spanning Tree) connection:

0/4096 /8192 /12288 / 16384 / 20480 / 24576 / 28672 / 32768 / 36864 / 40960 / 45056 / 49152 /
53248 / 57344 / 61440

MAX. Age: 6-40sec. The same definition as in the RSTP protocol.

Forward Delay: 4-30sec. The same definition as in the RSTP protocol.
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MAX. Hops: 6-40sec. It's a new parameter for the multiple spanning tree protocol. It is used in the
internal spanning tree instances. “CIST Remaining Hops” or “MSTI Remaining Hops” in the Spanning tree
protocol message would decrease by one when the message is propagated to the neighboring bridge.

If the Remaining Hops in a message is zero, the message (BPDU) would be regarded as invalid. Max
Hops is used to specify the initial value of the Remaining Hops for Regional Root Bridge (rither CIST
Regional Root or MSTI Regional Root).

Buttons
Apply : Click to save changes.
Reset : Click to undo any changes made locally and revert to previously saved values.

Back : Click to undo any changes made locally and return to the Users.

Port Config of Instance 1:

Y
LANT?ONIX = o il s e atologout [oFF_v| W @ G
= -
SM24TBT4SA Port Config of Instance 0 @boms - SpanningTres - Instance View
Switch DMS
Port Config Migration
, <
¥ System Check
» PortMana t S i ; . . ] ———
SLAEEETIED Port STP Path Cost Priority ~ Admin Admin Restricted Restricted TCN ‘ \_g:.ﬂezk|
» PoE Management < Enable Edge P2P Role —
A <
¥ VLAN Management 1 =l Ao v 128 w| | Yes v Auto Ho No o~ .
» Quality of Service <
2 [ o v 128w Yes v uo v o v No v
» Spanning Tree h
> State 3 «) uto v 1 v Yes uto ¥ o v No A
> Region Config
> Instance View 4 v o v : e v v v fe v e
» MAC Address Table < 5 = Auto v 122 v Yes v Auto v No No v
» Multicast <
6 ) ute v 128 v Yes v ute v o v No w ~
> Consoleflow
» DHCP < T [+ ute v 28 v Yes w uto v o v No w -
» Security < 2 =l Aute v 128 v Yes w Aute v No w No v v
» Access Control <
g ‘v‘ Ut v 1 ~ v Auto N A N A ~
» SNMP S
» Event Notification < 10 & o v 128w Yes v uo v o v No v
» Diagnostics ¢ 1 @ Ao v 128 v Yes v Auto v No v No v
» Maintenance <

Figure 8-3c: Port Config of Instance 0
Parameter descriptions:
Port: The logical port for the settings contained in the same row.

Path Cost: 1 — 200,000,000 or Auto. The same definition as in the RSTP specification. But in MSTP, this
parameter can be respectively applied to ports of CIST and ports of any MSTI.

Priority: 0/16/32/48/64/80/96/112/128/144/160/176 /192 /208 /224 / 240 . The same
definition as in the RSTP specification. But in MSTP, this parameter can be respectively applied to ports
of CIST and ports of any MSTI.

Admin Edge: Yes / No. The same definition as in the RSTP specification for the CIST ports. The factory
default setting is No (Non-Edge).

Admin P2P: Auto / True / False. The same definition as in the RSTP specification for the CIST ports.
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Restricted Role: Yes / No. If “Yes” causes the Port not to be selected as Root Port for the CIST or any
MSTI, even it has the best spanning tree priority vector. Such a Port will be selected as an Alternate Port
after the Root Port has been selected. This parameter is “No” by default. If set, it can cause lack of
spanning tree connectivity. It is set by a network administrator to prevent bridges external to a core region
of the network influencing the spanning tree active topology, possibly because those bridges are not
under the full control of the administrator.

Restricted TCN: Yes / No. If “Yes” causes the Port not to propagate received topology change
notifications and topology changes to other Ports. This parameter is “No” by default. If set it can cause
temporary loss of connectivity after changes in a spanning trees active topology as a result of persistent
incorrectly learned station location information. It is set by a network administrator to prevent bridges
external to a core region of the network, causing address flushing in that region, possibly because those
bridges are not under the full control of the administrator, or the status of MAC operation for the attached
LANSs transitions frequently.

Migration Check: The same definition as in the RSTP specification for the CIST ports. The STP
Migration Check (mCheck) variable. Automatically migrate from RSTP or MSTP to STP-compatible mode.
Buttons

Apply : Click to save changes.

Back : Click to undo any changes made locally and return to the MSTP Instance Config table.

Instance Status of Instance 0 :

A
LANT?ONIX = o il il i Auto-logout ] 9 G
- v
SM24TBT4SA Instance Status (ID=0) @tome - SpanringTree  Instancs View
Switch DMS S ——
Back || Refresh ‘

b System < -
» Port Management < MSTP State Disable
» PoE Management < Force Version MSTP

» VLAN Management
» Quality of Service

» Spanning Tree

> State

> Region Config

> Instance View
» MAC Address Table
» Multicast
> Consoleflow

» DHCP

-

Security
» Access Control

» SNMP

-

Event Notification

-

Diagnostics

-

Maintenance

Bridge Max Age
Bridge Forward Delay
Bridge Max Hops
Instance Priority
Bridge Mac Address
CIST ROOT PRIORITY

CIST ROOT MAC

20

15

20

32768

CIST EXTERNAL ROOT PATH COST

CISTROOT PORTID

CIST REGIONAL ROOT PRIORITY

CIST REGIONAL ROOT MAC

CIST INTERNAL ROOT PATH COST

CIST CURRENT MAX AGE

CIST CURRENT FORWARD DELAY

TIME SINCE LAST TOPOLOGY CHANGE

(SECs)

TOPOLOGY CHANGE COUNT (SECs)

Parameter descriptions:

MSTP State : MSTP protocol is Enable or Disable.
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Force Version : Shows the current spanning tree protocol version configured.

Bridge Max Age : Shows the Max Age setting of the bridge itself.

Bridge Forward Delay : Shows the Forward Delay setting of the bridge itself.

Bridge Max Hops : Shows the Max Hops setting of the bridge itself.

Instance Priority : Spanning tree priority value for a specific tree instance (CIST or MSTI)
Bridge Mac Address : The Mac Address of the bridge itself.

CIST ROOT PRIORITY : Spanning tree priority value of the CIST root bridge

CIST ROOT MAC : Mac Address of the CIST root bridge

CIST EXTERNAL ROOT PATH COST : Root path cost value from the point of view of the bridge’s MST
region.

CIST ROOT PORT ID : The port ID of the bridge’s root port. In MSTP, peer port of a root port may reside
in different MST region or in the same MST region. The first case indicates that the root port's owner is
the CIST regional root bridge.

CIST REGIONAL ROOT PRIORITY: Spanning tree priority value of the CIST regional root bridge. Note
that CIST Regional Root bridge is different from CIST Root bridge. One exception is that when a bridge
belonging to an MST region happens to be the root bridge of the CST (Common Spanning Tree). An MST
Region in the CST can be regarded as a common RSTP bridge. The IST (Internal Spanning Tree) and
MSTlIs are transparent to bridges outside this region.

CIST REGIONAL ROOT MAC : Mac Address of the CIST regional root bridge.

CIST INTERNAL ROOT PATH COST : Root path cost value from the point of view of the bridges inside
the IST.

CIST CURRENT MAX AGE : Max Age of the CIST Root bridge.
CIST CURRENT FORWARD DELAY : Forward Delay of the CIST Root bridge.

TIME SINCE LAST TOPOLOGY CHANGE (SECs) : Time Since Last Topology Change is the elapsed
time in unit of seconds for a bunch of “Topology Change and(or) Topology Change Notification receiving”
to occur. When new series of Topology Changes occur again, this counter will be reset to 0.

TOPOLOGY CHANGE COUNT (SECs) : The per spanning tree instance Topology Change Count
expresses the time spent in unit of seconds since the beginning of the Spanning Tree Topology Change to
the end of the STP convergence. Once there is no topology change occurring and no more topology
change notification received, the Topology Change count will be reset to 0.

Buttons
Back : Click to undo any changes made locally and return to the Users page.

Refresh : Click to manually refresh the page immediately.
Messages:

Please choose an Instance first
MSTRP disabled or force version is not MSTP
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Port Status of Instance 0 :

Y
LANT?ONIX‘ = LwmONIX ol ol Auto-logout H o c.
= v
SM24TBT4SA Port Status of Instance 0 @Home -~ Spanning Tres - Instance View
Switch DMS |
‘ Back | Refresh |
b System <
b EEREE T < PortNo  Status Role Path Cost  Priority Hello Oper.Edge  Oper.P2P  Restricted Role Restricted Ten
b PoE Management <l |1 FORWARDING ~ DSGN 20000 128 2 v
» VLAN Management < 2 DISCARDING disable 20000000 128 2 v
» Quality of Service s DISCARDING disable 20000000 128 2 v
> SPEnglEs 4 DISCARDING ~  disable 20000000 128 2 v
> State
» Region Confi 5 FORWARDING  DSGN 20000 128 2 v v
Region Config
> Instance View 6 FORWARDING  DSGN 20000 128 2 v v
» MAC Address Table ¢ 7 DISCARDING disable | 20000000 @ 128 2 v
y H <
¥ Multicast 8 DISCARDING disable 20000000 128 2 v
> Consoleflow ’
9 DISCARDING disable 20000000 128 2 v
» DHCP <
10 DISCARDING disable 20000000 128 2 v
» Security <
1 DISCARDING disable 20000000 128 2 v
» Access Control <
i \"
5 D < |12 DISCARDING disable 20000000 128 2 !
» Event Notification < 13 DISCARDING disable 20000000 128 2 v
» Diagnostics < 14 DISCARDING disable 20000000 128 2 v
» Maintenance s DISCARDING disable 20000000 128 2 v
16 DISCARDING disable 20000000 128 2 v

Figure 8-3e: Port Status of Instance 0
Parameter descriptions:
Port No: The port number to which the configuration applies.

Status: The forwarding status. Same definition as of the RSTP specification. Possible values are
“‘FORWARDING”, “LEARNING”, “DISCARDING”.

Role: The role that a port plays in the spanning tree topology. Possible values are “disable”(disable
port) , "alternate” (alternate port) , “backup” (backup port) , “ROOT” (root port) , “DSGN” (designated
port) , and “MSTR” (master port). The last 3 are possible port roles for a port to transit to FORWARDING
state

Path Cost: Displays currently resolved port path cost value for each port in a particular spanning tree
instance.

Priority: Displays port priority value for each port in a particular spanning tree instance.

Hello: Per port Hello Time display. It takes the following form: Current Hello Time/Hello Time Setting
Oper. Edge: Whether or not a port is actually an Edge Port.

Oper. P2P: Whether or not a port is actually a Point-to-Point port.

Restricted Role: Yes / No. If “Yes” causes the Port not to be selected as Root Port for the CIST or any
MSTI, even it has the best spanning tree priority vector. Such a Port will be selected as an Alternate Port
after the Root Port has been selected. This parameter is “No” by default. If set, it can cause lack of
spanning tree connectivity. It is set by a network administrator to prevent bridges external to a core region
of the network influencing the spanning tree active topology, possibly because those bridges are not
under the full control of the administrator.
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Restricted TCN: Yes / No. If “Yes” causes the Port not to propagate received topology change
notifications and topology changes to other Ports. This parameter is “No” by default. If set it can cause
temporary loss of connectivity after changes in a spanning trees active topology as a result of persistent
incorrectly learned station location information. It is set by a network administrator to prevent bridges
external to a core region of the network, causing address flushing in that region, possibly because those
bridges are not under the full control of the administrator, or the status of MAC operation for the attached
LANSs transitions frequently.

Buttons
Back : Click to undo any changes made locally and return to the Users.

Refresh : Click to manually refresh the page immediately.

Messages
Message: MSTP disabled or force version is not MSTP

Recovery: Click OK to clear, change the Instance Status parameter, and continue.
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Chapter 9 MAC Address Tables

9-1 Configuration

Switching of frames is based on the DMAC address contained in the frame. The switch builds a table that
maps MAC addresses to switch ports for knowing which ports the frames should go to (based upon the
DMAC address in the frame). This table contains both static and dynamic entries. The static entries are
configured by the network administrator if the administrator wants to do a fixed mapping between the
DMAC address and switch ports.

The frames also contain a MAC address (SMAC address), which shows the MAC address of the
equipment sending the frame. The SMAC address is used by the switch to automatically update the MAC
table with these dynamic MAC addresses. Dynamic entries are removed from the MAC table if no frame
with the corresponding SMAC address was seen after a configurable age time.

To configure MAC Address Table in the web Ul:

1. Click MAC Address Table and Configuration.

2. Specify the Disable Automatic Aging and Aging Time.
3. Configure the Port Members (Auto, Disable, Secure).
4

Click the Add New Static Entry button, and specify the VLAN ID, Mac address, Block, and Port
Member parameters.

5. Click Apply.
LANT?ONIXW = LATRON - — Auto-logout H o c.
SME8TBT2SA MAC Table Configuration @Home - MAC Address Tabl - Configuration
Switch DMS
Aging Configuration
» System <

¢ Disable Automatic Aging M

\ 4

Port Management

-

PoE Management e Aging Time 300 seconds

-

WLAN Management

-

Quality of Service < MAC Table Learning

-

Spanning Tree

Port Member
» MAC Address Table e
R 1 2 3 4 5 6 7 8 9 10
> Con guration
> Information Learning .@. @} .@j .@j .@. @} @j (::. IC :} .@j
» Multicast < Disable —~ — —~ ~ — — —~ —~ — —~
J O U J J [ | J () U
gCon-ueiion Secure @) ) e e e 0O 0O O ®) 0
L L L L L ) _ L L L
» DHCP ¢
» Security e Static MAC Table Configuration
» Access Control <
Delete VLAN ID MAC Address Block Port Member
» SNMP 4
» Event Notification “ | Add New Static Entry |

» Diagnostics

| Apply | Reset |

» Maintenance

Figure 9-1: MAC Table Configuration
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Parameter descriptions:

Aging Confiquration: By default, dynamic entries are removed from the MAC table after 300 seconds.
This removal is also called aging. Configure aging time by entering a value here in seconds. The valid
range is 10 - 1000000 seconds. Disable the automatic aging of dynamic entries by checking the Disable
Automatic Aging checkbox.

MAC Table Learning: If the learning mode for a given port is greyed out, another module is in control of
the mode, so that it cannot be changed by the user. An example of such a module is the MAC-Based
Authentication under 802.1X. Each port can do learning based upon the following settings:

Learning: Learning is done automatically as soon as a frame with unknown SMAC is received.
Disable: No learning is done.
Secure: Only static MAC entries are learned; all other frames are dropped.

NOTE: Make sure that the link used for managing the switch is added to the Static MAC

@ Table before changing to Secure learning mode, otherwise the management link is lost and
can only be restored by using another non-secure port or by connecting to the switch via
the Telnet interface.

Static MAC Table Configuration

The static entries in the MAC table are shown in this table. The static MAC table can contain 64 entries.
The MAC table is sorted first by VLAN ID and then by MAC address.

Delete: Check to delete the entry. It will be deleted during the next save.
VLAN ID: The VLAN ID of the entry.

MAC Address: The MAC address of the entry.

Block: Click it if you want to block this mac address.

Port Member: Check radio buttons to set which ports are members of the entry. Check or uncheck as
needed to modify the entry.

Buttons

Add New Static Entry: Click to add a new entry to the static MAC table. Specify the VLAN ID, MAC
address, and port members for the new entry. Click "Apply".

Apply: Click to save changes.
Reset: Click to undo any changes made locally and revert to previously saved values.
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9-2 Information

Entries in the MAC Table are shown on this page. The MAC Table contains up to 8192 entries, and is

sorted first by VLAN ID, then by MAC address.
To display the Dynamic MAC Table in the web Ul:
1. Click MAC Address Table and Information.
2. View the displayed MAC Address Table.
3. Click the buttons as required.

a
LANTRONIX' =| % oo
- . L L
SM8TBT2SA MAC Table Information @Home - MACAddress Table - Information
Switch DMS ———
Auto-refresh ‘ Refresh H Clear |
» System <
» Port Manasement < Show| 1w entries Search:
g
» PoE Management < Port Members
» <
VLA ST e Type VLAN * MACAddress “Blok CPU L 2 3 4 5 & 7T 8 8 ' 10
» Quality of Service <
Dynamic 1 00-40-C7-1D-52-E4 No v
» Spanning Tree <
Static 1 00-40-C7-1D-53-29 No v
» MAC Address Table h
> Configuration Dynamic 1 00-80-A3-C3-AB-72 No v
» [MEmEiey Dynamic 1 00-C0-F2-49-1E-FE No v
i <
» Multicast Dynamic 1 00-C0-F2-51-58-4A No v
> Consoleflow .
Dynamic 1 00-CO-F2-TF-43-52 No v
» DHCP <
Dynamic 1 00-C0-F2-86-DF-91 No v
» Security <
Dynamic 1 00-CO-F2-87-24-5C No v
» Access Control <
» SNMP ¢ Dynamic 1 00-C0-F2-88-05-56 No v
» Event Notification < Dynamic 1 00-CO-F2-88-72-24 No v
. . ¢
b DIEguEsiTes Previous 2 3 4 Next
b Maintananca <

Figure 9-2: MAC Table Information
Parameter descriptions:
Aging Configuration
Show x entries: At the dropdown, select how many lines to display per page (10, 25
Type: Indicates whether the entry is a Static or a Dynamic entry, or 802.1x, DMS.
VLAN: The VLAN ID of the entry.
MAC address: The MAC address of the entry.
Block: Whether the mac address is blocked or not.

Port Members: The ports that are members of the entry.

Buttons Auto-refresh
Auto-refresh: Check to refresh the page automatically every 3 seconds.
Refresh: Click to manually refresh the page. immediately

Clear: Click to clear the page.

Previous: Updates the system log entries, turn to the previous page.
Next: Updates the system log entries, turn to the next page.

, 60, 100, or 500).

Refresh || Clear
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@ Note: 00-40-C7-73-01-29 : your switch MAC address (for IPv4)

33-33-00-00-00-01 : Destination MAC (for IPv6 Router Advertisement) (reference IPv6 RA.JPG)
33-33-00-00-00-02 : Destination MAC (for IPv6 Router Solicitation) (reference IPv6 RS.JPG)
33-33-FF-73-01-29 : Destination MAC (for IPv6 Neighbor Solicitation) (reference IPv6 DAD.JPG)
33-33-FF-A8-01-01: your switch MAC address (for IPv6 global IP)

FF-FF-FF-FF-FF-FF: for Broadcast.
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Chapter 10 Multicast

10-1 IGMP Snooping

IGMP Snooping is used to establish the multicast groups to forward the multicast
packet to the member ports, and, in nature, avoids wasting the bandwidth while IP

P Multicast

multicast packets are running over the network. This is because a switch that does > |GMP Snooping
not support IGMP or IGMP Snooping cannot tell a multicast packet from a #» MLD Snooping
broadcast packet, so it can only treat them all as a broadcast packet. Without IGMP » MVR

Snooping, a multicast packet forwarding function is plain and nothing is different
from a broadcast packet.

The switch supports IGMP Snooping functions of query, report and leave, a type of packet exchanged
between IP Multicast Router/Switch and IP Multicast Host, can update the information of the Multicast
table when a member (port) joins or leaves an IP Multicast Destination Address. With this function, once a
switch receives an IP multicast packet, it will forward the packet to the members who joined in a specified
IP multicast group before.

The packets will be discarded by the IGMP Snooping if the user transmits multicast packets to the
multicast group that had not been built up in advance. IGMP mode enables the switch to issue IGMP
function that you enable IGMP proxy or snooping on the switch, which connects to a router closer to the
root of the tree. This interface is the upstream interface. The router on the upstream interface should be
running IGMP.

# Multicast Filtering Profile

10-1.1 Basic Configuration

This webpage lets you set the basic IGMP snooping on the switch, which connects to a router closer to
the root of the tree. This interface is the upstream interface. The router on the upstream interface should
be running IGMP.

Web Interface
To configure IGMP Snooping parameters in the web Ul:

Click Multicast, IGMP Snooping, and Basic Configuration.

Enable or disable the Global configuration.

Select the port you want to become a Router Port or enable/ disable the Fast Leave function.
Scroll to set the Throttling and Profile.

Click the Apply button to save the settings.

To cancel the setting, click the Reset button to revert to previously saved values.

2 e o
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Figure 10-1.1: IGMP Snooping Configuration

Parameter descriptions:

d

d

d

o
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o
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o
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Profile
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Global Configuration

Snooping Enabled: Enable the Global IGMP Snooping.

Unregistered IPMCv4 Flooding enabled: Enable unregistered IPMCv4 traffic flooding. Unregistered
IPMCv4 traffic is also called “unknown multicast”. After selected, the unregistered multicast stream will be
forwarded like normal packets. Once you un-selected it, an unregistered multicast stream will be
discarded.

IGMP SSM Range: SSM (Source-Specific Multicast) Range lets the SSM-aware hosts and routers run
the SSM service model for the groups in the address range. Format: (IP address/ sub mask).

Per IETF RFC 4607, IP version 4 (IPv4) addresses in the 232/8 (232.0.0.0 t0232.255.255.255) range are
designated as source-specific multicast (SSM) destination addresses and are reserved for use by source-
specific applications and protocols. For IP version 6 (IPv6), the address prefix FF3x::/32 is reserved for
source-specific multicast use.

Proxy Enabled: Enable IGMP Proxy. This feature can be used to avoid forwarding unnecessary join and
leave messages to the router side.

Port Related Configuration

Port: It shows the physical Port index of switch.

Router Port: Specify which ports act as router ports. A router port is a port on the Ethernet switch that
leads towards the Layer 3 multicast device or IGMP querier. If an aggregation member port is selected as
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a router port, the whole aggregation will act as a router port.
Fast Leave: Enable the fast leave on the port.
Throttling: Enable to limit the number of multicast groups to which a switch port can belong.

Profile: You can select profile when you edit in Multicast Filtering Profile.

Buttons
Auto-refresh: Check to refresh the page automatically every 3 seconds.
Refresh: Click to manually refresh the page. immediately
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10-1.2 VLAN Configuration

This page lets you set the VLAN parameters integrated for the IGMP Snooping function. Each page
shows up to 99 entries from the VLAN table, default being 20, selected through the "entries per page"
input field. When first visited, the web page will show the first 20 entries from the beginning of the VLAN
Table. The first displayed will be the one with the lowest VLAN ID found in the VLAN Table. The "VLAN"
input fields allow the user to select the starting point in the VLAN Table.

Web Interface
To configure IGMP Snooping VLAN parameters in the web Ul:
1. Click Multicast, IGMP Snooping, and VLAN Configuration.
2. Click the Add New IGMP VLAN button to add a new row to the table.
3. Click the Apply button to save the settings.
4. To cancel the setting, click the Reset button to revert to previously saved values.

a
LANTRONIX' =| ™% swwewwws $ 5| oo T M Q@ G
SM8TBT2SA IGMP Snooping Vlan Configuration @ttome - Mlicsst - 1GHP Snosping - Vian Confisuration

Switch DMS

Snooping IGMP

b System Delete VLANID Enabled Querier Compatibility RV Ql(sec) QRI(0.1 sec) LLQI(0.1 sec) URI(sec)

» Port Management — - -
‘ Del:—te| (] O IGMP-Auto v 2 125 100 10

» PoE Management

» VLAN Management

» Quality of Service

» Spanning Tree

Figure 10-1.2: IGMP Snooping VLAN Configuration

Parameter descriptions:

Start from Vlan: Click to refresh the displayed table starting from the "VLAN" input fields.

Delete: Check to delete the entry. The designated entry will be deleted during the next save.
VLAN ID: Displays the VLAN ID (VID) of the entry.

Snooping Enabled: Enable the per-VLAN IGMP Snooping. Only up to 32 VLANSs can be selected.

IGMP Querier: Enable to join IGMP Querier election in the VLAN. Disable to act as an IGMP Non-
Querier.

Compatibility: Compatibility is maintained by hosts and routers taking appropriate actions depending on
the versions of IGMP operating on hosts and routers within a network. The allowed selections are IGMP-
Auto, Forced IGMPv1, Forced IGMPv2, Forced IGMPv3. The default is IGMP-Auto. Compatibility

IGMP v1 is specified in RFC-1112; it was the first widely-deployed version and the first -
version to become an Internet Standard. e
IGMP v2, specified in RFC-2236, added the ability for a host to signal desire to leave a

multicast group. Forced IGHPvL
IGMP v3, specified in RFC 3376, adds support for "source filtering", that is, the ability :Eg :”D;

for a system to report interest in receiving packets *only* from specific source
addresses, or from *all but* specific source addresses, sent to a particular multicast address.

Rv: Robustness Variable. The RV allows tuning for the expected packet loss on a network. The allowed
range is 1 to 255; the default RV value is 2.
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Ql(sec): Query Interval. The Ql is the interval between General Queries sent by the Querier. The allowed
range is 1 to 31744 seconds; default query interval is 125 seconds.

QRI(0.1 sec): Query Response Interval. The Max Response Time used to calculate the Max Resp Code
inserted into the periodic General Queries. The allowed range is 0 to 31744 in tenths of seconds; the
default QRI is 100 in tenths of a second (10 seconds).

LLQI (0.1 sec): Last Member Query Interval. The Last Member Query Time is the time value represented
by the Last Member Query Interval, multiplied by the Last Member Query Count. The allowed range is 0
to 31744 in tenths of seconds; the default LLQI is 10 in tenths of a second (1 second).

URI(sec): Unsolicited Report Interval. The URI is the time between repetitions of a host's initial report of
membership in a group. The allowed range is 0 to 31744 seconds; the default URI is 1 second.

Buttons

Add New IGMP VLAN : Click to add a new IMCP VLAN entry to the table.

Apply: Click to save changes.

Reset: Click to undo any changes made locally and revert to previously saved values.
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10-1.3 Status

After you complete the IGMP Snooping configuration, you can view the IGMP Snooping Status. This page

displays the IGMP Snooping detail status.
To display the IGMP Snooping status in the web Ul:

1. Click Multicast, IGMP Snooping, and Status.
2. To auto-refresh the information, set “Auto-refresh” to On.
3. Click “Refresh” to refresh the IGMP Snooping Status.

IGMP Snooping Status

VLAN Querier Host Queerier Quernes Queres ¥l Reports
D Vériuon Véeruon Status Tranimitted Reécerved Reéceryed
Port Status

Figure 10-1.3: IGMP Snooping Status

Statistics
VLAN ID: The VLAN ID of the entry.
Querier Version: Working Querier Version currently.

Host Version: Working Host Version currently.

V1 Reports

Reécenmed

Vi Leaves

Querier Status: Shows the Querier status is "ACTIVE" or "IDLE". "DISABLE" denotes the specific

interface is administratively disabled.

Queries Transmitted: The number of Transmitted Queries.
Queries Received: The number of Received Queries.

V1 Reports Received: The number of Received V1 Reports.
V2 Reports Received: The number of Received V2 Reports.
V3 Reports Received: The number of Received V3 Reports.

V2 Leaves Received: The number of Received V2 Leaves.
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Router Port: This section displays which ports act as router ports. A router port is a port on the Ethernet
switch that leads towards the Layer 3 multicast device or IGMP querier. Static denotes the specific port is
configured to be a router port. Dynamic denotes the specific port is learnt to be a router port. Both denote
the specific port is configured or learnt to be a router port.

Port: Switch port number.
Status: Indicate whether specific port is a router port or not.

-
(T
-

Auto-refresh ofresh ‘

Buttons
Auto-refresh: Check to refresh the page automatically every 3 seconds.

Refresh: Click to manually refresh the page immediately.
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10-1.4 Group Information

After you complete setting the IGMP Snooping function, you can view the IGMP Snooping Group
Information. Entries in the IGMP Group Table are shown on this page. The IGMP Group Table is sorted
first by VLAN ID, and then by group. When the end is reached the text "No more entries" is shown in the
displayed table.

Group Member behavior: in order to be compatible with older version routers, IGMPv3 hosts must operate
in version 1 and version 2 compatibility modes. IGMPv3 hosts MUST keep state per local interface
regarding the compatibility mode of each attached network. A host's compatibility mode is determined
from the Host Compatibility Mode variable which can be in one of three states: IGMPv1, IGMPv2 or
IGMPv3. This variable is kept per interface and depends on the version of General Queries heard on that
interface as well as the older querier present timers for the interface.

Web Interface

To display the IGMP Snooping Group Information in the web Ul:
1. Click Multicast, IGMP Snooping, and Groups Information.
2. Specify how many entries to show in one page.

3. Click Previous or Next to change pages.

a
® o || g Auto-logout |OFF
LANTRONIX® = L] vy [CER O
SME8TBT2SA IGMP Snooping Groups Information SkHoms - Multicast - 15HP Snooping - Groups Information
Switch DMS —
Auto-refresh Refresh
» System <
b Err T < Show| 10« entries Search:
» PoE Management < Port Members
<
» VLANManagement VLAN ID *| Group 1 2 3 4 5 6 7 8 9 10
» Quality of Service <
Q 2 No data available in table
» Spanning Tree <
Previo Next
b MACAddressTable < reviots | e
» Multicast = 5 ______________________________________________________________________________________________________;J

» IGMP Snnaning

Figure 10-1.4: IGMP Snooping Groups Information

Parameter descriptions:

VLAN ID: VLAN ID of the group.

Groups: Group address of the group displayed.
Port Members: Ports under this group.

Buttons

Auto-refresh : Check this box to refresh the page automatically every 3 seconds.
Refresh : Click to manually refresh the page immediately.

Previous : Updates the system log entries, turn to the previous page.

Next : Updates the system log entries, turn to the next page.
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10-1.5 IGMP SFM Information

Entries in the IGMP SFM Information Table are shown on this page. The IGMP SFM (Source-Filtered
Multicast) Information table also contains the SSM (Source-Specific Multicast) information. This table is
sorted first by VLAN ID, then by group, and then by Port. Different source addresses belong to the same
group are treated as single entry.

Each page shows up to 99 entries from the IGMP SFM Information table, default being 20, selected
through the "entries per page" input field. When first visited, the web page will show the first 20 entries
from the beginning of the IGMP SFM Information table.

The "Start from VLAN", and "group” input fields allow the user to select the starting point in the IGMP
SFM Information Table. Clicking the Next button will update the displayed table starting from that or the
closest next IGMP SFM Information Table match. In addition, the two input fields will - upon a Previous
button click - assume the value of the first displayed entry, allowing for continuous refresh with the same
start address.

Web Interface

To display IGMP SFM Information in the web Ul:

1. Click Multicast, IGMP Snooping, and IGMP SFM Information.

2. To automatically refresh the information click “Auto-refresh”.

3. Click “Refresh” to refresh an entry of the IGMP Snooping Groups Information.

4. Click Previous or Next to change pages.

A
® o || g Auto-logout |OFF
LANTRONIX® = L] vy o] O ¢
SM8TBT2SA IGMP SFM Information g Home - Multicast - IGMP Snooping - IGMF SFM Information
Switch DMS —
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» PoE Management K VLAN ID * Group Port Mode Source Address Type
» VLAN Management <

No data available in table

v

Quality of Service <
Previous = Next

-

Spanning Tree
” L ___________________________________________________________________________________________________]
MAC Address Table < 4 (3

Figure 10-1.5: IGMP SFM Information

-

Parameter descriptions:

Search : You can search for the information that you want to view.
Show entries : You can choose how many items you want to show.
VLAN ID : VLAN ID of the group.

Group : Group address of the group displayed.

Port : Switch port number.

Mode : Indicates the filtering mode maintained per (VLAN ID, port number, Group Address) basis. It can
be either Include or Exclude.
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Source Address : IP Address of the source. Currently, system limits the total number of IP source
addresses for filtering to be 128.

Type : Indicates the Type. It can be either Allow or Deny.

Auto-refresh Refresh |

Buttons

Auto-refresh : Check this box to refresh the page automatically every 3 seconds.
Refresh : Click to manually refresh the page immediately.

Previous : Updates the system log entries, turn to the previous page.

Next : Updates the system log entries, turn to the next page.
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10-2 MLD Snooping

Curiously enough, a network node that acts as a source of IPv6 multicast traffic is only an indirect
participant in MLD snooping - it just provides multicast traffic, and MLD doesn’t interact with it. (Note,
however, that in an application like desktop conferencing a network node may act as both a source and
an MLD host; but MLD interacts with that node only in its role as an MLD host.)

A source node creates multicast traffic by sending packets to a multicast address. In IPv6, addresses with
the first eight bits set (that is, “FF” as the first two characters of the address) are multicast addresses, and
any node that listens to such an address will receive the traffic sent to that address. Application software
running on the source and destination systems cooperates to determine what multicast address to use.
(Note that this is a function of the application software, not of MLD.)

When MLD snooping is enabled on a VLAN, the switch acts to minimize unnecessary multicast traffic. If
the switch receives multicast traffic destined for a given multicast address, it forwards that traffic only to
ports on the VLAN that have MLD hosts for that address. It drops that traffic for ports on the VLAN that

have no MLD hosts.

MLD snooping enablad

Listener
(MLD host)

] [ ]

— [— [
=

Source \
= A

[ |:| Listener
[ | (MLD host)

Figure 10-2: MLD Snooping enabled
10-2.1 Basic Configuration

This page let you configure the MLD Snooping basic configuration and the parameters.
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Web Interface
To configure MLD Snooping in the web Ul:
1. Click Multicast, MLD Snooping, and Basic Configuration.

2. Select “on” to enable Snooping globally and configure the parameters.
3. Select the port to join Router Port and Fast Leave.
4. Atthe Throttling mode dropdown select unlimited or 1 to 10.
5. Click the Apply button to save the settings.
6. To cancel the settings, click the Reset button to revert to previously saved values.
a |
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» PoE Management < . .
Unregistered IPMCv6 Flooding _
» VLAN Management < Enabled v
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Figure 10-2.1: MLD Snooping Basic Configuration

Global Confiquration

Snooping Enabled: Enable the Global MLD Snooping.

Unregistered IPMCv6 Flooding Enabled: Enable unregistered IPMCv6 traffic flooding.
Flooding control takes effect only when MLD Snooping is enabled. When MLD Snooping is disabled, then
unregistered IPMCV6 traffic flooding is always active in spite of this setting.

MLD SSM Range: SSM (Source-Specific Multicast) Range allows the SSM-aware hosts and routers run
the SSM service model for the groups in the address (using IPv6 Address) range.

Proxy Enabled: Enable MLD Proxy. This feature can be used to avoid forwarding unnecessary join and
leave messages to the router side.

Port Related Configuration

Router Port: Specify which ports act as router ports. A router port is a port on the Ethernet switch that
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leads towards the Layer 3 multicast device or MLD querier. If an aggregation member port is selected as
a router port, the whole aggregation will act as a router port.

Fast Leave: Check the box to enable Fast Leave on the port.
Throttling: Enable to limit the number of multicast groups to which a switch port can belong.

Profile: You can select profile when you edit in Multicast Filtering Profile.

Buttons
Apply: Click to save changes.
Reset: Click to undo any changes made locally and revert to previously saved values.
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10-2.2 VLAN Configuration

When MLD snooping is enabled on a VLAN, the switch acts to minimize unnecessary multicast traffic.

If the switch receives multicast traffic destined for a given multicast address, it forwards that traffic only to
ports on the VLAN that have MLD hosts for that address. It drops that traffic for ports on the VLAN that
have no MLD hosts. To configure MLD Snooping VLAN in the web Ul:

1. Click Multicast, MLD Snooping, and VLAN Configuration.

2. Click the Add New MLD VLAN button.

3. Specify the VLAN ID parameters.

MLD Snooping Vlan Configuration Bitioma - Mot - WLDSnosging - Vian Corfigeration

VLAN Snooping MLD

Delete 1D Enabled  Querier Compatibility Ry Qlfsec) QRI(0.1 sec) LLQI{0.1 sec) URI{sec)
- MDAt 5
v ~ Forced MLDVE  w
] v

Figure 10-2.2: MLD Snooping VLAN Configuration

Parameter descriptions:

Delete: Check to delete the entry. The designated entry will be deleted during the next save.
VLAN ID: It displays the VLAN ID of the entry.

Snooping Enabled: Enable the per-VLAN IGMP Snooping. Up to 32 VLANSs can be selected.

MLD Querier: Enable to join IGMP Querier election in the VLAN. Disable to act as an IGMP
Non-Querier.

Compatibility: Compatibility is maintained by hosts and routers taking appropriate actions compatbily
depending on the versions of IGMP operating on hosts and routers within a network. The
allowed selections are MLD-Auto, Forced MLD v1, Forced MLD v2. The default compatibility — [IhEame
value is MLD-Auto. Forced MLDv1

Forced MLDw2

RV: Robustness Variable. The RV allows tuning for the expected packet loss on a network.
The allowed range is 1 to 255; the default RV value is 2.

Ql(sec): Query Interval. The Ql is the interval between General Queries sent by the Querier. The allowed
range is 1 to 31744 seconds; the default Ql is 125 seconds.

QRI(0.1sec): Query Response Interval. The Max Response Time used to calculate the Max Resp Code
inserted into the periodic General Queries. The allowed range is 0 to 31744 in tenths of seconds; the
default QRI is 100 in tenths of seconds (10 seconds).

LLQI (LMQI for IGMP): Last Member Query Interval. The Last Member Query Time is the time value
represented by the Last Member Query Interval, multiplied by the Last Member Query Count. The allowed
range is 0 to 31744 in tenths of seconds; the default LLQI is 10 in tenths of seconds (1 second).

URI(sec): Unsolicited Report Interval. The URI is the time between repetitions of a host's initial report of
membership in a group. The allowed range is 0 to 31744 seconds; the default URI is 1 second.

Buttons

Add New MLD VLAN : Click to add a new instance to the table for configuration.

Apply: Click to save changes.

Reset: Click to undo any changes made locally and revert to previously saved values.

33873 Rev. A https://www.lantronix.com/ Page 128 of 273



https://www.lantronix.com/

Lantronix SMXTBTxSA Web User Guide

10-2.3 Status

This page lets you view MLD Snooping Status and detail information. To display MLD Snooping Status in
the web Ul:

1. Click Multicast, MLD Snooping, and Status.

2. To automatically refresh the information select “on” at “Auto-refresh”.

3. Click “Refresh” to refresh an entry of the MLD Snooping Status Information.

MLD Snooping Status Wirizma © Bbicast - MO Srooging - Sk
Auito-refres)
Statistics
VLAN  Querier Host Querier Queries Queries W1 Reparts Wi Reports VI Leawes
{1 ¥] WeErsicn YeErsiomn Status I ransmitted H-cewed Heoeived Redenid Heceived
IDILE 3 i ]
J - W E il
Houter Fort
Port Status
SLE
Sta
Star

Figure 10-2.3: MLD Snooping Status

Parameter descriptions:

VLAN ID: The VLAN ID of the entry.

Querier Version: Working Querier Version currently.
Host Version: Working Host Version currently.

Querier Status : Show the Querier status is "ACTIVE" or "IDLE". "DISABLE" denotes the specific
interface is administratively disabled.

Queries Transmitted: The number of Transmitted Queries.
Queries Received: The number of Received Queries.

V1 Reports Received: The number of Received V1 Reports.
V2 Reports Received: The number of Received V2 Reports.

V1 Leaves Received: The number of Received V1 Leaves.
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Router Port: Display which ports act as router ports. A router port is a port on the Ethernet switch that
leads towards the Layer 3 multicast device or MLD querier.

Static denotes the specific port is configured to be a router port.

Dynamic denotes the specific port is learnt to be a router port.

Both denote the specific port is configured or learnt to be a router port.
Port: Switch port number.

Status: Indicate whether specific port is a router port or not.

Buttons Auto-refresh l Refresh |

Auto-refresh: Check to on to refresh the page automatically every 3 seconds.

Refresh: Click to manually refresh the page immediately.
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10-2.4 Groups Information

This page lets you set MLD Snooping Groups Information. The "Start from VLAN", and "group" input
fields let you select the starting point in the MLD Group Table.

Each page shows up to 99 entries from the MLD Group table, default being 20, selected through the
"entries per page" input field. When first visited, the web page will show the first 20 entries from the
beginning of the MLD Group Table.

To display MLD Snooping Group information in the web Ul:

1. Click Multicast, MLD Snooping, and Group Information.

2. To auto-refresh the information select "on” at “Auto-refresh”.

3. Click “Refresh” to refresh an entry of the MLD Snooping Group Information.

MLD Snooping Groups Information divome - Multicast - MLD Snoeping - Groups information
Auto-refresh
Show 1w+ entries Search:

Port Members

VLAN
D Group 1 2 3 4 5 b T 8 9 10 11 12 13 14 15 16 17 18
1 ffo2:fb >
1 fi02::1:f4e:20e9 v

ffo2::1:ff4f:bc3a v
1 ffo2::1:ffa4:a896 v

ff02::1:ffd4:ddc2 v

Figure 10-2.4: MLD Snooping Groups Information
Parameter descriptions:
VLAN ID: VLAN ID of the group.
Groups: Group address of the group displayed.
Port Members: Ports under this group.

Show entries: Choose how many items you want to view per page.

Buttons
Auto-refresh: Check to refresh the page automatically every 3 seconds.

Refresh: Click to manually refresh the page immediately.
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10-2.5 MLD SFM Information

Entries in the MLD SFM Information Table are shown on this page. The MLD SFM (Source-Filtered
Multicast) Information Table also contains the SSM (Source-Specific Multicast) information. This table is
sorted first by VLAN ID, then by group, and then by Port. Different source addresses that belong to the
same group are treated as single entry.

To display MLD SFM Information in the web Ul:

1. Click Multicast, MLD Snooping, and MLD SFM Information.
2. To auto-refresh the information click Auto-refresh “On”.
3. Click “Refresh” to refresh an entry of the MLD SFM Information.

MLD SFM Information @iiome - Mubicast - MLD Sncoping - MLDSFM Information

Auto-refresh

Show 10 « entries Search:
VLAN ID * Group Port Mode Source Address Type
1 ffo2::fb 11 Exclude MNone Allow
1 ffo2::1:f4e:2009 12 Exclude MNone Allow
1 ffo2::1:ff4f:bc3a 11 Exclude Mone Allow
1 ff02::1:ffa4:a896 8 Exclude MNone Allow
1 ff02::1:ffid4:ddc2 10 Exclude MNone Allow

Figure 10-2.5: MLD SFM Information
Parameter descriptions:
VLAN ID: VLAN ID of the group.
Group: Group address of the group displayed.
Port: Switch port number.

Mode: Indicates the filtering mode maintained per (VLAN ID, port number, Group Address) basis.
It can be either Include or Exclude.

Source Address: The IP Address of the source. Currently, the system limits the total number of IP source
addresses for filtering to be 128.

Type: Indicates the Type. It can be either Allow or Deny.

Show entries: You can choose how many items you want to display.

Buttons
Auto-refresh: Check to refresh the page automatically every 3 seconds.

Refresh: Click to manually refresh the page immediately.
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10.3 Multicast Filtering Profile

ICMP (Internet Control Message Protocol) generates error response, diagnostic, or routing messages.
ICMP messages contain information on routing difficulties or simple exchanges such as time-stamp or
echo transactions.

IGMP Snooping is used to establish the multicast groups to forward the multicast packet to the member
ports. It avoids wasting the bandwidth when IP multicast packets are running over the network. A switch
that does not support IGMP or IGMP Snooping cannot tell the multicast packet from the broadcast packet,
so it can only treat them all as broadcast packets. Without IGMP Snooping, the multicast packet
forwarding function is inactive and all packets are treated as broadcast packets.

A switch that supports IGMP Snooping can query, report, and leave a packet exchanged between an IP
Multicast Router/Switch and an IP Multicast Host, and can update the information of the Multicast table
when a member (port) joins or leaves an IP Multicast Destination Address. With this function, once a
switch receives an IP multicast packet, it will forward the packet to the members who joined in a specified
IP multicast group previously.

The packets will be discarded by IGMP Snooping if the user transmits multicast packets to the multicast
group that was not built up in advance. IGMP mode enables the switch to issue IGMP function that you
enable IGMP proxy or snooping on the switch, which connects to a router closer to the root of the tree.
This interface is the upstream interface. The router on the upstream interface should be running IGMP.

10.3-1 Switch > Multicast > Multicast Filtering Profile > Filtering Profile Table

The IPMC profile is used to deploy the access control on IP multicast streams. You can create a
maximum of 64 Profiles and a maximum 128 corresponding rules for each at the Multicast Filtering Profile
Configuration table.

Click the Add New Profile button to display the configurable parameters.

a

® o || rgmon Auto-logout |OFF v .

LANTRONIX" = wevewy r -1 B @ &
SM8TBT2SA Multicast Filtering Profile Configuration @Homs - Multizsst - Multizsst Flkering Profile - Filtering Profls Table
Switch DMS
Multicast Filtering Profile Mode Enabled
P System <
» Port Management < . . . c
= Filtering Profile Table Setting
» PoE Management <
» VLAN Management < Delete Profile Name Profile Description Rule
» Quality of Service < O Prof-1 15t MC profile ‘ Edit ‘
» Spanning Tree < —
» MAC Address Table < E— —_—
» Multicast > . .
‘ Add New Profile

» IGMP Snooping <

» MLD Snooping < Apply | Reset |

Parameter descriptions:

Multicast Filtering Profile Mode: Enable/Disable the Global IPMC Profile. The system starts to do
filtering based on profile settings only when the global profile mode is enabled. Select to Disable or
Enable globally. The default is Disabled.

Filtering Profile Table Setting
Delete: Click to delete the entry. The designated entry will be deleted during the next apply.

Profile Name: The name used for indexing the profile table. Each entry has the unique name which is
composed of at maximum 16 alphabetic and numeric characters. Enter a name for the new IPMC profile.
Avoid spaces between characters.
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Profile Description: Enter a description of the new IPMC profile. Additional description, which is
composed of at maximum 64 alphabetic and numeric characters, about the profile. No blank or space
characters are permitted as part of description. Use " " or "-" to separate the description sentence.

Rule: When the profile is created, click the edit button to enter the rule setting page of the designated
profile. Summary about the designated profile will be shown by clicking the view button. You can manage
or inspect the rules of the designated profile by using these buttons:

o List the rules associated with the designated profile.
> Adjust the rules associated with the designated profile.
Enter the parameters and click the Apply button, then click the Edit button, then click the Add Last Rule

button to display the MC Filtering Profile Rule Configuration Rule Settings table (In Precedence Order).
Buttons:

Add New Profile: Click to add new profile. Specify the name and configure the new entry.

Delete: Check to delete the entry. The designated entry will be deleted during the next save.

Apply: Click to save changes.

Reset: Click to undo any changes made locally and revert to previously saved values.

Multicast Filtering Profile Rule Configuration: At the Multicast Filtering Profile [4] Rule Settings page

click the Edit button in the Rule column of the table to display the Multicast Filtering Profile Rule
Configuration table.

Click the Add Last Rule button to display the Multicast Filtering Profile Rule Configuration page:

A
LANTRONIX" =| 7% wwwwwe e 2] M@ G
| SM8TBT2SA Multicast Filtering Profile Rule Configuration Fetioms - Multicsst - Mulicsst Filtering Profile - Fltering Profils Table
Switch DMS

Multicast Filtering Profile [Prof-1] Rule Settings

-

System

» Port Management < Delete Profile Name Entry Name Address Range Action Log

¥ PoE Management < ‘ Delete Prof-1 v NoEntries Deny v Disable
» VLAN Management <

» Quality of Service < Add Last Rule |

» Spanning Tree < Apply H Reset ” Back to Filtering Profile Table

PP I I

The IPMC profile is used to deploy the access control on IP multicast streams. It is allowed to create at
maximum 64 Profiles with at maximum 128 corresponding rules for each.

Parameter descriptions:
Profile Name: The name of the designated profile to be associated. This field is not editable.

Entry Name: The name used in specifying the address range used for this rule. Only the existing profile
address entries will be chosen in the selected box. This field is not allowed to be selected as none ("-")
while the Rule Settings Table is committed.

Address Range: The corresponding address range of the selected profile entry. This field is not editable
and will be adjusted automatically according to the selected profile entry.

Action: Select the learning action upon receiving the Join/Report frame that has the group address
matches the address range of the rule.

Permit. Group address matches the range specified in the rule will be learned.

Deny: Group address matches the range specified in the rule will be dropped.
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Log: Select the logging preference upon receiving the Join/Report frame that has the group address
matches the address range of the rule.

Enable: Corresponding information of the group address, that matches the range specified in the
rule, will be logged.

Disable: Corresponding information of the group address, that matches the range specified in the
rule, will not be logged.
Buttons

Add Last Rule: Click to add a new rule in the end of the specific profile's rule list. Specify the address
entry and configure the new entry. Click "Apply".

Delete: Check to delete the entry. The designated entry will be deleted during the next save.
Apply: Click to save changes.
Reset: Click to undo any changes made locally and revert to previously saved values.

Back to Filtering Profile Table: Click to return to previous page with no changes.
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10.3-1 Switch > Multicast > Multicast Filtering Profile > Filtering Address Entry

This page provides address range settings used in Multicast Filtering profile. The address entry is used to
specify the address range that will be associated with Multicast Filtering Profile. You can create up to 128
address entries in the system.

A
LANTQON | X ® = wNRONX ol il Auto-logout 9 C»
- .
SM24TBT4SA Multicast Filtering Profile Address Configuration @Home - Multicast - Multicast Filtering Profile - Filtering Adcless Entry
Switch DMS
Multicast Filtering Profile Table Setting
» System <
» Port Management < Delete Entry Name Start Address End Address
» PoE Management < | e |
» VLAN Management g
» Quality of Service < [ Add New Address (Range) Entry

» Spanning Tree

| Apply | Reset |

Parameter descriptions:
Delete: Click to delete the entry. The designated entry will be deleted during the next apply.

Entry Name: The name used for indexing the address entry table.
Each entry has the unique name which is composed of at maximum 16 alphabetic and numeric
characters.

Start Address: The starting IPv4/IPv6 Multicast Group Address that will be used as an address range.
End Address: The ending IPv4/IPv6 Multicast Group Address that will be used as an address range.

Buttons

Add New Address (Range) Entry: Click to add a new address range. Specify the name and configure
the addresses, then click "Apply".

Delete: Check to delete the entry. The designated entry will be deleted during the next save.
Apply: Click to save changes.
Reset: Click to undo any changes made locally and revert to previously saved values.
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10.4 MVR

» MVR
Multi VLAN Registration allows switches to automatically discover some of s Basic Confieuration
the VLAN information that would otherwise need to be manually configured. o

The MVR feature enables multicast traffic forwarding on the Multicast VLAN. s st

In a multicast television application, a PC or a television with a set-top box > MVR Channel Groups
can receive the multicast stream. > MVR SFM Information

Multiple set-top boxes or PCs can be connected to one subscriber port, which is a switch port configured
as an MVR receiver port. When a subscriber selects a channel, the set-top box or PC sends an IGMP join
message to Switch A to join the appropriate multicast. Uplink ports that send and receive multicast data to
and from the multicast VLAN are called MVR source ports.

10.4-1 Switch > MVR > Basic Configuration:

a
L/\NTQON'X = || wemomr T T ] mutologout [0FF_v| ) @ (G
- L
SM24TBT4SA MVR Basic Configuration @Home - Multicast - MVR - Basic Configuration
Switch DMS
MVR Mode [on @)
» System < -
» Port Management <
VLAN Interface Setting (Role [l:Inactive / S:Source / R:Receiver])
» PoE Management <
» VLAN Management < Interface
. . Ch I
» Quality of Service < A .. ar:me
Delete MVRVID MVR Name IGMP Address Mode Tagging Priority LLQI Profile
» Spanning Tree s
» MAC Address Table < |_‘ B -
» Multicast ¥ Port 1 2 3 4 5 6 7 & 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24 25 26 27 328
» IGMP Snooping <« Re B H BB DIODDNDNDNDDNDNNDODDDNDDDNDNDDDNDODODD

» MLD Snooping <

w MVR VLAN |

» MVR - ‘ e
> BT Immediate Leave Setting
> Statistics

> MVR Channel Groups Port Immediate Leave

> MVR SFM Information

,_.

» Multicast Filtering Profile ¢

2 =]
> Consoleflow
» DHCP o |3 )
» Security < 4 ~
» Access Control < 5 (]
» SNMP |6 9
» Event Notification < —

-

e e <

Global Setting

MVR Mode: Select on or off. The default is off. Enable/Disable the Global MVR. The Unregistered
Flooding control depends on the current configuration in IGMP/MLD Snooping. It is suggested to enable
Unregistered Flooding control when the MVR group table is full.

VLAN Interface Setting (Role [l:Inactive / S:Source / R:Receiver])

MVR VID: Enter the new VLAN ID for this new MVR VLAN. Caution: MVR source ports are not
recommended to be overlapped with management VLAN ports.

MVR Name: Enter a name for this new MVR VLAN. MVR Name is an optional attribute to indicate the
name of the specific MVR VLAN. Maximum length of the MVR VLAN Name string is 32. MVR VLAN
Name can only contain alphabets or numbers. MVR VLAN name can be edited for the existing MVR
VLAN entries or it can be added to the new entries.

IGMP Address: e.g., 192.168.1.40. Define the IPv4 address as source address used in IP header for
IGMP control frames. The default IGMP address is not set (0.0.0.0). When the IGMP address is not set,
system uses IPv4 management address of the IP interface associated with this VLAN. When the IPv4
management address is not set, system uses the first available IPv4 management address. Otherwise,
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system uses a pre-defined value. By default, this value will be 192.0.2.1.

Mode: At the dropdown select Dynamic or Compatible. The default is Dynamic. Specify the MVR mode
of operation. In Dynamic mode, MVR allows dynamic MVR membership reports on source ports. In
Compatible mode, MVR membership reports are forbidden on source ports. The default is Dynamic
mode.

Tagging: At the dropdown select Tagged or Untagged. The default is Tagged. Specify whether the
traversed IGMP/MLD control frames will be sent as Untagged or Tagged with MVR VID.

Priority: Enter 0 - 7. Specify how the traversed IGMP/MLD control frames will be sent in prioritized
manner. The default Priority is 0.

LLQI: Define the maximum time to wait for IGMP/MLD report memberships on a receiver port before
removing the port from multicast group membership. The value is in units of tenths of a seconds. The
range is 0 - 31744. The default LLQI is 5 tenths or one-half second.

Interface Channel Profile: At the dropdown select an existing Profile name. When the MVR VLAN is
created, select the profile to expand the corresponding multicast channel settings for the specific MVR
VLAN. The file established on Filtering Profile Table.

Port: The logical port for the settings.

Port Role: For each port choose a Role; each click displays the next role (I = Inactive, S = Source role,
and R = Receiver role). Configure an MVR port of the designated MVR VLAN as one of the following
roles.

Inactive: The designated port does not participate MVR operations.

Source: Configure uplink ports that receive and send multicast data as source ports. Subscribers
cannot be directly connected to source ports.

Receiver. Configure a port as a receiver port if it is a subscriber port and should only receive
multicast data. It does not receive data unless it becomes a member of the multicast group by
issuing IGMP/MLD messages.

Caution: MVR source ports are not recommended to be overlapped with management VLAN ports.
Select the port role by clicking the Role symbol to switch the setting. | indicates Inactive; S indicates
Source; R indicates Receiver. The default Role is Inactive.

Immediate Leave Setting

Port: The logical port for the settings.

Immediate Leave: Enable the fast leave on the port.

Buttons

Add New MVR VLAN: Click to add a new MVR VLAN entry to the table. Specify MVR VID, MVR Name,
IGMP Address, Mode, Tagging, Priority, LLQI, Interface Channel Profile. Click "Apply".

Delete: Check to delete the entry. The designated entry will be deleted during the next save.

Apply: Click to save changes.
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10.4-2 Switch > MVR > Statistics

This page displays the MVR detail Statistics that display after you have configured MVR on the switch.
It provides detailed MVR Statistics Information.

MVR Stat| Stlc 5 & Home Mubticast - MVE - Statistics
Auto-refresh
Statistics
IGMP/MLD IGMP/MLD IGMPv1
VLAN  Queries Queries Joins IGMPv2/MLDv1 IGMPv3/MLDv2 IGMPv2/MLDv1
D Received Transmitted Received Reports Received Reports Received Leaves Received
10 0,/0 1/1 0 0/0 0/0 0/0

VLAN ID: Displays the Multicast VID (VLAN ID).

IGMP/MLD Queries Received: The number of Received Queries for IGMP and MLD, respectively (e.g.,
xly).

IGMP/MLD Queries Transmitted: The number of Transmitted Queries for IGMP and MLD, respectively
(e.g., xly).

IGMPv1 Joins Received: The number of Received IGMPv1 Joins (e.g., 1 Join received).

IGMPv2/MLDv1 Reports Received: The number of Received IGMPv2 Join's and MLDv1 Reports,
respectively (e.g., x/y).

IGMPv3/MLDv2 Reports Received: The number of Received IGMPv3 Join's and MLDv2 Report's,
respectively.(e.g., x/y).

IGMPv2/MLDv1 Leaves Received: The number of Received IGMPv2 Leave's and MLDv1 Dones,
respectively (e.g., x/y).

Buttons
Auto-Refresh: Check this box to refresh the page automatically every 3 seconds.

Refresh: Click to manually refresh the page immediately.
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10.4-3 Switch > MVR > Group Information

This page displays MVR Groups detail information on the switch. Entries in the MVR Group Table are
shown on this page. The MVR Group Table is sorted first by VLAN ID, and then by group.

Each page shows entries from the MVR Group table, default being 10, selected through the "entries per
page" input field. When first visited, the web page will show the first 10 entries from the beginning of the
MVR Channels (Groups) Information Table.

The "Search" input fields let you select the starting point in the MVR Channels (Groups) Information
Table. It will update the displayed table starting from that or the closest next MVR Channels (Groups)
Information Table match.

a
LANT?ON'X — || o . Auto-logout H 0 &
- L ]
SM24TBT4SA MVR Groups Information Home - Multicast - MVR - MVR Channel Groups
Switch DMS —
Auto-refresh ‘ Refresh ‘
» System
Show 1« entries Search:

» Port Management

» PoE Management Port Members

»
VLA FrREETTETE VLANID* Group 1 2 3 4 5 6 7 & 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24 25 26 27 28

» Quality of Service
No data available in table

» Spanning Tree

» MAC Address Table Previous = Next

» Multicast v e}
» IGMP Snooping <

» MLD Snooping <

» MVR v

VLAN ID: Displays the VID (VLAN ID) of the group.
Group: Displays the Group ID of the group displayed.

Port Members: Indicates which ports are members (the Ports under this group).

Buttons

Show entries: You can choose how many items you want to show up.
Search: You can search for the information that you want to see.
Auto-refresh: Check to refresh the page automatically every 3 seconds.
Refresh: Click to manually refresh the page immediately.

Previous: Updates the system log entries, turn to the previous page.

Next: Updates the system log entries, turn to the next page.
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10.4-4 Switch > MVR > SFM Information

The MVR SFM (Source-Filtered Multicast) Information table also contains the SSM (Source-Specific
Multicast) information. This table is sorted first by VLAN ID, then by group, and then by Port.
Different source addresses belong to the same group are treated as single entry.

Each page shows up to 99 entries from the MVR SFM Information table, default being 10, selected
through the "entries per page" input field. When first visited, the web page will show the first 10 entries
from the beginning of the MVR SFM Information Table.

The "Search" input fields lets you select the starting point in the MVR SFM Information table. It will update
the displayed table starting from that or the closest next MVR SFM Information table match.

a
LANTRONIX =| “= ass oo [E 5] M @ G
- L
SM24TBT4SA MVR SFM Information @Home - Multicast - MVR - MVRSFM Information
Switch DMS
Auto-refresh ‘ Refresh |
» System E—
» Port Management < Show| 1+ entries Search:
}» PoE Management < VLAN ID 4 Group Port Mode Source Address Type Hardware Filter/Switch

> UL RiE: No data available in table

» Quality of Service <
) Previous | Next
» Spanning Tree 3

» MAC Address Table < 4«

» Multicast

VLAN ID: Displays the VID (VLAN ID) of the group.
Group: Displays the Group address of the group displayed.
Port: Indicates which ports are members.

Mode: Displays the filtering mode maintained per (VLAN ID, port number, Group Address) basis. It can be
either Include or Exclude.

Source Address: Displays the IP Address of the source. Currently, system limits the total number of IP
source addresses for filtering to be 128. When there is not any source filtering address, the text "None" is
shown in the Source Address field.

Type: Displays the configured type (either Allow or Deny).

Hardware Filter/Switch: Indicates whether data plane destined to the specific group address from the
source IPv4/IPv6 address could be handled by the chip.

Buttons

Auto-refresh: Check to refresh the page automatically every 3 seconds.
Refresh: Click to manually refresh the page immediately.

Show entries: You can choose how many items you want to show up.
Search: You can search for the information that you want to see.
Previous: Updates the system log entries, turn to the previous page.

Next: Updates the system log entries, turn to the next page.
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Chapter 11 Percepxion and LPM

This page lets you configure Percepxion parameters. This page has four sections: the Status,
Configuration, and Percepxion Connection 1 and Connection 2 sections as shown and described below.

Percepxion is Lantronix cloud-hosted or on-premise management platform that provides a single pane of
glass for centralized management and automated monitoring of deployed Lantronix products, along with
real-time notifications, managed APIs and data dashboards. For more information see
https://www.lantronix.com/percepxion/.

Lantronix Provisioning Manager (LPM) is a software application that provisions, configures and updates
Lantronix devices for local site installations and deployments. LPM discovery is enabled by default and is
not configurable. For more LPM information see https://www.lantronix.com/products/lantronix-
provisioning-manager/.

There are three pieces of information that the Percepxion client needs to complete registration and to
publish data and configuration to the Percepxion server: Serial Number, Device ID, and Device Key. The
Serial Number is always preprogrammed on the device (typically derived from the MAC address of the
first Ethernet port). A new device would also be preprogrammed with the Device ID and Key.

For existing devices where the ID and Key are not pre-programmed, LPM uses Lantronix proprietary
search and query protocol to get the device serial number, and then uses the switch REST API interface
to set the Device ID and Device Key.

11-1 Supported Firmware Versions

Devices must meet firmware requirements in order to work with Percepxion and LPM. The SMxTBTxSA
requires firmware v1.04.0110 or above.

11-2 Percepxion Agent Configuration

Navigate to Configuration > Percepxion > Percepxion Configuration to display the Percepxion Agent
Configuration page:

Status section:

A
LANTRONIX™ =| s M O G
- L L L
SM8TBT2SA Percepxion Agent Configuration @Home - Percepxion - Percepxion Config
Switch DMS
Status
» System <
» Port Management < Client state Running=br=Not registered - Device ID or Key not set
» PoE Management < Last status update 0 days 00:00:00
» VLAN Management ¢ Last content check 0 days 00:00:00
N . . <
Quality of Service Available Firmware updates None
» Spanning Tree < i . .
Available Configuration updates None
» MAC Address Table <

Status section:

Client state: Displays the existing Percepxion client state (e.g., Exited, Active, Inactive, Running, or Not
Registered).

Last status update: Displays the amount of time between status updates (e.g., 0 days 00:00:00 or <Not
Available>).

Last content check: Displays the amount of time between content checks (e.g., e.g., 0 days 00:00:00 or
<Not Available>).

Available Firmware updates: Displays a list of firmware that is available on the server. Select the
firmware from this list and click Update now to upgrade or downgrade the firmware. Displays <None> if no
Firmware updates are currently available.
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Available Configuration updates: Displays a list of configuration that is available on the server.
Select the configuration from this list and click Update now to upgrade or downgrade the firmware.
Displays <None> if no configuration updates are currently available.

Global Configuration section:

» Multicast ¢ Global Configuration
> Consoleflow
Enabled
» DHCP ¢
» Security & Device 1D ‘ |
» Access Control < Device Key ‘ |
y <
> SNMP Serial Number 0040C71D52E4
» Event Notification < .
Device Name SM24TBT4SA-52E4 |
» Diagnostics <
, . Device Description Lantronix SM24TBT45A |
» Maintenance

Status Update Interval (in minutes)
Content Check Interval (in minutes)

Apply Firmware Updates
Apply Configuration Updates

Active Connection Connection1

Parameter descriptions:
Enabled : Check the box to enable Percepxion globally. The default is disabled (unchecked).

Device ID: Displays the switch Device ID (read only). The Device ID may be provisioned through
Lantronix Provisioning Manager (LPM). Note: The Device ID can only be provisioned once. It will persist
across resets.

Device Key: Enter the key for the device; 32 alphanumeric characters. Note: Device Key may be

configured via the Lantronix Provision Manager (LPM). The entry field shows two icons:

o

—! : Click to Show the entered Device Key text.
Y

I : Click to Hide the entered Device Key text.
Serial Number : Displays the serial number of the switch in the format 0040C71D52E4. Read only.

Device Name : Enter a Percepxion Device Name for the switch of up to 32 alphanumeric characters
(e.g., SM24TBT4SA-52E4). Device Name can have only alphanumeric (a-z, A-Z, 0-9) characters,
hyphens (-), and underscores (_). Device Name must begin and end with an alphanumeric character.

Device Description : Enter a Percepxion Device Description for the switch of up to 32 alphanumeric
characters (e.g., Lantronix SM24TBT4SA).

Status Update Interval : Select the amount of time in minutes between status updates (1-1440 minutes).
The default is 1 minute. This is the frequency that the switch updates the device status to Percepxion.

Content Check Interval : Select the amount of time in minutes between content checks (1-56160
minutes). The default is 1 minute. This is the frequency that the switch checks Percepxion for updates to
configuration or firmware. The valid range is 1 hour — 2160 hours (90 days).

Apply Firmware Updates : Check the box to enable automatic switch firmware upgrades via Percepxion.
The default is enabled.

Apply Configuration Updates : Check the box to enable automatic switch configuration upgrades via
Percepxion. The default is enabled.
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Active Connection: At the dropdown select the configuration you want to be active (i.e., Connection 1 or
Connection 2. The default is Connection 1. This is the connection to use when connecting to Percepxion.
The configurable parameters for Connection 1 and Connection 2 are shown and described below.

Connection 1 and 2 sections:

Connection 1

Connect To Cloud v
Host |api‘pc—rcepxi0ﬂ,ai
Port 443

Secure Port

Validate Certificates

Connection 2

Connect To Cloud v
Host |api‘pc—rcepxi0ﬂ,ai
Port 443

Secure Port

Validate Certificates

| Apply H Reset

Connection 1:

Connect To : At the dropdown select the type of Percepxion connection to use for Connection 1 (Cloud
or On-premise). The default is Cloud connection. At the dropdown, select Cloud (default) or On-premise
as the Percepxion connection type for Connection 1. Percepxion is available in cloud or on-premise
installation. Choose cloud or on-premise setup according to the determination of your organization. See
the Percepxion Help page for more information.

Cloud setup connects you directly to the Percepxion server URL, allowing you to access your
devices through the Internet.

On-premise setup connects you to Percepxion through your organization's network. This means
you need to be physically "on-premises" to access your organization's network via Wi-Fi, or may
need to use a VPN connection. You may later view and update on-premise setup.

Host : Enter the IP address or host name of the Percepxion server for Connection 1. This is used by
Percepxion to register the switch.

Port : Enter the port number for Connection 1. The default is port 443.

Secure Port : Check the box to make the selected port a secure port for Connection 1. The default is
enabled.

Validate Certificates : Check the box to force using certificate validation for Connection 1. The default is
enabled. To validate certificates, Secure Port must be enabled.
Connection 2 :

Connect To : At the dropdown select the type of Percepxion connection to use for Connection 2 (Cloud
or On-premise). The default is Cloud connection. See the “Connect To” description in Connection 1
above.

Host : Enter the IP address of the Percepxion Host for Connection 2.

Port : Enter the port number for Connection 2 for Connection 2. The default is port 443.
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Secure Port : Check the box to make the selected port a secure port for Connection 2. The default is
enabled.

Validate Certificates : Check the box to enable using certificate validation of the Percepxion server
certificates. To validate certificates, Secure Port must be enabled. The default is enabled.

Buttons
Apply : Click to apply changes.
Reset : Click to undo any changes made locally and revert to previously saved values.

Messages:
device id : 32 alphanumeric characters
5

Status Update Interval 1 minute to 1 day (in minutes)

Content Check Interval is 1 minute to 90 days (in minutes)
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11-3 Percepxion Upload

Navigate to Configuration > Percepxion > Percepxion Upload to display the Percepxion Upload page.
This page lets you navigate to and upload a Percepxion Validate Certificates file.

Auto-logout H 9 c‘ ‘

LANTQON'X = “\1‘““’; L L L L L L L L : :

SM8TBT25A Percepxion Upload @ Home - Percepxion - Percepxion Upload
Switch DMS
File to Upload Choose File | No file chosen
b System

» Port Management < |

» PoE Management <

Parameter descriptions:
File to Upload: Click the Choose File button to navigate to and select a file to upload.

Upload File: Click the Upload File button to upload the chosen file.

33873 Rev. A https://www.lantronix.com/ Page 146 of 273



https://www.lantronix.com/

Lantronix SMXTBTxSA Web User Guide

Chapter 12 DHCP

This section lets you view and configure various DHCP parameters of the switch.
See also Appendix B DHCP Per Port on page 269. - ST

Configuration

P DHCP

Snooping Table

12-1 Snooping

> Statistics
12-1.1 Configuration » Relay
DHCP Snooping is used to block intruder on the untrusted ports of the switch device ? i
when it tries to intervene by injecting a bogus DHCP reply packet to a legitimate > Relay Statistics
conversation between the DHCP client and server. > Server
This page lets you configure the DHCP Snooping parameters of the switch. ; ServerStatus

DHCP Snooping can prevent attackers from adding their own DHCP servers to the network.
To configure DHCP snooping in the web Ul:

1. Click DHCP, Snooping, and Configuration.

2. Select “on” or “off” at the Snooping Mode selector.
3. Select “Trusted” or “Untrusted” for each port.

4. Click Apply.

LANTRONIX' =| "™ e  $888888888882822| » I H @ C

SM24TBT4SA DHCP Snooping Configuration @Home  DHCP - Srccping - Configuration
Switch DMS
Shooping Mode a}
» System < ’
» Port Management <
Port Mode Configuration
» PoE Management <
» VLAN Management < Port Mode
i i 4
» Quality of Service 1 Untrusted v
» Spanning Tree <
2 Trusted ~
» MAC Address Table <
» Multicast < 3 Trusted ~
> Consoleflow -
:
» DHCP v
» Snooping v 5 Trusted ~
> Configuration
6 Trusted ~
> Snooping Table
> Statistics T Trusted ~
» Relay <
8 Trusted ~
> Server
> Server Status 9 Trusted ~

Figure 12-1.1: DHCP Snooping Configuration

Parameter descriptions:

Snooping Mode : Indicates the DHCP snooping mode operation. Possible modes are:

on: Enable DHCP snooping mode operation. When DHCP snooping mode operation is enabled,
the DHCP request messages will be forwarded to trusted ports and only allow reply packets from
trusted ports.

off. Disable DHCP snooping mode operation.
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Port Mode Configuration: Indicates the DHCP snooping port mode. Possible port modes are:
Trusted: Configures the port as trusted source of the DHCP messages.
Untrusted: Configures the port as untrusted source of the DHCP messages.

Buttons
Apply : Click to save changes.
Reset : Click to undo any changes made locally and revert to previously saved values.
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12-1.2 Snooping Table

This page displays the dynamic IP assigned information after DHCP Snooping mode is disabled. All
DHCP clients obtained the dynamic IP address from the DHCP server will be listed in this table except for
local VLAN interface IP addresses. Entries in the Dynamic DHCP Snooping Table are shown on this

page.
To view the Dynamic DHCP Snooping Table in the web Ul:
1. Click DHCP, Snooping, and Snooping Table.

2. Use the buttons as needed.

Dynamic DHCP Snooping Table Biome  DHCP - Secopieg - Srccpeg Table
Auto-refresh
Show » | entries Search:
MAC Address * VLANID Port IP Address IP Subnet Mask DHCP Server
00-16-6C-D4-DD-C2 1 & 10.0.4.111 255.255.255.0 10.0.4.1

Figure 12-1.2: Dynamic DHCP Snooping Table
Parameter descriptions:
Show entries: You can choose how many items you want to show.
Search: You can search for the information that you want to see.
MAC Address: User MAC address of the entry.
VLAN ID: VLAN-ID in which the DHCP traffic is permitted.
Port: Switch Port Number for which the entries are displayed.
IP Address : User IP address of the entry.
IP Subnet Mask: User IP subnet mask of the entry.
DHCP Server: DHCP Server address of the entry.

Buttons Auto-refresh l Refresh ‘

Auto-refresh: Check to refresh the page automatically every 3
seconds.

Refresh: Click to manually refresh the page immediately.
Next: Updates the system log entries, turn to the next page.
Previous: Updates the system log entries, turn to the previous page.
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12-1.3 DHCP Detailed Statistics

This page provides statistics for DHCP snooping. Note that the normal forward per-port TX statistics are
not increased if the incoming DHCP packet is done by L3 forwarding mechanism. Also, a clear of the
statistics on a specific port may not take effect on global statistics since it gathers the different layer
overview.
To view detailed DHCP statistics via the web Ul:

1. Click DHCP, Snooping, and Detailed Statistics.

2. Use the Port select box to select the desired port.

Y
LANT?ON | X o — | wumonx ol il il Auto-logout (2 IS
- v
SM24TBT4SA DHCP Detail Statistics Port 1 @@Home - DHCP - Snooping - Statistics
Switch DMS —
Auto-refresh | Refresh | Clear Port 1 v
» System <
b Port Management < Receive Packets Transmit Packets
» PoE Management < Rx Discover 0 Tx Discover ]
» VLAN Management < Rx Offer 0 Tx Offer 0
. . <
» Quality of Service Rx Request 0 TX Request 0
» Spanning T ¢
panning free Rx Decline 0 Tx Decline 0
» MAC Address Table <
Rx ACK 0 TXACK 0
» Multicast <
Rx NAK 0 Tx NAK 0
> Consoleflow
» DHCP . Rx Release 0 Tx Release 0
» Snooping v Rx Inform 0 Tx Inform 0
> Configuration
Rx Lease Query 0 Tx Lease Query 0
> Snooping Table
» BEisiE Rx Lease Unassigned 0 Tx Lease Unassigned 0
statistics
» Relay < Rx Lease Unknow 0 Tx Lease Unknow 0
> Server Rx Lease Active 0 Tx Lease Active 0
> Server Status
Rx Discarded Checksum Error 0
» Security &
Rx Discarded from Untrusted 0
» Access Control &

Figure 12-1.2: Dynamic DHCP Snooping Table

Parameter descriptions:

Rx and Tx Discover: The number of discover (option 53 with value 1) packets received and transmitted.
Rx and Tx Offer: The number of offer (option 53 with value 2) packets received and transmitted.

Rx and Tx Request: The number of request (option 53 with value 3) packets received and transmitted.
Rx and Tx Decline: The number of decline (option 53 with value 4) packets received and transmitted.
Rx and Tx ACK: The number of ACK (option 53 with value 5) packets received and transmitted.

Rx and Tx NAK: The number of NAK (option 53 with value 6) packets received and transmitted.

Rx and Tx Release: The number of release (option 53 with value 7) packets received and transmitted.
Rx and Tx Inform: The number of inform (option 53 with value 8) packets received and transmitted.

Rx and Tx Lease Query: The number of lease query (option 53 with value 10) packets received and
transmitted.

Rx and Tx Lease Unassigned: The number of lease unassigned (option 53 with value 11) packets
received and transmitted.
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Rx and Tx Lease Unknown: The number of lease unknown (option 53 with value 12) packets received
and transmitted.

Rx and Tx Lease Active: The number of lease active (option 53 with value 13) packets received and
transmitted.

Rx Discarded checksum error: The number of discard packet that IP/UDP checksum is error.
Rx Discarded from Untrusted: The number of discarded packets that are coming from untrusted port.

Buttons

Port1 ﬂ

Statistics.

: Use the Port select box to select the port that you want to display the DHCP Detailed

Auto-refresh: Check to refresh the page automatically every 3 seconds.

Refresh: Click to manually refresh the page immediately.
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12-1.4 DHCP Relay Configuration

Navigate to the Switch > DHCP > Relay menu path to display the DHCP Relay Configuration table. Here
you can configure the DHCP Relay function.

A DHCP relay agent is used to forward and to transfer DHCP messages between the clients and the
server when they are not in the same subnet domain. It stores the incoming interface IP address in the
GIADDR field of the DHCP packet. The DHCP server can use the value of GIADDR field to determine the
assigned subnet. For such condition, please make sure the switch configuration of VLAN interface IP
address and PVID(Port VLAN ID) correctly.

A
LANTRONIX® =] “= ses wotown (7 <1 M@ G
- v
SM24TBT4SA DHCP Relay Configuration @Home - DHCP - Relay - Configuration
Switch DMS -
Relay Mode ﬁ )
b Systermn < i
» Port Management < Relay Server 0.0.0.0
» PoE Management € ~
z Relay Information Mode ﬁ‘)
» VLAN Management «
» Quality of Service < Relay Information Policy
» Spanning Tree <

-

Apply H Reset

MAC Address Table <

Parameters:

Relay Mode: Select on or off. The default is off. Indicates the DHCP relay mode operation. Possible
modes are:

On: Enable DHCP relay mode operation. When DHCP relay mode operation is enabled, the agent
forwards and transfers DHCP messages between the clients and the server when they are not in the
same subnet domain. And the DHCP broadcast message won't be flooded for security
considerations.

Off: Disable DHCP relay mode operation.
Relay Server: Enter the DHCP Relay server IP address.

Relay Information Mode: Select on or off. The default is off. Indicates the DHCP relay information mode
option operation. The option 82 circuit ID format as "[vlan_id][module_id][port_no]". The first four
characters represent the VLAN ID, the fifth and sixth characters are the module ID (always 0), and the
last two characters are the port number. For example, "00030108" means the DHCP message receive
form VLAN ID 3, switch ID 1, port No 8. And the option 82 remote ID value is equal the switch MAC
address. Possible modes are:

Enabled: Enable DHCP relay information mode operation. When DHCP relay information mode
operation is enabled, the agent inserts specific information (option 82) into a DHCP message when
forwarding to DHCP server and removes it from a DHCP message when transferring to DHCP
client. It only works when DHCP relay operation mode is enabled.

Disabled: Disable DHCP relay information mode operation.

Relay Information Policy:At the dropdown, select Replace, Keep, or Drop. Indicates the DHCP relay
information mode option operation. The option 82 circuit ID format as "[vlan_id][module_id][port_no]". The
first four characters represent the VLAN ID, the fifth and sixth characters are the module ID(in standalone
device it always equals 0, in stackable device it means switch ID), and the last two characters are the port
number. For example, "00030108" means the DHCP message receive form VLAN ID 3, switch ID 1, port
No 8. And the option 82 remote ID value is equal the switch MAC address.

Possible modes are:

Replace: Replace the original relay information when a DHCP message that already contains it is
received.
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Keep: Keep the original relay information when a DHCP message that already contains it is
received.

Drop: Drop the package when a DHCP message that already contains relay information is received.

Buttons
Apply: Click to save changes.
Reset: Click to undo any changes made locally and revert to previously saved values.
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12-1.5 DHCP Relay Statistics

Navigate to the Switch > DHCP > Relay > Relay Statistics menu path to display the DHCP Relay
Statistics table. This page provides statistics for DHCP relay.

A
| LANT?ON'X = LANTRONIX ol ol ol Auto-logout H 9 C.
— L
SM24TBT4SA DHCP Relay Statistics
Switch DMS —
Auto-refresh | Refresh ‘ Clear

b Systemn <
» Port Management € SelverSatistics
» PoE Management ¢ Transmitto Transmit Receive from Receive Missing Agent  Receive Missing Receive Missing
» VLAN Management < Server Error Server Option Circuit ID Remote ID
» Quality of Service < 0 0 0 0 0 0
» Spanning Tree <

Client Statistics

-

MAC Address Table <

» Multicast ¢ Transmit to Transmit Receive from Receive Agent Replace Agent Keep Agent Drop Agent
> Consoleflow Client Error Client Option Option Option Optien
» DHCP ¥ o0 0 0 0 0 0 0

» Snooping <

Server Statistics Parameters:

Transmit to Server: The number of packets that are relayed from client to server.

Transmit Error: The number of packets that resulted in error while being relayed from client to server.
Receive from Server: The number of packets received from server.

Receive Missing Agent Option: The number of packets received without agent information options.
Receive Missing Circuit ID: The number of packets received with the Circuit ID option missing.
Receive Missing Remote ID: The number of packets received with the Remote ID option missing.

Client Statistics Parameters:

Transmit to Client: The number of relayed packets from server to client.

Transmit Error: The number of packets that resulted in error while being sent to servers.
Receive from Client: The number of received packets from server.

Receive Agent Option: The number of received packets with relay agent information option.

Replace Agent Option: The number of packets which were replaced with relay agent information option.

Keep Agent Option: The number of packets whose relay agent information was retained.

Drop Agent Option: The number of packets that were dropped which were received with relay agent
information.

Buttons

Auto-refresh: Check to refresh the page automatically every 3 seconds.
Refresh: Click to manually refresh the page immediately.

Clear: Click to clear the page data.
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12-1.6 DHCP Server

Navigate to the Switch > DHCP > Server menu path to display the DHCP Server Configuration table.
Here you can add and configure new DHCP servers. Click the Add Interface button to start.

This page lets you enable or disable DHCP servers per system and per VLAN and configure Start IP and
End IP addresses. A DHCP server will allocate these IP addresses to the DHCP client and deliver
configuration parameters to the DHCP client.

LANTRONIX" =| % wwwewews £ 2 oo @55 H
SM8TBT2SA DHCP Server Configuration Brome P
Switch DMS

Interfaces
» System

» Port) Delete VLAN Mode Start IP End IP Lease time Subnet mask Default router DNS server

» PoEb

b VLAN
» Quality of Service

» Spanning Tree <

Delete: Check to delete the entry. It will be deleted during the next save.

VLAN: Enter the VLAN ID (VID) for this instance. Configure the VLAN in which a DHCP server is enabled
or disabled. Allowed VLAN are in the range 1 - 4095.

Mode: Indicates the operation mode per VLAN. Possible modes are:
Enable: Enable DHCP server per VLAN.
Disable: Disable DHCP server per VLAN. The default is Disabled.

Start IP: Enter the starting IP address for the range. The Start IP must be smaller than or equal to the
End IP.

End IP: Enter the ending IP address for the range.

Lease time: Enter a valid DHCP lease time of the DHCP Server. Value range between 1 and 8640000
hours.

Subnet mask: Enter the Subnet mask.
Default router: Enter the default router IP address.

DNS server: Enter the destination IP network or host address of this route.

Buttons

Add Interface: Click the button to create and configure an instance.

Apply: Click to save changes.

Reset: Click to undo any changes made locally and revert to previously saved values.

Messages:
This field is required.
ERROR: Not Found
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12-1.7 DHCP Server Status
Navigate to the Switch > DHCP > Server Status menu path to display the current DHCP Server Status.

DHCP Server Status @rome - DHCP - Server Status

Auto-refresh
Interfaces

VLAN Type Start 1P End IP Lease time Subnet mask Default router DMS server

1 Static 182.168.2.1 192.168.2.10 5 255.255.255.0 1234 1.2.3.6

Parameters:

VLAN: The VLAN ID of the entry.

Type: Indicates the operation type per VLAN. Possible types are: Static and DMS.
Start IP and End IP: Display the Start IP and the End IP.

Lease time: Displays lease time of the pool.

Subnet mask: Displays subnet mask of the DHCP address.

Default router: Displays the destination IP network or host address of this route.
DNS server: Displays DNS server.

Buttons
Auto-refresh: Check to refresh the page automatically every 3 seconds.

Refresh: Click to manually refresh the page immediately.
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Chapter 13 Security

» Security
This section lets you configure switch Security settings. You can use the Security features » Management
to restrict input to an interface by limiting and identifying MAC addresses. > IEEE 802.1X

3

b

IP Source Guard
13-1 Management

13-1.1 Account

3

b

ARP Inspection

» Port Security
This page displays current users and lets you add, edit, and delete users. Currently the » RADIUS
only way to login as another user on the web server is to close and reopen the browser. ACACS

® 1A +

To add a new User via the Web UI:
1. Click Security, Management, and Account.
2. Click the Add New User button to display the Add User webpage.
3. Specify the User Name, Password (twice) and Privilege Level parameters.
4. Click Apply.

LANTRONIX™ = s niotomit [0 <] B @ G|

L L L
SM8TBT28A Add User @ Home - Security -~ Management - Account
Switch DMS
User Settings
» System
» Port Management < User Name
lanag <
» PoE Management Password

» VLAN Management <
Confirm Password
» Quality of Service <
» Spanning Tree < Privilege Level 0 v

» MAC Address Table <

Reset ‘ Cancel

~

» Multicast ‘ Apply

Figure 13-1.1: Account Configuration — Add User

Parameter descriptions:
User Name: The name identifying the user. This is also a link to Add/Edit User webpage.

Password: Type the password. The allowed string length is 0 — 255 characters, and the allowed content
is the ASCII characters 32 - 126.

Confirm Password: Type the password again. You must type the same password again in the field.

Privilege Level: The privilege level of the user. The valid range is 0 - 15. If the privilege level value is 15,
it can access all groups, i.e. that is granted the fully control of the device. But others value must refer to
each group privilege level. User's privilege should be same or greater than the group privilege level to
have the access of that group. By default, most groups are at privilege level 5 and have read-only access
and privilege level 10 has the read-write access. The system maintenance (software upload, factory
defaults and etc.) need user privilege level 15. Generally, privilege level 15 can be used for an admin
account, privilege level 10 for a standard user account and privilege level 5 for a guest account.
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Buttons

Apply: Click to save changes.

Reset: Click to undo any changes made locally and revert to previously saved values.

Cancel: Click to undo any changes made locally and return to the Users.

Delete User: Delete the current user. This button is not available for new configurations (Add New User).

Edit a User page:

Ed[t User @ Home - Security - Management - Account

User Settings

User Name s
Password

Confirm Password

Privilege Level 15w
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13-1.2 Privilege Level

The Security > Management > Privilege Level menu path displays the Privilege Level Configuration table.
Here you can assign Read-Only or Read-Write privilege levels for each of the major functions. This page
lets you set Group Name Privilege Levels from 0 to 15.

LANTRONIX' = % wewwee werenor 1 B O G

SM8TBT2SA Pri\f“ege Level Configuration @Home - Security ~ Management - Privilege Level
Switch DMS
Privilege Level
» System <
Group Name Read-Only Read-Write
» Port Management <
» PoE Management < access-mgmt 5 0 v
» <
VLAN Management account 5 - .
» Quality of Service <
. acl 5 v 10 ~
» Spanning Tree <
» MAC Address Table < arp-inspection 5 v 10 v
» Multicast <
auth-method 5 v 10 v
» Percepxion <
dhep-rela 5 v 10~
» DHCP < prreay
b Security v dhcp-server 5 v 10 ~ |
» Management v |
N — dhcp-snooping 5 v 10 v

Drivile arE
> Privilege Level Hinonnctie £ o Mmoo

Parameter descriptions:

Group Name: The name identifying the privilege group. In most cases, a privilege level group consists of
a single module (e.g. LACP, STP or QoS), but a few of them contains more than one. The following
description defines these privilege level groups in detail: System: Contact, Name, Location, Timezone,
Daylight Saving Time, Log.

Privilege Levels: Every group has an authorization Privilege level for the following sub groups:
configuration read-only, configuration/execute read-write. User Privilege should be same or greater than
the authorization Privilege level to have the access to that group.

Read-Only: At the dropdown select a privilege level of 0-15 for any function (access-mgmt, account, arp-
inspection, etc.) that you want to change from the default value.

Read-Write: At the dropdown select a privilege level of 0-15 for any function (access-mgmt, account, arp-
inspection, etc.) that you want to change from the default value.

Buttons
Apply: Click to save changes.
Reset: Click to undo any changes made locally and revert to previously saved values.
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13-1.3 Auth Method

The Security > Management > Auth Method menu path displays the Auth Method Configuration tables,
where you can configure an authentication method (none, local, or radius) for each client (telnet, ssh,
http, https). You can also configure a service port number for telnet, ssh, http, and https clients, and
enable the HTTPS Redirect function on this page. The page also provides the Command Authorization
Method Configuration table and the Accounting Method Configuration table.

Y
LANTRONIX™ =| 7% S -
- L L L
SM8TBT2SA Auth Method Configuration geHome - Security - Management - Auth Method
Switch DMS
Authentication Method Configuration
» System <
» Port Management < Client Methods Service Port
» PoE Management ¢ telnet local v no v no v 23
» VLAN Management &
ssh local v no v no v 22
» Quality of Service <
» Spanning Tree < http local v no v no v 20
» MAC Address Table ¢ https ocal v e - . - s
» Multicast <
» Percepxion ¢ Command Authorization Method Configuration
» DHCP ¢ i
Client Methods Cmd Lvl CfgCmd Fallback
» Security s
» Management v telnet no ~ 0 \:| \:|
> Account J— —
ssh no ~ 0 [} [}
> Privilege Level
> Auth Method

Accounting Method Configuration
> Access Management

» |EEE 802.1X < Client Methods Cmd Lvl Exec
» |P Source Guard <

telnet 0 ]
» ARP Inspection < ene " - -
» Port Security < ssh no v 0 O

Section descriptions:

Authentication Method Configuration: The authentication section allows you to configure how a user is
authenticated when he logs into the switch via one of the management client interfaces. The table has
one row for each client type and several columns.

Command Authorization Method Configuration: The command authorization section allows you to limit
the CLI commands available to a user. The table has one row for each client type and several columns.

Accounting Method Configuration: The accounting section allows you to configure command and exec
(login) accounting. The table has one row for each client type and several columns,
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Parameter descriptions:

Methods: Select an authentication method (none, local, radius, or tacacs) for each client (telnet, ssh,
http, https). In the Command Authorization Method Configuration table and the Accounting Method
Configuration table, select a Method for telnet or ssh only (none or tacacs). The Method can be set to one
of the following values:

no: Authentication is disabled and login is not possible. o
local: Use the local user database on the switch for authentication.
radius: Use remote RADIUS server(s) for authentication. Remote Authentication Dial In User ragiE

Service is a networking protocol that provides centralized access, authorization and
accounting management for people or computers to connect and use a network service. L=

tacacs: Use remote TACACS+ server(s) for authentication. Terminal Access Controller Access Control
System Plus. It is a networking protocol which provides access control for routers, network access
servers and other networked computing devices via one or more centralized servers. TACACS+
provides separate authentication, authorization and accounting services.

redirect. enable HTTP Automatic Redirect to HTTPS (secure HTTP).

Methods that involve remote servers are timed out if the remote servers are offline. In this case, the next
method is tried. Each method is tried from left to right and continues until a method either approves or
rejects a user. If a remote server is used for ‘primary’ authentication, it is recommended to configure
secondary authentication as 'local'. This lets the management client login via the local user database if
none of the configured authentication servers are alive.

Service Port: Enter a service port number for telnet, ssh, http, and https clients as required.

Cmd Lvl: Authorize all commands with a privilege level higher than or equal to this level. Valid values are
0 - 15. Runs accounting for all commands at the specified privilege level. Specific command level that
should be authorized. Valid entries are 0 through 15.

Cfg Cmd: Check to also authorize configuration commands.
Fallback: Check the box to Enable the fallback mechanism.

Exec: Check the box to Enable exec (login) accounting. Runs accounting to determine if the user is
allowed to run an EXEC shell. This facility might return user profile information such as auto command
information.

Method: Accounting Method can be set to one of the following values:
no : accounting is disabled and login is not possible.
tacacs : use a remote TACACS server for accounting.

Cmd Lvl: Runs accounting for all commands at the specified privilege level. Specific command level that
should be authorized. Valid entries are 0 through 15.

Exec: Runs accounting to determine if the user is allowed to run an EXEC shell. This facility might return
user profile information such as auto command information.

Buttons
Apply: Click to save changes.
Reset: Click to undo any changes made locally and revert to previously saved values.
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13-1.4 Access Management

This section shows you how to configure access management table of the Switch including
HTTP/HTTPS, SNMP, and TELNET/SSH. You can manage the Switch over an Ethernet LAN or over the
Internet.
To configure Access Management in the web Ul:

1. Click Security, Management, Access Management.

2. Select “on” in the Mode of Access Management Configuration.
3. Click “Add New Entry”.
4. Checked Access Management method (HTTP/HTTPS, SNMP, and TELNET/SSH) in the entry.
5. Click Apply.
Access Management Configuration BT A0Sy MEAREETASL  AEIL BT
Delere WL 0 I Eddress bl aik Ll\:l!‘._;ll"' HITHHTTFS SNMP TELHET/55H

L L "

Figure 13-1.2: Access Management Configuration
Parameter descriptions:

Mode: Indicates the access management mode operation. Possible modes are:
On: Enable access management mode operation.
Off. Disable access management mode operation.

VLAN ID: Indicates the VLAN ID for the access management entry.
Delete: Check to delete the entry. It will be deleted during the next save.
IP address: Enter the source IP address.

Mask Length: Enter the Mask Length (1-32).

HTTP/HTTPS: Indicates that the host can access the switch from HTTP/HTTPS interface if the host IP
address matches the IP address range provided in the entry.

SNMP: Indicates that the host can access the switch from SNMP interface if the host IP address matches
the IP address range provided in the entry.

TELNET/SSH: Indicates that the host can access the switch from TELNET/SSH interface if the host IP
address matches the IP address range provided in the entry.

Note: When modifying authentication method behavior for telnet/ssh/http/https, the connection is closed if
configuring the first field of Method to "none".

Note: You cannot login if downgrading the switch to older firmware versions or loading an old config file in
new firmware.
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Buttons
Add New Entry: Click to add a new access management entry.

Apply: Click to save changes.
Reset: Click to undo any changes made locally and revert to previously saved values.
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13-2 IEEE 802.1X

13-2.1 Configuration

This page lets you configure 802.1X parameters of the switch. You can use 802.1X to connect users to a
variety of resources including Internet access, conference calls, printing documents on shared printers, or
logging on to the Internet.

To configure IEEE 802.1X in the web Ul:

1.

o0k wN

802.1X Configuration

3 afraci

System Configuration

Click Security, IEEE 802.1X, Configuration.

Select “on” in the Mode of IEEE 802.1X Configuration.
Set the System Configuration section parameters.

Set the Port Configuration parameters.

Click the Apply button to save the settings.

To cancel the setting click the Reset button to revert to previously saved values.

@ Home - Security - ISEEB02.1X - Configurstion

Mode L on @)

Reauthentication Enabled vl

Reauthentication Period 3600 seconds

EAPOL Timeout 20 seconds

RADIUS-Assigned VLAN Enabled O

Guest VLAN Enabled (v

Guest VLAN ID 1

Max. Reauth. Count 2

Allow Guest VLAN if EAPOL Seen (]

Port Configuration

Port Admin State RADIUS-Assigned Guest VLAN Port State Restart

VLAN Enabled Enabled

1 Force Authorized  w | [ O Link Down | i i |

2 Multi 802 1% v [ +) Link Down | | | |

3 Force Authorized v [ (w) Authorized | | | |

4 Portbased2021X v [ ] J Link Down | Reauthenticate | | Reinitialize |
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Parameter descriptions:

System Configuration

Mode: Select on or off. Indicates if IEEE 802.1X is globally enabled or disabled on the switch. If globally
disabled, all ports are allowed forwarding of frames.

Reauthentication Enabled: If checked, successfully authenticated supplicants/clients are
reauthenticated after the interval specified by the Reauthentication Period. Reauthentication for 802.1X-
enabled ports can be used to detect if a new device is plugged into a switch port or if a supplicant is no
longer attached.

For MAC-based ports, reauthentication is only useful if the RADIUS server configuration has changed.
It does not involve communication between the switch and the client, and therefore doesn't imply that a
client is still present on a port (see Aging Period below).

Reauthentication Period: Determines the period, in seconds, after which a connected client must be
reauthenticated. This is only active if the Reauthentication Enabled checkbox is checked. Valid values are
in the range 1 to 3600 seconds.

EAPOL Timeout: Determines the time for retransmission of Request Identity EAPOL frames. Valid values
are in the range 1 to 255 seconds. This has no effect for MAC-based ports.

RADIUS-Assigned VLAN Enabled : RADIUS-assigned VLAN provides a means to centrally control the
VLAN on which a successfully authenticated supplicant is placed on the switch. Incoming traffic will be
classified to and switched on the RADIUS-assigned VLAN. The RADIUS server must be configured to
transmit special RADIUS attributes to take advantage of this feature.

The "RADIUS-Assigned VLAN Enabled" checkbox provides a quick way to globally enable/disable
RADIUS-server assigned VLAN functionality. When checked, the individual ports' ditto setting determines
whether RADIUS-assigned VLAN is enabled on that port. When unchecked, RADIUS-server assigned
VLAN is disabled on all ports.

Guest VLAN Enabled: A Guest VLAN is a special VLAN - typically with limited network access - on which
802.1X-unaware clients are placed after a network administrator-defined timeout. The switch follows a set
of rules for entering and leaving the Guest VLAN as listed below.

The "Guest VLAN Enabled" checkbox provides a quick way to globally enable/disable Guest VLAN
functionality. When checked, the individual ports' ditto setting determines whether the port can be moved
into Guest VLAN. When unchecked, the ability to move to the Guest VLAN is disabled on all ports.

Guest VLAN ID: This is the value that a port's Port VLAN ID is set to if a port is moved into the Guest
VLAN. It is only changeabile if the Guest VLAN option is globally enabled. Valid values are 1- 4094.

Max. Reauth. Count: The number of times the switch transmits an EAPOL Request Identity frame
without response before considering entering the Guest VLAN is adjusted with this setting. The value can
only be changed if the Guest VLAN option is globally enabled. Valid values are in the range [1; 255].

Allow Guest VLAN if EAPOL Seen: The switch remembers if an EAPOL frame has been received on the
port for the life-time of the port. Once the switch considers whether to enter the Guest VLAN, it will first
check if this option is enabled or disabled. If disabled (unchecked; default), the switch will only enter the
Guest VLAN if an EAPOL frame has not been received on the port for the life-time of the port. If enabled
(checked), the switch will consider entering the Guest VLAN even if an EAPOL frame has been received
on the port for the life-time of the port. The value can only be changed if the Guest VLAN option is
globally enabled.
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Port Configuration

Port: The port number for which the configuration below applies.

Admin State: If 802.1X is globally enabled, this selection controls the port's authentication mode.
These modes are available:

Force Authorized: In this mode, the switch will send one EAPOL Success frame when the port
link comes up, and any client on the port will be allowed network access without authentication.

Force Unauthorized: In this mode, the switch will send one EAPOL Failure frame when the port
link comes up, and any client on the port will be disallowed network access.

Port-based 802.1X: In the 802.1X-world, the user is called the supplicant, the switch is the
authenticator, and the RADIUS server is the authentication server. The authenticator acts as the
man-in-the-middle, forwarding requests and responses between the supplicant and the
authentication server. Frames sent between the supplicant and the switch are special 802.1X
frames, known as EAPOL (EAP Over LANs) frames. EAPOL frames encapsulate EAP PDUs
(RFC3748). Frames sent between the switch and the RADIUS server are RADIUS packets.
RADIUS packets also encapsulate EAP PDUs together with other attributes like the switch's IP
address, name, and the supplicant's port number on the switch. EAP is very flexible, in that it
allows for different authentication methods, like MD5-Challenge, PEAP, and TLS. The important
thing is that the authenticator (the switch) doesn't need to know which authentication method the
supplicant and the authentication server are using, or how many information exchange frames
are needed for a particular method. The switch simply encapsulates the EAP part of the frame
into the relevant type (EAPOL or RADIUS) and forwards it.

When authentication is complete, the RADIUS server sends a special packet containing a
success or failure indication. Besides forwarding this decision to the supplicant, the switch uses it
to open or block traffic on the switch port connected to the supplicant.

NOTE: Suppose two backend servers are enabled and that the server timeout is
configured to X seconds (using the AAA configuration page) and suppose that the first
server in the list is currently down (but not considered dead).

Now, if the supplicant retransmits EAPOL Start frames at a rate faster than X seconds, then
it will never get authenticated, because the switch will cancel on-going backend
authentication server requests whenever it receives a new EAPOL Start frame from the
supplicant.

And since the server hasn't yet failed (because the X seconds haven't expired), the same
server will be contacted upon the next backend authentication server request from the
switch. This scenario will loop forever. Therefore, the server timeout should be smaller than
the supplicant's EAPOL Start frame retransmission rate.

Guest VLAN Enabled

When Guest VLAN is both globally enabled and enabled (checked) for a given port, the switch considers
moving the port into the Guest VLAN according to the rules outlined below.
This option is only available for EAPOL-based modes, i.e.:

° Port-based 802.1X
. Single 802.1X
. Multi 802.1X

For troubleshooting VLAN assignments, see "6-2 VLAN Membership” on page 72 and 6-3 VLAN Port
Status on page 74. These pages show which modules have (temporarily) overridden the current Port
VLAN configuration.

Guest VLAN Operation:

When a Guest VLAN enabled port's link comes up, the switch starts transmitting EAPOL Request Identity
frames. If the number of transmissions of such frames exceeds Max. Reauth. Count and no EAPOL
frames have been received in the meanwhile, the switch considers entering the Guest VLAN. The interval
between transmission of EAPOL Request Identity frames is configured with EAPOL Timeout. If Allow
Guest VLAN if EAPOL Seen is enabled, the port will now be placed in the Guest VLAN. If disabled, the

33873 Rev. A https://www.lantronix.com/ Page 166 of 273



https://www.lantronix.com/
http://192.168.1.1/help/help_nas.htm#Enabled
http://www.ietf.org/rfc/rfc3748
http://www.ietf.org/rfc/rfc2865.txt
http://www.ietf.org/rfc/rfc3748
http://www.ietf.org/rfc/rfc2716.txt
http://192.168.1.206/help/guest_vlan_glbl
http://192.168.1.206/help/help_nas.htm#eapol_timeout

Lantronix SMXTBTxSA Web User Guide

switch will first check its history to see if an EAPOL frame has previously been received on the port (this
history is cleared if the port link goes down or the port's Admin State is changed), and if not, the port will
be placed in the Guest VLAN. Otherwise it will not move to the Guest VLAN but continue transmitting
EAPOL Request Identity frames at the rate given by EAPOL Timeout.

Once in the Guest VLAN, the port is considered authenticated, and all attached clients on the port are
allowed access on this VLAN. The switch will not transmit an EAPOL Success frame when entering the
Guest VLAN.

While in the Guest VLAN, the switch monitors the link for EAPOL frames, and if one such frame is
received, the switch immediately takes the port out of the Guest VLAN and starts authenticating the
supplicant according to the port mode. If an EAPOL frame is received, the port will never be able to go
back into the Guest VLAN if the "Allow Guest VLAN if EAPOL Seen" is disabled.

Port State : The current state of the port. It can undertake one of the following values:
Globally Disabled: IEEE 802.1X is globally disabled.
Link Down: IEEE 802.1X is globally enabled, but there is no link on the port.

Authorized: The port is in Force Authorized or a single-supplicant mode and the supplicant is
authorized.

Unauthorized: The port is in Force Unauthorized or a single-supplicant mode and the supplicant
is not successfully authorized by the RADIUS server.

X Auth/Y Unauth: The port is in a multi-supplicant mode. Currently X clients are authorized and
Y are unauthorized.

Restart: Two buttons are available for each row. The buttons are only enabled when authentication is
globally enabled and the port's Admin State is in an EAPOL-based or MAC-based mode. Clicking these
buttons will not cause settings changed on the page to take effect.
Re-authenticate: Schedules a re-authentication whenever the quiet-period of the port runs out
(EAPOL-based authentication). For MAC-based authentication, re-authentication will be attempted
immediately. The button only has effect for successfully authenticated clients on the port and will not
cause the clients to get temporarily unauthorized.
Reinitialize: Forces a re-initialization of the clients on the port and thereby a re-authentication
immediately. The clients will transfer to the unauthorized state while the re-authentication is in
progress.

Buttons
Apply : Click to save changes.

Reset : Click to undo any changes made locally and revert to previously saved values.
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13-2.2 Status

This page displays 802.1X status information for each switch port. The status includes Admin State, Port
State, Last Source, Last ID and Port VLAN ID. To display 802.1X Status in the web Ul:

1. Click Security, IEEE 802.1X, Status.

2. Check “Auto-refresh” if desired.

3. Click “Refresh” to refresh the port detailed statistics.

4. Select which port that you want display 802.1X Statistics.

802.1X Status @rome  Secwwy  CEERSILN  Suma

Port Admin State Port State Last Source LastID Port VLAN ID

Figure 13-2.2: IEEE 802.1X Status
Parameter descriptions:
Port: The switch port number. Click to navigate to detailed 802.1X statistics for this port.

Admin State: The port's current administrative state. Refer to 802.1X Admin State above for a description
of possible values.

Port State: The current state of the port. Refer to 802.1X Port State above for a description of the
individual states.

Last Source: The source MAC address carried in the most recently received EAPOL frame for EAPOL-
based authentication, and the most recently received frame from a new client for MAC-based
authentication.

Last ID: The user name (supplicant identity) carried in the most recently received Response Identity
EAPOL frame for EAPOL-based authentication, and the source MAC address from the most recently
received frame from a new client for MAC-based authentication.

Port VLAN ID: The VLAN ID that 802.1X has put the port in. The field is blank if the Port VLAN ID is not
overridden by 802.1X. If the VLAN ID is assigned by the RADIUS server, "(RADIUS-assigned)" is
appended to the VLAN ID. If the port is moved to the Guest VLAN, "(Guest)" is appended to the VLAN ID.
Read more about Guest VLANSs here.

Buttons
Auto-refresh: Check to refresh the page automatically every 3 seconds.

Refresh: Click to manually refresh the page immediately.
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Example: Click a linked Port number to display its individual port statistics:

802.1X Statistics Port 3 @meme  Ieecty THELL Pens

Admin State

Port State Authorzed

» Spa g Tree ‘ Port Counters

Receive EAPOL Counters Tranumit EAPOL Counters
Total 0 Total

Resporse 1D 0 Rewponse |D

Responies . Requests

Start

Lopo®

Invalid Type

Invalid Length

Receive Backend Server Tranymit Backend Server

Counters Counters
Access Challenges 0 Reponies
Other Requests

b Event Notificat < Auth. Successes

» MENOALRCH . Auth. Failures

Supplicant info

MAL Address

VLAN ID

WVersion

Identity

Figure 13-2.3: 802.1X Statistics
Parameter descriptions:
Port State:
Port: You can select which port that you want display 802.1X Statistics.

Admin State: The port's current administrative state. Refer to 802.1X Admin State for a description of
possible values.

Port State: The current state of the port. Refer to 802.1X Port State for a description of the individual
states.

Port Counters: Displays Received and Transmitted EAPOL Counters, Received and Transmitted
Backend Server Counters, and Supplicant Info.

Buttons:

Auto-refresh: Check this box to refresh the page automatically every 3 seconds.

Refresh: : Click to manually refresh the page immediately.

Clear: Click to clear the counters for the selected port.

- EI Port select box: Use the dropdown to display the port for which you want to view statistics.
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13-3 Port Security
13-3.1 Configuration

This page lets you configure the Port Security settings of the Switch. You can use the Port Security
feature to restrict input to an interface by limiting and identifying MAC addresses.
To configure Port Security parameters in the web Ul:

1.  Click Security, Port Security, Configuration.

2. Select “Enabled” in the Mode of System Configuration.

3. Set Mode (Enabled or Disabled), MAC Limit, and Action (Trap, Shutdown, Trap & Shutdown) for
each port.

4. Click the Apply button to save the settings.
5. To cancel the settings click the Reset button to restore previously saved values.

Y
® = o il . Aute-logout _ »
LANTRONIX" =| s vewvwwwe » = r 1 M @ G|
SMETBT2SA Port Security Configuration @ Home - Security - Port Security - Configuration
Switch DMS
System Configuration
» System <
» Port Management < Mode ﬁ,)‘
» PoE Management <
» VLAN Management < Port Configuration
» Quality of Service < o .
Port Mode MAC Limit Action State Re-open
» Spanning Tree < .
1 Enabled ~ 4 Tra v Limit Exceeded ‘ |
» MAC Address Table < " \ J
» Multicast & 2 Disabled 4 None v~ Disabled ‘ |
» Percepxion < PR
3 Enabled v 4 Trap & Shutdown ~|  Ready ‘ |
» DHCP < [S—
» Security Yo 4 Enabled ~ 4 None v Ready ‘ |
» Management <
» IEEE 802.1X ¢! |5 Enabled v 4 None v Ready ‘ |
» |P Source Guard < |
& Disabled 4 None ~  Disabled ‘ |
» ARP Inspection < .
» Port Security R 7 Disabled 4 None ~  Disabled ‘ |
> Configuration . §
> Status g Disabled 4 None ~  Disabled ‘ |
» RADIUS < ) —
9 Disabled 4 None v Disabled ‘ |
» TACACS+ < e
» Access Control < 10 Disabled v 4 None v Disabled ‘ |
» SNMP < ;
e Reset ‘
» Event Notification < ) v

Figure 13-3.1: Port Security Configuration

System Confiquration

Mode: Indicates if Limit Control is globally enabled or disabled on the switch. If globally disabled, other
modules may still use the underlying functionality, but limit checks and corresponding actions are
disabled.

Port Configuration

Port: The port number to which the configuration below applies.
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Mode: Controls whether Limit Control is enabled on this port. Both this and the Global Mode must be set
to Enabled for Limit Control to be in effect. Note that other modules may still use the underlying port
security features without enabling Limit Control on a given port.

MAC Limit: The maximum number of MAC addresses that can be secured on this port. This number
cannot exceed 1024. If the limit is exceeded, the corresponding action is taken. The switch is "born" with
a total number of MAC addresses from which all ports draw whenever a new MAC address is seen on a
Port Security-enabled port. Since all ports draw from the same pool, it may happen that a configured
maximum cannot be granted, if the remaining ports have already used all available MAC addresses.

Action: If Limit is reached, the switch can take one of the following actions:
None: Do not allow more than Limit MAC addresses on the port, but take no further action.

Trap: If Limit + 1 MAC addresses seen on the port, send an SNMP trap. If Aging is disabled, only
one SNMP trap will be sent, but with Aging enabled, new SNMP traps will be sent every time the
limit gets exceeded.

Shutdown: If Limit + 1 MAC addresses is seen on the port, shut down the port. This implies that all
secured MAC addresses will be removed from the port, and no new address will be learned. Even if
the link is physically disconnected and reconnected on the port (by disconnecting the cable), the
port will remain shut down. There are three ways to re-open the port:

1) Boot the switch,

2) Disable and re-enable Limit Control on the port or the switch,

3) Click the Reopen button.

Trap & Shutdown: If Limit + 1 MAC addresses is seen on the port, both the "Trap" and the
"Shutdown" actions described above will be taken.

State: This column shows the current state of the port as seen from the Limit Control's point of view. The
state takes one of four values:

Disabled: Limit Control is either globally disabled or disabled on the port.
Ready: The limit is not yet reached. This can be shown for all actions.

Limit Reached: Indicates that the limit is reached on this port. This state can only be shown if Action
is set to none or Trap.

Shutdown: Indicates that the port is shut down by the Limit Control module. This state can only be
shown if Action is set to Shutdown or Trap & Shutdown.

Re-open Button: If a port is shut down by this module, you may reopen it by clicking this button, which
will only be enabled if this is the case. For other methods, refer to shut down in the Action section.

NOTE: Clicking the Re-open button causes the page to be refreshed, so non-
committed changes will be lost.

Buttons
Apply: Click to save changes.

Reset: Click to undo any changes made locally and revert to previously saved values.
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13-3.2 Status

This page shows the Port Security status. Port Security is a module with no direct configuration.
Configuration comes indirectly from other modules - the user modules. When a user module has enabled
port security on a port, the port is set-up for software-based learning. In this mode, frames from unknown
MAC addresses are passed on to the port security module, which in turn asks all user modules whether
to allow this new MAC address to forward or block it. For a MAC address to be set in the forwarding state,
all enabled user modules must unanimously agree on allowing the MAC address to forward. If only one
chooses to block it, it will be blocked until that user module decides otherwise. The status page is divided
into two sections - one with a legend of user modules and one with the actual port status.

To display Port Security Status in the web Ul:

1. Click Security, Port Security, and Status.

2. Check “Auto-refresh” if desired.

3. Click “Refresh” to refresh the port detailed statistics.

4. Click the port number to see the status for the specified port.

-
_ LANTROND Auto-l gout | OFF ~
LANTRONIX™ = veuvww ©c
SMBTBT25A POf‘t Secunty Status @@ Home Security - Port Security - Status
Switch DMS —
Auto-refresh ‘ Refresh |
» System < E—

» Port Management < SETEELE

} PoE Management € port State Mac Count
» <
VLAN Management 1 Limit Exceeded 4
» Quality of Service <
2 Disabled
» Spanning Tree <
3 Ready 0
» MAC Address Table &
» Multicast < 4 Ready 0
» Percepxion <35 Ready 0
» DHCP < 6 Disabled
> Security YT Disabled
» Management ¢
8 Disabled
» |EEE 802.1X ¢
» |P Source Guard ¢ 9 Disabled
# ARP Inspection < 10 Disabled
» Port Security v

> Configuration
> Status
Figure 13-3.2: Port Security Status
Parameter descriptions:

Port: The port number for which the status applies. Click the port number to see the status for this
particular port.
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State: Shows the current state of the port. It can take one of four values:

Disabled: No user modules are currently using the Port Security service.

Ready: The Port Security service is in use by at least one user module and is awaiting frames from
unknown MAC addresses to arrive.

Limit Reach: The Port Security service is enabled by at least the Limit Control user module, and
that module has indicated that the limit is reached and no more MAC addresses should be taken in.
Shutdown: The Port Security service is enabled by at least the Limit Control user module, and that
module has indicated that the limit is exceeded. No MAC addresses can be learned on the port until
it is administratively re-opened on the Limit Control configuration Web-page.

MAC Count (Current, Limit): The two columns indicate the number of currently learned MAC addresses
(forwarding as well as blocked) and the maximum number of MAC addresses that can be learned on the
port, respectively. If no user modules are enabled on the port, the Current column will show a dash (-).

Buttons Auto-refresh I Refresh ‘

Auto-refresh: Check to refresh the page automatically every 3
seconds.

Refresh: Click to manually refresh the page immediately.

Example: Port State = Limit Reach, MAC Count =4 on Port # 5

Port Security Status @rome  Secumy  PonSeccms St

Port State Mae Count
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13-4 |IP Source Guard

The IP Source Guard security feature restricts IP traffic on untrusted Layer 2 ports by filtering traffic based
on the DHCP snooping binding database or manually configured IP source bindings. This feature helps
prevent IP spoofing attacks.

13-4.1 Configuration

Navigate to Security > IP Source Guard > Configuration to configure IP Source Guard mode and port
mode settings and the max dynamic clients.

IP Source Guard Configuration Brome  Security 1 Source Guard  Configuretion
Mode Con (@)

Port Mode Configuration

Port Mode Max Dynamic Clients
1 Disabled Unlimited
2 Enabled Unlimited
3 nabled W w
4 Enabled W L
3 nabled Unlimited W
[ nabled W W
T Disabled W 2 v
8 nabled W d W

Parameter descriptions:

Mode: Select the global mode (on or off). The default is off.

Port: A row for configuring each port.

Mode: Select the mode for each port (Enabled or Disabled). The default is Disabled.

Max Dynamic Clients: At the dropdown select 0, 1, 2, or Unlimited. The default is Unlimited.
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13-4.2 Static Table

Navigate to Security > IP Source Guard > Static Table to create new Static IP Source Guard entries.

Static IP Source Guard Tabl.e dbHeme - Security - |P Source Guard - Stetic Table
Delete Port IP Address MAC Address
& 2 192.168.1.88 0C-22-33-44-535-66

Parameter descriptions:

Add New Entry: Click the button to add a row for configuring.

Port: At the dropdown select the port to be configured.

IP Address: Enter the IP address for this new entry.

MAC Address: Enter the MAC address for this new entry (must be a valid unicast MAC address).
Apply: Click the Apply button when done.
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12-4.3 Dynamic Table

The Security > IP Source Guard > Dynamic Table displays data on existing entries. Entries in the
Dynamic IP Source Guard Table are shown on this page. The Dynamic IP Source Guard Table is sorted
first by port, then by IP address, and then by MAC address.

Dynamic IP Source Guard Table #evome - Securiyy - 1P Seurce Guard - Dymamic Table
Auto-refresh Refresh |

Show 10 s« entries Search:

Port “ IP Address MAC Address

No data available in table

Parameters:

Port: Displays the configured port.

IP Address: Displays the IP address for the entry.

MAC Address: Displays the MAC address for the entry.
Previous: Click the button to display the previous set of entries.

Next: Click the button to display the next set of entries.
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13-5 ARP Inspection

This webpage lets you configure ARP Inspection settings including Mode (on and off) and Port (Enabled
and Disabled).

13-5.1 Port Configuration
The Security > ARP Inspection > Port Configuration page displays the Port Mode Configuration table.

ARP Inspection Configuration #hrome - Securty - ARP Inspecter - Port Configuretian
Mode [on @)

Port Mode Configuration

Port Mode Check VLAN Log Type

1 O O None W
2 ] ] None W
3 ¥ [+ Den v
4 (v [+ mit W
=] (w [v] v
6 | [&] one W

Parameters:

Mode: The global mode setting (on or off). The default is off.
Port: A row for each port to be configured.

Mode: Check the box if configured.

Check VLAN: Check the box if configured.

Log Type: Select None, Deny, Permit, or All. The default is None.
Apply: Click the button when done configuring.
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13-5.2 VLAN Configuration

The Security > ARP Inspection > VLAN Configuration path displays the VLAN Mode Configuration table.
Here you can specify ARP Inspection is enabled on which VLANSs.

First, you must enable the port setting on Port mode configuration web page. Only when both Global
Mode and Port Mode on a given port are enabled, ARP Inspection is enabled on this given port.

Second, you can specify which VLAN will be inspected on VLAN mode configuration web page. The log
type also can be configured on per VLAN setting.

SMETAT25A VILAM Mode {:CII'IHE[IFGHOI! ilimora - Sacurity - AP irapecion - VLAN Confipention

DS
Delete VLAN ID Log Type

Delete: Check to delete the entry. It will be deleted during the next save.
VLAN ID: The VID for this instance.
Log Type: Select None, Deny, Permit, or All. The default is None.

None: Log nothing.

Deny: Log denied entries.
Permit. Log permitted entries.
ALL: Log all entries.

Buttons
Add New Entry: Click the button to add a row for configuring.
Apply: Click the Apply button when done configuring.

Reset: Click to undo any changes made locally and revert to previously saved values.
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13-5.3 Static Table

This page lets you configure Static ARP Inspection Table parameters of the switch. You can use the Static
ARP Inspection Table to manage the ARP entries.

Navigate to the Security > ARP Inspection > Static Table menu path to display the Static ARP Inspection
Table:

SMATAT2SA Static ARP Inspection Table
DMS
Delete Part VLAN ID MAC Address IP Adddirésss
]
w G- 33- 30455540
¥ ]
Beo ol B8 12

Port: Select the port being configured.

VLAN ID: The VID for this instance.

MAC Address: Enter the MAC address for the entry. Must be a valid unicast MAC address. This is the
allowed Source MAC address in ARP request packets.

IP Address: Enter the IP address for the entry for allowed Source IP address in ARP request packets.

Buttons
Add New Entry: Click the button to add a row for configuring a new VLAN to add to the table.

Apply: Click the button when done configuring to save changes.
Reset: : Click to undo any changes made locally and revert to previously saved values.
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13-5.4 Dynamic Table

Navigate to the Security > ARP Inspection > Dynamic Table menu path to display the Dynamic ARP
Inspection Table. Entries in the Dynamic ARP Inspection Table are shown on this page. The Dynamic
ARP Inspection Table contains up to 1024 entries, and is sorted first by port, then by VLAN ID, then by
MAC address, and then by IP address.

Dynamic ARP Inspection Table @bkeme - Securty - ARPInspection - Dynamic Toble
Auto-refresh
Show 10w~ entries Search:

Port “ VLANID MAC Address IP Address

Mo data available in table

Search: Use the Search box to search for the information that you want to see.

Show entries: You can choose how many items you want to show.

Port: Switch Port Number for which the entries are displayed.

VLAN ID: The VID for this instance. The VLAN ID in which the ARP traffic is permitted.
MAC Address: User MAC address of the entry.

IP Address: User IP address of the entry.

Buttons:
Previous: Click the button to display the previous set of entries.

Next: Click the button to display the next set of entries.
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13-6 SNMP » SNMP

> Configuration
The Security > SNMP menu path lets you configure SNMP Communities, i SLIRE
SNMPv3 Users, Groups, Views, and Access and set and view RMON Statistics, » RMON Configuration
History, Alarm and Events. [

13-6.1 Configuration

Security > SNMP > Configuration

This webpage lets you configure SNMP System on the switch. This function is used to enable SNMP
globally and to configure SNMP read and write community names.

a
B f— LARNTRONE Auto-l gout OFF w
LANTRONIX™ = vevvey wolwt[0F ] M @ O
SM8TBT2SA SNMP Conﬁgurat\on #eHome - SMMP - Configuration
Switch DMS

Mode
b System B
» Port Management < Read Community public
» PoE Management < ) .

Write Community private Enabled
» VLAN Management E
» Quality of Service E | Apply H R:»zset|

Parameters:

Mode : Set to on to enable support for the SNMP protocol service. The default is off.

Read Community: Indicates the community read access string to permit access to SNMP agent.

The allowed string length is 1-31 characters, and the allowed content is ASCII characters from 33 to 126.
The field is applicable only when SNMP version is SNMPv1 or SNMPv2c. If SNMP version is SNMPv3,
the community string will be associated with SNMPv3 communities table. It provides more flexibility to
configure security name than a SNMPv1 or SNMPv2c community string. In addition to community string,
a particular range of source addresses can be used to restrict source subnet

Write Community: Indicates the community write access string to permit access to SNMP agent.

The allowed string length is 1-31 characters, and the allowed content is ASCII characters 33 - 126.

The field is applicable only when SNMP version is SNMPv1 or SNMPv2c. If SNMP version is SNMPv3,
the community string will be associated with SNMPv3 communities table. It provides more flexibility to
configure security name than a SNMPv1 or SNMPv2c community string. In addition to community string,
a particular range of source addresses can be used to restrict source subnet. At the dropdown you can
select Enabled (default) or Disabled.

Write Mode : At the dropdown select Enabled to support community write access string to permit access
to SNMP agent.

Buttons
Apply: Click to save changes.
Reset: Click to undo any changes made locally and revert to previously saved values.
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13-6.2 SNMPv3
Security > SNMP > SNMPv3 > Communities

The function is used to configure SNMPv3 communities. The Community is unique. To create a new
community account, check the Add New Entry button, and enter the account information then click the
Apply button. You can create up to six Groups.

a
LANTRONIX™ =| Ve wewwww e e c
SM8TBT2SA SNMPv3 Community Configuration @Home - SNMP - SNMPVS - Communities
Switch DMS
Delete Community Source IP Source Mask
» System <
» Port Management < ‘ Delete | 0-0.00 0
» PoE Management <
» VLAN Management Sy —
» Quality of Service < ﬂ E|

Community: Enter the IP address for this new entry. Indicates the community access string to permit
access to SNMPv3 agent. The allowed string length is 1-32 characters, and the allowed content is ASCII
characters 33-126. The community string will be treated as security name and map an SNMPv1 or
SNMPv2c community string.

Source IP: Enter the IP address for this new entry. Indicates the SNMP access source address. A
particular range of source addresses can be used to restrict source subnet when combined with source
mask.

Source Mask: Enter the Source Mask for this new entry. Indicates the SNMP access source address
mask.

Buttons:
Add New Entry: Click to add a row to the table and configure the new instance.
Apply: Click to save changes when done configuring.

Reset: Click to undo any changes made locally and revert to previously saved values.

Messages: The Community ip and mask are inconsistent.
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13-6.3 Security > SNMP > SNMPv3 >Users

This page lets you configure SNMPV3 users. You can create up to six Users.

A
— LANTRONDC Auto-logout |OFF v L3
LANTRONIX™ = vewve r ¥ M @ G
SM8TBT2SA SNMPv3 USEFCOI‘IfigUFatiOH @Home - SNMP - SNMPv3 - Users
Switch DMS
Authentication Authentication Privacy
b System ¢ Delete User Name Security Level Protocol Password Protocol  Privacy Password
» Port Management < —
‘ D%le:e‘ Auth, Priv v MD5 v DES ~

» PoE Management <
» VLAN Management ¥ | Add New Entn ‘
» Quality of Service e —

| Apply ‘ Reset |

-

Spanning Tree

User Name: Enter a name for this new user entry. The allowed string length is 1-31 characters, and the
allowed content is ASCII characters 33-126.

Security Level: Select the desired combination of Privacy and Authentication. Security Level indicates
the security model that this entry should belong to. Possible security models are:

NoAuth, NoPriv: No authentication and no privacy.
Auth, NoPriv: Authentication and no privacy.
Auth, Priv: Authentication and privacy.

The value of security level cannot be modified if an entry already exists. That means it must first be
ensured that the value is set correctly.

Authentication Protocol: If Authentication is configured, select a protocol; either: MD5 (uses the Merkle—
Damgard construction) or SHA (Secure Hash Algorithm). Note: the value of security level cannot be
modified if an entry already exists. That means you must first ensure that the value is set correctly.

The length of 'SHA Authentication Password' is restricted to 8-39 characters.

Authentication Password: If Authentication is configured, enter a password for authenticating. A string
identifying the authentication password phrase. For MD5 authentication protocol, the allowed string length
is 8 to 39. For SHA authentication protocol, the allowed string length is 8-39 characters.

The allowed content is ASCII characters 33-126.

Privacy Protocol: If Privacy is configured, select a protocol; either DES (Data Encryption Standard) or
AES (Advanced Encryption Standard). Indicates the privacy protocol that this entry should belong to.
Possible privacy protocols are:

DES: An optional flag to indicate that this user uses DES authentication protocol.
AES: An optional flag to indicate that this user uses AES authentication protocol.
Privacy Password: If Privacy is configured, enter a password for privacy. A string identifying the privacy

password phrase. The allowed string length is 8-31, and the allowed content is ASCII characters 33-126.
The length of 'Privacy Password' is restricted to 8—31 characters.

Buttons:

Add New Entry: Click to add a row to the table and configure the new instance.
Apply: Click to save changes when done configuring.

Reset: Click to undo any changes made locally and revert to previously saved values.
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13-6.4 Security > SNMP > SNMPv3 > Groups

This page lets you configure SNMPv3 groups. The Entry index key are Security Model and Security
Name. To create a new group account, check the Add New Group button, enter the group information,
and then click the Apply button. You can create up to 12 SNMP Groups.

SNMPv3 Group Configuration firome  SHNE - SNURG - Greums
Delete Security Model User Name Group Name
=] v2c S-Com-1
(] usm Bob Grp-2
o L w

Security Model: Select v1, v2¢, or usm (User-based Security Model). Indicates the security model that
this entry should belong to. Possible security models are:

v1: Reserved for SNMPv1.
v2c: Reserved for SNMPv2c.
usm: User-based Security Model (USM).

User Name: At the dropdown select an existing User Name to become a member of this new group.
A string identifying the security name that this entry should belong to. The allowed string length is 1-31
characters and the allowed content is ASCII characters 33-126.

Group Name: Enter the name for the new Group. A string identifying the group name that this entry
should belong to. The allowed string length is 1-32 characters, and the allowed content is ASCII
characters 33-126.

Buttons:
Add New Entry: Click to add a row to the table and configure the new instance.
Apply: Click to save changes when done configuring.

Reset: Click to undo any changes made locally and revert to previously saved values.
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13-6.5 Security > SNMP > SNMPv3 > Views

The function is used to configure SNMPv3 view. The Entry index keys are OID Subtree and View Name.
The maximum number of View entries is 12. The entry index keys are View Name and OID Subtree.

SNMPv3 View Configuration Brame - SHME - SNURI - Views
Delete View Name View Type QID Subtree
Profl ncluded W .0

View Name: Enter the name for this new View. A string identifying the view name that this entry should
belong to. The allowed string length is 1-31 characters, and the allowed content is ASCII characters
33-126.

View Type: Select included or excluded for this new View. Indicates the view type that this entry should
belong to. Possible view types are:

Included: An optional flag to indicate that this view subtree should be included.
Excluded: An optional flag to indicate that this view subtree should be excluded.

In general, if a view entry's view type is 'excluded’, there should be another view entry existing with view
type as 'included' and it's OID subtree should overstep the 'excluded’ view entry.

OID Subtree: Enter an Object Identifier for this new View. The format is .OID1.0ID2.0ID3 ...
The allowed string content is digital number or asterisk (*). This is the OID defining the root of the subtree
to add to the named view. The allowed OID length is 1-128.

Buttons:
Add New Entry: Click to add a row to the table and configure the new instance.
Apply: Click to save changes when done configuring.

Reset: Click to undo any changes made locally and revert to previously saved values.
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13-6.6Security > SNMP > SNMPv3 > Access

This page lets you configure SNMPv3 accesses. The Entry index key are Group Name, Security Model
and Security level. You can create up to 12 accesses.

SNMPv3 Access Conﬂguration BhHome - SNMP - SNMPG - Acoess
Delete Group Name Security Model Security Level Read View Name Write View Name
O Grp-1 any NoAuth, NoPriv None W Nome W
& Grp-2 usm Auth, Priv Profl W Profl W
W W X £ W W W

Group Name: Select the name of the existing Group. A string identifying the group name that this entry
should belong to. The allowed string length is 1-31 characters, and the allowed content is ASCII
characters 33-126.

Security Model: Select any, v1, v2¢, or usm for this instance. Indicates the security model that this entry
should belong to. Possible security models are:

Any: Any security model accepted(v1|v2c|usm).
v1: Reserved for SNMPv1.

v2c: Reserved for SNMPv2c.

usm: User-based Security Model (USM).

Security Level: Select the level of security to be applied. Indicates the security model that this entry
should belong to. Possible security models are:

NoAuth, NoPriv: No authentication and no privacy.

Auth, NoPriv: Authentication and no privacy.

Auth, Priv: Authentication and privacy.
Read View Name: Select None or an existing Read View Name at the dropdown. This is the name of the

MIB view defining the MIB objects for which this request may request the current values. The allowed
string length is 1-31 characters, and the allowed content is ASCII characters 33-126.

Write View Name: Select None or an existing Write View Name at the dropdown. This is the name of the
MIB view defining the MIB objects for which this request may potentially set new values. The allowed
string length is 1-31 characters, and the allowed content is ASCII characters 33-126.

Buttons

Add New Entry: Click to add a new instance. An empty row is added to the table, and the new instance
can be configured as needed.

Apply: Click to save changes.
Reset: Click to undo any changes made locally and revert to previously saved values.
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13-7 RADIUS
13-7.1 Configuration

This page lets you configure up to five RADIUS servers:
1. Click Security, RADIUS, Configuration.

2. Set Timeout, Retransmit, Deadtime, Key, NAS-IP-Address, NAS IPv6-Address,NAS-Identifier.
3. Click “Add New Entry” to display the configurable parameters.
4. Set Global Configuration parameters.
5. Set Server Configuration parameters.
6. Click the Apply button to save the settings. To cancel the settings, click the Reset button.
A
LANTQON'X =) v - Auto-logout [OFF | Q@ G
SMETBT2SA RADIUS Server Configuration @Home - Security - RADIUS - Configuration
Switch DMS
Global Configuration

» System <

» Port Management < Timeout 5 seconds

» PoE Management < Retransmit ; times

» VLAN Management <

. . Deadtime ] minutes

» Quality of Service <

» Spanning Tree g Key

» MAC Address Table g NAS-IP-Address

» Multicast <

i NAS-IPve-Address

» Percepxion <

» DHCP < NAS-Identifier

P Security M

% hiwgeme ¢ Server Configuration

» IEEE 802.1X <

» IP Source Guard . Delete Hostname Auth Port Acct Port Timeout Retransmit Key :

» ARP Inspection < ——

- . Add New Entry ‘

» Port Security < ____________

» RADIUS v | Apply || Reset |

> Configuration

Figure 13-7.1: RADIUS Server Configuration

Global Configuration parameters: These setting are common for all of the RADIUS servers.

Timeout: The number of seconds (1 to 1000) to wait for a reply from a RADIUS server before
retransmitting the request.

Retransmit: The number of times, in the range 1 to 1000, a RADIUS request is retransmitted to a server
that is not responding. If the server has not responded after the last retransmit it is considered to be dead.

Deadtime: Deadtime, which can be set to a number 0 to 1440 minutes, is the period during which the
switch will not send new requests to a server that has failed to respond to a previous request. This will
stop the switch from continually trying to contact a server that it has already determined as dead. Setting
the Deadtime to a value greater than 0 (zero) will enable this feature, but only if more than one server has
been configured.
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Key: The secret key - up to 63 characters long - shared between the RADIUS server and the switch.

: Click to hide the Key text as you enter it.

NAS-IP-Address: The IPv4 address to be used as attribute 4 in RADIUS Access-Request packets. If this
field is left blank, the IP address of the outgoing interface is used.

NAS-IPv6-Address: The IPv6 address to be used as attribute 95 in RADIUS Access-Request packets.
If this field is left blank, the IP address of the outgoing interface is used.

NAS-Identifier: The identifier - up to 255 characters long - to be used as attribute 32 in RADIUS Access-
Request packets. If this field is left blank, the NAS-Identifier is not included in the packet.

Server Configuration parameters: The table has one row for each RADIUS server and a number of
columns

Delete: To delete a RADIUS server entry, check this box. The entry will be deleted during the next Save.
Hostname: The IP address or hostname of the RADIUS server.

Auth Port : The UDP port to use on the RADIUS server for authentication. The officially assigned port
number for RADIUS Authentication is 1812). Note: by default, many access servers use port 1645 for
authentication requests.

Note: For Windows Server information on how to configure ports that Network Policy Server
(NPS) uses for Remote Authentication Dial-In User Service (RADIUS) authentication and
accounting traffic see https://docs.microsoft.com/en-us/windows-
server/networking/technologies/nps/nps-udp-ports-
configure#:~:text=The%20port%20values%200f%201812,and%201646%20for%20accounting%?2

Orequests
Acct Port : The UDP port to use on the RADIUS server for accounting. The officially assigned port

number for RADIUS Accounting is 1813. Note: by default, many access servers use port 1646 for
accounting requests.

Timeout: This optional setting overrides the global timeout value. Leaving it blank will use the global
timeout value.

Retransmit: This optional setting overrides the global retransmit value. Leaving it blank will use the
global retransmit value.

Key: This optional setting overrides the global key. Leaving it blank will use the global key.

Buttons

Add New Entry: Click to add a new RADIUS server. An empty row is added to the table, and the RADIUS
server can be configured as needed. Up to 5 servers are supported.

Apply: Click to save changes.

Reset: Click to undo any changes made locally and revert to previously saved values.
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Messages:

The value of NAS-IP-Address must be a valid IP address in dotted decimal notation (x.y.z.w), where x, y,
z, and w are decimal number between 0 and 255.

The input value NAS-IPv6-Address (111111111) is not a valid IPv6 address.
Hostname must be a valid hostname, unicast IPv4, or unicast IPv6 address
ERRORY! Failed to set host 66 ability

RADIUS Attributes

Value Description Data Type Reference

4 NAS-IP-Address ipv4addr IETF REC2865
32 NAS-Identifier text IETF REC2865

95 NAS-IPv6-Address ipv6addr IETF REC3162

The RADIUS Accounting protocol provides a protocol for carrying accounting information between a
Network Access Server and a shared Accounting Server per IETF RFC 2866.

See the IANA Considerations for guidance regarding IANA registration of values related to RADIUS as
defined in IETF REC2865.

See your RADIUS server documents for more information.
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13-7.2 Status

This page displays details of the RADIUS Authentication and Accounting servers’ status to ensure the
function is workable.

To display RADIUS Status in the web Ul:
1. Click Security, RADIUS, and Status.
2. Select a Server line to display the detail statistics for a particular RADIUS server.

RADIUS Server Status @Home - Secudty - RADIUS - Statws

RADIUS Authentication Server Status

4 IP Address Status
1 111111:1812 Ready
2 22222:1645 Ready
3 33:1812 Ready
4 44:1812 Ready
5 55:1812 Ready

RADIUS Accounting Server Status

# IP Address Status
1 111111:1813 Ready
2 222322:1646 Ready
3 33:1813 Ready
4 44:1813 Ready
5 55:1813 Ready

Figure 12-7.2: RADIUS Server Status

Parameter descriptions:

RADIUS Authentication Server Status

#: The RADIUS server number. Click to navigate to detailed statistics for this server (see below).

IP Address: The IP address and UDP port number (in <IP Address>:<UDP Port> notation) of this server.

State: The current state of the server. This field takes one of these values:
Disabled: The server is disabled.
Not Ready: The server is enabled, but IP communication is not yet up and running.
Ready: The server is enabled, IP communication is up and running, and the RADIUS module is ready
to accept access attempts.

Dead (X seconds left) : Access attempts were made to this server, but it did not reply within the
configured timeout. The server has temporarily been disabled but will get re-enabled when the dead-
time expires. The number of seconds left before this occurs is displayed in parentheses. This state is
only reachable when more than one server is enabled.

RADIUS Accounting Server Status
#: The RADIUS server number. Click to navigate to detailed statistics for this server.
IP Address: The IP address and UDP port number (in <IP Address>:<UDP Port> notation) of this server.
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Disabled: The server is disabled.
Not Ready: The server is enabled, but IP communication is not yet up and running.

Ready: The server is enabled, IP communication is up and running, and the RADIUS module is
ready to accept accounting attempts.
Dead (X seconds left): Accounting attempts were made to this server, but it did not reply within
the configured timeout. The server has temporarily been disabled but will get re-enabled when
the dead-time expires. The number of seconds left before this occurs is displayed in
parentheses. This state is only reachable when more than one server is enabled.

LANTRONIX

AT
ey L L L L L L]

State : The current state of the server. This field takes one of the following values:

Example: If you select Server#2 to display its RADIUS Authentication and Accounting Statistics:

A
F'.utc:-lc:go.t H' o c.p

SM8TBT25A RADIUS Statistics @Homs - Security - RADIUS - Status
Switch DMS —
Auto-refresh | Refresh || Clear server#l v
b System < - .
. RADIUS Authentication Statistics for Server #1
» Port Management
» PoE Management X Receive Packets Transmit Packets
v Ma <
2 O el Access Accepts 0 Access Requests 0
» Quality of Service < . .
Access Rejects 0 Access Retransmissions 0
» Spanning Tree <
Access Challenges 0 Pending Requests 0
» MAC Address Table <
i Malformed Access Responses 0 Timeouts 0
» Multicast g
» Percepxion ¢ Bad Authenticators 0
» DHCP < Unknown Types 0
b Security “ Packets Dropped 0
» Management
Other Info
» |EEE 802.1X
# IP Source Guard IP Address THost-1:1812
% ARP Inspection State Ready
#» Port Security -
Round-Trip Time 0ms
» RADIUS
» Confi t c e
L RADIUS Accounting Statistics for Server #1
> Status
» TACACS+ Receive Packets Transmit Packets
» Access Control ¢ Responses 0 Requests 0
» SNMP ¢ Malformed Responses 0 Retransmissions 0
» Event Notificati g . .
vent Howtication Bad Authenticators 0 Pending Requests 0
» Diagnostics <
Unknown Types 0 Timeouts 0
» Maintenance <
Packets Dropped 0
Other Info
IP Address THost-1:1813
Figure 13-7.2: RADIUS Statistics
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Parameter descriptions:
server #: You can select which server that you want display RADIUS.

RADIUS Authentication Statistics for Server #1: The statistics map closely to those specified in |IETF
RFC4668 - RADIUS Authentication Client MIB. Use the server select box to switch between the backend
servers to show details for.

Access Accepts: The number of RADIUS Access-Accept packets (valid or invalid) received from the
server.

Access Rejects: The number of RADIUS Access-Reject packets (valid or invalid) received from the
server.

Access Challenges: The number of RADIUS Access-Challenge packets (valid or invalid) received from
the server.

Malformed Access Responses: The number of malformed RADIUS Access-Response packets received
from the server. Malformed packets include packets with an invalid length. Bad authenticators or
Message Authenticator attributes or unknown types are not included as malformed access responses.

Bad Authenticators: The number of RADIUS Access-Response packets containing invalid
authenticators or Message Authenticator attributes received from the server.

Unknown Types: The number of RADIUS packets that were received with unknown types from the
server on the authentication port and dropped.

Packets Dropped: The number of RADIUS packets that were received from the server on the
authentication port and dropped for some other reason.

Access Requests: The number of RADIUS Access-Request packets sent to the server. This does not
include retransmissions.

Access Retransmissions: The number of RADIUS Access-Request packets retransmitted to the
RADIUS authentication server.

Pending Requests: The number of RADIUS Access-Request packets destined for the server that have
not yet timed out or received a response. This variable is incremented when an Access-Request is sent
and decremented due to receipt of an Access-Accept, Access-Reject, Access-Challenge, timeout, or
retransmission.

Timeouts: The number of authentication timeouts to the server. After a timeout, the client may retry to the
same server, send to a different server, or give up. A retry to the same server is counted as a retransmit
as well as a timeout. A send to a different server is counted as a Request as well as a timeout.

IP Address: IP address and UDP port for the authentication server in question.
State: Shows the state of the server. It takes one of the following values:

Disabled: The selected server is disabled.

Not Ready: The server is enabled, but IP communication is not yet up and running.

Ready: The server is enabled, IP communication is up and running, and the RADIUS module is
ready to accept access attempts.

Dead (X seconds left): Access attempts were made to this server, but it did not reply within the
configured timeout. The server has temporarily been disabled but will get re-enabled when the
dead-time expires. The number of seconds left before this occurs is displayed in parentheses.
This state is only reachable when more than one server is enabled.

Round-Trip Time: The time interval (measured in milliseconds) between the most recent Access-
Reply/Access-Challenge and the Access-Request that matched it from the RADIUS authentication server.
The granularity of this measurement is 100 ms. A value of 0 ms indicates that there hasn't been round-trip
communication with the server yet.

RADIUS Accounting Statistics for Server #x: The statistics map closely to those specified in RFC4670
- RADIUS Accounting Client MIB. Use the server select box to switch between the backend servers to
show details for.

Responses: The number of RADIUS packets (valid or invalid) received from the server.
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Malformed Responses: The number of malformed RADIUS packets received from the server.
Malformed packets include packets with an invalid length. Bad authenticators or unknown types are not
included as malformed access responses.

Bad Authenticators: The number of RADIUS packets containing invalid authenticators received from the
server.

Unknown Types: The number of RADIUS packets of unknown types that were received from the server
on the accounting port.

Packets Dropped: The number of RADIUS packets that were received from the server on the accounting
port and dropped for some other reason.

Requests: The number of RADIUS packets sent to the server. This does not include retransmissions
Retransmissions: The number of RADIUS packets retransmitted to the RADIUS accounting server.

Pending Requests: The number of RADIUS packets destined for the server that have not yet timed out
or received a response. This variable is incremented when a Request is sent and decremented due to
receipt of a Response, timeout, or retransmission.

Timeouts: The number of accounting timeouts to the server. After a timeout, the client may retry to the
same server, send to a different server, or give up. A retry to the same server is counted as a retransmit
as well as a timeout. A send to a different server is counted as a Request as well as a timeout.

IP Address: IP address and UDP port for the accounting server in question.
State: Shows the state of the server. It takes one of the following values:
Disabled: The selected server is disabled.
Not Ready: The server is enabled, but IP communication is not yet up and running.

Ready: The server is enabled, IP communication is up and running, and the RADIUS module is
ready to accept accounting attempts.

Dead (X seconds left): Accounting attempts were made to this server, but it did not reply within
the configured timeout. The server has temporarily been disabled but will get re-enabled when
the dead-time expires. The number of seconds left before this occurs is displayed in
parentheses. This state is only reachable when more than one server is enabled.

Round-Trip Time: The time interval (measured in milliseconds) between the most recent Response and
the Request that matched it from the RADIUS accounting server. The granularity of this measurement is
100 ms. A value of 0 ms indicates that there hasn't been round-trip communication with the server yet.
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13.8 RMON Configuration » RMON Configuration
Navigate to the Switch >Security > RMON menu path to configure remote ’ Sfat“““
monitoring. Here you can configure and view RMON statistics, history, alarms, > History
and events. > Alarm

> Ewvent
RMON Statistics Configuration » RMON Sratie ¢

1. Navigate to Switch > SNMP > RMON Configuration > Statistics to display the RMON Statistics
Configuration table.

2. Click the Add New Entry button.
Enter the desired parameters.
4. Click the Apply button to save the webpage changes to running-config.

w

SM8TBT2SA RMON Statistics Configuration #iHome - SNMP - RMON Configuration - Statistics a
Switch DMS |
Delete 1D Data Source |
» System <
» Port Management <« O 1 1361212211, 1
» PoE Management N | m 2 1361212211 2
» VLAN Management < —
‘ Delete | 1361212211
» Quality of Service <
» i <
Spanning Tree Add New Eniry
» MAC Address Table S p— 7‘
. Apply || Reset
b Multicast ¢

Parameter descriptions:
Delete: Check the box to delete the table entry.
ID: Enter an ID for the instance.

Data Source: The port ID which you want to be monitored with RMON.

Buttons
Add New Entry: Click the button to add a new row for configuring.
Apply: Click to save changes.

Reset: Click to undo any changes made locally and revert to previously saved values.

33873 Rev. A https://www.lantronix.com/ Page 194 of 273



https://www.lantronix.com/

Lantronix SMXTBTxSA Web User Guide

RMON History Configuration

Navigate to Switch > SNMP > RMON Configuration > History to display the RMON History Configuration
page:

LANTRONIX' =| 7% wewwes o c|
SM8TBT2SA RMON HiStOl’y Configuration @Home - SNMP - RMOM Configuration - History
Switch DMS
Delete ID Data Source Interval Buckets Buckets Granted
» System
b Port Management < \:| 1 .1.3.6.1.2.1.2.2.1.1. 1 1800 50 50
» PoE Management 8 ‘m| 1.3.6.1.2.1.22.1.1. 1200 50
» VLAN Management e
» Quality of Service < Add New Entry |
» Spanning Tree e FHQ‘

PP R '3

Delete: Check the box to delete the table entry.
ID: Indicates the index of the entry. The valid range is 1 to 65535.
Data Source: Indicates the port ID which you want to be monitored with RMON.

Interval: Indicates the interval in seconds for sampling the history statistics data. The valid range is 1 to
3600. The default value is 1800 seconds.

Buckets: Indicates the maximum data entries associated this History control entry stored in RMON.
The valid range is 1 to 3600. The default value is 50. This is the RMON “buckets requested’ value - the
requested number of discrete time intervals over which data is to be saved in the part of the media-
specific table associated with this historyControlEntry. When this object is created or modified, the probe
should set historyControlBucketsGranted as closely to this object as is possible for the particular probe
implementation and available resources. The default is 50 buckets.

Buckets Granted: The number of data saved in the RMON. The number of discrete sampling intervals
over which data will be saved in the part of the media-specific table associated with this
historyControlEntry.

See the RMON RFC (IETF REC 2819) for details on the particular probe implementation and available
resources.
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RMON Alarm Configuration

Navigate to Switch > SNMP > RMON Configuration > Alarm to display the RMON Alarm Configuration
page:

A
& LATRON Auto-logout [OFF v
LANTRONIX® = "'s wewwwe e 0o
SM8TBT2SA RMON Alarm Configuration #Home - SNMP - RMON Configuration - Alarm
Switch DMS

Delete D Interval Variable Sample Type Value StartupAlarm Rising Rising Falling Falling
> SpEET Threshold  Index  Threshold  Index
» Port Management «

o .1.3.6.1.2.1.2.2.1.
» PoE Management < ] 1 30 01 Delta ¥ 0 RisingOrFalling 4 2 3 1

8 .
» VLAN Management &
.1.3.6.1.2.1.2.2.1.

» Quality of Service « ‘ D;LEE‘ 30 00 Delta ¥ 0 RisingOrfalling  v| 0 0 0 0
» Spanning Tree «
» MAC Address Table < “ d New Entry ‘
» Multicast Apply | Reset|

ID: Indicates the index of Alarm control entry.
Interval: Indicates the interval in seconds for sampling and comparing the rising and falling threshold.
Variable: Indicates the particular variable to be sampled.

Sample Type: The method of sampling the selected variable and calculating the value to be compared
against the thresholds, possible sample types are:

Delta: Delta sampling subtracts the current sample value from the last sample taken and then
compares the difference to the threshold. Delta sampling is like a counter that records a value that is
constantly increasing. The difference between samples of the selected variable is used when
comparing against the thresholds.

Absolute: Absolute sampling compares the sample value directly to the threshold. Absolute sampling is
like a gauge that records values that go up or down. An actual value of the selected variable is used
when comparing against the thresholds.

Value: The value of the statistic during the last sampling period. (e.g., 72).

Startup Alarm: The alarm that may be sent when this entry is first set to valid (e.g., RisingOrFalling).
Rising Threshold: Rising threshold value.

Rising Index: Rising event index.

Falling Threshold: Falling threshold value.

Falling Index: Falling event index.

Buttons

Add New Entry : Click to add new entry.

Apply : Click to save changes.

Reset : Click to undo any changes made locally and revert to previously saved values.
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RMON Event Configuration

Navigate to Switch > SNMP > RMON Configuration > Event to display the RMON Event Configuration
page:

S LAHTRONDC Auto-logout »
LANTRONIX™ = sevewey forF_~] 0 C
SM&8TBT25A RMON Event Configuration gHome - SNMP - RMOMN Configuration - Event
Switch DMS

Delete ID Description Type Community Event Last
b System ¢ Time
» Port Management < -

] 1 Event 1 log v R-Com1l 0
» PoE Management <
» VLAN Management < | Delete ‘ none h
» Quality of Service <

i Add New Entry

» Spanning Tree < =
» MAC Address Table < | Apply | Reset |

'3

ID: Enter the index of the RMON event. The valid range is 1 to 65535. Each ID entry must be unique.
Desc: Indicates this event, the string length is 0 — 127 characters. The default is a null string.

Type: Indicates the notification of the event, the valid types are:
none: No logging action is performed.
log: A syslog entry is added.
snmptrap: An SNMP trap event is sent.
logandtrap: A syslog entry is logged and an SNMP trap event is sent.

Community: Specify the community when a trap is sent; the string length is 0 to 127 characters. The
default is "public".

Event Last Time: Indicates the value of sysUpTime at the time this event entry last generated an event
(e.g., 33554560 or 33 days, 55 hours, 45 minutes, and 50 seconds).

Buttons

Add New Entry : Click to add new entry.

Apply : Click to save changes.

Reset : Click to undo any changes made locally and revert to previously saved values.
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13.9 RMON Status » RMON Status
Navigate to the Switch > SNMP > RMON Status menu path to view RMON e
statistics, history, alarms, and events. > History

> Alarm

> Even

RMON Statistics Status
Navigate to Switch > SNMP > RMON Status > Statistics to display the RMON Statistics Status page:

a
LANTRONIX' = % wores T2 M@ G
- w L L
SM8TBT2SA RMON Statistics Status #Home - SNMP - RMON Status - Statistics
Switch DMS ——
Auto-refresh | Refresh |
» System <
» Port Management ¢ Show| wn « entries Search:
g
» PoE Management « Data 128 256 1024
b VLAN Management < * Source CRC Under- Over- 64 65~ ~ ~ 512~ ~
ID (ifindex) Drop Octets Pkts Broadcast Multicast Errors size size  Frag. Jabb. Coll. Bytes 127 255 511 1023 1588
» Quality of Service <
. 1 1 6201 160458234 1005983 645457 14928 0 0 o] o] 0 0 749707 73713 9552 8632 156187 8192
» Spanning Tree <
» MAC Address Table « 2 2 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0
» Multicast « showing 1to 2 of 2 entries Previous Next
» Percepxion «
4 >

Parameters:

ID: Indicates the index of Statistics entry.

Data Source (ifindex): The data source which you want to be monitored.

Drop: The total number of events in which packets were dropped by the probe due to lack of resources.
Octets: The total number of octets of data (including those in bad packets) received on the network.

Pkts: The total number of packets (including bad packets, broadcast packets, and multicast packets)
received.

Broad-cast: The total number of good packets received that were directed to the broadcast address.
Multi-cast: The total number of good packets received that were directed to a multicast address.

CRC Errors: The total number of packets received that had a length (excluding framing bits, but including
FCS octets) of between 64 and 1518 octets.

Under-size: The total number of packets received that were less than 64 octets.

Over-size: The total number of packets received that were longer than 1518 octets.

Frag.: The number of frames with a size is less than 64 octets received with invalid CRC.

Jabb.: The number of frames which size is larger than 64 octets received with invalid CRC.

Coll.: The best estimate of the total number of collisions on this Ethernet segment.

64 Bytes: The total number of packets (including bad packets) received that were 64 octets in length.

65~127: The total number of packets (including bad packets) received that were 65 to 127 octets in
length.

128~255: The total number of packets (including bad packets) received that were 128 to 255 octets long.
256~511: The total number of packets (including bad packets) received that were 256 to 511 octets long.
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512~1023: The total number of packets (including bad packets) received that were 512 to 1023 octets
long.

1024~1588: The total number of packets (including bad packets) received that were 1024 to 1588 octets
long.

Buttons

Auto-refresh : Check this box to refresh the page automatically every 3 seconds.
Refresh : Click to refresh the page immediately.

Previous : Updates the entries, turn to the previous page.

Next : Updates the entries, turn to the next page.
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RMON History Status

Navigate to Switch > SNMP > RMON Status > History to display the RMON History Status page. At the
Index dropdown select the desired index number.

A
wotgs [0 ~] M @ @

® — | wamom
LANTRONIX" = vevewe
SM8TBT2SA RMON History Status @Home - SNMP - RMON Status - History
Switch DMS —
Auto-refresh ‘ Refresh |
» System S
» Port Management < Index ndex2
» PoE Management g
» VLAN Management ¢ Show 1 ~ entries Search:
¥ Quality of Service ¢ Sample Index * SampleStart  Drop Octets Pkts Broadcast Multicast CRCErrors  Under-size  Over-size  Frag. Jabb. Coll. Utilization
i <
> SPEIE =S No data available in table
» MAC Address Table g
Showing 0 to 0 of 0 entries Previous = Next
» Multicast g
» Percepxion & ] 2
Parameters:

Sample Index: Indicates the index of the data entry associated with the control entry

Sample Start: The total number of events in which packets were dropped by the probe due to lack of
resources.

Drops: The total number of events in which packets were dropped by the probe due to lack of resources.
Octets: The total number of octets of data (including those in bad packets) received on the network.

Pkts: The total number of packets (including bad packets, broadcast packets, and multicast packets)
received.

Broadcast: The total number of good packets received that were directed to the broadcast address.
Multicast: The total number of good packets received that were directed to a multicast address.

CRC Errors: The total number of packets received that had a length (excluding framing bits, but including
FCS octets) of between 64 and 1518 octets.

Undersize: The total number of packets received that were less than 64 octets.

Oversize: The total number of packets received that were longer than 1518 octets.

Frag.: The number of frames which size is less than 64 octets received with invalid CRC.
Jabb.: The number of frames which size is larger than 64 octets received with invalid CRC.
Coll.: The best estimate of the total number of collisions on this Ethernet segment.

Utilization: The best estimate of the mean physical layer network utilization on this interface during this
sampling interval, in hundredths of a percent (.01% sampling interval).

Buttons

Auto-refresh : Check this box to refresh the page automatically every 3 seconds.
Refresh : Click to refresh the page immediately.

Previous : Updates the entries, turn to the previous page.

Next : Updates the entries, turn to the next page.
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Example: Index 1 RMON History Status

SMBTAT25A RMON History Status LR -
Switch DMSs _
sto-retresh DD | metresn |
b Syitern £
¥ Port Management ] Index el W
¥ PoE Managemsent 4
b VLA Managamant £ ShOW w w EMrieR Search:
¥ Quality of Sexvice 5 Sarmiple CRE | Under.  Cher-
b Spanning Tree £ Index Sample Start Dop Octets Pkt Broadcast  Multicsst  Erroes  sire sipe Frag. Jabb, Coll. Wnilization
¥ MAC Addvess Table £ o 3 -
50 231380 " -] COB0G X500 T - -] Q ] 1 [} L] ]
b Multicast 5
L
¥ DHCP 4 51 <] 1320000 6500 132 198 -} 1] o I3 a 18 o
Si01:30{100804)
¥ Sacurity < o
4 4
b A Coarrtral P 52 sansoatey O 1000 #0016 2 ] 9 ] 0 1 0
(R W 4
3 Conigurntion L solsopag) 280000 130 26 » 1B @ o ¢ @ S
* SMMPVE b =
P ’ o 48 & [} 1 0 o
> RMON Configeration = 8:31:30(198208) e B & ! &
» EMOM Stabus B
o
H
3 Skabiatecs 55 013198099 =] 1900000 9500 190 FLL] - Q 1] & L1} n 1]
¥ Mgty
3 Alarm showing 1 to & of 6 entries Priious - ezl
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RMON Alarm Status
Navigate to Switch > SNMP > RMON Status > Alarm to display the RMON Alarm Status page:

a
LANTRONIX" =| "% welws 5 0 M@ G
- L L L
SM8TBT2SA RMON Alarm Status @Home - SNMP - RMON Status - Alarm
Switch DMS ——
Auto-refresh | Refresh |
» System S
» Port Management < Show| 1 w|entries Search:
» PoE Management ¢ ID * Interval Variable Sample Type Value  Startup Alarm Rising Threshold Rising Index Falling Threshold Falling Index
» \ <
LEitiiagacamans 1 30 136121221101 Delta 353354 RisingOrFalling 4 2 3 1
» Quality of Service g
Showing 1to 1 of 1 entries Previous Next
» Spanning Tree <
» MAC Address Table g S 2

Parameters:

ID: Indicates the index of Alarm control entry.

Interval: Indicates the interval in seconds for sampling and comparing the rising and falling threshold.
Variable: Indicates the particular variable to be sampled.

Sample Type: The method of sampling the selected variable and calculating the value to be compared
against the thresholds. Possible sample types are:

Delta: Delta sampling subtracts the current sample value from the last sample taken and then
compares the difference to the threshold. Delta sampling is like a counter that records a value that is
constantly increasing. The difference between samples of the selected variable is used when
comparing against the thresholds.

Absolute: Absolute sampling compares the sample value directly to the threshold. Absolute sampling is
like a gauge that records values that go up or down. An actual value of the selected variable is used
when comparing against the thresholds.

Value: The value of the statistic during the last sampling period. (e.g., 72).

Startup Alarm: The alarm that may be sent when this entry is first set to valid (e.g., RisingOrFalling).
Rising Threshold: Rising threshold value.

Rising Index: Rising event index.

Falling Threshold: Falling threshold value.

Falling Index: Falling event index.

Buttons

Auto-refresh : Check this box to refresh the page automatically every 3 seconds.
Refresh : Click to refresh the page immediately.

Previous : Updates the entries, turn to the previous page.

Next : Updates the entries, turn to the next page.
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RMON Event Status

Navigate to Switch > SNMP > RMON Status > Event to display the RMON Event Status page:

LANTRONIX® =| s wweswwes o

»

»

»

»

»

»

»

SM8TBT2SA
Switch DMS
System

Port Management

PoE Management

VLAN Management
Quality of Service

Spanning Tree

MAC Address Table

Parameters:

<

<

¢

'y

= Auto-logout H o C‘
—
RMON Event Status gbHome - SNMP - RMON Status - Event
Auto-refresh
Show| 1 ~ entries Search:
Event Index * LogIndex Log Time Log Description
No data available in table
Showing 0 to 0 of 0 entries Previous = Next

4

Event Index: Indicates the index of the event entry.

Log Index: Indicates the index of the log entry.

Log Time: Indicates the time that the Event was logged.

Log Description: Indicates the Event description.

Buttons
Auto-refresh : Check this box to refresh the page automatically every 3 seconds.
Refresh : Click to refresh the page immediately.

Previous : Updates the entries, turn to the previous page.

Next : Updates the entries, turn to the next page.
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13.10 TACACS+ Configuration

Navigate to Switch >Security >TACACS+ > Configuration to display the TACACS+ Server Configuration
page. Here you can configure up to six TACACS+ servers.

A
— LATRONIX Auto-logout |[OFF v [ 3

LANTRONIX™ = veuvey L ¥ M @ G

SME8TBT2SA TACACS+ Server Configuration @hHome - Securty - TACACS  Configuration

Switch DMS
Global Configuration

b System ¥
» Port Management < Timeout 5 seconds

\ <
» PoE Management Deadtime . minutes
» VLAN Management <

. . Key
» Quality of Service <
» Spanning Tree <

Server Configuration

-

MAC Address Table <

» Multicast < Delete Hostname Port Timeout Key
» Percepxion ¢ [l THost-1 678 100
» DHCP ¥ —
. | Delete |

P Security 7

» Management <

» |EEE 802.1X < | |

% P Source Guard < | Apply H Reset ‘

Global Configuration Parameters:

Timeout: The number of seconds, in the range 1 - 1000, to wait for a reply from a TACACS+ server
before it is considered to be dead.

Deadtime: Deadtime, which can be set to 0 - 1440 minutes, is the period during which the switch will not
send new requests to a server that has failed to respond to a previous request. This will stop the switch
from continually trying to contact a server that it has already determined as dead. Setting the Deadtime to
a value greater than 0 (zero) will enable this feature, but only if more than one server has been
configured.

Key: The secret key - up to 63 characters long - shared between the TACACS+ server and the switch.

Server Configuration Parameters:

Delete : To delete a TACACS+ server entry, check this box. The entry will be deleted during the next
Save.

Hostname: The IP address or hostname of the TACACS+ server.
Port: The TCP port to use for TACACS+ server for authentication.

Timeout: This optional setting overrides the global timeout value. Leaving it blank will use the global
timeout value.

Key: This optional setting overrides the global key. Leaving it blank will use the global key.
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Buttons

Add New Entry: Click to add a new TACACS+ server. An empty row is added to the table, and the
TACACS+ server can be configured as needed. Up to 6 servers are supported.

Apply: Click to save changes.

Reset: Click to undo any changes made locally and revert to previously saved values.

Messages:

Authentication Error  HTTPD cache has no valid entry

Hostname must be a valid hostname, unicast IPv4, or unicast IPv6 address
Meaning: You entered an invalid Key or Hosthame parameter.

Recovery: 1. Click the Previous button to clear the error message. 2. Re-enter a valid Key or Hostname
parameter. 3. Continue operation.
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13.11 Access Control List

This page lets you configure Access Control List rules. An Access Control List (ACL) is a sequential list of
permit or deny conditions that apply to IP addresses, MAC addresses, or other more specific criteria.

This switch tests ingress packets against the conditions in an ACL one by one. A packet will be accepted
as soon as it matches a permit rule or dropped as soon as it matches a deny rule. If no rules match, the
frame is accepted. Other actions can also be invoked when a matching packet is found, including rate
limiting, copying matching packets to another port or to the system log, or shutting down a port. This page
shows the Access Control List (ACL), which is made up of the ACEs defined on this switch. Each row
describes the ACE that is defined. The maximum number of ACEs is 256 on each switch. Click on the
lowest plus sign to add a new ACE to the list. Reserved ACEs are used for internal protocol and cannot
be edited or deleted; the order sequence cannot be changed and the priority is highest.

Navigate to Switch >Access Control List > Access Control List to display the default Access Control List
Configuration page:

A
® || LA Auto-logout |OFF  +~ » |

LANTRONIX™ = vevvwe oF ] M @ C

SMETBT2SA Access Control List Configuration @Homs - Access Control - Access Control List

Switch DMS
Auto-refresh Refresh H Clear | Remove All

» System <
» Port Management < ACE Ingress Port Frame Type Action Metering Mirror Counter

| » PoE Management < @

Click the ﬂ icon to add an ACE from the ACE Configuration page. The selection at the Frame Type
dropdown (Any, Eternet Type or IPv4) determines the set of parameters displayed after selection.

ACE Configuration / Frame Type: Any

ACE COnflgUFatIOn #FeHome - Access Control - Access Control List
Ingress Port All Action Permit v
Port1
Port2 .
Ports . Mirror Disabled +
Frame Type Ay v Metering Disabled +
Counter Disabled v
| Apply H Reset H Cancel ‘

33873 Rev. A https://www.lantronix.com/ Page 206 of 273



https://www.lantronix.com/

Lantronix SMXTBTxSA Web User Guide

ACE Configuration / Frame Type: Ethernet Type

ACE Configuration @roms - Access Coneral - Acsass Cantral Lt
Ingress Port All - Action Deny v
Port1
Port 2 :
Ports o Mirror Enabled
Frame Type Ethernet Type v Metering Enabled v
Metering Bandwidth 1000000 Kbps
MAC Parameters
Counter Diszbled
SMAC Filter Any v
DMAC Filter Any v VLAN Parameters
C-VLAN Tagged Any v
Ethernet Type Parameters
C-VLAN ID Filter Any v
Ethernet Type Filter
C-VLAN Tag Priority Any v
S-VLAN Tagged Any v
S-VLAN ID Filter Any v
S-VLAN Tag Priority Any v
| Apply || Reset || Cancel
ACE Configuration / Frame Type: IPv4
ACE Configu ration fiHoms - Access Control - Access Control List
Ingress Port All - Action Permit v
Port1
Port2 .
Port3 Mirror Disabled v
Frame Type 1Pva v Metering Disabled
Counter Disabled

IP Parameters

IP Protocol Filter TCP Parameters

IP Fragment Aoy v Source Port Filter Any v
ToS Filter Any v Destination Port Filter Any v
SIP Filter Any v TCP FIN Any v
DIP Filter Any v TCP SYN Any v
TCP RST Ay v
TCP PSH Any v
TCP ACK Ay v
TCP URG Any v

\Anpw

Reset H Cancel
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ACE Configuration Parameters:
ACE: Indicates the ACE ID.
Ingress Port: Select the ingress port of the ACE. Possible values are:

All: The ACE will match all ingress port.
Port: The ACE will match a specific ingress port.

Frame Type: Indicates the frame type of the ACE. Possible values are:
Any: The ACE will match any frame type.
Ethernet Type: The ACE will match Ethernet Type frames. Note that an Ethernet Type
based ACE will not get matched by IP and ARP frames.
IPv4: The ACE will match all IPv4 frames.

Action: Indicates the forwarding action of the ACE. Possible values are:

Permit. Frames matching the ACE may be forwarded and learned.
Deny: Frames matching the ACE are dropped.
Shutdown: Specify the port shut down operation of the ACE.

Metering: Enable or disable metering mode. The default value is "Disabled".

Metering Bandwidth: Enter an integer value between 16 and 1000000 Kbps.

IPv4 v

Any
Ethernet Type
1Pv4

Permit T

Dany
Parmit

Shutdown

Mirror: Specify the mirror operation of this port. Frames matching the ACE are mirrored to the destination
mirror port. The allowed values are: Enabled: Frames received on the port are mirrored. Disabled:

Frames received on the port are not mirrored. The default value is "Disabled".

Counter: The counter indicates the number of times the ACE was hit by a frame.

MAC Parameters

SMAC Filter: Specify the source MAC filter for this ACE. (Only displayed when the frame type is Ethernet
Type or ARP.) Any: No SMAC filter is specified. (SMAC filter status is "don't-care".) Specific: If you want to
filter a specific source MAC address with this ACE, choose this value. A field for entering an SMAC value

displays.

SMAC Value: When "Specific" is selected for the SMAC filter, you can enter a specific source MAC

address. The legal format is "XX-XX-XX-XX-XX-XX" OF "XX.XX.XX.XX.XX.XX" OF "XXXXXXXXXXXX" (X is a

hexadecimal digit). A frame that hits this ACE matches this SMAC value.

DMAC Filter: Specify the destination MAC filter for this ACE. Any: No DMAC filter is specified. (DMAC
filter status is "don't-care".) MC: Frame must be multicast. BC: Frame must be broadcast. UC: Frame
must be unicast. Specific: If you want to filter a specific destination MAC address with this ACE, choose

this value. A field for entering a DMAC value displays.

DMAC Value: When "Specific" is selected for the DMAC filter, you can enter a specific destination MAC

address. The legal format is "XX-XX-XX-XX-XX-XX" OF "XX.XX.XX.XX.XX.XX" OF "XXXXXXXXXXXX" (X is a

hexadecimal digit). A frame that hits this ACE matches this DMAC value.
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VLAN Parameters

802.1Q Tagged: Specify whether frames can hit the action according to the 802.1Q tagged. The allowed
values are: Any: Any value is allowed ("don't-care"). Enabled: Tagged frame only. Disabled: Untagged
frame only. The default value is "Any".

VLAN ID Filter: Specify the VLAN ID filter for this ACE. Any: No VLAN ID filter is specified. (VLAN ID filter
status is "don't-care".) Specific: If you want to filter a specific VLAN ID with this ACE, choose this value. A
field for entering a VLAN ID number displays.

VLAN ID: When "Specific" is selected for the VLAN ID filter, you can enter a specific VLAN ID number.
The valid range is 1 to 4094. A frame that hits this ACE matches this VLAN ID value.

Tag Priority: Specify the tag priority for this ACE. A frame that hits this ACE matches this tag priority. The
valid number range is 0 to 7. The value Any means that no tag priority is specified (tag priority is "don't-
care".)

IPv4 Parameters

The IP parameters can be configured when Frame Type "IPv4" is selected.

IP Protocol Filter: Specify the IP protocol filter for this ACE. Any: No IP protocol filter is specified ("don't-
care"). ICMP: Select ICMP to filter IPv4 ICMP protocol frames. Extra fields for defining ICMP parameters
will appear. These fields are explained later in this section. UDP: Select UDP to filter IPv4 UDP protocol
frames. Extra fields for defining UDP parameters will appear. These fields are explained later in this
section. TCP: Select TCP to filter IPv4 TCP protocol frames. Extra fields for defining TCP parameters will
display. These fields are explained later in this section. Other: If you want to filter another specific IP
protocol filter with this ACE, choose this value. A field for entering an IP protocol filter displays.

IP Protocol Value: When "Specific" is selected for the IP protocol value, you can enter a specific value.
The valid range is 0 to 255. A frame that hits this ACE matches this IP protocol value.

IP TTL: Specify the Time-to-Live settings for this ACE. Zero: IPv4 frames with a Time-to-Live field greater
than zero must not be able to match this entry. Non-zero: IPv4 frames with a Time-to-Live field greater
than zero must be able to match this entry. Any: Any value is allowed ("don't-care").

IP Fragment: Specify the fragment offset settings for this ACE. This involves the settings for the More
Fragments (MF) bit and the Fragment Offset (FRAG OFFSET) field for an IPv4 frame. No: IPv4 frames
where the MF bit is set or the FRAG OFFSET field is greater than zero must not be able to match this
entry. Yes: IPv4 frames where the MF bit is set or the FRAG OFFSET field is greater than zero must be
able to match this entry. Any: Any value is allowed ("don't-care").

IP Option: Specify the options flag setting for this ACE. No: IPv4 frames where the options flag is set
must not be able to match this entry. Yes: IPv4 frames where the options flag is set must be able to match
this entry. Any: Any value is allowed ("don't-care").

SIP Filter: Specify the source IP filter for this ACE. Any: No source IP filter is specified. (Source IP filter is
"don't-care".) Host: Source IP filter is set to Host. Specify the source IP address in the SIP Address field
that appears. Network: Source IP filter is set to Network. Specify the source IP address and source IP
mask in the SIP Address and SIP Mask fields that appear.

SIP Address: When "Host" or "Network" is selected for the source IP filter, you can enter a specific SIP
address in dotted decimal notation.

SIP Mask: When "Network" is selected for the source IP filter, you can enter a specific SIP mask in dotted
decimal notation.

DIP Filter: Specify the destination IP filter for this ACE. Any: No destination IP filter is specified.
(Destination IP filter is "don't-care".) Host: Destination IP filter is set to Host. Specify the destination IP
address in the DIP Address field that appears. Network: Destination IP filter is set to Network. Specify the
destination IP address and destination IP mask in the DIP Address and DIP Mask fields that appear.

DIP Address: When "Host" or "Network" is selected for the DIP Filter, you can enter a specific DIP
address in dotted decimal notation.

DIP Mask: When "Network" is selected for the DIP Filter, you can enter a specific DIP mask in dotted
decimal notation.
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ICMP Parameters

ICMP Type Filter: Specify the ICMP filter for this ACE. Any: No ICMP filter is specified (ICMP filter status
is "don't-care"). Specific: If you want to filter a specific ICMP filter with this ACE, you can enter a specific
ICMP value. A field for entering an ICMP value appears.

ICMP Type Value: When "Specific" is selected for the ICMP filter, you can enter a specific ICMP value.
The allowed range is 0 to 255. A frame that hits this ACE matches this ICMP value.

ICMP Code Filter: Specify the ICMP code filter for this ACE. Any: No ICMP code filter is specified (ICMP
code filter status is "don't-care"). Specific: If you want to filter a specific ICMP code filter with this ACE,
you can enter a specific ICMP code value. A field for entering an ICMP code value appears.

ICMP Code Value: When "Specific" is selected for the ICMP code filter, you can enter a specific ICMP
code value. The allowed range is 0 to 255. A frame that hits this ACE matches this ICMP code value.

TCP Parameters

Source Port Filter: Specify the TCP/UDP source filter for this ACE. Any: No TCP/UDP source filter is
specified (TCP/UDP source filter status is "don't-care"). Specific: If you want to filter a specific TCP/UDP
source filter with this ACE, you can enter a specific TCP/UDP source value. A field for entering a
TCP/UDP source value appears. Range: If you want to filter a specific TCP/UDP source range filter with
this ACE, you can enter a specific TCP/UDP source range value. A field for entering a TCP/UDP source
value appears.

Source Port No.: When "Specific" is selected for the TCP/UDP source filter, you can enter a specific
TCP/UDP source value. The allowed range is 0 to 65535. A frame that hits this ACE matches this
TCP/UDP source value.

Source Port Range: When "Range" is selected for the TCP/UDP source filter, you can enter a specific
TCP/UDP source range value. The allowed range is 0 to 65535. A frame that hits this ACE matches this
TCP/UDP source value.

Destination Port Filter: Specify the TCP/UDP destination filter for this ACE. Any: No TCP/UDP
destination filter is specified (TCP/UDP destination filter status is "don't-care"). Specific: If you want to
filter a specific TCP/UDP destination filter with this ACE, you can enter a specific TCP/UDP destination
value. A field for entering a TCP/UDP destination value appears. Range: If you want to filter a specific
range TCP/UDP destination filter with this ACE, you can enter a specific TCP/UDP destination range
value. A field for entering a TCP/UDP destination value displays.

Dest. Port No.: When "Specific" is selected for the TCP/UDP destination filter, you can enter a specific
TCP/UDP destination value. The allowed range is 0 to 65535. A frame that hits this ACE matches this
TCP/UDP destination value.

Destination Port Range: When "Range" is selected for the TCP/UDP destination filter, you can enter a
specific TCP/UDP destination range value. The allowed range is 0 to 65535. A frame that hits this ACE
matches this TCP/UDP destination value.

TCP FIN: One of several TCP flag names used only when filtering TCP (urg, ack, psh, rst, syn, and fin).
Specify the TCP "No more data from sender" (FIN) value for this ACE. 0: TCP frames where the FIN field
is set must not be able to match this entry. 7: TCP frames where the FIN field is set must be able to match
this entry. Any: Any value is allowed ("don't-care").

TCP SYN: One of several TCP flag names used only when filtering TCP (urg, ack, psh, rst, syn, and fin).
Specify the TCP "Synchronize sequence numbers" (SYN) value for this ACE. 0: TCP frames where the
SYN field is set must not be able to match this entry. 7: TCP frames where the SYN field is set must be
able to match this entry. Any: Any value is allowed ("don't-care").

TCP RST: One of several TCP flag names used only when filtering TCP (urg, ack, psh, rst, syn, and fin).
Specify the TCP "Reset the connection" (RST) value for this ACE. 0: TCP frames where the RST field is
set must not be able to match this entry. 1: TCP frames where the RST field is set must be able to match
this entry. Any: Any value is allowed ("don't-care").
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TCP PSH: One of several TCP flag names used only when filtering TCP (urg, ack, psh, rst, syn, and fin).
Specify the TCP "Push” function (PSH) value for this ACE. 0: TCP frames where the PSH field is set must
not be able to match this entry. 7: TCP frames where the PSH field is set must be able to match this entry.
Any: Any value is allowed ("don't-care").

TCP ACK: One of several TCP flag names used only when filtering TCP (urg, ack, psh, rst, syn, and fin).
Specify the TCP "Acknowledgment field significant" (ACK) value for this ACE. 0: TCP frames where the
ACK field is set must not be able to match this entry. 7: TCP frames where the ACK field is set must be
able to match this entry. Any: Any value is allowed ("don't-care").

TCP URG: One of several TCP flag names used only when filtering TCP (urg, ack, psh, rst, syn, and fin).
Specify the TCP "Urgent Pointer field significant" (URG) value for this ACE. 0: TCP frames where the
URG field is set must not be able to match this entry. 7: TCP frames where the URG field is set must be
able to match this entry. Any: Any value is allowed ("don't-care").

UDP Parameters

Source Port Filter: Specify the TCP/UDP source filter for this ACE. Any: No TCP/UDP source filter is
specified (TCP/UDP source filter status is "don't-care"). Specific: If you want to filter a specific TCP/UDP
source filter with this ACE, you can enter a specific TCP/UDP source value. A field for entering a
TCP/UDP source value appears. Range: If you want to filter a specific TCP/UDP source range filter with
this ACE, you can enter a specific TCP/UDP source range value. A field for entering a TCP/UDP source
value appears.

Source Port No.: When "Specific" is selected for the TCP/UDP source filter, you can enter a specific
TCP/UDP source value. The allowed range is 0 to 65535. A frame that hits this ACE matches this
TCP/UDP source value.

Source Port Range: When "Range" is selected for the TCP/UDP source filter, you can enter a specific
TCP/UDP source range value. The allowed range is 0 to 65535. A frame that hits this ACE matches this
TCP/UDP source value.

Dest. Port Filter: When "Specific" is selected for the TCP/UDP destination filter, you can enter a specific
TCP/UDP destination value. The allowed range is 0 to 65535. A frame that hits this ACE matches this
TCP/UDP destination value.

Destination Port Range: When "Range" is selected for the TCP/UDP destination filter, you can enter a
specific TCP/UDP destination range value. The allowed range is 0 to 65535. A frame that hits this ACE
matches this TCP/UDP destination value.
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Ethernet Type Parameters

The Ethernet Type parameters can be configured when Frame Type "Ethernet Type" is selected.

EtherType Filter: Specify the Ethernet type filter for this ACE.
Any: No EtherType filter is specified (EtherType filter status is "don't-care").
Specific: If you want to filter a specific EtherType filter with this ACE, you can enter a specific
EtherType value. A field for entering a EtherType value appears.

Ethernet Type Value: When "Specific" is selected for the EtherType filter, you can enter a specific
EtherType value. The allowed range is 0x600 to OxFFFF but excluding 0x800 (IPv4), 0x806 (ARP) and
0x86DD (IPv6). A frame that hits this ACE matches this EtherType value.

Example:
LANTRONIX™ =| e H 0 ¢
- v L L
SM8TBT2SA Access Control List Configuration @iHome - Access Control - Access Control List
Switch DMS
Auto-refresh ‘ Refresh ‘ Clear H Remove All
» System <
D RISt < ACE Ingress Port Frame Type Action Metering Mirror Counter
=)
» PoE Management < 1 Any IPv4/Other 255 SIP:0.0.0.0/32 DIP:0.0.0.0/24  Deny 1000000 Kbps  Enabled 0 [xJE
» VLAN Management ¢ 2 Any Ethernet Type Permit Disabled Disabled Disabled @&
» Quality of Service 3 Ay IPv4/TCP SIP:0.0.0.0/24 DIP:0.0.0.0/32 Shutdown 1000000 Kbps Disabled Disabled @ G
» S ing Tr <
panning free 4 Any Any Permit Disabled Disabled Disabled @&
» MAC Address Table S
5 2 Any Permit Disabled Disabled Disabled @&
b Multicast <
. ©
» Percepxion <

Control Icons

0 Add ACE to end of list.

E" Edit ACE on this line.
e Delete ACE on this line.

Buttons

Auto-refresh : Check this box to automatically refresh the page every 3 seconds.
Refresh : Click to manually update webpage information immediately.
Clear : Click to clear the ACL configuration information.

Remove All : Click to remove all ACL entries from the table. At the confirmation prompt click OK to
proceed.
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13.12 Access Control Status

This page displays the Access Control status.

® LApRONX ik . Auto-logout -OFF ~
L/\NT?ON'X =| ‘v TV VYYw ¥ = stologout [oFF_~] 2] g
SM8TBT2SA Access Control Status @ Home - Access Control - Access Control Status ‘
Switch DMS —
Auto-refresh ‘ Refresh ‘
» System < —

¢ Port Status

-

Port Management

-

PoE Management g Port State Re-open

-

VLAN Management <
1 None

~

-

Quality of Service

» Spanning Tree < 2 None ‘ |
» MAC Address Table < —_—
3 None ‘ |
» Multicast < —
» Percepxion <| |4 None ‘ |
» < )
oHeE 3 None ‘ |

» Security <
6 None ‘ |
» Access Control M J
> Access Control List l
7 None ‘ |

> Access Control Status

» SNMP < 8 None ‘ |
» Event Notification < —
9 None ‘ |
» Diagnostics < R —
» Maintenance < 10 None ‘ |

Port: The port number of the access control status.

State: Shows the current state of the port. It can take one of two values:

None: The port is normally used.
Shutdown: The port is shut down by ACL rule.

Re-open button: Click to recover the shutdown port that was triggered by the ACL rule.

Buttons
Auto-refresh: Check this box to refresh the page automatically every 3 seconds.

Refresh: Click to manually refresh the page immediately.
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13.13 Switch > Event Notification
This page displays the SNMP Trap, Syslog, and Event Notification menu options.

13.13.1 Switch > Event Notification > SNMP Trap

Navigate to the Switch > Event Notification > SNMP Trap menu path to display the SNMP Trap Hosts
Configuration table. Here you can add and configure up to six SNMP Trap hosts.

» MAC Address Table <

ry
® — || o [ §_.] Auto-logout |[OFF - »
LANTRONIX® E| Vs svewewse = = -] M @ C
SM8TBT2SA SNMP Tl’ap Hosts Configuration gk Home - Event Notification - SNMP Trap
Switch DMS
Delete MNo Name Mode Version  Destination Address Destination Port Severity Level
b System ¢
1
» Port Management « O
» PoE Management « O 2
» VLAN Management < B0 3
i i <
¥ Quality of Service 0 4
» Spanning Tree <
O
O

6
Multicast <

» Percepxion & Apply

R ’

-

Click a line to display its configurable parameters:

r Y
S = wmae i = Auto-logout [OFF  + :
LANTRONIX® =| s wewewwew » = e H ec
SMETBT2SA Add SNMP Trap Host @iHome - Event Notification -~ SNMP Trap
Switch DMS
Trap Host Settings
» System
» Port Management < No 1

-

PoE Management < Trap Mode

VLAN Management <

-

Trap Version v2e
» Quality of Service <
Trap Community
» Spanning Tree <
» MAC Address Table < Trap Destination Address
i <
> Multicast Trap Destination Port 169
» Percepxion <
Severity Level Emerg
» DHCP <
» Security <
[ Apply H Reset H Cancel ]
b Arcace Cantral <
Parameters:

No: Displays the instance number for this line in the table.

Trap Name: Indicates the community access string when sending SNMP trap packet. This comes from
the Trap Community parameter (see below).
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Trap Mode: Indicates the SNMP mode operation. Possible modes are:
Disabled: Disable SNMP mode operation (default). -
UDP: Enable UDP SNMP mode operation. —
TCP: Enable TCP SNMP mode operation. :|:.:_:

Trap Version: The SNMP trap version. SNMP trap supports version 2c.

Trap Community: Enter the SNMP community name. This is the community access string when sending
SNMP trap packet. The allowed string length is 1-32 characters, and the allowed content is ASCII
characters 33 - 126. This becomes the “Name” parameter.

Trap Destination Address: Indicates the SNMP trap destination address.

Trap Destination Port: Indicates the SNMP trap destination port. SNMP Agent will send SNMP message
via this port, the port range is 1~65535.

Severity Level: At the dropdown select what level of message to send to trap server. Possible levels are:
Emerg: Emergency; System is unusable.

Alert. Action must be taken immediately. m
Crit. Critical conditions.  Emers

Error. Error conditions. Alert
Warning: Warning conditions. crie
Notice:  Normal but significant conditions. _I:rr,
Info: Information messages. Motice
Debug: Debug-level messages. 'E
Debug
Buttons

Apply: Click to save changes.
Reset: Click to undo any changes made locally and revert to previously saved values.

Cancel: Click to cancel the page edits.

Example

The screen below shows three SNMP Trap Hosts configured:

SNMP Trap Hosts Configuration @Home - Event Notification -~ SNMP Trap
Delete Ne  Name Mode Version Destination Address Destination Port Severity Level
I_- 1 1 TCP v2c 192.168.1.30 162 Crit
E 2 Bob UDpP vac 192.168.1.40 162 Warning
& 3 admin TCP vac 192.168.1.10 162 Emerg

w
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13.13.2 Switch > Event Notification > eMail

The Switch > Event Notification > eMail menu path displays the SMTP Configuration page. Configure
SMTP (Simple Mail Transfer Protocol) on this page. Simple Mail Transfer Protocol is the message-
exchange standard for the Internet.

The switch is to be configured as a client of SMTP while the server is a remote device that will receive
messages from the switch on which the alarm events occurred.

To configure SMTP via the web UI:
1. Click Event Notification, Syslog, and eMail.

2. Specify the SMTP Configuration parameters.
3. Click Apply.

SM TP Conﬂgu I'Eltlon @EHome - Event Notification - eblail

Mail Server 152.168.1.88

User Name

m

Password

Sender smi6tatisa

Return Path smibtat?sa@192.162.90.3
Email Address 1 jefischierman@comeast.com
Email Address 2 bibb@system.com

Email Address 3 techsupport@univeral.org
Email Address 4

Email Address 5

Email Address 6

Figure 13-13.1: SMTP Configuration page
Parameter descriptions:

Mail Server : The IP address or hostname of the mail server. IP address is expressed in dotted decimal
notation. This will be the device that sends out the email for you

User Name : Specify the username on the mail server.
Password : Specify the password of the user on the mail server.
Sender : Specify the sender name of the alarm mail.

Return Path : Specify the sender email address of the alarm mail. This address will be the "from" address
on the email message.

Email Address # : Specify the email address of the receiver.
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Buttons
Apply: Click to save changes.
Reset: Click to undo any changes made locally and revert to previously saved values.
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13.13.3 Switch > Event Notification > Syslog

The Switch > Event Notification > Syslog menu path provides the Syslog Configuration and View Log
menu options.

Syslog is a standard for logging program messages. It allows separation of the software that generates
messages from the system that stores them and the software that reports and analyzes them. Syslog is
supported by a wide variety of devices and receivers across multiple platforms.

13.13.3.1 Syslog Configuration

Here you can enable System Logging and provide an IP Address for up to six Syslog servers. To
configure Syslog Configuration in the web interface:

1. Click Event Notification, Syslog, and Syslog Configuration.

2. At Mode, select “on” to enable Syslog globally.

3. Specify the syslog parameters including the IP Address of Syslog server and Port number.
4. Click Apply.

SYStEIT"I LogConfiguration @ Home - Event Notification - Sysiog - Systog Configuration

Mode ﬁ

Server 1
Server2
Server 3
Serverd
Servers

Server e

Figure 13-13.3.1: System Log Configuration page
Parameter descriptions:

Mode: Select the server mode of operation. When the mode is “on” (enabled) syslog messages will be
sent out to the configured syslog server. The syslog protocol is based on UDP communication and
received on UDP port 514 and the syslog server will not send acknowledgments back to the sender since
UDP is a connectionless protocol and it does not provide acknowledgments. The syslog packet is always
sent out even if the syslog server does not exist. Possible modes are:

On: Enable server mode operation.
Off. Disable server mode operation.

Server 1 to 6: Indicates the IPv4 hosts address of syslog server. If the switch provides DNS, it also can
be a host name (FQDN).

Buttons

Apply: Click to save changes.

Reset: Click to undo any changes made locally and revert to previously saved values.
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13.13.3.2 View Log

This page displays the switch system log (Syslog) information. To display the log configuration in the
web interface:

1. Click Event Notification, Syslog, and View Log.

2. Observe the log information.

System Log Information @Home - Eventhotficition - Syllog - ViewLog
Show 10 w entries Search:
1D * Level Time Message
1 Warning 2017-01-01T00:00:05+00:00 Switch just made a warm boot.
2 nfo 2017-01-01T00:00:06+00:00 Password of user 'admin' was changed
3 Info 2017-01-01T00:00:07+00:00 Management IP address was changed
4 nfo 2017-01-01T700:00:09+00:00 SFP module inserted on port 17
5 Info 2017-01-01T00:00:09+00:00 SFP module inserted on port 18
6 Warning 2017-01-01700:00:11+00:00 Linkupon port &

Interface GigabitEthernet 1/17 rx power 0.00

T nfo 2017-01-01T00:00:20+00:00 EERGT,
exceeds Alarm-Low Limitation

8 Warning 2017-01-01T00:00:21+00:00 Linkupon port 3

9 Wwarning 2017-01-01T00:00:22+00:00 Link up on port 5

10 Warning 2017-01-01T00:00:22+00:00 Link up on port 7

Showing 1 to 10 of 27 entries n 2 |3 Next

Figure 13-13.3.2: System Log Information page

Parameter descriptions:
ID: The ID of the system log entry.
Level: the level of the system log entry. The following level types are supported:

Debug: debug level message.

Info: informational message.

Notice: normal, but significant, condition.

Warning: warning condition.

Error: error condition.

Crit: critical conditions.

Alert: action must be taken immediately.

Emerg: system is unusable.
Time: Displays the log record by device time; the time of the system log entry.
Message: Displays the log detail message; the message of the system log entry (e.g., LINK-UPDOWN).
Search: Lets you search for the information that you want to view.

Show entries: Lets you choose how many items you want to view per page (i.e., 10, 25, 60, ALL).
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Buttons

Refresh: Updates the system log entries, starting from the current entry ID.

Clear Logs: Clears all the system log entries and display “No data available in table”.
Next: Updates the system log entries, turn to the next page.

Previous: Updates the system log entries, turn to the previous page.

System Log Message Examples

Warning LINK-UPDOWN: Interface GigabitEthernet 1/1, changed state to up.

Warning WARM-START: Switch just made a warm boot.

Info LOGIN: Login passed for user 'admin’

Info LOGOUT: User " logout

Warning SFP: Interface GigabitEthernet 1/17 rx power 0.00 exceeds Alarm-Low Limitation
Warning POE-PD-OFF: Port 3 PoE PD off

Warning LINK-UPDOWN: Interface GigabitEthernet 1/7, changed state to up.

Info SFP: Interface GigabitEthernet 1/17 rx power 0.00 exceeds Alarm-Low Limitation
Info LACP: LACP was enabled on port 2 w ith key 1

Alert MGMT-IP-CHANGE: Management IPv4 address of interface VLAN 1 was changed
Info SFP: SFP module inserted on port 9
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13.13.3 Event Configuration

The Event Notification > Event Configuration page displays the Event Configuration table. Here you can
view and configure severity levels, Syslog status, and Trap status for each Group Name.

Event Configuration Bivome - Eventhiotfiession - Event Configueation
Group Name Severity Level Syslog Trap SMTP
802.1X o v v = =
ACCESS-MGMT néo v | | ()
ACL nfe ~ = E [
AUTH-FAILED Warning W ™ = )
COLD-START Warning W = [ E
LACP o w = C )]
LINK-UPDOWN Warning v |~ ]
LOGIN v | = &
LOGOUT nfo v vl ] 1|
LOOP-PROTECTION nfo v v [

MAC-TABLE v | = ]
Parameters:

Group Name: The name identifying the severity group.

Severity Level: Every group has a severity level. These levels are supported:
Emergency: System is unusabile.

Alert. Action must be taken immediately.
Critical: Critical conditions.

Error. Error conditions.

Warning: Warning conditions.

Notice: Normal but significant conditions.
Information: Information messages.

Debug: Debug-level messages.

Syslog: Check the checkbox to enable Syslog for this Group Name.
Trap: Check the checkbox to enable Syslog for this Group Name.
SMTP : Check the checkbox to enable SMTP email events for this Group Name.

Buttons
Apply: Click to save changes.
Reset: Click to undo any changes made locally and revert to previously saved values.
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Chapter 14 Diagnostics > Diagnostics

This module provides basic system diagnostics to help you determine system health. > Ping

The diagnostics include Ping, Traceroute, Cable Diagnostics, and Mirroring. ~
* Traceroute

» Cable Diagnostics

14-1 Ping
* Mirroring
This page lets you issue ICMP Ping packets to troubleshoot IPv4 or IPv6 connectivity issues.
To configure a PING in the web interface:
1. Click Diagnostics and Ping.
2. Specify IP Address, IP Version, Ping Length, and Ping Count.
3. Click Start.
Plng @Home - Diagnostes - Ping
IP Address
IP Version Pyl w
Ping Length 34
Ping Count
PING 192.168.1.100 (192.168.1.100): 34 data bytes
42 bytes from 192.168.1.100: seq=0 tti=64 time=20ms
42 bytes from 192,168.1.100: seq=1 ttl=64 time<1ms
42 bytes from 192.168.1.100: seq=2 ttl=64 time=30ms
--- 192.168.1. 100 ping statistics --—-
3 packets transmitted, 3 packets received, 0% packet loss
round-trip min/avg/max = 0.0/16.6/30.0 ms
Figure 14-1: Ping Diagnostic page
Parameter descriptions:
IP Address: Enter the IP Address of the device that you want to ping.
Pvé

IP Version: Select the required IP Version (IPv4, IPv6, or Domain Name).

=2

omain Mame

Egress Interface: Specify an interface VLAN for sending ICMPv6 Echo packets.
Ping Length: The payload size of the ICMP packet. Values range from 1-1452 bytes.
Ping Count: The count of the ICMP packet. Values range from 1-60 times.

Start: Click the “Start” button to start to ping the target IP address.

After you press Start, five ICMP packets are transmitted, and the sequence number and roundtrip time are
displayed upon reception of a reply. The page refreshes automatically until responses to all packets are
received, or until a timeout occurs.
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Successful Ping:

PING 192.168.1.77 (192.168.1.77): 56 data bytes

64 bytes from 192.168.1.77: seq=0 ttI=64 time=0.000 ms
64 bytes from 192.168.1.77: seq=1 ttI=64 time=0.000 ms
64 bytes from 192.168.1.77: seq=2 ttlI=64 time=0.000 ms
64 bytes from 192.168.1.77: seq=3 ttI=64 time=0.000 ms
64 bytes from 192.168.1.77: seq=4 ttl=64 time=0.000 ms

--- 192.168.1.77 ping statistics ---
5 packets transmitted, 5 packets received, 0% packet loss
round-trip min/avg/max = 0.000/0.000/0.000 ms

Failed Ping:

PING 192.168.1.32 (192.168.1.32): 56 data bytes
Request timed out.
Request timed out.
Request timed out.
Request timed out.
Request timed out.

--- 192.168.1.32 ping statistics ---
5 packets transmitted, 0 packets received, 100% packet loss

Messages:

Please enter a valid IP v4 address.

Please enter a valid IP v6 address.

Please enter a valid domain name address.

33873 Rev. A https://www.lantronix.com/

Page 223 of 273


https://www.lantronix.com/

Lantronix SMXTBTxSA Web User Guide

14-2 Traceroute
This page allows you to issue ICMP or UDP packets to diagnose network connectivity issues.

To configure a traceroute in the web Ul:

1. Click Diagnostics and Traceroute.

2. Specify IP Address, IP Version, IP Protocol, Wait Time, Maximum TTL, and Probe Count.
3. Click Start.

Traceroute dHome - Diagnostics - Tracersute

IP Address 192 168.1.99

IP Version Byd W
IP Protocol cME W

Wait Time

Maximum TTL 20

Probe Count

traceroute to 192.168.1.99 (192.168.1.99), 20 hops max, 3& byte packets

.....

Figure 14-2: Traceroute page
Parameter descriptions:
IP Address: The destination IP Address.
IP Version: Select the IP Version (IPv4, IPv6, or Domain Name).
IP Protocol: The protocol (ICMP or UDP) packets to send.
Egress Interface: Specify an egress interface for sending traceroute packets. Only used in IPv6.

Wait Time: Set the time (in seconds) to wait for a response to a probe (default 5.0 sec). Values range
from 1 to 60. The payload size of the ICMP packet. Values range from 2 bytes to 1452 bytes.

Maximum TTL: Specify the maximum number of hops (max time-to-live value) traceroute will probe.
Values range from 1 to 255. The default is 30.

Probe Count: Sets the number of probe packets per hop. Valid values are 1 - 10. The default is 3.

Button
Start: Begin traceroute to the IP address that you selected.

Message: fraceroute: can't connect to remote host: Network is unreachable
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14-3 Cable Diagnostics

This section is used for running the Cable Diagnostics for copper ports. Press Start to run the
diagnostics. This will take approximately 5 seconds. If all ports are selected, this can take approximately
15 seconds. When completed, the page refreshes automatically, and you can view the cable diagnostics
results in the cable status table. Note that this is only accurate for cables of length 7 -140 meters. The 10
Mbps and 100 Mbps ports will be linked down while running the Cable Diagnostics. Running on a 10
Mbps or 100 Mbps management port will cause the switch to stop responding until it is complete.

The cable length reported could have a plus or minus 3 meter inaccuracy if the diagnostic port to be
checked is link down, and it could have a plus or minus 15 meter inaccuracy if the diagnostic port to be
checked is link up. Note that the port link up on 10M speed is not supported.

To run a Cable Diagnostic in the web Ul:

1. Click Diagnostics and Cable Diagnostics.

2. Se the Port that you want to check.

3. Click Start.
A
LANTRONIX® =| T oo
- . vy
SMBTBTZSA Ca ble Dia gnOSfICS gHome - Diagnostics -~ Cable Diagnostics
Switch DMS —
Port3 w | Start |
> System e - :
b Port Management ¢ Cable Diagnostics Status
(=)
» PoE Management < Port Link Status Test Result Length
» \ ¢
VLAN Management 1 e 0K 8.00 (m)
» Quality of Service &
2
» Spanning Tree e
3 Link Down Abnormal 0.00 (m)
» MAC Address Table <
» Multicast © 4
» Percepxion < 5 1G 0K 6.00 (m)
» DHCP < 8 16 0K 11.00 (m)
» Security < 7
» Access Control < 8
» SNMP <
9
» Event Notification <

Figure 14-3: Cable Diagnostics page

Port : At the dropdown, select he port number on which you want to run Cable Diagnostics.

Cable Diagnostics Status

Port: The Port number you are requesting Cable Diagnostics.

Link Status: Provides the current link speed of the port (e.g., 1G or Link Down).
Test Result: The status of the cable pair being diagnosed (e.g., OK or Abnormal)
Length: The length (in meters) of the cable pair.

Button

Start : Start cable diagnostics on the port that you selected. The message displays
momentarily.
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Message: The cable length reported could have a plus or minus 3 meter inaccuracy if the diagnostic port
to be checked is link down, and it could have a plus or minus 15 meter inaccuracy if the diagnostic port to
be checked is link up.

Meaning: informational message only, detailing the accuracy of the diagnostic in certain conditions.
Recovery: None; click the OK button and continue operation.

33873 Rev. A https://www.lantronix.com/ Page 226 of 273



https://www.lantronix.com/

Lantronix

SMXTBTxSA Web User Guide

14-4 Mirroring

You can mirror traffic from any source port to a target port for real-time analysis. You can then attach a
logic analyzer or RMON probe to the target port and study the traffic crossing the source port in a
completely unobtrusive manner.

Mirror Configuration is used to monitor the traffic of the network. For example, assume that Port A and
Port B are Monitoring Port and Monitored Port respectively; the traffic received by Port B will be copied to
Port A for monitoring. To configure Mirror parameters in the web Ul:

1.

ok wbd

' LANTRONIX® =| " wwwwese

Mirror Configuration:

Click Diagnostics and Mirroring.
At the Mode selection select on.
At the dropdown select the Monitor Destination Port.
Select Disabled, Enabled, TX Only, or RX only as the port mirror Mode for each port.
Click the Apply button to save the settings.
To cancel the setting click the Reset button to revert to previously saved values.

SMETBT2SA
Switch DMS
» System

» Port Management

-

PoE Management

-

VLAN Management

-

Quality of Service

-

Spanning Tree

-

MAC Address Table

-

Multicast

-

Percepxion

-

DHCP

-

Security

-

Access Control

-

SNMP

-

Event Notification

-

Diagnostics
> Ping
> Traceroute
> Cable Diagnostics

> Mirroring

» Maintenance

Mirror Configuration

ode [ @

Monitor Destination Port Portz v

Menitor Source Port Configuration

Port Mode

L Disabled +
7 Rxonly — +
3 Disabled +
4
p Disabled
6 Disabled
; Disabled
2 Disabled
5 Disabled
o Disabled w
oy | esa

Figure 14-4: Mirror Configuration page

Mode: Indicates the Mirror mode operation. Possible modes are:

on: Enable Mirror mode operation.
off: Disable Mirror mode operation.

Auto-logout H 0 C’

gHome - Diagnostics - Mirroring

Monitor Destination Port : Port to output the mirrored traffic. Also known as the mirror port. Frames from
ports that have either source (rx) or destination (tx) mirroring enabled are mirrored on this port.
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Monitor Source Port Configuration:

Port: The logical port for the settings contained in the same row.
Mode: Select mirror mode:

Rx only: Frames received on this port are mirrored on the mirror port. Frames transmitted are not
mirrored.

Tx only: Frames transmitted on this port are mirrored on the mirror port. Frames received are not
mirrored.

Disabled: neither frames transmitted nor frames received are mirrored.

Enabled: Frames received and frames transmitted are mirrored on the mirror port.

Buttons
Apply: Click to save changes.

Reset: Click to undo any changes made locally and revert to previously saved values.
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Chapter 15 Maintenance  Maintenance

» Configuration
This chapter describes the switch Maintenance configuration tasks to enhance the
performance of local network including Save, Backup, Restore, Activate, Delete, Restart

> Save startup-config

Device, Factory Defaults, and Firmware upgrade and Firmware Selection. > Backup
> Restore
. . > Activate
15-1 Configuration X
> Delete

The switch stores its configuration in a number of text files in CLI format.

» Restart Device

The files are either virtual (RAM-based) or stored in flash on the switch. > Factory Defaults

There are three system files: » Firmware
> Firmware Upgrade

¢ running-config: A virtual file that represents the currently active configuration on
the switch. This file is volatile. The config settings must be different than the default
settings.

o startup-config: The startup configuration for the switch, read at boot time.

o default-config: A read-only file with vendor-specific configuration. This file is read when the system
is restored to default settings.

> Firmware Selection

It is also possible to store up to two other files and apply them to running-config, thereby switching

configuration.

15-1.1 Save running-config

This will copy the running-config to startup-config, thereby ensuring that the currently active
configuration will be used at the next reboot.

To save running configuration in the web Ul:
1. Click Maintenance, Configuration, Save startup-config.

2. Click Save Configuration.

r Y
= L2 Rt L. Auto-logout |OFF + : »
LANTRONIX" Z| Vs sowenwes » = o T M @ C
SM&TBT2SA Save Running Configuration to startup-config @eHome - Maintenance - Configuration - Save startup-config
Switch DMS
b System < Please note:
» Port Management < The generation of the configuration file may be time consuming, depending on the amount of non-
default configuration.

» PoE Management <
» VLAN Management S

. . | Save Configuration ‘
» Quality of Service < QSR e

Figure 15-1.1: Save Running Config to startup-config
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Button

Save Configuration: Click to save configuration; the running configuration will be written to flash memory
for system boot up to load this startup configuration file. When done, the message “startup-config saved
successfully.” displays. Note: The generation of the configuration file may be time consuming, depending
on the amount of non-default configuration.

Sample running-config file in WordPad:

....|...O
! &

..||...'I..||...2..||...3..||...4..|||||5|||||||a|||||||?|

hsername admin privilege 15 password encrypted sha
3kel2cT5aTh5048a435fbéec8le52£E92d6dT95a8k5a%c1T0T0EEa63Cc9Tas3b2
exec-timeout autologout O

1

vlan 1

!

access-list ace 1 frame-type ipv4d ip-protocol 255 s=ip 0.0.0.0/32
dip 0.0.0.0/24 tos ip-precedence 4 action deny metering 1000000
mirror counter

access-list ace 2 frame-type etype ctag tagged stag-priority 0-3
access-list ace 3 frame-type ipvd-tcp =sip 0.0.0.0/24 dip
0.0.0.0/32 ip-flag ip-fragment 1 tos ip-precedence 0 action
shutdown metering 1000000

access-list ace 4

access-list ace 5 ingress interface GigabitEthernst 1/2
radius-server key encrypted BFDR4650D3169D385383SE6RA0CC2Z3659D
radius-server host THost-1 auth-port 1812 acct-port 1813 timeout
5 retransmit 3 key encrypted ES16ARE1881CEZDRA4641F38B4SE1B3AS
tacacs-server key encrypted T9F4B19BE2ADE6CEB4FCE636DSEES5FD4S
tacacs-server host THost-1 port €78 timecut 100 key encrypted
BFDR4650D3165D389889E6A0CC23655D

tacacs-server host Thost-2 port 765 timecut 40 key encrypted
FESBA3CCS59E107F2341BESCBES TFCBA
port-security
poe management mode class—-consumption

trap 1 UDP v2c 192.168.1.99% 1 admin 162

trap 2 UDP v2c 192.168.1.88 3 Adminl23 162

SnMp-SEeYvVer Service

rmon alarm 1 ifTnCctets 1 30 delta rising-threshold 4 2 falling-
threshold 3 1 koth

rmon event 1 description Event 1 log

dms service-mode enabled priority non
percepxion

1

interface GigabitEthernet 1/1

porc—-security

portc-security violation trap

rmon collection stats 1

rmon collection history 1 interwval 1000 buckets 40

1
interface GigabitEthernet 1/2

rmon collection stats 2

rmon collection history 2 interwval 1900 buckets 60

1
interface GigabitEthernet 1/3

porc—-security

port-security violation trap-shutdown

1
interface GigakbitEthernet 1/4

port—-security

1
interface GigakbitEthernet 1/5

port—-security

1

interface GigakbitEthernet 1/6

]
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15-1.2 Backup Configuration

This webpage lets you export the Switch Configuration for maintenance needs. Any current configuration
files will be exported as text format.

If the file system is full (i.e., contains the three system files mentioned above plus two other files), it is
not possible to create new files, but an existing file must be overwritten or another deleted first.

To back up a configuration file in the web Ul:
1. Click Maintenance, Configuration, Backup.
2. Select running-config, default-config, or startup-config for backup.

3. Click the Backup button. At the prompt select Open or Save or View Download.

'y
S LANTRONIC Auto-logout [ 2
LANTRONIX" = vewowe br <] M @ C
SM8TBT2SA BaCkUp Configuration F|le #Home - Maintenance - Configuration - Backup
Switch DMS S
Select configuration file for backup.
» System € Please note: running-config may take a while to prepare for download.
» Port Management e .
File Name

» PoF Management B
» VLAN Management ¢ @ running-config
» Quality of Service < (O default-config
» Spanning Tree ¢ () startup-config
» MAC Address Table e )
» Multicast E | ST |

Figure 15-1.2: Backup Configuration File

Parameter descriptions:
running-config: A virtual file that represents the currently active configuration on the switch. This file is
volatile. The config settings must be different than the default settings.

default-config: A read-only file with vendor-specific configuration. This file is read when the system is
restored to default settings.

startup-config: The startup configuration for the switch, read at boot time.

Buttons

Backup : Click the “Backup” button then the switch will start to download the configuration from flash
memory to the PC or Server. Note: running-config may take a while to prepare for download.

Note: Starting at firmware v1.01.1201, the Backup config file name will automatically include the device's
IP address and the date.
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Example:

A sample startup-config page is shown below:

Bid

= | startup-config_10.0.4 - WordPad
| —

Home View '-@J'
= Cut T o == - — ] o Eeme Find
D " Courier New 11 ~|A A == ~ :E' . ,a‘,,.ﬁ Efivi 4 Fin
Copy - ey e abh
Copy 33¢ Replace
Paste B 7 U ae X x* &~ A~ ||=|= = =| 5 | PFidure Paint Dateand Insert | ...
- : — | — ~  drawing time object | Ol Selectall
Clipboard Fant Paragraph Insert Editing
-g---.---1---.---2---.---3---.---4---.---5---.---5- | O

»

username admin privilege 15 password encrypted sha
Bce576e3b5410415bde908bd4deelsdfbl167a%c873fc4bbBallf6cf2ab448a518
exec—timeout auteologout 0
I
vlan 1
I
ipmec profile 4
description 44
ipmc mode
ip dhep snooping
ip dhep relay
ip helper-address 1.2.3.4
ip dhep relay information option
ip
access—list ace 1

m

dhep relay information policy drop

access—list ace 2 frame-type etype
access—list ace 3 frame-type ipvé

ip igmp snooping

ipve mld host-proxy
ipvé mld snooping
mvr vlan 1 name 4
mvr vlan 1 igmp-address 0.0.0.0
mvr vlan 1 mode dynamic
Il mvr vlan 1 frame tagged tagged
mvr vlan 1 frame priority 0O
mvr vlan 1 last-member-guery-interval 5
mvr vlan 1 channel 4

radius-server key encrypted
2937FA9640CFDAFB57650CD3D926AF4F4CEBE44ED20138409B8A8E6EBSAS98A5DECIESD282913B27D5
1B75525C8AR3CA32836BSB5SF69BES287945E57C041B4320

radius—-server
radius—-server
radius—-server
key encrypted
spanning-trees
spanning-tree
spanning-tree
spanning-tree
spanning-tree
spanning-tree
spanning—tree
spanning-trees
spanning-tree

attribute 4 1%2.168.1.111

attribute 32 11111111

host 111111 auth-port 1812 acct-port 1813 timeout 5 retransmit 3
BFDA4630D3165D38%883E6R0CC236559D

name 00-C0-F2-45-AB-14 revision 1
1 wlan 2,5,20-40

2 wlan 100-200

max—hops 11

max—age 10

forward-time 11

0 priority 36864

1 priority 28672

mst
mst
mst
mst
mst
mst
mst
mst

poe management mode class—consumption
poe auto—check

dm= service-mode enabled priority high
event group B02.1X smtp enable

100% (=) -
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15-1.3 Restore Configuration

It is possible to import a file from the web browser to all the files on the switch, except default-config,
which is read-only. Select the source file to restore, and select the destination file on the target.
To restore a configuration via the web Ul:

1. Click Maintenance, Configuration, and Restore.

2. Browse to and select a Source File.

3. Click the Restore button.

A
LANTRONIX® =| ‘7% -
- L L L
SM8TBT25A Restore COHfigUI’atiDn @@ Home - Maintenance - Configuration - Restore
Switch DMS
Source File Choose File | running-co...0_20240102
P System <
‘ <
> PortManagement Destination File
» PoE Management e
File Name Parameters
» VLAN Management <
» Quality of Service < (O running-config @® Replace (O Merge
» Spanning Tree E () startup-config
[ 3 < .
MAC Address Table T B
» Multicast e
» Percepxion B | ‘

Figure 15-1.3: Restore Configuration
There are three destination file name selections:

running-config: A virtual file that represents the currently active configuration on the switch. This file is
volatile. You can select “Replace” the existing file, or “Merge” the existing running-config file with the new
file. If the destination is running-config, the file will be applied to the switch configuration.

This can be done in two ways:

Replace: The current configuration is fully replaced with the configuration specified in the source
file.

Merge: The source file configuration is merged into running-config.
startup-config: The startup configuration for the switch, read at boot time.

Create new file: A read-only file with vendor-specific configuration. This file is read when the system is
restored to default settings.

Buttons

Browse: Click the browse button to search for the configuration text file and filename.

Restore: Click the “Restore” button then the running web management PC will start to upload the
configuration from the location PC configuration into the managed switch.

Message: The config file is uploaded successfully.
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15-1.4 Activate Configuration

It is possible to activate any of the configuration files present on the switch, except for running-config
which represents the currently active configuration.

To activate a configuration file in the web UlI:
1. Click Maintenance, Configuration, and Activate Configuration.
2. Select the File Name to be activated.

3. Click the Activate Configuration File button. This will initiate the process of completely replacing the
existing configuration with that of the selected file.

N [ Lis) Auto-logout |OFF v »
LANTRONIX™ = suwwe o <] 1 @ €
SM8TBT25A ACti\."ate CanigU ration @& Home - Maintenance - Configuration - Activate
Switch DMS
b System ¢ Activate File Name
» Port Management < startup-config
» PoF Management <
P VLANM t & ) . . .
ranagemen Activate Configuration File |
» Nualitv nf Qanvira <

Figure 15-1.4: Activate Configuration
Parameter descriptions:
Activate: Select the radio button to activate the selected file.

startup-config: The startup configuration for the switch, read at boot time.

Buttons

Activate Configuration File: Click the button then the selected file will be activated and will become this
switch's running configuration.
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15-1.5 Delete config

It is possible to delete any of the writable files stored in flash, including startup-config. If this is done and
the switch is rebooted without a prior save operation, this effectively resets the switch to its default
configuration.

To delete a configuration file in the web Ul:
1. Click Maintenance, Configuration, Delete config.
2. Click Delete Select.

DeleteConfiguration @Home - Maintenance - Configuration - Delete config
Delete File Name
Peter_config
alan_config

Delete Configuration File

Figure 15-1.5: Delete Configuration

Parameter descriptions:
Delete: Select the file that you want to be deleted.

startup-config: The startup configuration for the switch, read at boot time.

Buttons
Delete Configuration File: Click the button then the selected file will be deleted.
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15-2 Restart Device

This webpage lets you restart switch for any maintenance needs. Any configuration files or scripts that
you saved in the switch should still be available afterwards.

To restart the device in the web Ul:

1. Click Maintenance and Restart Device.

2. Check or uncheck the Always-On PoE option checkbox.

3. Click Yes.
A
LANTRONIX" =| s wewwwe e G
SME8TBT2SA Restart Device gHome - Maintenance - Restart Device
Switch DMS
b System S Are you sure you want to perform a Restart?
» Port Management <
» PoE Management < \:IA\waysOnPoE

» VLAN Management :

Yes

[No

P SO | P ST ¢

Figure 15-2: Restart Device

Parameter descriptions:
Restart Device: You can restart the switch on this page. After restart, the switch will boot normally.

Buttons

Always-On PoE: Check for the switch to maintain power to PDs during device restart. Always-on PoE
ensures that there is uninterrupted PoE power to the PDs even when a switch is upgraded or restarted.
This is critical when 24/7 surveillance cannot have any interruptions.

Yes: Click to restart the device.

No: Click to undo any restart action and return to the System Configuration page without restarting the
configuration.
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15-3 Restore Factory Defaults

This webpage lets you reset the Switch configuration to Factory Defaults. Any configuration files or
scripts are restored to factory default values.

To reset the switch configuration to its Factory default settings in the web Ul:

1. Click Maintenance and Factory Defaults.

2. Check the box if you want to keep the current IP configuration.

3. Click Yes.
. a
L/\NT-\)OI\“X = R —— : : purerlozeut Moo
SM8TBT2SA Restore Configuration to Factory Default @Home - Maintenance - Factory Defaults
Switch DMS
» System ¢ Are you sure to restore configuration to factory

?
» Port Management ¢ default

» PoE Management ¢
» VLAN Management ¢ |:| Keep IP Configuration
» Quality of Service < |\‘res No
Figure 15-3: Restore Config to Factory Defaults
Buttons

Keep IP Configuration: Check if you want to keep the current IP address configuration after the restore
is completed. The Gateway IP address is kept when restoring the switch to its factory defaults with the
Keep IP Configuration checkbox checked.

Yes: Click the button to reset the configuration to Factory Defaults.

No: Click to undo any restore action and return to the System Configuration page without restoring the
configuration.
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15-4 Firmware

This webpage lets you upgrade and select Firmware. The Switch can be enhanced with value-added
functions by installing firmware upgrades. Note: You cannot login if downgrading the switch to older
firmware versions or loading an old config file in new firmware. Do not restart or power off the device at
this time or the switch may fail to function afterwards.

15-4.1 Firmware Upgrade

This page starts an update of the firmware controlling the switch. To upgrade switch firmware in the web
ul:

1. Click Maintenance, Firmware, and Firmware Upgrade.

2. Click the Choose File button.

3. Browse to and select the file to upgrade the switch to (e.g.,
SM8TBT2SA_v1.04.0110_CM_202312006.tar.gz.imgs).

4. Check the Always On PoE checkbox if desired.

5. Click the Upload button. Continue operation when the message “Firmware upgrade in progress
Completed!” displays.

A
LANTQON | X e LANTRONX Auto-logout H 9 C‘
- L L %
S MBTBTZSA Fi rmware U pgra d e #&Home - Maintenance -~ Firmware - Firmware Upgrade
Switch DMS
Firmware File | Choose File |Nofile chosen
b System I
» Port Management < [ Always on PoE
» PoE Management < | Upload

Figure 15-4.1 Firmware Upgrade page

Parameter descriptions:

Always-On PoE: Always On PoE (soft reboot) allows a warm reboot of the switch without affecting the
PoE output to the PD, providing continuous power even during firmware upgrade. Always-on PoE
ensures that there is uninterrupted PoE power to the PDs even when a switch is upgraded or restarted.
This is critical when 24/7 surveillance cannot have any interruptions.

Buttons:

Choose File: Click the button to search for the Firmware filename.

@ Note: This page facilitates an update of the firmware controlling the switch. A Software Upload will
update the managed switch to the software image at the specified location. After the software image is
uploaded, a page announces that the firmware update is initiated. After about a minute, the firmware is
updated and the switch restarts.

"ﬁ“ WARNING: While the firmware is being updated, Web access appears to be defunct. The front
LED flashes Green/Off with a frequency of 10 Hz while the firmware update is in progress. Do not restart
or power off the device at this time or the switch may fail to function afterwards.
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Messages:

Message: Error : The firmware is already update.
Meaning: You are trying to upgrade to the current (existing) firmware version.
Recovery: Verify that you are upgrading to the latest version.

Message: The firmware update was successful.
Meaning: The software was successfully updated.
Recovery: None required.

Message: Firmware upgrade in progress  Waiting, please stand by...

Wiaiting, please stand by

Meaning: While the firmware is being updated, do not restart or power off the switch or it may fail to
function afterwards.
Recovery: None. Wait for the upgrade to complete.

Message: Firmware upgrade in progress

The uploaded firmware image is being transferred to flash.
The system will restart after the update.

Until then, do not reset or power off the device!

Waiting, please stand by ...

Processing, please stand by ...

Restarting, please wait ...

Message: Error : The firmware image is invalid. Please use a correct firmware image.

Meaning: You tried to upload an invalid firmware file.

Recovery: Check the file format and location. Make sure the firmware filename prefix matches your
specific switch model (e.g., sm16tat2sa).
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15-4.1 Firmware Image Selection

This page lets you activate an alternate firmware image. This page provides information about the active
and alternate (backup) firmware images in the device and allows you to activate the alternate image.
The web page displays two tables with information about the active and alternate firmware images.

Note: You cannot login if downgrading the switch to older firmware versions or loading an old config file in
new firmware.

1.

2.
3.
4

LANTRONIX" =

-

-

-

-

-

-

-

-

-

-

-

3

Navigate to Maintenance > Firmware > Firmware Selection to display the Firmware Selection page.
Verify the Active Image and Alternate Image information.

Check or uncheck the Always On PoE checkbox.

Click the Activate Alternate Image button to swap the firmware versions.

SMBTBT2SA
Switch DMS
System

Port Management
PoE Management
VLAN Management
Quality of Service
Spanning Tree
MAC Address Table
Multicast
Percepxion

DHCP

Security

Access Cantrol

Parameters:

Active Image

Partition: Indicates whether “primary” or “secondary” flash partition will provide the firmware upgrade
image.

LANTRON

A
Auto-logout H 9 C*

Firmware Selection

Active Image

Partition
Version

Date

Alternate Image

Partition
Version

Date

|:\ Always On PoE

#kHome - Maintenance - Firmware - Firmware Selection

secondary
v1.04.0124

2023-12-19 11:10:26 UTC

primary
v1.04.0102

2023-08-18 10:11:52 UTC

Activate Alternate Image

| Cancel

Version: The active firmware version (e.g., v1.04.0124).
Date: The active firmware build date (e.g., 2023-12-19 17:99:42 UTC).

Alternate Image

Partition: e.g., “secondary” firmware image.

Version: The alternate firmware version (e.g., v1.04.0102).
Date: The alternate firmware build date (e.g., 2023-09-06 12:32:55 UTC).

33873 Rev. A

https://www.lantronix.com/

Page 240 of 273



https://www.lantronix.com/

Lantronix SMXTBTxSA Web User Guide

Buttons:

Always On PoE: Always On PoE (soft reboot) allows a warm reboot of the switch without affecting the
PoE output to the PD, providing continuous power even during firmware upgrade.

Activate Alternate Image: Click the button to activate the Alternate Firmware image.

Cancel: Click to cancel the page edits.
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Chapter 16 DMS (Device Management System)

The Lantronix DMS (Device Management System) is an intelligent management tool embedded in the

switch to intuitively help IT/TS in reducing support time, cost, and effort.

In the SMXTBTxSA main menu pane on the left, navigate to the DMS tab to display the main DMS

features: DMS Mode, Graphical Monitoring, Management, and Maintenance.

DMS features include:

o DMS automatically discovers and displays all devices connected to the switch using standard
networking protocols such as LLDP, UPnP, ONVIF, etc.

e DMS supports up to 256 devices within four subnets.

e DMS operates via an intuitive web GUI to allow you to:
o Power down the IP cameras, NVRs, or any PoE devices.

O O O O

Remotely identify the exact cable break location.
Detect abnormal traffic issues on IP cameras/NVR.
Monitor devices' status (e.g., link up, PoE power, traffic, etc.).
Configure VLAN/QOS intuitively for better solution quality/reliability.

When you click the DMS tab, the default (startup) DMS webpage (DMS > Graphical Monitoring >

Topology View) displays:

LANTRONIX' =| s wwwewwws & =

SM8TBT2SA Topology View

Switch IMS

> DMS Mode

» Management

» Maintenance

BN NN NN NN [N

Q

DEEREEEEE]

O

‘vvﬁ

J-‘J-\J‘\I\J‘\J‘\l'vw

Auto-logout |OFF v | =] e o

@Home - Graphical Monitoring - Topology View

O

Q
()Y
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16-1 DMS Mode - DMS Controller Switch

You can configure DMS mode and monitor device numbers/ DMS Controller Switch IP.

e DMS is controlled by the DMS Controller switch, as specified by DMS Mode selection.

e The DMS Controller Switch is in charge of syncing DMS information in order to manage Topology
View, Floor View, and trap event / data polling / DHCP server assignment.

DMS Controller ) Managed Devices . U
| -
Switch I :
I =
: & In & secure ol
e | == P .
* Atthe DMS : : o
dropdown sekect
“High Pricrity”. : -
I ~u o
| )
. 1 B E
—=m 1
1
I =
* Set two switches to : na - =
: *riarity”™ Tor i = 10} - "
! 1 —
* Manages Topology & )
Floor View, trap events, | 0:-
data polling, & DHCP | = = "}
SEMEr il'i!i.l';rll"l'!rll I P
i

p to 256 devices within 4 subnets:

the device is a Switch

the dewvice is a PG

the dewice is an |P Camesa

Iha device is an |P Phane.

the device is an AP.

the davice 15 a Router

P davica delectad by DMS, bul device lype not recognized
{"unknown” devics typea)

DMS Controller Switch and Managed Devices

Note:

1. If there are more than two Switches set as High-priority or no High-priority mode switch, the Switch

with the longer system uptime will be the DMS Controller switch.

If two switches have same up time,

the switch with the smaller MAC address will be assigned as the DMS Controller Switch.
2. You can set two switches to High Priority for Controller Switch redundancy.
3. The DMS Controller Switch should be put in a secure location such as a server room, with access and

authority limited to IT staff.

4. The DMS Controller Switch is the center of IP / Event management to operate the DMS:
a. When enabled DHCP Server mode in DMS network, the DMS Controller switch is responsible for

assigning IP address for all devices.

b. The DMS Controller Switch will Collect, Poll, and Sync DMS information, and act as the Event

Notification control center to manage all device information.
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16-2 DMS Mode

1.

2
3.
4

Click DMS > DMS Mode to display the DMS Information page.
At the DMS Mode dropdown select Enabled or Disabled.
At the DMS Priority dropdown select High, Mid, Low, or Non.
Click the Apply button. The DMS Information page updates.
 LANTRONIX® =| 75 wwwewe L B
SM8TBT2SA Information @eHome - DS Hode
Switch DMS
f > DMS Mode DHS tode v v
» Graphical Monitoring ¢ DMS Priority Non v
| » Management ¢ Total Devices 256
: > Maintenance ¢ On-line Devices 57
Off-line Devices 199
Controller IP 172.27.198.7

Apply |

DMS Mode Information parameters
DMS Mode: At the dropdown select Enabled or Disabled. The default is Enabled.

DMS Priority: At the dropdown select High, Mid, Low, or Non. -
High: Choose "High" to make this switch the DMS Controller switch (Master switch). H'Eh Y
Mid: Makes this switch a middle priority.
Low: Makes this switch a low priority (default). Lowe
Non: This switch will never become the Controller switch (Master switch). This is the Man

default setting.

Total Devices: Displays the Total / On-line/ Off-line Devices count in the DMS network (read only).

On-line Devices: Displays the total number of discovered devices that are currently on line (e.g., 3).

Off-line Devices: Displays the total number of discovered devices that are currently off line (e.g., 1).

Controller IP: Displays the active DMS Controller Switch’s IP Address (read only).

DMS Mode Buttons
Apply: Click to save changes.
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16-3 Graphical Monitoring

Navigate to the DMS > Graphical Monitoring menu path to view the options of DMS Graphical Monitoring
Topology View, Floor View, and Map View.

16-3.1 Topology View

Navigate to the DMS > Graphical Monitoring > Topology View menu path. Note that automatic logout
occurs when the screen is idle for over 10 minutes on the DMS Topology View page.

Click the {é} button to display the right pane menu tabs (Device, Group, and Config).

a
= wywox . Auto-logout |OFF v 2 'S
LANTRONIX =| T semmes £ 2| Hoc
SMaTBT2SA Topology View iHome - Giaphicalonitoring - Topology View
Switch DMS - " o
Il T ? Device Group Config
3 + | \ == p
> DMS Mode . | {2 {é} A - @ [sve -
» Graphical Manitoring ™ ‘ ? Il O ?) KA ]
» Topology Viev | T | \ ; ) ¢ N =
> Floor View ? 7) E [ ]
> Map View 3 7 ] (
» Management < ? ° :
4 < ?
» Maintenance < | Ot ? - <
; O- ) O
?
= = |
B; ?
™ ~
\ ?)
\ ?
\ = o
‘ e ¥
‘I 1 O_ — 7 ]
| Y
| I
|
[ ‘ 2
\ =g & o
. N ? >

The Topology View icons and controls are shown and described below.
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Topology View Icons / Controls

Click anywhere and drag to move the display area up /down/ left /right.

J—

+

Click “+” or “-” to zoom in or zoom out the display area.

2 J
|;|i Ganaral PO
: 192.165.70.14
Port 1 (1.008Mb)

A Black device icon indicates device is operating normally. Click a device
icon to show its device console.

SIEPM1040-354-LRT-C
192.168.1.77

Fort 1 -Park 7

B

A Red device icon indicates the device is operating abnormally.

@ 40CEMNIC-1
|;|i General PC
* 192.168.70.14
Part 1 (1.00288)

A Red circled device number shows the number of alarm notifications for the
device.

=)

Click this icon to select the set of information to be displayed (MAC, IP, PoE
power, etc.).

Config

Click this icon to sort, filter, or configure basic settings (e.g., VLAN, QoS).

Device Categories and St

atuses

The device is a Switch.

The device is a General switch.

The device is a PC.

The device is an IP Camera.

The device is an IP Phone.

The device is a Wireless Access Point (WAP).

= The device is a Router.
¢ \. : .f A
:_ —@— _: The device is an LED Light.
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=B

Black icon: Device link up. You can select a function and check for issues.

~a

Red icon: Device link down. You can diagnose the link status.

=

Icon with number: indicates some event has occurred (e.g. Device Off-line, IP
Duplicate, etc.) on the IP device; you can click on the device icon to check
events in Notification.

40CENIC-1
|;|a Ganaral PC
’ 192.1E5.70.14
Part 1 (0.008MD)

A Red circled device number shows the number of alarm notifications for the
device.

?

Icon with question mark: Unknown Device; the IP device is detected by DMS,
but the device type can't be recognized and will be classified as an ‘Unknown’
device type.

* ¥,
#

Icon with question mark and red N:indicates the device is ‘Unknown’ and is
not connected.

40GEMNIC-1
;la Ganaral PO
" 192.165.70.14
Fart: 1 (1.0058)

A Black device icon indicates device is operating normally. Click device icon
to show its device console.

SIEPM1040-354-LRT-C

=g 192188177 A Red device icon indicates the device is operating abnormally.
Part 1-Part 7
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DMS Topology View parameters

Device tab parameters

Devices dropdown: Select the device type (All, SWITCH, PC, IP Camera, IP Phone, AP,

Others, or Off Line).

Snapshot icon: Use the a icon to capture the displayed topology view.

File format: Select the graphics file type (SVG, PNG, or PDF).

Search box: Use the ‘Q
IP/MAC address or Model/Device name.

Group tab parameters
Vlan ID: Enter a VLAN ID (VID) for the new group (1-4095).

Name: Enter a name for the new group.

Traffic Priority: At the dropdown select Default or O (Low) —
7 (High).

OUI 1: Enter an Organizationally Unique Identifier.
OUI 2: Enter a second Organizationally Unique Identifier.

OUI 3: Enter a third Organizationally Unique Identifier.
Apply: Click when done entering the new group data.
Delete: Click to close the new group configuration dialog.

Config tab parameters

Total Device: Displays the total number of devices discovered.
Controller IP: The control device IP address in the format 0.0.0.0.

DHCP Server IP: The IP address of the configured DHCP Server;
otherwise --- if no DHCP Server is configured.

DHCP Server: At the dropdown select Enabled or Disabled.
The default is Disabled.

IP Range: The range type (Single Subnet or Multiple Subnet).

If you select Multiple Subnet, selection fields display for Range 1 - Range 4.

Apply: Click the button to make the changes.

| to search for a device by typing

All
All
SWITCH
PC

1P Camera
1P Phone
AP

Gthers

A L
SVG
SVG
PNG
PDF

RN

Device Group Config
[ -lq
|New Group |E]
oo | |
_— |
Traffic Priority  |Default | ']
ous | |
vz | |
ouz | |
Apply Delete
Device | Group Config
Total Device 2
Controller IP 192.168.1.77

DHCP Server IP

|:D|'sabled '|

DHCP Server
P Range |single Subnet !
Apply
Device Group Config
Total Device 2
Controller IP 192.168.1.77
DHCP Server IP -
DHCP Server |Enabled M
P Range |Multiple Subnet |~ |
Range 1 0.0.0.0 ~0.0.0.0
Range 2 0.0.0.0 10.0.0.0
Range 3 0.0.0.0 H0.0.0.0
Range 4 0.0.0.0 -0.0.0.0
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Device data

Click a device in the Topology View to display its discovered data:

LANTRONIX' =| % wewwws |
SM8TBT2SA Topology View
Switch DMS
> DMS Mode SM8TBT2SA X

SWITCH

SMBTBT2SA

SM8TBT2SA

+
» Graphical Monitoring -

> To

00-40-c7-10-53-29

» Management 172.27.198.150

» Maintenance < %

POE Supply ow

@ A

—_
Login Upgrade

Q 7

Find Switch  PoE Config

rd Notification

. SMSTBT2SA
‘m‘ 172.27.198.150
N

Device data parameters

Device Type: e.g., SWITCH, PC, IP Camera, IP Phone, AP (Access Point).
Device Type is displayed automatically. If an unknown type is detected, you
can still select its type from a pre-defined list.

An IP device recognized as a DMS Control switch supports "Upgrade" and
"Find Switch" functions.

An IP device recognized as a PoE device supports "Upgrade" and "Reboot"
functions.

An IP device recognized as an IP Camera via the ONVIFE protocol will
support the "Streaming" function.

Device Name: e.g., SM16TAT2SA. Create your own Device Name or alias
for easy management such as "1F_Lobby Cam1".

Model Name: e.g., SM16TAT2SA.

Mac Address: e.g., 00-40-c7-1c-cb-6e; displayed automatically by DMS.
IP Address: e.g., 192.168.1.77; displayed automatically by DMS.

Http port: e.g., port 80.

PoE Used: e.g., 2 Watts; displayed automatically by DMS.

PoE Supply: e.g., PoE or non-PoE.

Login icon: Click to display the login window.

Upgrade icon: Click to display a window in which you can enter a Tftp
Server IP address and the name of a firmware file to upgrade to.

Find Switch icon: Click to flash the device LEDs for 15 seconds to help find
the device. Click OK to clear the message.

Parent Node / Undo Parent: click to toggle between switching the selected
device with its parent node device and back.

A
roogon [0 ] W @ O

@Home - Graphical Monitoring - Topology View

~L
T3

50
(A~

v

A

YN

=

TV-1P320-PI X

‘v‘

|Genera| IP Camera

TV-IP320-PI

Viac Addre d8-eb-97-ce-06-26
IP Address 192.168.90.100
Hitp Po 80
PoE Used 2w
@ 2 O
&
Login Diagnostics PoE Reboot
23
SM24DP4XA X
Device Type SWITCH
Device Name SM24DP4RA
Model Name SM24DP4xA

Mac Address 00-c0-f2-Te-57-01

P Address 192.168.85.2
Hitp Por |SD |
PoE Supp Mon-PoE
@ 4 Q
Login Upgrade Find Switch Disgnostics.
Dashboard Naotification
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PoE Config icon: Click to display a window in which you can enable or disable PoE Auto Checking

globally and enable or disable POE Mode on a port-by-port basis.
PoE Reboot. Click to re-boot PoE.

PoE Supply and PoE Used: displayed automatically by DMS.
Dashboard icon: Click to display the dashboard.

Notification icon: Click to display an editable message area.

Unknown Device parameters

You can click on an unknown device to

display its discovered data (see descriptions ?
above). If an unknown type is detected, you L.
can still select its type from a pre-defined list.

192.168.1.99
| Port: 3 (0.001MB)

16-3.2 PoE Auto Checking “AutoFill” Feature

192.168.1.99

®

\_Unknown Device

|V|

00-1b-11-b2-6d-4b
192.168.1.99
a0

MNon-PoE

Notification

Monitor

When you enable Auto Power Reset (PoE Auto Checking) in DMS, the IP addresses of the connected

devices are automatically filled in the Auto Power Reset configuration page.

1. Configure the “PoE Auto Checking” parameter at Switch > PoE Management > PoE Auto Checking.
The “Failure Action” parameter can be set to “Reboot Remote PD” or “Nothing”.
2. Configure PoE parameters at DMS > Graphical Monitoring > Topology View. Left click on the switch

icon to display its device configuration popup. Click the PoE Config ( FeEcefa ) icon to display the PoE

Auto Checking pane:

LANTRONIX = 75 wewwweww 82 =
SME8TBT2SA Topology View darom ol Topol
Switch
> DMS Mode [ # SMBTBT2SA x
» Graphical Monito
POEAuto Checking :  [Disable
Port POE Mode S
1 [Disable =
2 Disable [~
» Ma‘legemcm
3 Disable b
» Maintenance < -
4 Disable
s Disable i
SMBTBT2SA 6 Disable
G 17227196 150 =
/ 7 Disable -
8 Disable =]
9 |Disable
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16-3.3 DMS Firmware Upgrade Procedure

—_—

Navigate to the DMS > Graphical Monitoring > Topology View or Floor View menu path.

Click the @ button to display the right pane menu tabs (Entry and Config).

Connect all switches and make sure DMS is working.
- Set all switches with different IP addresses and in the same IP segment.
- Make sure gateway IP address is configured.

Enable the TFTP server and set the correct image path.

Fgp Tipded by Ph. Jounin — ] b=
Current Directons i e | Erowse |
Server interffaces i'l A21E8.E130 Realtek PCle GEE Fan_:_i Showe Dir !
Tip Server | Thp Client | DHECP server  Log viewer |
< >
Clear | Copy |
About | Settings | Help |
. . s . « » .
5. Click switch’s icon, then click the “Upgrade” button in the Dashboard.
SM8TBT2SA Topology View @Home - Graphical Monitoring - TovologyView &
Switch DMS
Device Group Config
> DMS Mode SM8TBT2SA x %:(:3} Total Device 1
» Graphical Monitoring ¥ . Device Type SWITCH w2 Controller IP 0.0.00
v iew DHCP Server IP
> Floor View Model Name SMBTBT25A | )
7 e T, SMBTBT2SA | Mac Address 00-40-c7-1d-53-29 < [Multiple Subnet |~ ]

() 17227 198150
» Management < ) IP Address 172.27.198.150 Range 1

o/TL \a #

Login Upgrade d Switch PoE Config

v Apply |

Dashboard Noification
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6. Enter the Tftp Server IP address and FW image name (e.g.,
SM8TBT2SA_v1.04.0040_CM_202312001 .tar).

SM8TBT2SA TOpOlOgy View dHome - Graphical Monitoring - TopologyView 4
Switch DMS
Devire Group Config
> DMS Mode SMBTBT2SA x 1
» Graphical Monitoring ™~ £ o)
) Tiip Server IP - [0.0.0.0 | Fie |
> Topology View rip
> Floor View Name P Version Status i n
i
> Map View SMBTBT2SA 172.27.198 150 v1.04.0124 — MuTpISSIhnes n
‘ v Apply |
v Apply
7. Click “Apply” to start the FW upgrade.
8. Observe the upgrade status until completion.
SMBTAT2SA Topology View b - Genghatal Wosihiing - bbby Viee
Switch DMs :
i}
b DMS Made SMATATZSA ® {éf
¥ Graphical Monitoring ¥ Vo2 1BEG 130 2 20T g2 KA
by - T
¥ Floor View Hame i® Wirsdon Seatus F
Mag View EMETATIEA 1692 9838 136 v1.00.138 2070001 D153 —
STarie Pl wad
¥ Management " SMETATIEA 182 9636 136 ¥1.00.758 - — o x|

¥ Mainlenanoe

| i Tl by . i

Cumerd Dpaciory _ el Frone
b L T T [T bt O
Vg B | T Dl | DHIF srves L v

e e e T TG 10 el S AR 1F 88 ]

Plausd sy o Ble TMNTAT 7o s, TR PIDTC . b ccied JOLATH THA2 547
Correcion, s rom 152 1600 1o port 1 mrs%m 14240

o] i v, Mok ot BLNTTE2 WG E

L ko et 1550 JECUATH T 125 TR

-y
Fis s - 10 00
BT e IO penc

S
Fl o 11

N Bt ek 1 THE Brnstoee
ANENRRENERRDNNEEEE

Message: Error : Firmware download fail displays if the TFTP Server IP address or the FW image name

entered is incorrect.

_ O | ooy |

el I
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16-3.4 Floor View

Navigate to the DMS > Graphical Monitoring > Floor View menu path. After you have added a Floor
Image at DMS > Maintenance > Floor Image, the Floor View lets you:

Drag and drop (anchor) devices onto Floor Maps
Find device location instantly

Store up to 10 Maps per Switch

IP Surveillance/VolP/WiFi applications

Other features same as Topology View

2

Click the {éu)\j button to display the right pane menu tabs (Device and Config).

LANTRONIX® =| == z ma2s 8282 . | woosu (V) W @ o
SME8TBT25A Floor View BHome - Graphical Mosnsring - FiooeView
Switch DMS | E
N, o '8
> DMS Mode + ¥ & -] @ [sve
« = K. 7 | |FloorPlanFirststFloor (192.168.1.77)
' 1%t Floor | Q
' je== )
» Management 4
» Maintenanc B 7
o SHIPPING |_lJ e
L :
?
” 1881
00-28-8C-04-0d-C2
5
? 1p2.188 1
} 00-18-2 ]
? ]
DMS Floor View parameters Al

All
SWITCH
PC

Device tab parameters
Devices dropdown: Select the device type (All, SWITCH, PC, IP Camera, IP Phone, AP,

IP Camera

Others, or Off Line). 1P Phone
AP
Snapshot icon: Use the ﬁ icon to capture the displayed topology view. Others
Off Line
File format: Select the graphics file type (SVG, PNG, or PDF). '
SVG z]
SVG :|
Search box: Use the ‘Q | to search for a device by typing IP/MAC PNG
address or Model/Device name. PDF
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Confiq tab parameters
Total Device: Displays the total number of devices discovered.

Controller IP: The control device IP address in the format 0.0.0.0.
IP Range: The range type (Single Subnet or Multiple Subnet).
DHCP Server IP: Select Enabled or Disabled.

DHCP Server: Select Single Subnet or Multiple Subnet.

Apply: Click the button to save the selections.

Example: Drag and drop the devices to the desired locations:

LANTRONIX = v H =

SM8TBT2SA Floor View
Switch DMS

Device Config
Totzl Device 2
Controller IP 152168177
DHCP Server P -
DHCP Sarver [Disabled [~
IP Range [Single Subnet [~

+ Apply

Auto-logout [OFF v | [ 9 G

@Home - Graphical Monitoring =~ FloorView

> DMS Mode + 1st FIOOI'| {é}
» Graphical Monitoring “ EXTT oM K A
> Topology View W L ¢ N
> Floor View P
> Map View
»  Management < SHIPPING
»  Maintenance 5
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16-3.5 Map View

Navigate to the DMS > Graphical Monitoring > Floor View menu path. The Map View lets you:

¢ Anchor devices onto Google Maps

¢ Find devices instantly from Map

¢ Search on-Line by Company/Address
¢ Run outdoor IP Cam/WiFi applications
e Other features same as Topology View

Click the {é}' button to display the right pane menu tabs (Device and Config).

LANTRONIX® = \ A : FEEEEEEE - = H oot 0 V) M @ G
SMBTBT2SA Map View o - Gruphica Moraring - MapView
Switch DMS |
Config
» DMS Mode Google |
5 This page cant load Google Maps comectly.
» Management * 2621881200
»  Maintenance < 061844100
AR 2NN
Co--184tc-30
T oN
Y_ '.‘E :3:» -
« Ly ' ) x
If the message “192.168.1.77 wants to know your location | TR s -
displays, click the Allow button. @ Know your location
|
| Allow Block

DMS Map View parameters
Device tab:

Devices dropdown: Select the device type (All, SWITCH, PC, IP Camera, IP Phone, AP, Others, or Off
Line).

Search box: Use the ‘Q | to search for a device by typing IP/MAC address or
Model/Device name.

Config tab parameters:

. . . . . i onfi
Total Device: Displays the total number of devices discovered. é{ e Corfe
Total Device 2
Controller IP: The control device IP address in the format 0.0.0.0. controller 1P 000.0
IP Range: The range type (Single Subnet or Multiple Subnet). 7 enee [Single Subnet __|*]

‘ +  Apply |

Apply: Click the button to save the selections.
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Satellite View: From DMS > Graphical Monitoring > Map View you can click Satellite to replace the Map
View with a satellite view:

Contritute

48 Discovery Suite 250, Irvine, CA 92618
Located in: Irvine Centre Drive
(O Open-Closes5PM

lantronix.com

)

¥, (949) 4533990
M67V+RJ Irvine, California

4]  sendtoyourphone

& Suggestan edit

Click the linked text View on Google Maps and enter an address:

5 >
= "
£
48 Discovery, Irvine, CA Q, X & Y Restaurants [0 Hotels [®) Things to do A 8 Transit PI> E m
? ; ) O UG =
L
o Crowdstrike i
Explore
2]
=) 4
=
] ()
o a
R 48 Discovery
Building Qr Street IMS
sl - oNONONCN &
2 L% ’JE Discovery,
Directions Save Mearby Send to Share q Irvine, CA 92618
ey phone
More
a"’(\ a
© 48 Discovery, Irvine, GA 92618 £ (
Thales Avionics g
7 Suggest an edit on 48 Discovery ::
$ =
. & ) (i)
Q.  Addamissing place i @f
- . & s
% Add your business %
Masimc 9 / %O.x
(N
Photos 4
@
Accurate Backgr, 4 q
- 3ce]
Al Google [
] - =
Map data 92022 Google _ United Stetee  Tarms  Privacy  Sendfeedback  200ftL 1
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Message: This page can't load Google Maps correctly.
Meaning: Click OK to clear the message.

Message: Do you own this website?
Meaning: Click to go to the Google developers maps_documentation page.

Messages:

1. Oops! Something went wrong. This page didn't load Google Maps correctly. See the JavaScript
console for technical details.

2. Google Maps API error: MissingKeyMapError

3. This page can't load Google Maps correctly.

Meaning: At DMS > Maps View the page did not load correctly.

Recovery:

1. Replace YOUR_API_KEY on the last line of your code with your actual API key.

1. If you don't have one, you can get it for free on the Google Developers Website.

2. Make sure your Billing is set up correctly. Check on your Google developer console.

3. Enable the API Library for this Google Maps JavaScript APIl. Check on your Google developer
console.
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16-4 Management

Navigate to the DMS > Management menu path to view the Device List and Map API Key webpages.

16-4.1 Device List
Navigate to DMS > Management > Device List to show all devices and information detected by DMS.

— LAHTRONEX Auto-logout » |
LANTRONIX" = vosvwe ¥~ M @ G
SM8TBT2SA Device List gbHome - Management - Device List
Switch DMS ———
Auto-refresh | Refresh || Edit
> DMS Mode —
» Graphical Monitoring < Show| 1 +|entries Search:
» Management - [[] Remove  status Device Type * Model Name Device Name MAC IP Address
> Device List \
> Map APl Key ® Online Others 00-80-A3-C3-83-E0 172.27.198.26 !
p APl Key
|
b MR ETETes ¢ ® Online  Others SLB 00-80-A3-C3-AA-EE 172.27.198.18
®Online  Others General Switch B2-SLB3 00-80-A3-C3-AB-10 172.27.198.224
®0Online  Others 00-80-A3-C3-AB-72 172.27.198.8 ?
® Online Others 18-7TA-3B-38-8E-8A 172.27.198.1 ]
|:\ @ Offline Others 68-05-CA-00-0E-82 172.27.198.67
|:\ @ Offline Others 68-05-CA-01-50-D8 172.27.198.63 3
|:\ ® Offline Others 68-05-CA-06-29-84 172.27.198.69
O @ Offline  Others 0s365-testbed-pcl 0s365-testbed-pcl 68-05-CA-07-99-29 172.27.198.61
|:\ ® Offline Others 68-05-CA-08-BA-C1 172.27.198.67 |
Showing 1 to 10 of 256 entries Previous 2 3 45 .. 26 Next
\ Apply \

DMS > Management > Device List parameters
Show x entries: At the dropdown select the number of devices to list per page (10, 25, 60, or All). The
default is 10 entries per page.

Remove: Check the box to delete the table entry at the next Apply. Only Offline devices can be removed
from the DMS Device List.

Status: The status of the detected device (e.g., Online or Offline).

Device Type: The type of the detected device (e.g., SWITCH, IP Cameras, or Others.
Model Name: The model of the detected device (e.g., SM8TBT2SA or SM24TBT4SA).
Device Name: The name of the detected device (e.g., SM8TBT2SA or SM24TBT4SA).
MAC: The MAC address of the detected device (e.g., 00-40-C7-1C-CB-6E).

IP Address: The IP address of the detected device (e.g., 192.168.1.77).

Http Port: Click the Edit button to edit the Http Port number.

User Name: Click the Edit button to edit the User Name.

Password: Click the Edit button to edit the Password.

Buttons

Auto-refresh: Select on to automatically refresh the page every 3 seconds. The default is off.
Refresh: Click the button to refresh the page immediately.
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Edit: Click the button to display the table with editable fields. Click the Edit icon to edit the Device Name,
Http Port, User Name, and Password. This function can also be configured in the Dashboard of Topology
view. There is no HTTP connection function for Unknown Device and PC type devices, so the Ul doesn't
provide "Edit HTTP port" function for configuring it. See below.

Show xx entries: At the dropdown select how many entries to show per page (10, 25, 60, or All).
Search: Enter key word(s) to search for on the page.

Remove: Only Offline devices provide "Remove" function to remove from DMS device list.
Previous: Click to display the previous set of entries (if any exist).

Next: Click to display the next set of entries (if any exist).

Apply: Click to save changes.

You can click the Edit button to show additional fields for editing:

Device List @Home - Manapemant - Dwvick List
Auto-refresh
Show | 10w entries Search: |
Device , Model Http
Remowve Status Type Name Device HName MAC IP Address Part User Name Password
® P R e e
i z 00-0%-18-4E-20-E9 192.168.1.100
nline Camera
1 P
3 ) 00-16-6C-D4-DD-C2  192.163.1.100 dmin. | wem
Online  Camera
] A Al 10 = A
o Others 00-09-18-4F-BC-3A  192.251.200.121
Online
» S e g R T
Bl Others 00-1B-11-B2-6D-4B  192.188.1.99
Online
L . il -
onl Others AC-CC-8E-BA-FT-C1 192.168.0.90
unline
L] LN & prs &a = - & B e Ea A = Pws
onl SWITCH SM16TAT2SA SMIBTAT25A 00-C0-F2-TC-59-28  192.168.1.77
Online

Showing 1 to & of 6 entries n

Additional Parameter descriptions:

Device Name: Enter the desired name for this device.
Http Port: Edit the HTTP port number for this device.
User Name: Edit the Username for this device.

Password: Edit the Password for this device.
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16-4.2 MAP API Key

Navigate to DMS > Management > Map API Key menu path to display the Google Map API Key
Configuration page. You need a valid API key and a Google Cloud Platform billing account to access
Google core products. If not, DMS Map View will not be able to load Google Map correctly.

Visit the Google website below and follow the directions to get an API key:
https://developers.google.com/maps/documentation/directions/get-api-key

To configure the DMS Management API Key via the web Ul:
1. Click DMS, Management, Map API Key.
2. Specify the Google Map API Key.
3. Click Apply to save the settings.

LANT?ON'X = T o L Auto-logout 9 C’
SM8TBT2SA Google Map API Key Configuration @Home - Management - Map APl Key
Switch DMS
Key
> DMS Mode

» Graphical Monitoring <

\ Apply
» Management > N
> Device List

> Map APl Key

Parameter descriptions

Key: Enter the Google API Key. To use the Google Maps Embed API, you must register your app project
on the Google API Console and get a Google API key which you can add in this field.

Buttons

Apply: Click to save changes.
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16-4 Maintenance > Floor Image

Navigate to DMS > Maintenance > Floor Image to display the Floor Image Maintenance page. This page
lets you add or delete a floor image.

Each DMS switch provides 10 files space for uploading. Only JPG and PNG formats ae supported. File
size is limited to 256KB.

All DMS switches' floor image in the same network can be shared together. For example, if Switch 1 has
uploaded 10 floor images, Switch 2 uploaded 5 images, the total of 15 floor images can be shared and
selected on all DMS switches in the same network.

File name will attach IP address to let you know on which DMS switch the floor image is stored.

LANT?ON | X E = e » CL . Auto-logout 0 c»

SMSTBTZSA FIOOI’ |mage Maintenance @ Home - Maintenance - FloorImage
Switch DMS
Maximum: 0 files Used: 0 file(s) Free: 0 file(s)
> DMS Mode
e oy ¢
SRR = R Add Floor Image: | Choose File |Nof'|le chosen
»  Management e
Name
» Maintenance M
> Floor Image |—|
> Traffic Monitor S
Select No. File Name Image

No informaticn found

| Delete ‘

Parameter descriptions

Maximum: x files: By default this field displays "Maximum: 10 files". With each switch added and
discovered, the maximum value increases by 10. For example, if only two switches are connected to each
other, the maximum number of files will increase from 10 to 20 (on both switches). But once the
connection is removed and after an approximate 1 minute wait, the maximum number of files will restore
to 10.

The maximum number of images displayed is additive. When the switch is stand alone with no
connections to other DMS switches, the number displayed is 10. As other DMS switches are added, the
field is incremented by 10 for each one.

Used: x file(s): The number of files that have already been uploaded.

Free: x file(s): The number of files that can be uploaded before reaching the maximum number of
images.

Add Floor Image: Click Choose File and browse to and select a File Name to add.

Add: Click to add the selected file.

Select: Displays the selected image name.

No.: Displays the instance number.

File Name: Displays the selected file name.
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Image: Displays the selected image. Image added (FloorPlanFirstFloor):

Floor Image Maintenance @Home - Mainenance - Floor Image
Maximum: 10 files Used: 1 file(s) Free: 9 file(s)

Add Floor Image: ‘Choose File | No file chosen

Name

Select Mo. File Name Image

= Flast

] 1 FloorPlanFirststFloor (192.168.1.77)

Message: 192.168.1.77 says: Insufficient Space. Only x files available.
Meaning: The file is too large or no file exists.
Recovery: Click the OK button to clear the message and choose a new File Name to add.

Message: Special Characters are not allowed in Name.

Meaning: The Floor Image filename has special characters (dash, space, numbers, etc.) which are not
allowed.

Recovery: Click the OK button to clear the message and choose a File Name with no special characters.
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16-5 Maintenance > Traffic Monitor

DMS supports traffic monitoring of each port and keeps a one-week record that can be used to compare
and analyze with visual charts. The page displays two different graphs for a selected device.

Procedure

1. Click DMS > Maintenance > Traffic Monitor.
2. Select the parameters to display.

3. Select the device to monitor.

Traffic Momitor v Fa—

S FATSE

] ' t 1] ] s N 5 @O u T ] 2 3 = 323 » # 32 F a PN

LR FEN 0] o R W
ELE
I--C"-'-i
L]
s
uE v
s
LR
Twy
-1 2 | Timig
] |
R T N I T T T TR A T 4 % W W fr A % M H @ @ O

Parameter descriptions:

0 Total Rx Tx

Total / Rx / Tx: Select the set of data to be displayed.

< 2011/01/04 (VIS

<yy/mm/dd >: Select the date of data displayed.

Day / Week: Select a day’s worth of data or a week’s worth of data to be displayed.
Device List: Displays the set of discovered devices.

Throughput: Vertical axis shows throughput (e.g., 0 M — 18000 M or 0 M-1200 M). The unit of measure is
Mbps.

Port: Horizontal axis shows the switch port numbers.
Time (Hour): Horizontal axis shows the time elapsed in hours (0-23).

The graph’s vertical axis shows throughput and the unit of measure is Mbps.
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Message: Traffic Monitor feature is only available on master controller. Current master controller IP
Address: 192.168.90.52.

Tradfe: Ligranod fuadard il Sy PrdeddShe 0N 7L KN 0N e
Curtenl manbir Soni et B 4030w 160 18890 53

-
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16-6 DMS Troubleshooting

Problem: The switch lists itself is the only device in Topology View of DMS.
Problem: In DMS, the Local image shows the IP address of another switch.

Description: The switch is listed as only device in DMS Topology View in DMS; all devices are listed in
DMS device list. This is usually because the switch's gateway is not configured appropriately.

Resolution: An IP Route must be configured manually. For example, a switch IP address of 192.168.1.77
should have the following IP route configured: ip route 0.0.0.0 0.0.0.0 192.168.1.x. Without the IP route
configured, you may be unable to view all devices on the network in DMS.

1. Go to DMS > Management > DMS Mode to check if the controller IP is correct.
2. Verify that the gateway of this switch is correctly configured.
3. Verify that all connected devices are displayed in DMS Topology View.

Problem: DMS Connectivity diagnostics fails to ICMP reachable device.

Description: DMS displays a device which is reachable via ICMP ping as failing the connection status in
diagnostics. Cable status displays as OK.

Resolution: Contact Technical Support.

Problem: DMS will discover the device type, name and model of some cameras and hosts but others are
displayed as Unknown.

Description: When a device is detected by DMS, the device’s information (such as type, model
name...etc.) can be recognized via LLDP (e.g. Switch), UPnP (e.g. AP), ONVIF (e.g. IP cam), NBNS (e.g.
PC) packets if the device supports these protocols. So if the device display as Unknown, that means this
device does not issue above mentioned protocol for DMS to recognize.

Resolution: You can manually assign and configure the device type and name for the unknown devices.
See the Topology View > Dashboard or the Topology View section.

Message: This page can’t load Google Maps correctly.

Recovery:

1. Click the OK button to clear the message.

2. Navigate to DMS > Management > Map API| Key.

3. See “16-4.2 MAP API Key” on page 261.

4. Click the linked text “Do you own this website?” to display the Google API Key and Billing Errors
Troubleshooting page.

5. For help on finding error messages, see the section on checking errors in your browser.

6. See the Google Maps Platform FAQ for more information.

Problem: The switch cannot discover / display devices in DMS mode.
Solution: 1. Make sure DMS Mode = Enabled and DMS Priority = High. 2. Refresh the web browser page.
3. Update web browser cache. 4. Open a new web browser window.

Issue: |E Tab fix for Chrome-Firefox - DMS Topology view issue.

Description: In order to log into a camera on a switch with PoOE+ or PoE++ from the DMS Topology View
window from a browser other than Internet Explorer, you must have an “IE Tab” extension installed. This
is needed for both Chrome and Firefox. IE Tab is an extension for the Google Chrome and Mozilla Firefox
web browsers that lets you view pages using the Internet Explorer layout engine.

Recovery:

Google Chrome: https://chrome.google.com/webstore/detail/ie-
tab/hehijbfgiekmijfkfipbkbammijbdenadd?hl=en-US

Firefox: https://addons.mozilla.org/en-US/firefox/addon/open-in-internet-explorer/
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Appendix A Troubleshooting

Refer to the SMxTBTxSA Install Guide for install Troubleshooting, Warranty, Support, and Compliance
information.

General Troubleshooting Procedure

Many problems are caused by the following situations. Check for these items first when you start
troubleshooting:

1. Verify the install procedures were performed correctly. See the SMxTBTxSA Install Guide.

2. Check if the POWER LED is Off:
e Check connections between the switch, the power cord and the wall outlet.
e Contact your dealer for assistance.

3. Check if the Link LED is Off:

o Verify that the switch and attached device are powered on.

e Be sure the cable is plugged into the switch and corresponding device.

e If the switch is installed in a rack, check the connections to the punch-down block and patch
panel.

o Verify that the proper cable type is used and its length does not exceed specified limits.

e Check the adapter on the attached device and cable connections for possible defects. Replace
the defective adapter or cable if necessary.

4. Make sure all devices connected to the SMxTBTxSA are configured to auto negotiate or are configured
to connect at half duplex (all hubs are configured this way, for example).

5. Check the cabling:
e Look for faulty or loose cables.
e Look for non-standard and miswired cables.

6. Make sure you have a valid network topology:
e Check for improper Network Topologies.
e Make sure that your network topology contains no data path loops.

7. Check the port configuration.

e Make sure ports have not been put into a “blocking” state by Spanning Tree, GVRP, or LACP.
The normal operation of the Spanning Tree, GVRP, and LACP features may put the portin a
blocking state.

o Verify that the port has not been configured as disabled via software.

8. Make sure connected devices (e.g., SFPs, switches, hubs) are cabled, powered, and operating
properly.

9. If possible, try switching modes (i.e., from Web Ul to CLlI, or vice versa).

10. Verify the specific function that failed (e.g., port config, POE or VLAN management, QoS, Spanning

Tree). Refer to the specific function's user manual page and online Help for details. Verify that the
function you are trying to perform is supported by your particular switch model.

11. Run the tests in the Diagnostic tab of the Web Ul. Verify that the interface is assigned to the correct
VLAN. Use the Layer 2 traceroute. Check for spanning-tree problems such as BPDU floods or
flapping mac address. Try a ping to broadcast IP address of subnet from your L3 device (Gateway).

12. Record any related error messages, conditions, and configurations for your Tech Support Specialist to
consider. See below.

13. Contact Tech Support.
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Record Device and System Information

After performing the troubleshooting procedures, and before calling or emailing Technical Support, please
record as much information as possible to help the Tech Support Specialist.

1. Select the SMXTBTxSA Switch > System > System Information menu path to gather the
information below or as requested by the Tech Support Specialist.

2. Record Model:

Hardware Version: Firmware Version:

PoE Firmware Version: S/N:

3. LED Status:

4. Additional information for your Tech Support Specialist. See the “Troubleshooting” section above.

Your Lantronix service contract number:

A description of the failure:

A description of any action(s) already taken to resolve the problem (e.g., change mode, reboot, etc.):

The serial and revision numbers of all involved Lantronix products in the network:

A description of your network environment (layout, cable type, etc.):

Network load and frame size at the time of trouble (if known):
The device history (i.e., have you returned the device before, is this a recurring problem, etc.):

Previous Return Material Authorization (RMA) numbers:
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You can get Model, P/N, and S/N information from the Box label and the Device label:

LANTRONIX

Modsl: SMETBT25A | MODEL SM24TBT4SA

Ut 100-240% -, 50-60Hz, 504 max

T T T e A

em: nopzsewroato | [IINTRNARNINARERAIN

SIN: A227123AR3600001

Product Label Package Label
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Appendix B  DHCP Per Port

You can configure DHCP Per Port via the CLI and Web Ul. The DHCP Per Port factory default mode is
Disabled. See the CLI Reference for CLI mode operation.

The switch’s DHCP server assigns IP addresses. Clients get IP addresses in sequence and the switch
assigns IP addresses on a per-port basis starting from the configured IP range. For example, if the IP
address range is configured as 192.168.10.20 - 192.168.10.37 with one DHCP device connected to port
1, the client will always get IP address 192.168.10.20, then port 3 is always distributed IP address
192.168.10.22, even if port 2 is an empty port (because port 2 is always distributed IP address
192.168.10.21).

The switch does not allow a DHCP per Port pool to include the switch’s address.
IP address assigned range and VLAN 1 should stay in the same subnet mask.

The configurable IP address range is allowed to configure over 18 IP addresses, but the switch always
assigns one IP address per port connecting device.

The DHCP Per Port function is only supported on VLAN 1.
The DHCP Per Port function allows the switch to connect only one DHCP client device.

When the DHCP Per Port function is enabled, the switch software will automatically create the related
DHCP pool named “DHCP_Per _Port”.

Once the DHCP Per Port function is enabled on one switch, IPv4 DHCP client at VLAN1 mode (DMS
DHCP mode), DHCP server mode are all limited to be enabled at the same time (an error message
displays if attempted).

If the DHCP server pool has been configured, once you enable the DHCP Per Port function, then that
DHCP server pool configuration will be overwritten.

For VLAN 1 only: clients issued DHCP packets will not be broadcast/forwarded to other ports. DHCP
packets in others VLANs will be broadcast/forwarded to other ports.

DHCP-Per-Port is configured entirely on the Switch > Configuration > System > IP page, IP Interfaces
window. The feature is enabled here and an IP range (pool) is entered. The “automatic” results of this
action can be displayed in:

o Switch > Configuration > System > DHCP > Server > Mode (Global Mode — Enabled, VLAN Mode -
VLAN 1 created)

e Switch > Configuration > System > DHCP > Excluded (Excluded range created based on range
entered)

e Switch > Configuration > System > DHCP > Pool (Pool “DHCP_Per_Port” created based on range
entered)

Actual DHCP operation is monitored as normal under System > Monitor > DHCP.

The DHCP Per Port pages and parameters are described below.
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DHCP Per Port Mode Configuration

The DHCP Per Port function lets you assign an IP address based on the switch port the device is
connected to. This will speed up installation of IP cameras, as the cameras can be configured after they
are on the network. The DHCP Per Port assignment lets you know which IP was assigned to which
camera.

Note: to prevent IP conflict, each switch can be allocated a different IP range.

To configure DHCP Per Port via the Web Ul, navigate to the System > IP Address > Advanced IP
Settings menu path.

Auto-logou: H 9 C’

LANTRONIX" =| Vs wewewe

SM8TBT2SA Advanced IP Settings @Home  System  IPAddress  Advanced IP Settings
Switch DMS
DNS Server Mo DNS server v
» System

|
> System Information

% IP Address v

.
IP Interfaces

> [P Settings
e DHCP Per Port
> Advanced IP Settings
Mode Enabled v
e

> System Time VLAN VANL v

» LLDP <

> UPnP IP 192.168.1.1 - 19216818

\, y
» Port Management <
» PoE Management < DHCPv4 IPva IPve
» VLAN Management < Delete VLAN Enable Fallback Current Lease Address Mask Length  Address Mask Length
» Quality of Service @ 1 v 20 172.27.198.150/24 | 192168.0.77 2
» Spanning Tree < —
Delete | 2 O 20 200.27.198.150 24
» MAC Address Table — 7
» Multicast
| Add Interface ‘

» Percepxion <
» DHCP < Link-Local Address binding interface VLAN1 v
» Security <
» Access Control < Lionts
» SNMP < Delete Network Mask Length Next Hop VLAN
» Event Notification <
» Diagnostics < | AddiReuts ‘ v

Parameter descriptions: The DHCP Per Port parameters and buttons are described below.

DHCP Per Port Mode: at the dropdown select Enable or Disable the DHCP Per Port function globally.
The default is Disabled.

IP: enter the IPv4 IP address range to be used when the DHCP Per Port function is enabled (e.g.,

192.168.10.20 - 192.168.10.37).

The DHCP Per Port IP range must be within the interface subnet. Note

that DHCP Per Port with IPv6 is not supported at this time. The DHCP Per Port IP range must equal the
switch port number excluding uplink ports (16).

Apply: Click to save changes to the entries. If the entries are valid, the webpage message “Update
success!” displays. Click the OK button to clear the message. If any entries are invalid, an error message
displays. Click the OK button to clear the message and enter valid values, then click the Apply button

again.

Reset: Click to undo any changes made locally and revert to previously saved values.
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DHCP Server Mode Configuration

When DHCP Per Port is enabled at Switch > System > IP Address > Advanced IP Settings, the
checkbox and selection in the DHCP Server Mode Configuration section becomes grayed out (cannot be
selected):

Auto-logout [DFF__ v 0 &

L L L Led

[ Ui ; A &

LANTRONIX" =

Advanced IP Settings

Switch DMS
DNS Server w
» System 1
1
> System Information |
> 1P Address IP Interfaces
» IP Settings
= DHCP Per Port
Mode Enablad v
> System Time ™ 1
» LLDP <
> UPnP
DHCPv4 1Pv4 IPVE
» Port Management %
Delete VLAN Enable Fallback Current Lease  Address Mask Length  Address Mask Length
» PoE Management <
» VLAN Management ~ C\ 1 0 152.168.1.77 Lad
» Quality of Service s
» Spanning Tree 3
» MAC Address Table < Link-Local Address binding interface VLANL W
» Multicast 3
» DHCP < IP Routes
» Security <
Delete Network Mask Length Gateway Next Hop VLAN
¥ Access Control < o
[ M 0.0.0.0 0 192.168.1.254 1}
» SNMP &
]
» Event Notification | Add Route | :

| Reset

» Diagnostics |
<

» Maintenance

To monitor DHCP Per Port status, navigate to the System > IP Address > Status menu path.

AR

-
n oot OFF v] B @

LANTRONIX" =|

SM8TBT25A IP Status @Home - System - [Paddress - Stews
Switch DMS —
Auto-refresh (D | Refresh |
» System e E
> System Information IP Interfaces
» IP Address v
> IP Settings Interface 4 Type Address Status
> Advanced IP Settings . .
0s:lo Link 00-00-00-00-00-00 UP LOOPBACK RUNNING MTU:16436 Metric:1
> Status
> System Time 0S:lo 1Pvd 127.0.0.1/8
» LLDP < 0silo IPV6 z1/128
> upne VLAN1 Link 00-40-C7-1D-53-29 UP BROADCAST RUNNING MULTICAST MTU:1500 Metric:1
<
> Port Management VLAN1 1Pv4 172.27.198.150/24 DHCP
» PoE Management <
WLAN IPvE fe80::240:cTff:feld:5325/64 Link Local Address
» VLAN Management <
VLAN2 Link 00-40-C7-1D-53-29 UP BROADCAST RUNNING MULTICAST MTU:1500 Metric:1
» Quality of Service <
. 3 VLAN2 IPv4 200.27.198.150/24 Manual
» Spanning Tree
» MAC Address Table < VLAN2 IPVE feB0:x240:cTff-feld:5329/64 Link Local Address
=t .y}
» Percepxion <
IP Routes
» DHCP <
» Security <
Network “ Gateway Status Interface
» Access Control <
0.0.0.0/0 172.27.198.1 UP GATEWAY VLANL
> SNMP <
» Event Notification < 0.00.0/0 0.00.0 ue VLANL
b Fhmresis ¢ 127.0.0.0/24 0.0.00 up 0Silo
» Maintenance < 169.254.0.0/16 0.0.00 up VLANL
172.27.198.0/24 0.0.00 up VLANL
200.27.198.0/24 0.0.00 up VLAN2
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Messages

Message: Interface xx not using DHCP

Meaning: The Interface being configured does not have DHCP enabled and configured.

Recovery: 1. Click the OK button to clear the webpage message. 2. Enable and configure DHCP for the
interface being configured. See “DHCP Server Mode Configuration” on page 271.

Message: The value of ‘DNS Server’ must be a valid IP address in dotted decimal notation (‘x.y.z.w’).
Meaning: You entered an invalid IP address for the DNS Server being configured.

Recovery: 1. Click the OK button to clear the webpage message. 2. Enter a valid IP address in the format
X.y.z.w per the on-screen restrictions. See “DHCP Server Mode Configuration” on page 271.

Message: ‘DHCP Interface VLAN ID’ must be an integer value between 1 and 4095.
Meaning: You entered an invalid VLAN ID for the DHCP Interface.

Recovery: 1. Click the OK button to clear the webpage message. 2. Enter a valid VLAN ID for the DHCP
Interface (1-4095). See “DHCP Server Mode Configuration” on page 271.

DHCP Per Port VLAN

The switch supports the DHCP IP Per Port function. It lets you IP Interfaces
have an IP address from a DHCP pool on a switch be statically

assigned to a switchport, such that whichever device plugs into the  PHcPPerPort
switchport it will always be assigned that specific IP address. The Mode ebied v
IP address is configured in the interface config settings. Note that
this is binding an IP address to an interface, not to a MAC address,
which is the classic binding technique found on most switches. P

VLAN VLANT  w

172.27.100.10 - | 172.27.100.10

Navigate to Configuration > System > IP and at the dropdown

select the DHCP Per Port VLAN parameter (the VLAN associated with the IP interface). Only ports in this
VLAN will be able to access the IP interface. This field is only available for input when creating a new
interface.

See “3-2.1 Advanced IP Settings” on page 12 for more information.

33873 Rev. A https://www.lantronix.com/ Page 272 of 273



https://www.lantronix.com/

Lantronix SMXTBTxSA Web User Guide

LANTRONIX

Lantronix Corporate Headquarters
48 Discovery, Suite 250

Irvine, CA 92618, USA

Toll Free: 800-526-8766

Phone: 949-453-3990

Fax: 949-453-3995

Technical Support
Online:_https://www.lantronix.com/technical-support/

Sales Offices
For a current list of our domestic and international sales offices, go to the Lantronix web site at
www.lantronix.com/about/contact.
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